
كاربر  آموزشی:  استاندارد  هـ،  ف.  ـ15/7ـ   87 استاندارد:  كد   FreeHand كاربر   
FreeHand/ مؤلفان: فرناز ریاحی، شهناز امين، معصومه عطيف؛ برنامه ریزی محتوا و 
نظارت بر تأليف: دفتر تأليف کتاب های درسی فنی و حرفه ای و کاردانش ]برای[ وزارت 

آموزش و پرورش، سازمان پژوهش و برنامه ریزی آموزشی.
تهران: شرکت چاپ و نشر کتاب های درسی ایران، 1392.

472ص.
7 ـ 2197 ـ 05ـ964ـ 978

فيپا
1ـ فری هند )برنامه كامپيوتر(،٢ـ گرافيک كامپيوتری

الف ـ ریاحی، فرناز، 1350، ب ـ امين، شهناز، 135٢ ، ج ـ عطيف، معصومه، 1356،
و  فنی  تأليف کتاب هـای درسی  دفتر  ـ  هـ  آمـوزشی.  برنامه ریزی  و  پژوهش  ـ سازمان  د 

حـرفـه ای و کـاردانش. و ـ اداره کلّ نظارت بر نشر و توزیع مواد آموزشی.
       385 T   /  1392  14ک

  373
2295413

:

:
:
:
:
:
:

:
:
:

عنوان و نام پدیدآور

مشخصات نشر
مشخصات ظاهری

شابک
وضعيت فهرست نویسی

موضوع
شناسه افزوده

رده بندی کنگره
رده بندی دیویی

شمارهٔ کتاب شناسی ملی

1392

 FreeHand كاربر
شاخۀ: كاردانش
زمينۀ: خدمات

گروه تحصيلی: كامپيوتر
زيرگروه: كامپيوتر

رشتۀ مهارتی: تصويرسازی كامپيوتری
شماره رشته مهارتی: 314ـ101ـ17ـ3

كد رايانه ای رشتۀ مهارتی: 6139
Freehand نام استاندارد مهارت مبنا: كاربر

كد استاندارد متولی: 87 ـ15/7 ف. هـ  
 شمارۀ درس: نظرى0480 و   عملى 0481



وزارت آموزش و پرورش  
سازمان پژوهش و برنامه ريزى آموزشى 

 برنامه ریزى محتوا و نظارت بر تأليف: دفترتأليف کتاب های درسی فنى  و حرفه اى و کاردانش
نام کتاب: کاربر FreeHand ـ 612/5

مؤلفان: فرناز رياحی، شهناز امين و مهندس معصومه عطيف
ویراستار ادبى: شيوا غمگسار و هما تيموری

         نظارت بر چاپ و توزیع: ادارۀ کلّ نظارت بر نشر و توزيع مواد آموزشی  
       تهران: خيابان  ايرانشهر  شمالى  ـ  ساختمان  شمارۀ 4 آموزش و پرورش )شهيد موسوى(
         تلفن: 9ـ88831161، دورنگار: 88309266، کدپستى: 1584747359،

 www.chap.sch.ir :وب سايت             
                        صفحه آرا: امير رشيدی مقدم

طراح جلد: مريم فرجيان
    ناشر:   شرکت چاپ و نشر کتاب های درسی ايران: تهران ـ کيلومتر ١٧ جادّۀ مخصوص کرج ـ خيابان ٦١ )داروپخش(

 ـ  37515               تلفن: 5 ـ 44985161، دورنگار: 44985160، صندوق پستی: 139
   چاپخانه:  شرکت افست »سهامی عام«

         نوبت چاپ و سال انتشار : چاپ اوّل برای سازمان  1392

حقّ چاپ محفوظ است.

همکاران محترم و دانش آموزان عزيز:
بـه نشانى  پيشنهادات و نظرات خود را در بارۀ محتواى اين کتاب 
تهران ـ صندوق پستى شمارۀ  4874/15  دفتر تأليف  کتاب های درسی فنى و 

حرفه اى و کاردانش ، ارسال فرمايند.
tvoccd@roshd.ir پيام نگار    )ايميل( 
www.tvoccd.medu ir وب گاه   )وب  سايت( 

ISBN  978  -  964- 05-2197-7     978  ـ   ـ  964  ـ   05 شابک  7   ـ2197

محتوای این كتاب دركميسيون تخصصی رشته كـامپيوتر دفتر تأليف  کتاب های درسی فنی و حرفه ای و كاردانش 
با عضویت: بتول عطاران، محمد  عباسی، الهه اسماعيل زاده، نادیا ماجدی و ميترا اميدوار تأیيد شده است 



به  و  كنيد  دراز  ديگران  پيش  را  خود  دست  پيشرفته،  صنايع  احتياجات  در  كه  مادام  بدانيد 
دريوزگي عمر را بگذرانيد، قدرت ابتکار و پيشرفت در اختراعات در شما شکوفا نخواهد شد.

امام خميني » قد ّس سره الشّريف«



به نام خدا

مجموعه كتاب هاي درس رشته كامپيوتر شاخه كاردانش
)استاندارد  وزارت فرهنگ و ارشاد اسلامي(

 رشته  توليد چندرسانه ايرشته طراحي صفحات وبرشته تصويرسازي

مفاهيم پايه فناوري اطلاعاتمفاهيم پايه فناوري اطلاعاتمفاهيم پايه فناوري اطلاعات

سيستم عامل مقدماتيسيستم عامل مقدماتيسيستم عامل مقدماتي

اطلاعات و ارتباطاتاطلاعات و ارتباطاتاطلاعات و ارتباطات

2007 Word 2007واژه پرداز Word 2007واژه پرداز Word واژه پرداز

2007 Excel 2007صفحه گسترده Excel 2007صفحه گسترده Excel صفحه گسترده

2007 PowerPoint 2007ارايه مطالب PowerPoint 2007ارايه مطالب PowerPoint ارايه مطالب

نرم افزارهاي اداري تکميلينرم افزارهاي اداري تکميلينرم افزارهاي اداري تکميلي

2007 Access 2007بانك اطلاعاتي Access 2007بانك اطلاعاتي Access بانك اطلاعاتي

سيستم عامل پيشرفتهسيستم عامل پيشرفتهسيستم عامل پيشرفته

برنامه نويسي مقدماتيبرنامه نويسي مقدماتيبرنامه نويسي مقدماتي

طراحي امور گرافيکي با رايانهطراحي امور گرافيکي با رايانهطراحي امور گرافيکي با رايانه

FreeHand كاربرFlash كاربرFlash كاربر

CorelDraw طراحي صفحات وب مقدماتيكاربرDirector كاربر

ميکس رايانه ايطراحي صفحات وب پيشرفته



مجموعه كتاب هاي درسي رشته كامپيوتر شاخه كاردانش
)استاندارد وزارت كار و امور اجتماعي(

رشته برنامه نويسي پايگاه داده رشته  توليد چندرسانه ايرشته طراحي صفحات وبرشته تصويرسازي

مفاهيم پايه فناوري اطلاعاتمفاهيم پايه فناوري اطلاعاتمفاهيم پايه فناوري اطلاعاتمفاهيم پايه فناوري اطلاعات 

سيستم عامل مقدماتيسيستم عامل مقدماتيسيستم عامل مقدماتيسيستم عامل مقدماتي

اطلاعات و ارتباطاتاطلاعات و ارتباطاتاطلاعات و ارتباطاتاطلاعات و ارتباطات

سيستم عامل پيشرفتهسيستم عامل پيشرفتهسيستم عامل پيشرفتهسيستم عامل پيشرفته

2007 Word 2007واژه پرداز Word 2007واژه پرداز Word 2007واژه پرداز Word واژه پرداز

2007 Excel صفحه گسترده Excel صفحه گسترده
20072007 Excel 2007صفحه گسترده Excel صفحه گسترده

 PowerPoint ارايه مطالب
2007

 PowerPoint ارايه مطالب
2007

 PowerPoint ارايه مطالب
2007

 PowerPoint ارايه مطالب
2007

نرم افزارهاي اداري تکميلينرم افزارهاي اداري تکميلينرم افزارهاي اداري تکميلينرم افزارهاي اداري تکميلي

برنامه نويسي مقدماتي طراح گرافيك رايانه ايطراح گرافيك رايانه ايطراح گرافيك رايانه اي

نرم افزار گرافيکي Flash شهروند الکترونيکي
Mxبرنامه نويسي ويژوال بيسيك شهروند الکترونيکي

پيشرفته )جلد اول(

FreeHand طراحي مقدماتي صفحات وبنرم افزار گرافيکيDirector برنامه نويسي ويژوال بيسيك نرم افزار گرافيکي
پيشرفته )جلد دوم(

نرم افزار گرافيکي 
CorelDrawInterdev رايانه كارSSP مديريت پايگاه دادهتدوين فيلم و صدا

Flash Mx نرم افزار گرافيکيDreamweaver رايانه كار Flash نرم افزار گرافيکي
Mxمهارت عمومي برنامه نويسي

CIW نرم افزار گرافيکي رايانه كار
Authorware



فهرست مطالب
مقدمه ...............................................................................................................................................................13

واحد كار اول: توانايي رعايت اصول ايمني و بهداشتي در محيط كار
كليات ...............................................................................................................................................................15
1-1 مهندسي محيط و محل انجام كار )ارگونوميك( .......................................................................... 15
2-1 عوامل مؤثر در استفاده صحيح از رايانه ...........................................................................................15
3-1 خستگي بدن .........................................................................................................................................18
4-1 عوارض استفاده از رايانه ......................................................................................................................18
5-1 مقررات انضباطي كارگاه ......................................................................................................................19
واژه نامه .............................................................................................................................................................19
خلاصه مطالب ................................................................................................................................................20

FreeHand واحد كار دوم: توانايي نصب نرم افزار
كليات.................................................................................................................................................................22
1-2 آشنايي با تصاوير برداري و پيكسلي..................................................................................................22
23................................................................FreeHand  MXa 2-2 امكانات لازم براي نصب نرم افزار
25.................................................................................................................FreeHand 3-2 اجراي برنامه
25.....................................................................................................................Welcome 4-2 كادرمحاوره
26..........................................................................................................................Wizard 5-2 كادرمحاوره
واژه نامه..............................................................................................................................................................29
خلاصه مطالب..................................................................................................................................................29
آزمون نظري ..................................................................................................................................................30
آزمون عملي .................................................................................................................................................. 31

واحد كار سوم: توانايي شناخت محيط نرم افزار FreeHand MXa و كار در آن
كليات .............................................................................................................................................................. 33
33 .............................................................................. FreeHand MXa 1-3 شناخت محيط نرم افزار
2-3 تنظيمات واحد اندازه گيري ............................................................................................................... 39
40 ........................................................................................... )Preferences( 3-3 تنظيمات ساختاري
4-3 روش هاي بازكردن يك تصوير گرافيكي ......................................................................................... 43
5-3 بزرگنمايي ............................................................................................................................................. 46
6-3 كاربرد ابزار Hand در هنگام بزرگنمايي ...................................................................................... 47
7-3 تنظيم حالت هاي نمايشي تصوير ..................................................................................................... 48
8-3 ايجاد نماي ديد سفارشي .................................................................................................................. 50
52 ................................................................................................... Keyboard Shortcuts 9-3 فرمان
53........................................................................... FreeHand MXa 10-3 انواع فرمت هاي نرم افزار



55 .................................................................................... FreeHand 11-3 روش هاي ذخيره سازي در
56....................................................................................................................................Revert 12-3 فرمان
57.................................................................................FreeHand 13-3 سفارشي كردن محيط برنامه
58 ........................................................................................... FreeHand 14-3 بستن فايل و خروج از
واژه نامه ........................................................................................................................................................... 59
خلاصه مطالب ............................................................................................................................................... 59
آزمون نظري .................................................................................................................................................. 61
آزمون عملي ................................................................................................................................................... 63

واحد كار چهارم: توانايي  ايجاد فضاي  موردنياز  جهت  قرارگيري  اشياي  گرافيكي
كليات .............................................................................................................................................................. 65
1-4 ايجاد صفحه پيش فرض ..................................................................................................................... 65
65 ............................................................................................................................. Document 2-4 پنل
74 ..................................................................................................................... Master Page 3-4 صفحه
83 ................................................................................................... )Page Rulers( 4-4 كار با خط  كش
84 ............................................................................................................. )Guides( 5-4 خط هاي راهنما
89 ....................................................................................................................... )Grid( 6-4 خطوط شبکه
90 ........................................................................................................................................... Snap 7-4 ابزار
واژه نامه ........................................................................................................................................................... 92
خلاصه مطالب ............................................................................................................................................... 92
آزمون نظري .................................................................................................................................................. 93
آزمون عملي.....................................................................................................................................................95

واحد كار پنجم: توانايي استفاده  از عناصر و ابزار در طراحي و ترسيم مسيرها
كليات .............................................................................................................................................................. 98
1-5 ابزار Pen و تنظيمات آن .................................................................................................................. 98
103 ................................................................................................................... Bezigon 2-5 ابزار ترسيم
3-5 ابزار ترسيم خط )Line( و تنظيمات آن.......................................................................................105
4-5 ابزار Pencil و تنظيمات آن ......................................................................................................... 107
5-5 ابزار Variable Stroke Pen tool و تنظيمات آن ............................................................ 109
6-5 ابزار خوشنويسي Calligraphic Pen tool و تنظيمات آن ............................................. 110
111 ....................................................................................... )Rectangle( 7-5 ابزار ترسيم چهارگوش
115 ....................................................................................................................... Ellipse 8-5 ابزار ترسيم
115 ........................................................................................... )Polygon( 9-5 ابزار ترسيم چندضلعي
10-5 ابزار ترسيم ستاره .......................................................................................................................... 117
واژه نامه............................................................................................................................................................119
خلاصه مطالب ............................................................................................................................................ 119
آزمون نظري ............................................................................................................................................... 121



آزمون عملي ................................................................................................................................................ 123
FreeHand MXa واحد كار ششم: توانايي ترسيمات ديگر در نرم افزار

كليات ........................................................................................................................................................... 125
125 ........................................................................................................................................... Arc 1-6 ابزار
126 ...................................................................................................................................... Spiral 2-6 ابزار
129 ................................................................................................................ )Pointer( 3-6 ابزار انتخاب
136 ............................................................................................................................. Freeform 4-6 ابزار
141 ....................................................................................................................................... Knife 5-6 ابزار
143 ................................................................................................. Eraser 6-6 پاك كردن مسير با ابزار
144 ...................................................................................................... Lasso 7-6 انتخاب اشکال با  ابزار
145 .......................................................................................................................... Connector 8-6 ابزار
146 ................................................................................................... Edit 9-6 برخي از فرمان هاي منوي
واژه نامه ......................................................................................................................................................... 151
خلاصه مطالب ............................................................................................................................................ 151
آزمون نظري ............................................................................................................................................... 153
آزمون عملي .................................................................................................................................................155

واحد كار هفتم: توانايي كار با رنگ و ويرايش آن
كليات ........................................................................................................................................................... 157
1-7 مدل هاي رنگ و كاربردهاي آن ها....................................................................................................157
2-7 پنل هاي رنگ .................................................................................................................................... 160
163 .................................................. )Change Attribute Color( 3-7 تغيير خصوصيت رنگ ها
164 ................................................................................................... )Tints( 4-7 ايجاد تناليته هاي رنگ
167 .............................................................................................................................. Swatches 5-7 پنل
6-7 آشنايي با انواع پالت هاي رنگ ....................................................................................................... 172
172 .................................................... Library 7-7 استفاده از جدول رنگ هاي فتوشاپ و رنگ هاي
174 .............................................................................. Swatches 8-7 مديريت ليست رنگ ها در پنل
175 .............................................................................................................. Stroke & Fill Color 7-9
10-7 اصول ويرايش رنگ ....................................................................................................................... 177
واژه نامه ......................................................................................................................................................... 184
خلاصه مطالب ............................................................................................................................................ 184
آزمون نظري ............................................................................................................................................... 185
آزمون عملي ................................................................................................................................................ 187

واحد كار هشتم: توانايي استفاده از پركننده ها و فرمان هاي ويرايش اشياء
كليات ........................................................................................................................................................... 189
189 ............................................................................................. Object در پنل Add Fill 1-8 دكمه
2-8 انواع طرح ها ....................................................................................................................................... 190



203 ..................................................................................... Object در پنل Add Stroke 3-8 دكمه
209 ..................................................................................................................... Eye Dropper 4-8 ابزار
209 ................................................................................................................................. Create 5-8 فرمان
212 ............................................................................................................................... Distort 6-8 فرمان
واژه نامه ........................................................................................................................................................ 215
خلاصه مطالب ............................................................................................................................................ 215
آزمون نظري................................................................................................................................................. 217
آزمون عملي ................................................................................................................................................ 218

واحد كار نهم: توانايي كار با متن
كليات ........................................................................................................................................................... 221
221 ......................................................................................................................................... Text 1-9 ابزار

2-9 انتخاب و تنظيمات متن ..................................................................................................................224    
226 ...................................................................................................................................... Text 3-9 منوي
244 .................................................................................................. Object در پنل Text Block 9-4
246 ........................................................................................ FreeHand MXa 5-9 فارسي نويسي در
واژه نامه ......................................................................................................................................................... 248
خلاصه مطالب ............................................................................................................................................ 248
آزمون نظري ............................................................................................................................................... 249
آزمون عملي ................................................................................................................................................ 251

واحد كار دهم: توانايي انجام كار روي اشياء
كليات ........................................................................................................................................................... 253
253 .............................................................................................................................. Group 1-10 گزينه
254 ....................................................................................................................... Ungroup 2-10 گزينه
255 .................................................................................................................................. Lock 3-10 گزينه
256 ............................................................................................................................ Unlock 4-10 گزينه
256 .................................................................................................................................... Join 5-10 گزينه
257 ................................................................................................................................... Split 6-10 گزينه
258 ......................................................................................................................... Arrange 7-10 فرمان
258 ................................................................................................................................ Align 8-10 گزينه
262 ................................................................................................ )Transform( 9-10 تغيير در اشياء
272 ............................................................................................................ Combine 10-10 فرمان هاي
281 ............................................................................ Alter Path 11-10 ويرايش مسير با فرمان هاي
290 ................................................................................................ Mirror 12-10 انعکاس اشياء با ابزار
واژه نامه ......................................................................................................................................................... 293
خلاصه مطالب ............................................................................................................................................ 294
آزمون نظري ............................................................................................................................................... 295



آزمون عملي ................................................................................................................................................ 297
واحد كار يازدهم: توانايي استفاده از جلوه هاي ويژه

كليات ........................................................................................................................................................... 299
299 ....................................................... Add effect 1-11 اضافه كردن جلوه هاي ويژه با استفاده از
315 ....................................................................................................................... Envelope 2-11 فرمان
319 ................................................................................................................ Fisheye Lens  3-11 ابزار
320 ................................................................................................................... 3D Rotation 4-11 ابزار
323 .............................................................................................................................. Shadow 5-11 ابزار
326 .............................................................................................................................. Smudge 6-11 ابزار
328 ..................................................................................................................................... Bend 7-11 ابزار
329 ........................................................................................................................... Roughen 8-11 ابزار
330 ............................................................................................. )Perspective( 9-11 ايجاد پرسپکتيو
332 ........................................................................................................................... Extrude 10-11 ابزار
واژه نامه ......................................................................................................................................................... 333
خلاصه مطالب ............................................................................................................................................ 334
آزمون نظري ............................................................................................................................................... 336
آزمون عملي ................................................................................................................................................ 337

Graphic Hose و Styles ،واحد كار دوازدهم: توانايي استفاده از لايه ها، سمبل ها
كليات .............................................................................................................................................................340
340 ..........................................................................................................................)Layers(  1-12 لايه ها
352 .................................................................................................................................Library 2-12 پنل
359 ...............................................................................................................................)Style(  3-12 سبك
368 ............................................................................................................... Graphic Hose 4-12 ابزار
371 ................................................................................................................................... Chart 5-12 ابزار
واژه نامه ......................................................................................................................................................... 372
خلاصه مطالب ............................................................................................................................................ 373
آزمون نظري ............................................................................................................................................... 374
آزمون عملي ................................................................................................................................................ 376

واح�د كار س�يزدهم: توانايي اس�تفاده از تصاوي�رBitmap در نرم اف�زار FreeHand و 

ويرايش آن ها
379 .................................................... FreeHand 1-13 آشنايي با فرمت هاي قابل ورود به نرم افزار
379 ............................................................................... )Bitmap( 2-13 وارد كردن تصوير طرح بيتي
382 ........................................................................... Optimize In Fireworks 3-13 كار با فرمان
384 ....................................................... Trace 4-13 تبديل تصاوير نقشه بيتي به برداري توسط ابزار
389 .................................................................... )Bitmap( 5-13 تبديل تصوير برداري به طرح بيتي
واژه نامه ......................................................................................................................................................... 392



خلاصه مطالب ............................................................................................................................................ 392
آزمون نظري ............................................................................................................................................... 393
آزمون عملي ................................................................................................................................................ 394
واحد كار چهاردهم: توانايي متحرك س�ازي و اس�تفاده از سند FreeHand در صفحات 

وب
كليات ........................................................................................................................................................... 397
397 ...................................................................................... FreeHand 1-14 مفاهيم اوليه حركت در
398 .................................................................................................................... Action Tool 2-14 ابزار
401 ............................................................ FreeHand به سند Flash Action 3-14 انتساب يك
402 ................................................................................... FreeHand در Flash هايAction 14-4
5-14 آزمايش فيلم .................................................................................................................................. 404
6-14 متحرك سازي با متن و شئ ........................................................................................................ 405
418 ........................................................ HTML با فرمت Webدر FreeHand 7-14 انتشار سند
422 ........................................................................................................................ URL 8-14 انتساب يك
واژه نامه ........................................................................................................................................................ 426
خلاصه مطالب ............................................................................................................................................ 426
آزمون نظري ............................................................................................................................................... 427
آزمون عملي ................................................................................................................................................ 429

FreeHand MX واحد كار پانزدهم: توانايي  ارسال  و  چاپ  گرافيك  در  نرم افزار
كليات ........................................................................................................................................................... 431
431 ............................................................................................................................. Export 1-15 فرمان
434 ............................................................................................................. Export Again 2-15 فرمان
434 ............................................................................................ Email  3-15 ارسال يك سند به صورت
435 ................................................................................................................................. Print 4-15 فرمان
440 ..........................................................)Color Management(  5-15 آشنايي با مديريت رنگ
441 .................................................................................................................. Output Area 6-15 ابزار
واژه نامه ......................................................................................................................................................... 444
خلاصه مطالب ............................................................................................................................................ 444
آزمون نظري ............................................................................................................................................... 445
آزمون عملي ................................................................................................................................................ 447
آزمون پاياني )نظري( ................................................................................................................................ 448
آزمون پاياني )عملي( ................................................................................................................................ 457
پاسخنامه ..................................................................................................................................................... 459
ضميمه الف ................................................................................................................................................. 464
ضميمه ب ................................................................................................................................................... 468
فهرست منابع ............................................................................................................................................. 472





مقدمه

ستايش پروردگار بي همتا را كه بار ديگر ما را مفتخر كرد تا بتوانيم در وادي علم و دانش 
گام برداشته و آموخته ها و تجارب خود را در اختيار همگان قرار دهيم. در اين زمان كه علم 
در همه عرصه هاي زندگي بشر پا نهاده است، بر آن شديم تا حضور آن را در كنار هنر يادآور 
شويم. در اين راستا كتاب حاضر به آموزش نرم افزار گرافيکي FreeHand MXa پرداخته كه در 
 FreeHand واقع نگارش 11/02 اين برنامه است. تنظيم مطالب كتاب بر اساس استاندارد كاربر
ــلامي صورت گرفته است و به جرأت مي توان گفت كه اين كتاب  ــاد و فرهنگ اس وزارت ارش

خودآموز و مرجع كاملي براي كاربران FreeHand است.
ــورت گام به گام و  ــي به ص ــت كه مطالب آموزش ــعي ما بر اين بوده اس در اين كتاب س
ــود. همچنين  ــته ش تصويري همراه با مثال و تمرينات متعدد و خلاق براي دانش آموزان نوش
ــب مهارت هاي  با تمرينات كاربردي و پروژه هاي عملي در انتهاي كتاب، هنرجويان را به كس

بيشتر سوق داده ايم.
مطالب كتاب در 15 واحدكار تهيه شده كه شامل موارد زير است:

توانايي رعايت اصول ايمني و بهداشتي در محيط كار، نصب نرم افزار FreeHand و شناخت 
محيط آن، ايجاد فضاي مورد نياز براي قرارگيري اشياي گرافيکي و استفاده از عناصر و ابزار 
در طراحي و ترسيم ها، كار روي اشياء و ويرايش آن ها، كار با رنگ و پركننده ها، كار با متن، 
استفاده از جلوه هاي ويژه، استفاده از لايه ها، سمبل ها و سبك ها، متحرك سازي و استفاده از 

سند FreeHand در صفحات وب، صدور و چاپ فايل هاي گرافيکي.
ــت الکترونيکي  ــه آدرس پس ــود ب ــنهادات خ ــال نظرات و پيش ــا ارس ــه ب ــم ك  اميدواري

F_Riahi2000@yahoo.com  ما را در رفع كاستي هاي اين كتاب ياري نماييد.

مؤلفان
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كليات 
ــتفاده از  ــط كاري كه در آن قراردارد و موقعيت بدني و نحوه اس ــان با توجه به محي انس
ابزارهاي محيط كار و رعايت بهداشت در پيرامون خود، تحت تأثير شرايط قرار مي گيرد و اگر 
ــي از فشارهاي وارد  ــب و اصولي با ابزار و محيط كارش برقرار نکند، عوارض ناش ارتباط مناس
شده بر او سبب اخلال در اجراي درست كار، خستگي و ناراحتي در اندام هاي او مي شود. در 
دنياي امروز، كاربرد رايانه در زمينه هاي مختلف اهميت داشته و استفاده از آن اجتناب ناپذير 

است، نحوه قرارگيري درست كاربر پشت دستگاه در استفاده بهينه از آن مؤثر است.
1-1 مهندسي محيط و محل انجام كار )ارگونوميك(

ــخت افزار/  ــان با ابزارها، تکنولوژي )س ــش ارگونوميك، به مطالعه ارتباط و تعامل انس دان
نرم افزار( و فعاليت هاي كاري و محيطي كه در آن كار مي كند، مي پردازد. هدف اصلي، ايجاد 

هماهنگي و مناسب بودن كار براي هر فرد است.

شکل 1-1 دسترسي به ابزارهاي محيط كار

2-1 عوامل مؤثر در استفاده صحيح از رايانه
به منظور رعايت ارگونومي و حفظ سلامتي بايد به عواملي در هنگام كار با كامپيوتر توجه 

داشت، اين عوامل عبارتند از: 
1-2-1 چيدمان رايانه 

ــت ها و پشت، گردن و ... سه  ــکل براي دس ــلامت و جلوگيري از ايجاد مش براي حفظ س
توصيه زير را رعايت كنيد:

1- ماوس و ساير ابزارهاي ورودي را در كنار صفحه كليد قرار دهيد تا فشار وارده در دسترسي 
 به وسايل، روي شانه ها كاهش يابد. براي اينکه ماوس حركتي روان داشته باشد از زيرماوسي

)Mouse Mat( استفاده كنيد.
 Mouse Mat : براي بهبود و پيشرفت كاربرد ماوس كامپيوتر مورد استفاده قرار مي گيرد 
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)شکل 1-2(.
Mouse Mate : اين وسيله مستقيماً به ماوس مي چسبد، كف دست در حالت خنثي قرار 

مي گيرد و ماوس به يك ماوس ارگونوميك تبديل مي شود )شکل 1-3(.
      

                       

                              

                                     شکل 2-1      شکل 1-3

2- صفحه نمايش را در پشت صفحه كليد بگذاريد و لبه بالايي آن را در امتداد چشم هايتان 
ــم ها را نزديك به اندازه طول شانه در نظر بگيريد  قراردهيد. فاصله بين صفحه نمايش و چش
ــانتي متر است(. براي كم كردن تشعشع در صفحه  ــب معمولاً بين 48 تا 71 س )فاصله مناس
نمايش هاي كنوني تکنولوژي جديدي به كار مي رود. همچنين براي كاهش درخشندگي آن 
ــت و چپ بچرخانيد. در صورت وجود پنجره، بايد امتداد آن با  ــمت بالا، پايين يا راس را به س

صفحه نمايش زاويه 90 درجه داشته باشد و كاربر پشت به آن قرار نگيرد.
3- براي نگه داشتن صفحه ها در هنگام تايپ مطالب، از يك نگهدارنده )Holder( استفاده 

كنيد. تنظيم فاصله و ارتفاع آن مانند صفحه نمايش است.
2-2-1 صندلي مناسب 

ــب براي كار با رايانه مجهز به تکيه گاه )پشتي(، دسته و ارتفاع قابل تنظيم  صندلي مناس
است و لبه جلوي نشيمنگاه آن انحنايي رو به پايين دارد.

تنظيم ارتفاع صندلي
ــي كه براي اين كار در نظر  ــد كاربر و ارتفاع ميز، ارتفاع صندلي با اهرم هاي ــا توجه به ق ب
ــده است، تنظيم مي شود. ارتفاع صندلي نبايد سبب ايجاد ناراحتي در پشت ران يا  گرفته ش

زانو شود.
3-2-1 ميز مناسب

ــب برای كار با رايانه، فضاي كافي براي همه وسايل را دارد و ارتفاع ميز  ــطح ميز مناس س
ــتقرار آن در صورت وجود  ــد كه كاربر پاهايش را جمع كند و محل اس نبايد آن قدر كم باش

پنجره در محيط كار، به نحوي است كه كاربر در كنار پنجره قرار بگيرد.
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ــار به آن ها، از يك  ــراي جلوگيري از وارد آمدن فش ــر پاها روي زمين قرار نگرفت ب  نكت�ه: اگ
زيرپايي استفاده كنيد.

4-2-1 تهويه و نور 
ــايل خنك كننده براي كم  ــد و از تهويه و وس ــته باش در محيط كار بايد هوا جريان داش
ــي از وجود جريان الکتريسيته در قطعه هاي الکتريکي استفاده شود تا  اثر كردن حرارت ناش
ــتم رايانه با بالا رفتن حرارت كم نشود. براي روشن كردن ميز كار بهتر است از  كارايي سيس

چراغ مطالعه استفاده شود همچنين نور مستقيم، به كاربر نتابد.

5-2-1 روش هاي به كارگيري ماوس و صفحه كليد
ــار مچ ها، بازوها و  روش ها و تکنيك هاي صحيح به كارگيري ماوس و صفحه كليد از فش

آرنج ها كم مي كند و مي تواند از فشار ثابت شانه ها بکاهد.
هنگامي كه تايپ مي كنيد دست ها و بازوها را ثابت نگه نداريد،  	

همچنين آن ها را روي ميانه دسته صندلي قرار ندهيد.
هنگامي كه با ماوس و صفحه كليد كار مي كنيد كف دست يا  	

مچ دستتان را ثابت نکنيد يا وزنش را روي آرنج نيندازيد.
ــتقيم نگه داريد و ميزان خم شدگي مچ به  مچ دستتان را مس 	

سمت بالا يا پايين يا داخل و بيرون را به حداقل برسانيد.
ــتتان، 120	 درجه يا بيشتر باشد و از زاويه  زاويه بازِ آرنج دس

كمتر از 90 درجه اجتناب كنيد.
 جدول 1-1 حالت هاي مناسب و نامناسب كار با صفحه كليد

حالت مناسب 
آزاد است، در حالي  دست هايتان 
قرار  طرف  دو  در  آرنجتان  كه 
دارد و صفحه كليد روي پاهايتان 

است.

حالت مناسب
 ساعدتان را روي دسته صندلي 
قرار دهيد و دست هايتان را به 

حالت آزاد قرار دهيد.

حالت مناسب
يا  ميز  روي  ساعدها 
مخصوص  صفحه  يك 

قرار دارد.

حالت نامناسب
وقتي كه با صفحه كليد كار 
مي كنيد، مچتان را ثابت نگه 

نداريد.
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ــتراحت داده و  ــار به مدت 5 دقيقه به خودتان اس ــاعت يك ب  نكت�ه: حداقل هرس
حركات كششي انجام دهيد.

3-1 خستگي بدن 
هنگامي كه انسان در اجراي فعاليت خود از نظر ذهني و جسمي بازدهي مناسب نداشته 
ــده است. در كار با رايانه چشم ها، دست ها، پاها و ... با رعايت نکردن شرايط  ــد، خسته ش باش

ارگونومي خسته مي شوند. 
1-3-1 رفع خستگي بدن هنگام كار

ــغول به كار هستيد براي استراحت و تجديد قوا لازم است كه موارد بعد را  زماني كه مش
براي قسمت هاي مختلف بدن انجام دهيد:

ــگاه كرده و براي يك لحظه  ــر 20	 دقيقه يك بار به يك فاصله دورتر ن چشـم ها: ه
كوتاه به يك فاصله نزديك نگاه كنيد.

ــورت بادبزني باز كرده و  ــت هايتان را به ص دسـت ها و بازوهـا: هر20	 دقيقه انگش
ــتتان را روي پاهايتان بگذاريد و در حالي  كه  ــپس دس حركت دهيد و بچرخانيد س

شست هايتان بالاست، آن را تکان دهيد.
بدن در وضعيت نشسته: هر 30	 دقيقه يك بار بلند شويد و حركت كششي انجام 

دهيد و هر يك ساعت يك بار، 5 دقيقه بلند شويد و راه برويد.

       

  شکل 4-1 حركت بادبزني انگشتان و حركت شست                   شکل 5-1حالت كششي

4-1 عوارض استفاده از رايانه 
ــبب ايجاد عوارض ناشي از كار با رايانه  ــتگي در كاربر رايانه و عدم رفع آن، س تداوم خس
مي شود كه عبارتند از كمردرد، پادرد، درد در مچ دست، احساس ناراحتي در گردن و شانه ها 

و ضعيف شدن ديد چشم ها.
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1-4-1 نحوه پيشگيري از عوارض استفاده از رايانه

ــت اندام ها طبق آنچه در  ــتن و به كارگيري درس ــا رايانه طرز صحيح نشس ــگام كار ب هن
ــتگي و عوارض كار با رايانه را كم كرده و حتي مانع از  ــت، خس ــده اس صفحات قبل گفته ش

ايجاد ناراحتي مي شود.
در شکل 6-1 روش درست نشستن هنگام كار با رايانه نشان داده شده است.

شکل 6-1 طرز نشستن هنگام كار با رايانه

5-1 مقررات انضباطي كارگاه 
هنگام كار با رايانه رعايت يکسري مقررات براي به حداقل رسيدن آسيب ها، ضروري است 

كه برخي از آن ها به اين شرح است:
روشن و خاموش كردن سيستم ها بر طبق ضوابط و اصول درست 	
شناسايي وسيله ها و تجهيزات جانبي و استفاده صحيح از آن ها  	

و  ــب از حافظه هاي كمکي مانند فلاپي، Cool disk ،CD و ... 	 ــتفاده درست و مناس اس
ــي آن ها با نرم  اطمينان از بي عيب بودن حافظه هاي كمکي از لحاظ فيزيکي و بررس
افزارهاي ضد ويروس و كرم )Worm( و مطمئن شدن از عدم ويروسي بودن آن ها.

ــتگاه ها و ابزارها بايد از رطوبت، ميدان هاي مغناطيسي، ضربه خوردن،   نكته: دس
ساييده شدن و خش افتادن در امان باشند.
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واژه نامه
Cool diskحافظه كمکي

Ergonomicمهندسي محيط و محل انجام كار

Foot Restزيرپايي

Holderنگهدارنده

Postureطرز نشستن و ايستادن

                  
                                 

            
خلاصه مطالب

براي رعايت ارگونوميك بايد به موارد زير توجه داشت: 	
1- وضعيت مناسب بدن 

2- وضعيت مناسب  و محل قرار گرفتن ميز و صندلي
3- وضعيت مناسب نور و روشنايي

4- تهويه مناسب
5- استفاده از ابزارهايي كه ارگونوميك در آن ها رعايت شده است.
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كليات 
ــرفت هاي علمي و تکنولوژي سبب شده است كه سيستم سنتي صنعت چاپ  امروزه پيش
ــتي جاي خود را به كامپيوترها و اجزاي جانبي دقيق و نرم افزارهاي گرافيکي  و گرافيك دس

دهد و در اين صنعت تحول ايجاد كند.
ــما را در طراحي و ايجاد  ــت كه ش ــك برنامه گرافيکي برداري اس ــزار FreeHand ي نرم اف
اشکال گرافيکي نظير آرم ها، طراحي جلد كتاب، بروشور، كارت ويزيت و پوستر ياري مي كند. 
علاوه بر  اين، مي توانيد تصاوير ساخته شده در اين  برنامه را با برنامه Flash به تصاوير متحرك 
ــازي تصاوير را به نحوي فراهم  كنيد كه قابل استفاده  تبديل كنيد، همچنين امکان ذخيره س

در صفحات وب باشد.
ــن نرم افزار در كنار Photoshop به عنوان مکمل ويرايش تصوير، كاربران را در طراحي،  اي

تصوير سازي و چاپ ياري مي رساند.
ــده  ــخه )MXa 1102( از نرم افزار FreeHand آموزش داده ش ــه مهارتي نس ــن پيمان  در اي

است.
1-2 آشنايي با تصاوير برداري و پيكسلي

 گرافيك كامپيوتري به طور كلي به دو بخش پيکسلي )Raster( يا طرح بيتي )Bitmap( و برداري 
)Vector( تقسيم مي شود.

ــاپ با پيکسل ها سروكار دارد، يعني هرتصوير  نرم افزارهاي پيكسـلي:	 نظير فتوش
ــکل يا پيکسل با رنگ هاي مختلف تشکيل مي شود كه  از تعداد زيادي نقاط مربع ش
هرچه تعداد اين پيکسل ها بيشتر باشد، جزييات تصوير بيشتر مشخص شده و تصوير 

داراي وضوح بيشتري مي شود.
متون در اين نوع نرم افزارها داراي كيفيت پايين تري هستند و وضوح آن ها به تعداد  	
ــتگي دارد، به همين دليل بحث درجه وضوح  ــکيل  دهنده متن بس ــل هاي تش پيکس
ــاپ كيفيت و هموار بودن لبه هاي حروف  )Resolution( پيش مي آيد يعني در فتوش

و اشکال به ميزان Resolution تصوير بستگي دارد. 
 نرم افزارهاي برداري: در اين گونه نرم افزارها تصاوير و متون از يکسري خطوط و منحني ها كه 
ــوند. به عبارت ديگر اشکالي نظير  ــاس فرمول هاي رياضي تعريف شده اند، تشکيل مي ش براس
دايره، خط، كمان و غيره به صورت موضوعات مستقلي هستند كه مي توانيد به سادگي آن ها 
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ــد.  ــته باش ــا كنيد يا تغيير مقياس دهيد بدون اين كه در كيفيت آن ها تأثيري داش را جابه ج
ــطح كيفي ترسيمات و متون در  ــي ندارد بنابراين س در اين نوع نرم افزارها درجه وضوح نقش
ــت. از اين رو بسياري از طراحان ترجيح مي دهند كه تصويرسازي را  حداكثر ميزان ممکن اس
ــاپ انجام دهند سپس آن  را به FreeHand منتقل كرده و تايپ و حروف نگاري را در  در فتوش

اين محيط انجام دهند و در نهايت آن  را چاپ كنند.
نرم افزارهاي Adobe Illustrator ، FreeHand و CorelDRAW نمونه هايي از گرافيك برداري 

هستند.

 توجه: اندازه فايل هاي Vector از فايل هايBitmap بسيار كمتر است.

 نكته: كيفيت و وضوح ترسيم Vector به وضوح صفحه نمايش و چاپگر وابسته نيست.

 

شکل 1-2 به ترتيب از راست به چپ: تصوير برداري و پيکسلي

ــت كه در نرم افزار  ــلي در اين اس  توج�ه: اصلي ترين تفاوت نرم افزارهاي برداري و پيکس

ــيم و حجم آن بي تأثير است، اما در نرم افزار  ــم شده، در كيفيت ترس ــکل رس برداري تغيير اندازه ش
پيکسلي با كاهش و افزايش اندازه تصوير، كيفيت و حجم آن نيز كم و زياد مي شود.

FreeHand  MXa 2-2 امكانات لازم براي نصب نرم افزار
 برنامه FreeHand با پردازش تصاوير و محاسبات پيچيده اي سروكار دارد، بنابراين رايانه اي كه اين 

نرم افزار روي آن نصب مي شود، حداقل بايد اين امکانات را داشته باشد:
پردازنده: سرعت پردازنده بايد Pentium III 600MHz يا بالاتر باشد.	
سيستم عامل: مي تواند يکي از اين ويندوزها باشد:	

XP, Vista, Seven ,  NT4(Service Pack6 (, 2000

حافظه MB :RAM 512 يا بالاتر 	
كارت گرافيكي: كارت گرافيك 16 بيتي با وضوح 768×1024 مناسب است.	
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 	100  MBنصب مي شود حداقل FreeHand حافظه ديسک سخت: در پارتيشني كه
فضاي آزاد موردنياز است. 

درايوCD  يا DVD: كامپيوتر حداقل بايد به يکي از اين درايوها مجهز باشد.	
  FreeHand 1-2-2 نصب نرم افزار

براي نصب برنامه گرافيکي FreeHand مي توانيد از سه روش مختلف استفاده كنيد. در هر 
سه روش با اجراي فايل Setup.exe، ويزارد نصب آشکار مي شود؛ اين روش ها عبارتند از:

1- اجـراي خودكار CD يا DVD نصب برنامه: اگر برنامه نصب به صورت خودكار اجرا 
 ،)Setup يا Install( شود، در پنجره ظاهر شده با كليك روي نام برنامه يا گزينه نصب نرم افزار

فايل اجرايي نصب برنامه يعنيSetup.exe  اجرا مي شود.
2- اجراي دستي نصب برنامه: در اين روش ابتدا روي آيکن CD يا DVD كليك راست 
ــي خواهيد  ــاب گزينه Open به فايل اجرايي نصب برنامه دسترس ــد و پس از آن با انتخ كني

داشت.
3- اسـتفاده از گزينه  Add or Remove Programs  درControl Panel : در اين روش 
ــهCD or Floppy  كليك كرده و  ــتفاده از پنجره Add or Remove Programs روي دكم با اس
ــك روي دكمه مرور )Browse( در  ــل اجراي نصب برنامه يعنی setup.exe را با كلي ــير فاي مس

كادر متني Open درج كنيد.
ــه روش گفته شده مي رسيد. در اين  ــترك بين س با اجراي فايل setup.exe به مراحل مش
ــير نصب فايل هاي  ــود و در مرحله هاي بعدي، تعيين مس ــکار مي ش مرحله ويزارد نصب آش
برنامه، سبب كپي شدن فايل ها در مسير انتخابي مي شود. پس از پايان نصب برنامه و اجراي 

آن، محيط برنامه طبق شکل 2-2 آشکار مي شود.

شکل 2-2 محيط برنامه FreeHand پس از اجرا
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FreeHand MXa  3-2 اجراي برنامه
براي  اجراي  برنامه مي توانيد  مسير

ــاب  Start → All Programs → Macromedia → Macromedia FreeHand MXa  را انتخ

كرده يا از ميانبري كه روي صفحه Desktop ايجاد كرده ايد، استفاده كنيد.
Welcome 4-2 كادرمحاوره

با اجراي مسيرHelp→Welcome  كادرمحاورهWelcome  ظاهر مي شود. كادر خوشامدگويي 
FreeHand شامل اين پيوندها است:

What’s New 2-4-1

ــر قرار مي دهد. به منظور  ــا و امکانات جديد برنامه را در اختيار كارب ــه اي از ابزاره خلاص
ــه برنامه با كليك روي علامت  ــده ب ــراري ارتباط بهتر با كاربر برخي از امکانات اضافه ش برق

دوربين به صورت تصويري نشان داده مي شود.)شکل 2-3(
                                                                         

  

شکل 3-2 نمايش ابزارهاي جديد اضافه شده به برنامه  

Using FreeHand MX 2-4-2

ــد كه مي  توانيد به  ــان مي ده ــن گزينه، راهنماي برنامه FreeHand را نش ــك روي اي كلي
صورت سرفصل موضوعات، كلمه هاي كليدي و جستجوي عبارت ها و كلمه ها  از آن استفاده 

كنيد.
Learning FreeHand MX 2-4-3

 Adobe و با استفاده از سايت Online ــرفصل ها و درس هاي برنامه به صورت براي مرور س
از اين پيوند استفاده مي شود. 
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View the FreeHand MX product pages 2-4-4
 Online به صورت Adobe ــتي از محصولات ارائه شده توسط شركت ــمت ليس در اين قس

مشاهده مي شود. 
Visit the Macromedia Designer & Developer Center 2-4-5

ــعه نرم افزار به كار مي رود.  ــي و توس ــز طراح ــاط با مرك ــراري ارتب ــد، براي برق ــن پيون اي
ــد  پيون روي  ــما  ش ــك  كلي ــتيد،  هس ــل  متص ــت  اينترن ــه  ب ــه   هنگامي ك
Visit the Macromedia Designer & Developer Centerصفحه Adobe Design Center را ظاهر 

مي كند.
Visit the FreeHand MX Support Center 2-4-6

 Visit the FreeHand MX Support با مركز ارائه خدمات برنامه از طريق پيوند Online ارتباط
 Center امکان پذير است. در صفحه اين پيوند، نکات اساسي و منابع و تجهيزات مورد نياز برنامه

FreeHand MXa ، مشکلات چاپ و كار با متن ها و ... در اختيار كاربر قرار مي گيرد.

Wizard 5-2 كادرمحاوره
ــود، اين است  همان طوركه مي دانيد ويژگي برنامه هايي كه به صورت Wizard اجرا مي ش
كه در هر مرحله از اجراي برنامه مورد نظر، سؤال ها و انتخاب هايي آشکار مي شود كه براساس 
ــما را به مرحله بعدي اجراي برنامه  ــخي كه به سؤال مطرح شده مي دهيد، ش انتخاب و پاس
هدايت مي كند. به عبارتي ويزارد يك برنامه، راهنما و هدايت كننده كاربر براي اجراي سريع 

و راحت فرمان ها و دستورالعمل هاي موردنظر اوست.
 ،Help→Wizards… ــير در برنامه FreeHand نيز چنين امکاني وجود دارد و با اجراي مس

كادرمحاوره Wizard مطابق شکل 4-2 مشاهده مي شود.
ــبب اجراي يك  ــج دكمه قرار دارد و كليك روي هر كدام س ــاورهWizard ، پن در كادرمح

ويزارد خاص مي شود كه در اين بخش به صورت خلاصه شرح داده شده است.

 Wizard شکل 4-2 كادرمحاوره اصلي
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Welcome 2-5-1

ــکل 5-2 اجرا مي شود كه پنج  ــامدگويي مطابق ش با كليك روي اين دكمه، ويزارد خوش
دكمه موجود در اين كادرمحاوره به اين شرح است:

    

Welcome شکل 5-2 كادرمحاوره ويزارد

Setup 2-5-2

ــاي فايل FreeHand مثل واحد اندازه گيري، اندازه صفحه، افقي يا  در اين بخش تنظيم ه
عمودي بودن صفحه و انتخاب رنگ هاي مورد استفاده در سند انجام مي شود. 

Setup شکل 6-2 فايل ايجاد شده با ويزارد

    Screen-based 2-5-3

ــتفاده در  ــا و عناصرگرافيکي مورد اس ــوط به ايجاد تصويره ــراي انجام تنظيم هاي مرب ب
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ــت آمده از برنامه هاي گرافيکي تدوين و  ــانه اي، تصويرهاي به دس اينترنت، پروژه هاي چند رس
ويرايش تصوير از ويزاردScreen-based استفاده مي شود.

Stationary 2-5-4

ــند هاي چندصفحه اي كه تنظيم هاي استاندارد سربرگ، كارت ويزيت، برچسب  ايجاد س
ــتي و پاكت نامه را دارند؛ همچنين نمونه هاي آماده آن ها در برنامه با  ــکت، برچسب پس ديس
استفاده از اين ويزارد قابل اجرا است. انتخاب رنگ با توجه به پالت هاي رنگي آماده يا حالت 

سياه و سفيد از ديگر مواردي است كه مي توانيد با استفاده از اين ويزارد انجام دهيد. 

Stationary در ليست رنگ فايل اجرا شده در ويزارد Metallic و رنگ Fun  شکل 7-2 طرح

Publication 2-5-5

ــاي كاري براي تقويم، كتاب، خبرنامه و  ــر و ايجاد صفحه ه در اين ويزارد تنظيم هاي نش
آگهي ها انجام مي شود. 

ــده سندي را باز كنيد و به تفاوت هاي  تمرين : در هر كدام از حالت هاي گفته ش
آن ها دقت كنيد.
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واژه نامه
Business cardكارت ويزيت
Developer Centerمركز توسعه
Freestyleطرح آزاد

Interfaceرابط
Illustrationتصوير

Measurementاندازه گيري
Multi Pagesچندصفحه اي

Newsletterخبرنامه
Overviewبرداشت كلي

Publicationنشر
Screen-basedاساس نمايش تصوير

Snappingچسبيدن
Stationeryنوشت افزار

Support Centerمركز خدمات
Web-relatedمربوط به وب

خلاصه مطالب
ــت كه براي طراحي و ترسيم آرم، لوگو،  FreeHand MX يك نرم افزار گرافيکي برداري اس

جلد كتاب و مجله، كاغذ كادو و جعبه دستمال كاغذي و ... به كار مي رود. ابزارها و پنل هاي 
مختلف امکانات گوناگوني را براي اين برنامه فراهم كرده اند.

ــه ــتي و گزين ــودكار، دس ــه روش خ ــد از س ــه FreeHand مي تواني ــب برنام ــراي نص  ب
Add Or Remove Programs در Control Panel استفاده كنيد.
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعيين كنيد.

1-در نرم افزارهاي پيکسلي تصاوير از خطوط و منحني تشکيل شده است.
2- اندازه فايل هاي Vector از فايل هاي Bitmap كمتر است.

3- حافظهRAM  مورد نياز براي نصب FreeHand حداقل 64 مگابايت است. 
ــتفاده  4- براي انجام تنظيمات مربوط به ايجاد تصاوير اينترنتي از ويزارد Stationary اس

مي شود.
معادل گزينه  هاي سمت راست را از ستون سمت چپ انتخاب كرده و مقابل هر عبارت بنويسيد.

Screen-based               FreeHand5- تنظيم هاي مربوط به ايجاد سند و صفحه كاري در
 ،FreeHand ــده در ــناخته ش ــند، بازكردن فايل هاي موجود با فرمت هاي ش 6- ايجاد س
Stationery                                            Help بازكردن فايل هاي ويرايش شده، نحوه استفاده از
ــاي آماده آن ها در  ــتفاده از نمونه ه ــربرگ و كارت ويزيت و اس ــاد تنظيم هاي س 7- ايج
 Welcome                                                                                        برنامه
Setup 8- تنظيم هاي نشر و ايجاد صفحه هاي كاري براي تقويم و جلد كتاب             
Publication    9- ايجاد تصوير براي وب و چندرسانه اي و تدوين تصويرها در حين كار

گزينه صحيح را انتخاب كنيد.

10- كدام يك از نرم افزارهاي زير از نوع برداري هستند؟
 FreeHand -ب                Photoshop -الف

د-  ب و ج هستند    Corel Draw -ج
11- فايل اجرايي نصب برنامه FreeHand، .............. است.

Serialnumber.txt -د     Keygen.exe-ج  Setup.exe -ب       Setup.txt -الف
 FreeHand ــان دهنده مقدار فضاي آزاد موردنياز، براي نصب برنامه 12- كدام گزينه نش

است؟
ج- 100                   د- 128 الف- 70                 ب- 64         

13- كدام گزينه دسترسي كاربر به فايل هايي را كه اخيراً با آن ها كار كرده و روي آن ها 
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ويرايش انجام داده است، فراهم مي كند؟
 Open -ب              FreeHand Help -الف

New -د              Previous File  -ج
ــه چه منظور  ــه Learning FreeHand MX ب ــامدگويي، گزين ــاوره خوش 14- در كادر مح

استفاده مي شود؟
الف- بررسي Help برنامه               

Online ب- مرور سرفصل ها و درس هاي برنامه به صورت
ج- كار با مركز طراحي و توسعه نرم افزار از طريق اينترنت

  Online د- مشاهده محصولات به صورت
در جاي خالي عبارت مناسب را بنويسيد.

ــاده FreeHand را فراهم  ــه الگوهاي از پيش آم ــي ب ــه .............. امکان دسترس 15- دكم
مي كند.

ــريع و راحت فرمان ها و  ــه، راهنما و هدايت كننده براي اجراي س ــك برنام 16- ........... ي
دستورالعمل هاي موردنظر كاربر است.

ــده و با ..........  ــتر ش ــل ها جزييات تصوير بيش ــلي با ........... پيکس 17- در نرم افزار پيکس
پيکسل ها جزييات تصوير كمتر شده و حجم آن كاهش مي يابد.

به سؤالات زير پاسخ تشريحی دهيد.
18-  سه مورد از مزاياي برنامه گرافيکي برداری را بيان كنيد.

 19- حداقل چهار مورد از كاربردهاي FreeHand را بنويسيد. 
آزمون عملي

1- در برنامه فتوشاپ، تأثير تغيير كيفيت تصوير در اندازه و حجم آن را نشان دهيد.
2- نرم افزارFreeHand  را در درايو موردنظر نصب كرده و اجرا كنيد.

ــي كرده و روش به كار بردن  ــده بررس 3- مواردي كه در نگارش جديد نرم افزار اضافه ش
Help برنامه را نشان دهيد.
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كليات
ــبيه نسخه هاي قبلي اين نرم افزار است؛ البته  نرم افزار FreeHand MXa داراي محيطي ش

ابزارها و قابليت هاي جديدي به آن افزوده شده است كه به شرح آن خواهيم پرداخت. 
FreeHand MXa 1-3 شناخت محيط نرم افزار

پس از نصب اين برنامه كه در واحد كار قبل گفته شد، از مسير زير برنامه را اجرا كنيد.
Start→All Programs→Macromedia→Macromedia FreeHand MXa

با اجراي برنامه، محيط كار FreeHand MXa ظاهر مي شود. اكنون مي توانيد براي ترسيم، 
ــتفاده از فرمان File→Open يك فايل ذخيره  ــك صفحه طراحي جديد ايجاد كنيد يا با اس ي

شده را باز كنيد. 
ايجاد فايل جديد

براي ايجاد صفحه جديد به يکي از روش هاي زير عمل كنيد:
1- فرمان File→New را انتخاب كنيد.

2- كليد ميانبر Ctrl+N را بفشاريد.
3- ابزار  را از نوار ابزار اصلي برنامه انتخاب كنيد. 

ــود كه مي توانيد در قسمت  ــکل 1-3 ظاهر مي ش كه در اين صورت صفحه اي مطابق با ش
صفحه طراحي )به شکل يك ورق كاغذ ديده مي شود( ترسيمات خود را انجام دهيد.

      

FreeHand MXa شکل 1-3 محيط کار
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Main 1-1-3 نوارابزار

ــده و حاوي آيکن هايي است  اين نوارابزار در بالاي پنجره برنامه و در زير نوار منو واقع ش
كه امکان دسترسي سريع به فرمان هاي مورداستفاده در FreeHand را فراهم مي سازد؛ نظير 
ــکل 1-3(. اين نوار ابزار با  ــاي Save، پنل Lock ،Object يا قفل موضوعات و غيره )ش فرمان ه

استفاده از روش هايی كه ذكر می شود قابل انتخاب است:  
 كليك  راست  روي قسمت خاكستري نوارهاي ابزار ديگر)مانند نوار Info( بجز  نوارمنو	 

Window→Toolbars→Mainانتخاب نوار ابزار موردنظر 
جدول 1-3  توضيح آيکن هاي نوارابزار

توضيحاتنام آيكنآيكن
Newايجاد يك فايل جديد
Openبازكردن فايل ذخيره شده
Saveذخيره فايل جاري

ImportFreeHand واردكردن فايل ها  از برنامه هاي ديگر به
Printچاپ فايل جاري
Lock   قفل كردن موضوع انتخاب شده

Unlock   بازكردن قفل موضوع انتخاب شده
Graphicsجستجو و جايگزيني

Align  Alignبازكردن پنل
TransformTransform بازكردن پنل

LibraryLibrary بازكردن پنل
ObjectObject بازكردن پنل

Windowبازكردن فايل بدون بستن فايل هاي ديگر با قابليت دسترسي به تمامي پنل ها

Color MixerColor Mixer بازكردن پنل
SwatchesSwatches بازكردن پنل

LayersLayers بازكردن پنل
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)Info( 2-1-3 نوارابزار اطلاعات

ــامل اندازه، موقعيت و ساير  ــود و اطلاعاتي ش اين  نوار در پايين پنجره برنامه ظاهر مي ش
خصوصيات موضوعات ترسيمي و موقعيت اشاره گر را نشان مي دهد )شکل 3-2(.

 Info شکل 2-3 نوارابزار

)Toolbox( 3-1-3 جعبه ابزار

جعبه ابزار در FreeHand MX دربرگيرنده ابزارهاي مختلفي است. 
جعبه ابزار Tools با استفاده از روش هاي زير ظاهر مي شود:

	Window→Tools انتخاب گزينه
	Ctrl+F2 كليد ميانبر

)Panels( 4-1-3 پنل ها

زماني كه اولين بار وارد FreeHand مي شويد كادرهايي را مشاهده مي كنيد كه با يکديگر 
ــده اند و در سمت راست محيط برنامه قرارگرفته اند، به هر كدام از اين كادرها پنل  تركيب ش
مي گويند كه مي توانيد آن  ها را جا به جا كنيد، از حالت تركيب شده خارج نماييد و با پنل هاي 

مورد نظرخود در يك گروه قرار دهيد. 
پنل ها با استفاده از روش هاي زير قابل دستيابي هستند:

 منوي Window و انتخاب پنل موردنظر 	
	Main انتخاب پنل موردنظر از نوار ابزار 

* اين پنل ها به طور پيش فرض با يکديگر گروه بندي شده اند:
ــد  ــرار گرفته ان ــام Properties	 ق ــه ن ــروه ب ــك گ ــل Object و Document در ي   پن

)شکل 3-3(.
پنل  Styles ،Swatches وLibrary در يك گروه به نام  Assets قرارگرفته اند.	
پنلColor Mixer  و Tints در يك گروه به نام  Mixer and Tints قرارگرفته اند.	
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  Properties شکل 3-3 پنل گروهي

پنل Align و Transform در يك گروه به نام  Align and  Transformقرارگرفته اند.	
ــما مي توانيد  ــده اند ولي ش برخي از پنل ها نظير Layers با پنل هاي ديگري گروه بندي نش

آن ها را به دلخواه با پنل هاي ديگر در يك گروه قرار دهيد.
ــمت راست پنل ها، آيکني به نام Panel’s Options Menu )شکل 4-3( قرار دارد كه  در س

اگر روي آن كليك كنيد منوي كنترلي پنل باز مي شود.

 )Panel’s Options Menu( شکل 4-3 نمايش منوي پنل

اعمالي كه مي توان روي پنل ها انجام داد عبارتند از:
كوچك و بزرگ كردن پنل ها

ــمت پايين باشد اجزاي  مثلث نوار عنوان پنل را كليك كنيد. هنگامي كه جهت مثلث به س
ــت باشد فقط نوارعنوان پنل  ــمت راس پنل نمايش مي يابد و در صورتي كه جهت مثلث به س

نشان داده مي شود.
جابه جاكردن پنل ها در بين گروه ها

براي انجام اين عمل مراحل بعد را انجام دهيد:
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1- روي منوي كنترلي پنل كليك كنيد.
 2- يکي از گروه هاي پنل را از زيرمنوي »With نام پنل Group« انتخاب نماييد يا گزينه
ــا پنل به گروه موردنظر انتقال يابد. در اين صورت پنل در  ــد ت New Panel Group را برگزيني

يك پنجره جداگانه قرار خواهد گرفت.

ــا پنل Tints در يك گروه قرار گرفته به   مثـال 1: مي خواهيد پنل Mixer را كه ب
پنل Document منتقل كنيد؛ براي اين منظور مراحل زير را انجام دهيد:

1- منوي كنترلي پنل Mixer را باز كنيد.
  Documentــده گزينه 2- گزينه Group Mixer with را انتخاب كرده و از زير منوي باز ش

را برگزينيد )شکل 3-5(.

شکل 5-3 جابه جايي پنل ها

3- در اين صورت پنل Mixer به صورت زبانه اي در پنل Document قرار مي گيرد.

 توجه: قبل از انتقال، پنل مقصد بايد روي صفحه قرار داشته باشد.

تمرين 1: پنل Layers را به پنل Object منتقل كنيد.

تغييرنام پنل هاي گروهي
براي تغيير نام يك پنل گروهي به صورت زير عمل كنيد:

1- از منوي پنل موردنظر، گزينه Rename Panel Group را انتخاب كنيد.
2- در نوار عنوان پنل، مکان نما به صورت چشمك زن ظاهر خواهد شد.
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ــود  ــا نام جديد اعمال ش ــاريد ت ــد Enter را بفش ــپ كرده و كلي ــد را  تاي ــام جدي  3- ن
)شکل 3-6(.

شکل 6-3 تغييرنام پنل گروهي

ــه My Layout تغيير  ــي Object and Document را ب ــل گروه تمريـن 2: نام پن
دهيد.

تركيب )dock( پنل ها 
ــب )dock( كنيد. هنگامي كه  ــر و با پنل هاي گروهي تركي ــد پنل ها را با يکديگ مي تواني

پنل ها dock مي شوند جابه جايي آن ها روي صفحه نمايش آسان تر خواهد شد. 
براي اين منظور مراحل زير را انجام دهيد:

1- اشاره گر را به گوشه سمت چپ پنل موردنظر برده و نقاط gripper را كه در اين محل 
قرار دارند، درگ كنيد )شکل 3-7(.

gripper شکل 7-3 نمايش نقاط

ــمت پنل موردنظر برده و كليد ماوس را رها كنيد. در اين صورت پنل ها  2- پنل را به س
با هم تركيب مي شوند )شکل 3-8(.

شکل 8-3 پنل هاي تركيب )dock( شده
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ــا را از حالت dock خارج  ــاط gripper مي توانيد پنل ه ــتفاده از درگ نق  توج�ه: با اس

كنيد.
توصيف پنل ها

ــده  ــرح داده ش هر پنل ويژگي متفاوتي دارد كه در اين جا برخي از پنل ها به اختصار ش
است:

پنل Object: امکان تنظيم زمينه، خط دور و جلوه هاي اشياء را فراهم مي كند. همچنين 
ــب شئ انتخاب  ــياء را تنظيم كنيد. گزينه هاي اين پنل برحس مي  توانيد موقعيت و اندازه اش

شده تغيير مي كند.
پنل Document: به منظور ايجاد، اصلاح صفحات سند و وضوح چاپ به كار مي رود.

ــدن اشياء در صفحه نمايش را امکان پذير مي كند. از  پنل Layers: كنترل ترتيب ظاهر ش
لايه ها مي توان به عنوان بخشي از ايجاد انيميشن ها استفاده كرد.

پنل Swatches: رنگ ها را ذخيره كرده و امکان اعمال آن ها را به خط دور يا زمينه براي 
اشکال فراهم مي سازد.

پنل Mixer: امکان تعريف رنگ ها را امکان پذير مي كند.
پنل Styles: به شما امکان مي دهد ظاهر تصاوير گرافيکي و متن را به صورت شيوه هايي 

ذخيره كنيد تا بعداً به ساير اشياء اعمال كنيد. 
پنل Tints: امکان ايجاد ته رنگ ها را فراهم مي كند.

ــن نمادها براي كار با قلم موها،  ــاي گرافيکي را ذخيره كرده و از اي پنـل Library: نماده
ايجاد صفحات اصلي و ايجاد انيميشن هاي SWF( Flash( استفاده مي شود.

پنل Align: براي تنظيم ترازبندي يا توزيع اشياء به كار مي رود.
ــر مقياس، كج كردن و  ــل امکان جابه جايي، چرخش، تغيي پنـل Transform: در اين پن

انعکاس اشياء فراهم مي شود.
2-3 تنظيمات واحد اندازه گيري

ــت )Status(  قرار دارد و دربرگيرنده  ــن پنجره برنامه FreeHand MXa، نوار وضعي در پايي
ــت. براي انتخاب واحد اندازه گيري  ــکل 9-3 نشان داده شده اس ــت كه در ش گزينه هايي اس
ــويUnits   از نوار وضعيت كليك كرده و واحد موردنظر خود را انتخاب  بايد روي منوي بازش
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كنيد )مثلًا به  ميلي متر(. با انتخاب اين واحد، همه اشکال و موضوعاتي كه از اين به بعد رسم 
مي شوند و همچنين خط كش، برحسب آن واحد محاسبه خواهند شد.

)Status( شکل 9-3 نوار وضعيت

)Preferences( 3-3 تنظيمات ساختاري
ــتفاده از كادرمحاوره Preferences مي توانيد نحوه عملکرد برنامه FreeHand MXa را  با اس

كنترل كرده و پارامترهاي اجرايي و ساختاري برنامه را تنظيم كنيد.
ــورت كادرمحاوره  ــد، در اين ص ــاب كني ــه Preferences	 را انتخ ــوي Edit گزين از من
ــود كه شامل ده زبانه است و هركدام تنظيمات بخش هايي  Preferences ظاهر مي ش

از برنامه را به عهده دارند )شکل 3-10(.

Preferences شکل 10-3 كادرمحاوره
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 توجه: براي كار با Preferences، از كليد ميانبر Ctrl+U هم مي توانيد استفاده كنيد.

در همه زبانه   ها دكمه Defaults	 وجود دارد كه تنظيمات جاري را به حالت پيش فرض 
اوليه برمي گرداند. در ادامه به توضيح برخي از پارامترهاي مهم موجود در اين زبانه   ها 

مي پردازيم:
1- زبانه General: تنظيمات عمومي در اين محل انجام مي گيرد.

ها براي برگرداندن اعمال انجام شده به عقب را تعيين مي كند  	Undo تعداد :Undo's

كه بهتر است مقدار آن را افزايش دهيد.
 توجه: Ctrl+Z  كليد ميانبر Undo است.

 

2- زبانه Object: تنظيمات مربوط به موضوعات و اشکال در اين محل انجام مي گيرد.
ــتن كليد Alt	 و درگ  ــودن اين گزينه، نگه داش ــال ب ــا فع Alt-drag copies paths: ب

موضوع باعث كپي آن مي شود.
ــوند، نشانگرضخامت هاي  Default Line weights:	 اعدادي كه در اين كادر وارد مي ش

از پيش تعريف شده براي ابزار Line هستند.
3- زبانه Text: پارامترهاي تنظيمي مربوط به متن را كنترل مي كند.

Always Use Text Editor: بافعال بودن آن، درصورتي كه ابزار Type	 را برگزينيد و روي 

صفحه كليك كنيد يك كادر متني براي تايپ يا ويرايش متن موردنظر باز مي شود.
ــند را كنترل  ــده در س ــوط به صفحات ايجاد ش ــات مرب 4- زبانـه Document: تنظيم

مي كند.
New document template:	 با اين گزينه مي توانيد يك فايل دلخواه را انتخاب كنيد 

ــي اين فايل ايجاد  ــان File→New صفحه جديد با فراخوان ــا در هنگام اجراي فرم ت
شود.

Always Review unsaved documents upon Exit:	 با فعال بودن آن در هنگام خروج 

ــود كه اعلان مي كند تمام اسناد ذخيره نشده را ذخيره  از برنامه، كادري ظاهر مي ش
كنيد.
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ــه FreeHand را كنترل  ــده ب ــات مربوط به فايل هاي وارد ش 5- زبانـه Import: تنظيم
مي كند.

ــده از FreeHand به  6- زبانه Export: پارامترهاي تنظيمي مربوط  به فايل هاي صادر ش
برنامه هاي ديگر را كنترل مي كند.

ــي را كنترل  ــده انگليس 7- زبانـه Spelling: تنظيمات مرتبط با تصحيح متون تايپ ش
مي كند.

ــور را كنترل  ــط مانيت ــه نمايش رنگ ها توس ــوط ب ــاي مرب 8- زبانـه Colors: پارامتره
مي كند.

Guide color: تغيير رنگ خطوط راهنما	

Grid color: تغيير رنگ خطوط شبکه اي 	

ــط مانيتور را انجام مي دهد يعني  Color management:	 انجام مديريت رنگ ها توس

نحوه ظاهر شدن رنگ ها روي صفحه نمايش را تعيين مي كند.
ــمت انجام  ــه  نحوه نمايش ابزار و پنل ها در اين قس 9- زبانـه Panels: تنظيمات مربوط ب

مي گيرد.
Show Tooltips:	 فعال بودن اين گزينه باعث مي شود كه با نگه داشتن اشاره گر ماوس 

روي يك ابزار يا آيکن، نام آن نمايش داده  شود.
Label Panel tabs with: با انتخاب Text	 در منوي بازشو اين گزينه، مي توان در پنل 

جاري فقط نام زبانه هاي پنل را مشاهده كرد.
با انتخاب Icon، يك آيکن به نام زبانه پنل نشان داده مي شود.

ــود  ــبب نمايش نام به همراه آيکن در زبانه پنل مي ش  انتخابText and Icon ، س
)شکل 3-11(.

شکل 11-3 سه تنظيم براي برچسب هاي زبانه هاي پنل

ــن محل كنترل  ــط مانيتور در اي ــردازش تصاوير توس ــت پ 10- زبانـه Redraw: وضعي
مي شود.

گزينـه Enable Anti-aliasing:	 فعال بودن اين گزينه، منحني و لبه هاي موضوعات 
را حتي در زمان بزرگنمايي نرم تر نشان مي دهد.
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 ، 	Preview براي بالا بردن سرعت پردازش تصوير در حالت :Redraw while scrolling

 Scroll ــط كليدهاي ــد، در اين صورت وقتي توس ــت اين گزينه غيرفعال باش بهتر اس
)كليدهاي پيمايش صفحه(، صفحه را جابه جا مي كنيد بعد از توقف، تصوير پردازش 

مي شود يعني تصوير در حين Scroll  قابل ديدن است.
4-3 روش هاي بازكردن يك تصوير گرافيكي

ــيماتي را كه ايجاد و ذخيره كرده ايد، در برنامه FreeHand باز كنيد.  ــما مي توانيد ترس ش
همچنين تصاوير با فرمت هاي گوناگون در اين برنامه قابل باز شدن هستند.

Open 1-4-3 فرمان

ــايي  ــتفاده از اين فرمان مي توان فايل هاي گرافيکي كه براي FreeHand قابل شناس با اس
است، باز كرد. اين فرمان به چند روش اجرا مي شود:

File از منوي Open 1- انتخاب گزينه
  Ctrl+O 2- فشردن همزمان كليد تركيبي

Main 3- كليك روي آيکن  از نوار ابزار
كادرمحاوره Open در FreeHand مشابه نرم افزارهايي است كه قبلًا با آن ها آشنا شده ايد 

بنابراين در اين جا از توضيحات بيشتر صرفنظر مي شود.

 نكته: با استفاده از گزينه Open Recent در منوي File مي توانيد فايل هايي را كه 
اخيراً بازكرده ايد، مشاهده كنيد.

Import 2-4-3 فرمان

فرمان Import كه در منوي File واقع شده است؛ به منظور وارد كردن فايل هاي گرافيکي 
ديگري غير از فرمت FreeHand به اين برنامه به كار مي رود. همچنين مي توانيد اين فرمان را 

با كليك روي آيکن  در نوار ابزار Main اجرا كنيد.
ــکل 12-3 باز  ــا اجراي فرمانFile→Import  كادر محاوره Import Document مطابق ش ب

مي شود.

 توجه: كليد تركيبي Ctrl+R روش ديگري براي اجراي فرمان Import است.
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Import Document شکل 12-3 کادر محاوره

با روش اجراي آن در نرم افزار Photoshop قبلًا آشنا شده ايد.

 توجه: در منوي بازشو Files of type چنانچه All Known Types را انتخاب كنيد، در 

ــايي  مرورگر كادر محاوره Import همه فايل هايي كه يکي از قالب ها يا فرمت هاي قابل شناس
توسط FreeHand را داشته باشند، نشان داده مي شوند.

ــي از  ــت كه هنگام مرور فايل ها، با ارائه پيش نمايش كادر Preview پيش نمايش فايل اس
محتويات آن ها مي توان فايل موردنظر را به سرعت يافت.

ــود، در  پس از انتخاب فايل موردنظر روي دكمه Open كليك كنيد تا فايل فراخواني ش
اين صورت اشاره گر ماوس به صورت  تبديل شده و اكنون در هر كجا از صفحه گرافيکي 

كليك كنيد، فايل در آن نقطه درج مي شود. 

ــد تصوير به اندازه موردنظر روي   توج�ه: پس از اجراي فرمان Import اگر بخواهي
صفحه درج شود، بايد به اندازه دلخواه درگ كنيد.

فايل هاي گرافيکي پيکسلي )طرح بيتي يا Bitmap( با فرمت هاي tiff ،jpg و غيره پس از ورود به 
FreeHand، به صفحه جاري متصل )Link( مي شوند اما نمي چسبند؛ به عبارت ديگر وارد شدن آن ها به 

 صفحه در حجم فايل تأثيري ندارد و حجم آن زياد نمي شود و تنها از طريق مسيري كه داده شده، 
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پيش نمايشي از آن در FreeHand نشان داده مي شود كه قابل چاپ نيز هست.
ــل FreeHand به كامپيوتر ديگر،  ــود كه در صورت انتقال فاي اين خصوصيت باعث مي ش
ــده( به فايل FreeHand موجود باشند، اين  ــلي متصل شده )Link ش چنانچه فايل هاي پيکس
ــن صورت در كامپيوتر مقصد  ــوند، در غير اي ــا نيز همراه با فايل FreeHand منتقل ش فايل ه

نمايش داده نخواهند شد و به صورت ديده مي شوند.
ــل FreeHand به طور كامل  ــان Edit→Links به فاي ــلي را از طريق فرم ــاي پيکس فايل ه

بچسبانيد )Embedded( كه در اين صورت به حجم فايل افزوده مي شود.

 توجه: زماني كه تعداد صفحات سند جاري زياد باشد و در اغلب صفحات فايل هاي 

ورودي پيکسلي داشته باشيم، در اين صورت Link كردن فايل پيکسلي جالب نيست و باعث 
افزايش بي رويه حجم فايل FreeHand خواهد شد.

تمرين 3: تفاوت فرمان Import و Open را بيان كنيد.

ــکل 13-3 از Shape هاي Photoshop استفاده كرده و آن ها   مثال 2: در طراحي ش
را در سند خود وارد كنيد. 

شکل 3-13

1- ابتدا شکل سگ را با ابزارهاي مناسب رسم كنيد.
ــگ و شکل استخوان ها را با استفاده از Shape ها در Photoshop رسم كرده  2- ردپاي س

و در فايل هاي جداگانه با پسوند tif. ذخيره كنيد.
ــکل 13-3 در محل  3- فايل ها را با فرمان Import وارد كار طراحي خود كرده و طبق ش

و در جهت مناسب  قرار دهيد.
تمرين 4: آرم موجود در شکل 14-3 را با استفاده از نرم افزار فتوشاپ رسم كرده، 
سپس در يك واژه پرداز )مثل WordPad(، متن زير آن را تايپ كرده و وارد )Import( محيط 
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FreeHand كنيد )كاربرد فرمان Import در وارد كردن متون طولاني(.

شکل 3-14

5-3 بزرگنمايي
ــتري از تصوير  ــه براي ديدن جزييات بيش ــود ك ــگام كار، گاهي اوقات لازم مي ش در هن
ــمت هاي بيشتري از تصوير، عمل  ــود يا براي ديدن قس ــي از آن بزرگنمايي ش يا طرح، بخش

كوچکنمايي انجام گيرد.
براي اين عمل، روش هاي مختلفي وجود دارد كه برخي از اين روش ها عبارتند از:

 Magnification 1-5-3 منوي بازشو

توسط اين منو كه در شکل 15-3 نشان داده شده  است، مي توانيد يکي از بزرگنمايي هاي 
از پيش تنظيم شده را انتخاب كنيد. براي دسترسي به اين منوي بازشو از منوي View گزينه  

Magnification را برگزينيد.

Magnification مين بزرگنمايي گزينه شکل 15-3 فر

ــکل 3-9(  ــو Magnification واقع در نواروضعيت )ش ــن مي توانيد از منوي بازش همچني
بزرگنمايي موردنظر را انتخاب كنيد يا درصد بزرگنمايي موردنظر را تايپ كرده سپس كليد 

Enter را بفشاريد.

 Zoom 2-5-3 ابزار

انتخاب ابزار  در جعبه ابزار Tools يا فشردن كليدZ  از صفحه كليد علامت ذره بين را 
در اختيار شما قرار مي دهد. بعد از انتخاب اين ابزار روي ذره بين علامت + نشان داده مي شود. 
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ــد؛ همچنين مي توان با ابزارZoom  اطراف  ــا هر بار كليك ، ميزان بزرگنمايي افزايش مي ياب ب
شکل موردنظر كادري رسم كرد تا عمل بزرگنمايي انجام شود.

 نكته: درحالي كه ابزارZoom  انتخاب شده است، مي توانيد با نگه داشتن كليد Alt شئ بزرگ 
شده را كوچك كنيد.

 تمرين 5: بررسي كنيد كليد ميانبر Ctrl+Spacebar چه عملي انجام مي دهد.
View 3-5-3 گزينه هاي بزرگنمايي در منوي

ــت كه به منظور انجام عمل بزرگنمايي )Zoom(  براي  ــامل گزينه هايي اس منويView  ش
تنظيم نمايش شئ انتخابي در صفحه به كار مي رود كه در جدول 2-3 شرح داده شده اند.  

View از منوي Zoom جدول 2-3 گزينه هاي مربوط به

Fit SelectionCtrl + Alt + 0 بزرگنمايي را طوري تغيير مي دهد كه فقط موضوع يا موضوعات انتخابي
در بزرگ ترين حالت، نمايش داده شود.

Fit To PageCtrl+Shift+W با اين گزينه مي توانيد صفحه جاري را به همراه همه موضوعات موجود
در آن مشاهده كنيد.

Fit AllCtrl + 0 بزرگنمايي به گونه اي خواهد شد كه مي توانيد تمام صفحات موجود در
سند را مشاهده كنيد. 

Magnification)3-19 در اين مجموعه، انواع حالت هاي بزرگنمايي از 6% تا 800% وجود دارد. )شکل

ــمتي از تصوير دلخواه،  ــتفاده از زيرمنوي Magnification در قس تمرين 6: با اس
بزرگنمايي 200% و كوچکنمايي 25% را اعمال كنيد.

ــوي بزرگنمايي )Magnification( در نوار وضعيت )Status( نيز   نكته: منوي بازش
شامل گزينه هاي مربوط به Zoom است.

6-3 كاربرد ابزار Hand در هنگام بزرگنمايي
ــاير  ــالات مثلًا هنگامي كه بزرگنمايي را افزايش مي دهيد، براي ديدن س ــي از ح در برخ
قسمت هاي تصوير نياز به ابزار Hand داريد. از اين ابزار براي جابه جايي به سمت بالا، پايين، 
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راست، چپ و مايل استفاده مي شود.
Hand استفاده از ابزار

1- از جعبه ابزار Tools ابزار Hand را انتخاب كنيد يا كليد H از صفحه كليد را بفشاريد 
)شکل 3-16(. 

Hand شکل 16-3 ابزار

2- با اين ابزار در پنجره سند كليك كنيد و ماوس را به سمت دلخواه بکشيد.

ــه داريد ، ابزار  ــزاري اگر كليد Spacebar را نگ ــتفاده از هر اب  نكت�ه: هنگام اس
Hand براي جابه جايي، روي صفحه نمايش در اختيار شما قرار مي گيرد.

7-3 تنظيم حالت هاي نمايشي تصوير
ــما روي  ــراي نحوه نمايش تصوير يا طراحي ش ــي را ب FreeHand MXa گزينه هاي مختلف

صفحه نمايش ارايه مي دهد. برخي از اين گزينه ها جزييات بيشتري از كار را نشان مي دهند 
ــد تا اين جزييات نشان داده  شود. بعضي گزينه ها سريع تر ولي با  ولي مدت  زيادي طول مي كش

جزييات كمتري تصوير را نشان مي دهند.
ــي وجود دارد )شکل 17-3( كه عبارتند  در نواروضعيت، امکان انتخاب حالت هاي نمايش

از: 

شکل 17-3 انواع حالت هاي نمايشي 

ــي خود همراه با  ــکل واقع همه موضوعات و رنگ ها در ش ــن حالت 	 Preview : در اي

جزييات به نمايش درمي آيند و به عنوان پيش نمايشي از چاپ خواهند بود.
ــان داده مي شود ولي طيف رنگ ها  در اين حالت رنگ هاي اصلي نش 	 : Fast Preview

)Gradient( و تركيب ها )Blend( با جزييات  كمتري نمايش  مي يابند. سرعت نمايش 
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در اين حالت بيشتر از Preview است.

ــاب گزينه View→Fast Mode حالت  ــيد، انتخ  نكته: اگر در حالت Preview باش
Fast Preview را نمايش مي دهد.

ــتفاده از كليد ميانبر Ctrl+K قابل  ــي در منوي View يا با اس Keyline: اين حالت نمايش

دستيابي است. با انتخاب اين گزينه، موضوعات به صورت خطوط محيطي ديده شده و رنگ ها 
ــدن نمايش موضوعات، نحوه قرارگيري آن ها در  ــوند، بدين ترتيب با ساده تر ش مخفي مي ش

صفحه بهتر مشاهده شده و انتخاب موضوعات راحت تر است.

 توجه: براي اصلاح گره1 ها و مسيرها بهتر است از حالت نمايشي Keyline استفاده 
كنيد.

ــاده تر و خلاصه تر ارايه مي شود  Fast Keyline : در اين حالت نمايش خطوط به صورت س

و روش سريع تري براي نمايش تصاوير در حالت Keyline است.

 View→Fast Mode باشيد، انتخاب گزينه Keyline نكته: در صورتي كه در حالت 
حالت Fast Keyline  را نمايش مي دهد.

1- با اصطلاح گره و مسير در واحدهاي كار 5 و 6  آشنا خواهيد شد.
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شکل 18-3 انواع حالت هاي نمايشي

ــي چهار  تمريـن 7: يکي از تصاوير موجود در FreeHand را باز كنيد و به بررس
حالت نمايشي روي آن بپردازيد.

8-3 ايجاد نماي ديد سفارشي
ــي مکرراً احتياج  ــاي مختلف ديد از نظر بزرگي و كوچک ــگام طراحي به نماه ــر در هن اگ
داشتيد، مي توانيد از طريق گزينه View→Custom نماهاي سفارشي را ايجاد و ذخيره كنيد. 

  مثال 3: ايجاد يك نماي سفارشي 
ــمتي از موضوع رسم شده را Zoom كنيد، مثلًا بزرگنمايي گوشه سمت چپ يك  1- قس

تصوير دلخواه را به 326% افزايش دهيد )شکل 3-19(.
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Zoom 3-19 شکل

2- گزينه View→Custom→New را انتخاب كنيد.
.)Left corner نامي را براي اين نما انتخاب كنيد )مثلًا New View 3- در كادرمحاوره

4- دكمه OK را كليك كنيد تا نما ايجاد شود.

شکل 20-3 تعريف نماي سفارشي

تمريـن 8: نمايي به نام See با بزرگنمايي 85% براي تصوير دلخواه ايجاد كنيد، 
سپس آن را در حالت Fast Keyline نمايش دهيد. 
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Keyboard Shortcuts 9-3 فرمان
ــريع ترين روش هاي كار در برنامه كاربردي، استفاده از كليدهاي ميانبر صفحه  يکي از س

كليد است. 
ــامل تمام فرمان هاي منويي و بسياري از  ميانبرهاي صفحه كليد در FreeHand تقريباً ش
ــد را به گونه اي تغيير دهيد تا با  ــت. مي توانيد ميانبرهاي صفحه كلي آيتم هاي غيرمنويي اس
عادت  هاي كاري شما در نرم افزارهاي ديگر هماهنگ شود، همچنين مي توانيد به فرمان هايي 
كه فاقد كليد ميانبر هستند، ميانبر اضافه كنيد. ليست ميانبرهاي پيش فرض FreeHand  در 

ضميمه آمده است.
1-9-3 اختصاصي  كردن ميانبرها

ــبت  ــما امکان مي دهد تا ميانبرهاي صفحه كليدي را كه به فرمان ها نس FreeHand به ش

ــد، اختصاصي كنيد، بنابراين مي توانيد ميانبرهايي را به فرمان ها اضافه كنيد يا آن ها  مي دهي
را به نحوي تغيير دهيد كه با ساير برنامه ها تطبيق داشته باشند. براي اين منظور به صورت 

زير عمل كنيد:
ــان Keyboard Shortcuts را اجرا كنيد. در اين صورت كادرمحاوره  ــوي Edit فرم 1- از من

Customize نمايان مي شود )شکل 3-21(.

wCustomize

ــراي تعريف ميانبر  ــان موردنظر را ب ــمت چپ كادرمحاوره Customize فرم 2- از بخش س
انتخاب كنيد.
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 Current shortcut keys 3- در صورتي كه كليد ميانبري قبلًا تعريف شده باشد در ناحيه
ظاهر مي شود، در غير اين صورت مي توانيد كليد ميانبري به آن اختصاص دهيد.

ــردن  ــن  Press new shortcut keyبا فش ــر مي توانيد در كادر مت ــف ميانب ــراي تعري 4- ب
،Alt+Ctrl با كليدهاي ديگر صفحه كليد همچنين كليد تركيبي Ctrl يا Alt همزمان كليدهاي 

Shift+Ctrl  ياShift+Alt  با كليدهاي ديگر، ميانبر تعريف كنيد.

5- روي دكمه Assign كليك كنيد تا كليد ميانبر تنظيم شود.
6- حال با كليك دكمه Close به صفحه برنامه بازگرديد.

ــده باشد آن فرمان بعد از عبارت ــبت داده ش  نكته: در صورتي كه ميانبر به فرمان ديگري نس
Currently assigned to ظاهر مي شود.

 توجه: دكمه Remove كليد ميانبر نسبت داده شده به يك فرمان را حذف مي كند.

تمرين 9: براي فرمان Magnification كليد ميانبرCtrl+Shift+M  را تعريف كنيد.
FreeHand MXa 10-3 انواع فرمت هاي نرم افزار

ــر يا تهيه فيلم و  ــيمات، براي تهيه خروجي به كمك چاپگ ــازي ترس به منظور ذخيره س
ــاير برنامه ها )Export( يا  ــل از FreeHand به س ــراي چاپخانه و همچنين انتقال فاي ــك ب زين
ــتن عملکرد و موارد  ــي به Import( FreeHand( دانس ــردن فايل از برنامه هاي گرافيک واردك
ــت. FreeHand فرمت هاي  ــتفاده از قالب بندي ها يا فرمت هاي مختلف فايل ها ضروري اس اس

مختلفي را براي ذخيره يا فراخواني فايل هاي گرافيکي پشتيباني مي كند.

 توجه: فرمت FH11، فرمت استاندارد و اصلي  FreeHand MXa است.

 	Photoshop را به نرم افزارهاي ديگري نظير FreeHand ــل درصورتي كه بخواهيد فاي
ــازگار با  ــك فرمان Export با فرمتي كه س ــت فايل را به كم ــال دهيد، لازم اس انتق

نرم افزار مقصد باشد، ذخيره كنيد.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : كاربر

شماره : 15/7- ف - هـ
54

ــا روش هاي ديگر،  ــه File→Save	 ي ــتفاده از گزين ــازي تصوير با اس هنگام ذخيره س
ــو Save As Type قالب  ــد از منوي بازش ــود كه مي تواني ــاوره Save باز مي ش كادرمح

)فرمت( ذخيره سازي فايل را از بين اين فرمت ها انتخاب كنيد:
 fh11-1 : فرمت اصلي فايل ها در FreeHand است كه معمولاً ترسيمات با اين فرمت ذخيره 

مي شوند.
ft11 -2 1: براي محافظت فايل از تغييرات غيرعمدي به كارمي رود.

Eps -3 2: درصورتي كه مي خواهيد از تصوير ساخته شده در يك برنامه گرافيکي برداري 
يا برنامه نشر روميزي )مثل Page Maker( استفاده كنيد، اين فرمت را به كار بريد.

ــده  ــرح داده ش ــتفاده در FreeHand در جدول 3-3	 ش رايج ترين فرمت هاي قابل اس
است.

  1-FreeHand Template

                                                                                                                       2-Encapsulated postscript
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 FreeHand MX جدول 3-3 فرمت هاي رايج در

فرمت )پسوند رديف
شرحفايل(

1Fh5,Fh7,Fh8,
Fh9,Fh10

 MX و نسخه FreeHand براي نقل و انتقال فايل بين نسخه هاي قديمي تر
به كار مي رود.

2cdr .به كار مي رود CorelDRAW و FreeHand انتقال فايل بين براي نقل و 
اين پسوند فرمت فايل هاي برنامه CorelDRAW است.

3txt.به كار مي رود .txt براي نقل و انتقال فايل هاي متني با پسوند

4ai.به  كار   مي رودAdobe Illustratorو FreeHand براي  نقل    و     انتقال     فايل     بين

5gif
از قالب هاي گرافيکي پيکسلي است كه ضمن ذخيره سازي، عمل فشرده سازي را  يکي 
هم انجام مي دهد. اين فرمت براي طراحي بخش هاي مختلف صفحات Web نيز به كار 

مي رود.

6jpeg يا  jpg در RGB و CMYK فرمتي  بسيار رايج و  كم حجم براي ذخيره سازي فايل هاي
فشرده ترين حالت ممکن است و در محيط وب نيز به كار مي رود. 

7png است و فشرده سازي را بدون افت كيفيت Web فرمت قابل استفاده در صفحات
انجام مي دهد.

8psd فرمت اصلي فايل هاي فتوشاپ است كه براي نقل و انتقال فايل هاي پيکسلي
بين FreeHand و Photoshop به كار مي رود.

9pdf.است Adobe Acrobat  Reader اين فرمت قابل استفاده در برنامه

10tif و FreeHand  بـراي نقــل  و انتقــال  فايل هــاي گرافيـــکي   پيکســلي    بيـن
برنامه هـاي گرافيکي پيکسلي نظير فتوشاپ به كار مي رود.

11bmp است. اين  فرمت Windows فرمت    استاندارد    برنامه هاي گرافيکي سيستم       عامل
 تصاوير را به صورت طرح بيتي )پيکسلي( درخود ذخيره  مي سازد.

FreeHand 11-3 روش هاي ذخيره سازي در
ــود؛ اين كار باعث مي شود كه در صورت  ــت فايل مکرراً ذخيره ش هنگام طراحي لازم اس
قطع ناگهاني برق يا قفل شدن كامپيوتر، فايل كاري از بين نرفته و از انجام ترسيمات مجدد 

جلوگيري شود. 



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : كاربر

شماره : 15/7- ف - هـ
56

  Save 1-11-3 فرمان

با اجراي فرمان Save كادر محاوره Save Document روي صفحه ظاهر مي شود كه با كليه 
قسمت هاي آن در نرم افزارهاي ديگر آشنا شده ايد.

 توجه: كليد ميانبر Ctrl+S راه ديگري براي ذخيره ترسيمات است.

ــت فايل را از  ــازي يا فرم ــد نوع قالب ذخيره س ــوي Save as type مي تواني ــوي بازش از من
بين فرمت هاي eps. وFh11. انتخاب كنيد.

ــام ويرايش براي ذخيره  ــيد، پس از انج  توج�ه: اگر فايلي را قبلًا ذخيره كرده باش

تغييرات روي همان فايل با نام، پسوند و مسير قبلي از فرمان Save استفاده كنيد.
Save As 2-11-3 فرمان

 هرگاه بخواهيد فايل را با نامي ديگر يا با فرمت و مسير ديگري روي ديسك ذخيره كنيد، از فرمان
Save As يا از كليد تركيبي Ctrl+Shift+S استفاده كنيد. كادرمحاوره اي كه پس از اجراي اين 

فرمان باز مي شود مانند كادر محاوره Save است.

ــل را فراهم  ــاد كپي هاي متعدد از فاي ــان Save As امکان ايج ــتفاده از فرم  نكت�ه: اس
مي كند.

ــپس آن را به نام تمرين10: يك   تصوير  دلخواه را وارد صفحه FreeHand كرده س
My Picture.fh11 ذخيره كنيد. 

Revert 12-3 فرمان
با استفاده از فرمان Revert مي توانيد به آخرين مرحله ذخيره شده در ترسيمات بازگرديد. 

براي انجام اين كار به صورت زير عمل كنيد:
1- از منوي File گزينه Revert را انتخاب كنيد.

ــان Revert را تأييد كنيد.  ــما مي خواهد فرم ــود كه از ش ــداري ظاهر مي ش  2- كادر هش
)شکل 3-22(.

3- دكمه Revert را كليك نماييد.



Free Hand پيمانه مهارتی : كاربر
57واحد كار سوم: توانايی شناخت محيط نرم افزارFreeHand  MXa و كار در آن 

شکل 3-22
FreeHand 13-3 سفارشي كردن محيط برنامه

در محيط برنامه FreeHand امکان سفارشي كردن موارد زير وجود دارد:
اختصاصي كردن ميانبرهاي صفحه كليد	
تغيير در نوار ابزارها	
تغيير در جعبه ابزار	

1-13-3 تغيير در نوار ابزارها و جعبه ابزار

ــاي موردنظر خود  ــا و جعبه ابزار را با آيکن ه ــي مي توانيد هر يك از نوار ابزاره ــه راحت ب
اختصاصي كنيد، براي اين منظور مراحل بعد را انجام دهيد:

1- مسير Window→Toolbars→Customize را انتخاب كنيد. كادرمحاوره Customize با 
فعال بودن زبانه Toolbars نمايش مي يابد )شکل 3-23(.

ــي كنيد،  ــزاري را كه مي خواهيد سفارش ــاوره، نوار اب ــمت چپ كادر مح ــال از س 2- ح
برگزينيد.

Toolbars با انتخاب زبانه Customize شکل 23-3 كادر محاوره

3- در اين صورت آيکن هاي مربوط به نوار ابزار )Toolbar  ( انتخاب شده در سمت راست 
كادرمحاوره نمايش مي يابد.

ــن موردنظر را به داخل نوار ابزار يا جعبه ابزار درگ كنيد. در اين هنگام آيکن به  4- آيک
ابزارها اضافه مي شود )شکل 3-24(. 
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شکل 24-3 اضافه كردن آيکن به جعبه ابزار

 نكته: در صورتي كه كادرمحاوره Customize Toolbars باز باشد، مي توانيد آيکن هاي يك نوار 
ابزار را با آيکن هاي نوار ابزار ديگر جابه جا كنيد.

 Alt ــتن كليد  توجه: بدون باز كردن كادر محاوره Customize Toolbars مي توانيد با نگه داش
و درگ، آيکن دلخواهي را از يك نوار ابزار به نوار ابزار ديگر منتقل كنيد.

 FreeHand 14-3 بستن فايل و خروج از
چند راه پيشنهادي براي بستن فايل:

 File از منوي  Close1- انتخاب گزينه
 Ctrl+W2- فشردن كليد تركيبي

:FreeHand چند راه پيشنهادي براي خروج از
1- دابل كليك روي  از نوار عنوان

 File از منوي  Exit2- انتخاب گزينه
ــردن كليد تركيبي Ctrl+Q كه همه فايل هاي باز را مي بندد و از FreeHand خارج  3- فش

مي شود.
)Title Bar( 4- انتخاب علامت  از نوار عنوان
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واژه نامه
Fitاندازه شدن، مناسب كردن

Informationاطلاعات
Modifyتغيير دادن

Panelقاب
Preferenceارجحيت
Revertبازگشت
Unitsواحدها

خلاصه مطالب 
عمليات كوچك  و بزرگ كردن، جابه جايي، گروه  كردن، تغييرنام و dock	 كردن پنل ها 

را مي توان انجام داد.
نواروضعيت شامل اجزاي زير است:  	

ــي، دكمه هاي انتخاب صفحه، دكمه افزودن صفحه و  بزرگنمايي، انواع حالات نمايش 	
منوي بازشوي واحد اندازه گيري. 

ــيمات  ــايZoom و Magnification	 هردو براي  بزرگنمايي و كوچکنمايي  ترس گزينه ه
به كار  مي رود. 

ــوان فايل ها را با قالب بندي يا فرمت هاي مختلفي ذخيره كرد )با  در اين برنامه مي ت 	
 .)File از منوي Save As يا Save انتخاب گزينه

با استفاده از گزينه Edit→Preferences نيز مي توانيد محيط FreeHand	 را طبق نياز 
خود تنظيم كنيد. 

 	FreeHand مي توان تصاوير گرافيکي را در  Importو Open ــتفاده از فرمان هاي با اس
باز كرد.

در حالت نمايشي Preview	 همه موضوعات و رنگ ها در شکل واقعي خود و همراه با 
ــان مي دهد ولي  جزييات نمايش مي يابند. حالت Fast Preview رنگ هاي اصلي را نش

طيف رنگ ها و تركيبات با جزييات كمتر ظاهر مي شود. 
در  ــان مي دهد. 	 حالت Keyline تصاوير را به صورت خطوط محيطي و بدون رنگ نش
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ــاده تر است و روش سريع تري براي  حالتFast Keyline ، نمايش خطوط به صورت س
نمايش تصاوير است.

ــوان ميانبر صفحه كليد براي اجراي  مي ت 	 Keyboard Shortcuts ــتفاده از فرمان با اس
فرمان ها تعريف كرد.

ــيمي را به آخرين مرحله  ــتفاده از فرمان Revert	 مي توانيد تغييرات فايل ترس با اس
ذخيره سازي برگردانيد.

در محيط FreeHand	 مي توانيد نوارابزارها و جعبه ابزار را سفارشي كنيد.
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعيين كنيد.

1- كليد Ctrl+0 بزرگنمايي را به حدي مي رساند تا تمام صفحات سند مشاهده شود.
2- كليد Shift ابزار Hand را در تصوير جابه جا مي كند.

3- سرعت حالت نمايشي Fast Preview بيشتر از Preview است.
معادل گزينه  هاي سمت راست را از ستون سمت چپ انتخاب كرده و مقابل هر عبارت بنويسيد.

  Revert                                 .است FreeHand 4- فرمان وارد كردن فايل در برنامه
Customize Toolbar                         فعال مي شود Z 5- ابزار بزرگنمايي كه با كليد
       Import                                     6- لغو كليه اعمال به بعد از آخرين ذخيره سازي
            Zoom                        .است Window 7- گزينه سفارشي كردن نوار ابزارها كه در منوي

گزينه صحيح را انتخاب كنيد.

8- كدام يك از اعمال زير روي پنل ها صورت نمي گيرد؟
الف- تغيير نام         ب- جابه جايي        ج- تركيب )dock(          د- حذف

9-  با استفاده از كدام نوارابزار مي توان اطلاعاتي در زمينه  شکل  ترسيم  شده  و  همچنين 
موقعيت مکان نما به دست آورد؟

Tools د- نوار        Status ج- نوار          Info ب- نوار         Menu  الف- نوار
10- كدام گزينه نادرست است؟

الف- توسط نقاط gripper مي توان عمل تركيب پنل ها را انجام داد.
ب- FreeHand يك نرم افزار برداري است.

ج- منوي Unit در نوار ابزار Info قرار دارد.
د- كليد Ctrl+F2 جعبه ابزار را نمايان مي كند.

11-  براي رسيدن به بزرگنمايي 130% از كدام گزينه استفاده مي شود؟
الف- Magnification از منوي View و انتخاب %130

ب- تايپ 130% در منوي  Magnification از نواروضعيت
Ctrl+1 ج- فشردن كليد تركيبي

View در منوي Zoom د- استفاده از گزينه
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12- تنظيم تعداد Undo ها در كدام كادر محاوره انجام مي گيرد؟
Customize -د  Open  -ج  General -ب     Preferences -الف

ــده و  ــي تصاوير به صورت خطوط محيطي ديده ش ــاب  كدام حالت نمايش ــا انتخ 13-  ب
رنگ ها مخفي مي شوند؟

     Preview -ب     Fast Preview-الف
د- گزينه هاي الف و ج صحيح هستند.               Keyline -ج

14- گزينه Fit all در منوي View به چه منظور استفاده مي شود؟
الف- حداكثر بزرگنمايي را بر اساس موضوع انتخاب شده در تصوير ارايه مي دهد.

ب- اگر چندين صفحه گرافيکي داشته باشيد همه صفحات را در محيط نشان مي دهد.
ج- صفحه گرافيکي را به طور كامل در محيط كار نشان مي دهد.

د- همان بزرگنمايي 100% است.
15- در مورد فرمان Revert كدام گزينه صحيح است؟

الف- براي بازگرداندن هر عملي به يك مرحله قبل به كار مي رود.
ب- لغو كليه اعمال انجام شده در ترسيمات انجام مي گيرد.

ج- كليه تغييرات در ترسيم به آخرين مرحله ذخيره سازي برمي گردد.
د- به منظور تازه سازي صفحات برنامه به كار مي رود.
16- فرمت استاندارد براي FreeHand MX چيست؟

FH10 -د    FH -ج      FH11 -ب       FHMX -الف
ــلي )مثل فتوشاپ(  ــب ترين فرمت براي واردكردن فايل هاي بيت مپي يا پيکس 17- مناس

به FreeHand كدام است؟
TIF -د       GIF-ج       EPS -ب              PDF -الف

 در جاي خالي عبارت مناسب را بنويسيد.

18- فرمان .................. براي تعريف كليد ميانبر به كار مي رود.
19- دستور ............. فايل را با نام و مسير ديگر ذخيره مي كند.

 Preferences  ــه .................. از كادر ــيDisplay font preview  در زبان ــتور تنظيم 20- دس
است.
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به سؤالات زير پاسخ تشريحی دهيد.

21-  وظيفه نوارابزار Main در محيط FreeHand چيست؟
22- تفاوت فرمانOpen  با Import را بنويسيد؟

23- مد نمايشي Keyline چه تفاوتي با مد Preview دارد؟
24- چگونه مي توان تعداد مراحل Undo را در FreeHand افزايش داد؟

آزمون عملي

يك  سند به نام Free1.Fh11 ايجاد كنيد، سپس:
1- فايل تصويري دلخواهي را بازكنيد.

2- تصوير را در بزرگ ترين حالت ممکن نمايش دهيد.
3- پنل Tint را با Layer در يك گروه قرار دهيد.

4- نام پنل گروهي سؤال 3 را به My Panel تغيير دهيد.
5- بزرگنمايي صفحه را از طريق منوي View به 400% برسانيد.

6- براي فرمان Revert كليد ميانبر Alt+R تعريف كنيد.
ــپس به جاي خود  ــزار Main به نوار ابزار Info منتقل كنيد س ــزار Save را از نوار اب 7- اب

بازگردانيد.
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كليات
 )Template( ــتفاده از الگوها ــند يا اس ــدم اول در طراحي پروژه هاي گرافيکي، ايجاد س ق
ــت. به منظور صفحه آرايي هماهنگ در يك سند مي توانيد صفحه اصلي )Master Page( و  اس
 Document  تعريف كنيد و تنظيمات صفحات را با استفاده  از پنل )Child Page( صفحه فرعي
ــنا  ــيمات دقيق آش ــم براي ترس تغيير دهيد. همچنين در اين واحدكار با ابزارهاي كمك رس

مي شويد.
1-4 ايجاد صفحه پيش فرض

ــتفاده از ويزارد Welcome يك سند  ــد، مي توانيد با اس همان طور كه قبلًا توضيح داده ش
ــندي شامل يك صفحه خواهيد  ــازيد. علاوه بر اين كه با اجراي FreeHand س پيش فرض بس

داشت، اجراي مسير File→New نيز فايل يك صفحه اي ايجاد مي كند.
Document 2-4 پنل

ــت كه به شکل يك ورق كاغذ  ــند جديد اس ــمتي از س صفحه گرافيکي )Art board( قس
ديده شده و در واقع همان بوم نقاشي محسوب مي شود و موضوعاتي را كه مايليد چاپ شود 
ــه را چركنويس )Pasteboard( مي نامند  ــيم كنيد. ناحيه اطراف صفح بايد در اين ناحيه ترس

)شکل 4-1(.
ــت و در واقع ابعاد  ــط پنل Document قابل تنظيم اس ابعاد و جهت صفحه گرافيکي توس
چاپ را تعيين مي كند. اين كادر محاوره شامل يك كادر پيش نمايش در سمت چپ است كه 

موقعيت صفحات را نمايش مي دهد.
ــکل 2-4( كه از منوي Window قابل  اين پنل در مجموعه پنلProperties  قرار دارد )ش

دسترسي است. 
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FreeHand شکل 1-4 نمايش صفحه در برنامه

Document شکل 2-4 پنل

Document نمايش پنل
پنل Document با استفاده از روش هايي كه ذكر خواهد شد، ظاهر مي شود:

گزينه Document را از منوي Window انتخاب كنيد تا پنل باز شود.
روي آيکن  از نوارابزار Main كليك كرده و زبانه Document را انتخاب كنيد.
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 Main ــه صورت پيش فرض در نوار ابزار ــت كه دكمه  ب  توجه: لازم به ذكر اس
ــرار دادن آن در نوار ابزار  ــير Window→Toolbars→Customize براي ق ــرار ندارد و از مس ق

Main استفاده مي شود.

Document 1-2-4 تنظيم ابعاد صفحه در پنل

ــتفاده از منوي بازشو،  ــت و با اس صفحه پيش فرض در پنل Document به ابعاد Letter اس
ــتانداردي مثل A4 را  مي توان اندازه صفحه موردنظر را تعيين كرد. درصورتي كه صفحات اس
ــاس اندازه هاي استاندارد تنظيم خواهد  انتخاب كنيد، صفحه گرافيکي به طور اتوماتيك براس

شد.
درصورتي كه اندازه موردنظر شما در منوي بازشو نباشد، مي توان ابعاد صفحه را به دلخواه 
تعيين يا به اصطلاح سفارشي كرد. براي اين منظور از منوي بازشو، گزينه Custom را انتخاب 
 )Height( كرده، سپس جهت قرار گيري صفحه را مشخص كنيد. در مرحله بعد طول صفحه
را در كادر x و عرض صفحه )Width( را در كادر y وارد كنيد، سپس كليد Enter را بفشاريد 

تا اندازه ها به صفحه اعمال شوند )شکل 4-3(.

 Document شکل 3-4 تنظيم ابعاد سفارشي در پنل

 نكته: قبل از تنظيم ابعاد صفحه در پنل Document، ابتدا بايد واحد اندازه گيري صفحه تعيين 
شود.

 )Page( 2-2-4 ابزارانتخاب صفحه

ــي )دلخواه( يك صفحه با ابزارPage  به دو روش انجام مي شود كه به  تنظيم ابعاد سفارش
شرح زيرهستند:
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روش اول:
1- ابزارPage  را از جعبه  ابزار Tools انتخاب كنيد.

ــتگيره هايي  2- روي صفحه اي كه مي خواهيد ابعاد آن  را تغيير دهيد، كليك كنيد تا دس
در اطراف لبه هاي آن ظاهر شود. 

ــيدن فلش دوطرفه هر يك از دستگيره هاي اطراف صفحه، اندازه صفحه تغيير  3- با كش
خواهد كرد )شکل 4-4(.

Page شکل 4-4 تنظيم ابعاد صفحه با ابزار

 Info توجه: در هنگام كشيدن دستگيره ها، براي مشاهده ابعاد صفحه به نوار ابزار 
توجه داشته باشيد.

 نكته: تغيير اندازه صفحه تأثيري بر اندازه موضوع ترسيمي ندارد.

روش دوم:
1- ابزارPage  را از جعبه  ابزار Tools انتخاب كنيد.

2- كليد Alt را نگه داشته، روي صفحه دابل كليك كنيد.
3- كادرمحاوره Modify Page ظاهر مي شود )شکل 4-5(.
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Modify Page شکل 5-4 كادر

3-2-4 چرخاندن صفحه 

براي افقي و عمودي كردن صفحه به صورت زير عمل كنيد:
1- ابزار Page را از جعبه ابزار انتخاب كنيد.

2- روي صفحه موردنظر كليك كنيد تا دستگيره ها در اطراف صفحه ظاهر شود.
ــه اي در خارج از صفحه حركت دهيد تا به صورت منحني درآيد،  ــاره گر را به گوش 3- اش

حال به سمت پايين درگ كنيد تا جهت صفحه تغيير كند.

 توجه: با چرخش صفحه، جهت محتويات آن تغيير نمي كند.
ــده انجام مي شود در  ــتفاده از ابزار Page روي صفحه انتخاب ش برخي از اعمالي كه با اس

جدول 1-4 درج شده  است.

جدول 1-4 عملکرد ابزار Page روي صفحه

Page Tool شرحاعمال ابزار

 Page Tool در هنگام درگ صفحه با ابزار 
از صفحه جاري يك كپي مشابه تهيه مي كند.كليد Alt را بفشاريد.

Page Tool+Del.صفحه جاري را حذف مي كند

Page Tool+جابه جايي صفحه در فضاي چركنويس همراه با محتويات صفحهدرگ صفحه

 Page Tool+Ctrl+جابه جايي صفحه در فضاي چركنويس بدون  محتويات صفحهدرگ صفحه
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تمرين 1: با ابزار Page يك كپي از صفحه جاري تهيه كنيد، سپس آن را افقي كنيد.

4-2-4 تنظيم حاشيه مجازي )Bleed( يك صفحه

ــه را چاپ نمي كند، بنابراين براي  ــولاً FreeHand MX بخش هاي خارج از يك صفح معم
ــمت Bleed استفاده مي شود  ــيه در اطراف صفحه گرافيکي از قس تنظيم ناحيه اضافي يا حاش
ــتري رنگ در اطراف  ــردن كليد Enter يك كادر خاكس و با وارد كردن اندازه موردنظر و فش

صفحه كاري ظاهر مي شود كه ناحيه Bleed نام دارد )شکل 4-6(.
دليل استفاده از Bleed را هنگام برش لبه هاي كاغذ در چاپخانه متوجه مي شويد چرا كه 
كادر Bleed به عنوان محافظ، دور صفحه اصلي قرار مي گيرد تا درصورتي كه قسمت كوچکي 

از كار شما خارج از صفحه اصلي قرار داشت، در زمان برش چاپ حذف نشود.

            

Document شکل 7-4 جابه جايي صفحه با استفاده از پنل       Bleed شکل 6-4 نمايش ناحيه

Document 5-2-4 جابه جايي صفحه از طريق پنل

ــه در ناحيه پيش نويس مي توانيد،  ــدSpacebar  همزمان با درگ صفح ــتن كلي با نگه داش
صفحه را جابه جا كنيد )شکل 4-7(. 

6-2-4 افزودن ابعاد سفارشي به ليست اندازه صفحه

درصورتي كه بخواهيد از صفحه ايجاد شده با ابعاد سفارشي )دلخواه( زياد استفاده كنيد، 
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ــتاندارد موجود بی افزاييد تا در آينده بتوانيد به  ــت اندازه صفحات اس مي توانيد آن را به ليس
سرعت به آن دست يابيد. براي اين كار مراحل زير را دنبال كنيد:

 Document ــل ــه واقع در پن ــوي اندازه صفح ــوي بازش ــه Edit از من ــاب گزين  1- انتخ
)شکل 4-8(.

Edit  Page Sizes  شکل 8-4 نحوه نمايش كادرمحاوره

Edit Page Sizes در كادر محاوره New 2- كليك روي دكمه
Page Size 3- تعريف يك نام براي اندازه سفارشي در قسمت

4- وارد كردن اندازه موردنظر در كادر x و y )طول و عرض صفحه(
5- انتخاب دكمه Close كه با بسته شدن كادر محاوره، اندازه  اختصاصي در منوي بازشو 

ظاهر خواهد شد.

ــي   توجه: دكمه Delete در كادر محاوره Edit Page Sizes براي حذف اندازه سفارش

به كار مي رود.

7-2-4 وضعيت نمايش صفحات

ــکل 9-4( كه با  ــه دكمه قرار دارد )ش در پايين كادر پيش  نمايش در پنل Document س
كليك روي هر يك از آن ها در صورتي  كه بيش از يك صفحه داشته باشيد، مي توانيد حالت 

نمايش آن ها را روي كادر پيش نمايش و داخل فايل تنظيم كنيد. 

شکل 9-4 وضعيت نمايش صفحات
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 نكت�ه: با درگ صفحات از داخل كادر پيش نمايش، مي توان صفحات گرافيکي را 
به منظور طراحي صفحات كتاب، تقويم و ... به هم چسباند.

ــراردادن صفحات يا  ــا روش ديگري براي كنار هم ق ــي كنيد آي تمرين 2: بررس
چسباندن آن ها به يکديگر وجود دارد؟

Document 8-2-4 منوي كنترل در پنل

همان طور كه گفته شد در گوشه سمت راست بالاي پنل Document، منوي كنترل وجود 
ــود كه شامل گزينه هايي است كه برخي  دارد  كه با كليك روي آن زيرمنويي باز مي ش

از آن ها در اين جا آمده اند:
چنانچه به بيش از يك صفحه نياز داشته باشيد، مي توانيد از اين گزينه  	 :Add pages

براي اضافه كردن صفحه جديد در كنار صفحه قبلي استفاده كنيد )شکل 4-10(.

Add Pages شکل 10-4 نحوه نمايش كادر

 نكته: براي افزودن تعدادي صفحه با اندازه هاي متفاوت، لازم است براي هر اندازه 
خاص يك بار فرمان Add pages را اجرا كنيد.

Duplicate: از صفحه جاري يك كپي مشابه تهيه مي كند.	

Remove: صفحه جاري را حذف مي كند.	
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ــند به نام Test2 به همراه يك صفحه 60×40 سانتي متري، سه  تمرين 3: يك س
ــند؛  ــبيده باش صفحه A4 و دو صفحه B5 ايجاد كنيد، به طوري كه دو صفحه B5 به هم چس

سپس كليه صفحات را نمايش دهيد.

  )Printer Resolution(9-2-4 درجه وضوح

ــد درجه وضوح تصوير يا  ــو در پايين پنل Document مي تواني ــتفاده از منوي بازش با اس
كيفيت چاپ را تعيين كنيد؛ اين درجه هرچه بالاتر باشد كيفيت تصاوير در چاپ بهتر خواهد 

بود. درجه وضوح براي صفحه نمايش، 72dpi و براي چاپ، 300dpi است.

 توجه: واحد اندازه گيري وضوح تصوير dpi1 و به معني نقطه در اينچ است.

 مثال 1: تنظيمات صفحه مي خواهيد سندي به نام Test1 را كه شامل دو صفحه 
ــت،  ــدازه 200×450 ميلي متر و ديگري به اندازه A5 با درجه وضوح dpi 350 اس ــي به ان يک

ايجاد كنيد، براي اين منظور مراحل زير را انجام دهيد:
1- ابتدا واحد اندازه گيري ميلي متر را از نوار وضعيت انتخاب كنيد.

ــدازه صفحه در پنل  ــو تنظيم ان ــدازه 200×450، از منوي بازش ــراي وارد كردن ان 2- ب
ــدار450 را در كادر x و 200 را در كادر  y وارد  ــه Custom را انتخاب و مق Document  گزين

كنيد.
3- مقدار dpi 350 را در منوي بازشو  Printer Resolution  وارد كنيد.

ــوي كنترل پنل  ــاد صفحه دوم از من ــت، براي ايج ــده اس ــال صفحه اول ايجاد ش 4- ح
Document  گزينه Add pages را انتخاب كنيد.

 Page size عدد 1 را وارد كرده، سپس در منوي بازشو  Number of new pages5- در كادر
اندازه استاندارد A5 را انتخاب كنيد.

.)File→Save( ذخيره كنيد Test1 6- فايل را به نام

   1- Dot Per Inches   
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Master Page 3-4 صفحه
 Master Page )صفحه اصلي1( اين امکان را مي دهد تا صفحه هاي سندي كه ايجاد مي كنيد؛ 

ــد. مي توانيد ويژگي هايي از  ــخص شده داشته باش ــجم و از قبل مش صفحه آرايي ثابت و منس
ــه معمولي مانند محل قرارگيري متن و گرافيك آن را در Master Page تعريف كنيد و  صفح
اين خصوصيات را به همه يا تعدادي از صفحه هاي موردنظرتان اعمال كنيد. بدين ترتيب هر 
ــند اعمال  تغييري كه در صفحه اصلي ايجاد مي كنيد به طور خودكار به صفحه هاي ديگر س

مي شود.

 توجه: مي توانيد يك يا بيش از يك صفحه اصلي در سند داشته باشيد.

 نكته: از Templates نيز براي  ايجاد  سندهايي كه صفحه آرايي  آن ها از قبل  تعريف 
 شده  است، استفاده مي شود.

FreeHand به شما امکان مي دهد كه يكMaster Page  جديد ايجاد كنيد يا صفحه سند 

جاري را به يك Master Page تبديل كنيد.
ــازيد، اندازه، جهت و تنظيمات Bleed صفحه جاري سند  زماني كه يك Master Page مي س
ــات صفحه اصلي را  ــر بخواهيد، مي توانيد تنظيم ــود، البته اگ ــراي آن در نظر گرفته مي ش ب
تغيير دهيد. هنگامي كه يك صفحه سند را به Master Page تبديل مي كنيد، عناصر و اجزاي 

صفحه سند در Master Page قرار مي گيرد.
 در پنلLibrary ، صفحه اصلي به عنوان يك نماد گرافيکي مديريت مي شود و كارهايي كه در 

)جدول2-4( درج شده روي آن قابل اجراست:
جدول 4-2

آشكار ساختنپنهان كردنحذفتغييرنامگروه بنديايجاد يک نسخه كپي

DuplicateGroupRenameDeleteHideShow

1- صفحه مادر 



Free Hand پيمانه مهارتی : كاربر
75واحد كار چهارم: توانايی ايجاد فضای مورد نياز جهت قرارگيری اشيای گرافيکی 

ــتفاده از Master Page در سندهاي ديگرِ FreeHand مي توانيد آن   توجه: براي اس
را Export كرده سپس آن را به سند جاري وارد )Import( كنيد.

 	Childبه يك Master Page ــال يك ــي كه با صفحه اصلي كار مي كنيد؛ با اعم هنگام
ــر و اجزاي Master Page در پايين ترين لايه Child Page )صفحه فرعي(  Page ، عناص

قرار مي گيرد.
Master Page 1-3-4 ايجاد

با استفاده از دو پنل Document و Library مي توانيد يك Master Page ايجاد كنيد؛ براي 
ساخت Master Page از طريق پنل Document مراحل زير را انجام دهيد:

ــل Document در صورتي كه فعال  ــاب Window→Document، براي نمايش پن 1- انتخ
نباشد.

2- از منوي پنل Document گزينه New Master Page را طبق شکل 11-4 انتخاب كنيد. 
)همچنين مي توانيد از منوي پنل Library گزينه New Master Page را برگزينيد.(

3- متن و گرافيك موردنظرتان را در محلي از صفحه Master Page كه در نظر گرفته ايد، 
قرار دهيد )شکل 4-11(.

4- صفحه ها و ويژگي هاي Master Page را ذخيره كرده و پنجره آن را ببنديد.

Document شکل 11-4 ايجاد صفحه اصلي با استفاده از پنل

ــام Master Page-01 در فايلی با نام Example1 با   مثـال 2: يك صفحه اصلی با ن
توجه به مشخصات زير ايجاد كنيد:

اندازه صفحه A4، عمودی و سه دكمه با رنگ دلخواه در سمت چپ صفحه قرار دهيد. 
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ــتفاده از برنامه گرافيکي نقاشي )Paint( يا فتوشاپ يك كادر با  اندازه 4/4×21  1- با اس
  Export ــپس آن را ــت، ايجاد كنيد س ــده اس ــانتی متر كه در آن متن My Project درج ش س

نماييد.
2- در برنامه FreeHand يك سند جديد ايجاد كرده، اندازه و جهت صفحه را از طريق پنل 
 Document از منوي كنترل پنل New Master Page ــم نماييد و روي گزينه Document تنظي

كليك كنيد.
3- پنل library را از مسير  Window→Library باز كنيد.

ــه  ــه Samples كه در پوش 4- از طريق منوي كنترلي Library فايلGel Buttons را از پوش
ــپس دكمه های مورد نظرتان را انتخاب كرده و  برنامه FreeHand قرار دارد، Import كنيد س

در صفحه قرار دهيد.
ــند FreeHand وارد كنيد  ــه س ــي موردنظر را ب ــه گرافيک ــده در برنام ــم ش 6- كادر رس

)File→Import( و در بالاي صفحه قرار دهيد )مطابق شکل 4-12(.

شکل 12-4 مشخص كردن محل اشياء در صفحه اصلي

7- فايل را با نام Example1 ذخيره كنيد. 
ــما مي توانيد با استفاده از گزينه New Master Page در منوي كنترل پنل Library يك  ش

Master Page جديد نيز ايجاد كنيد كه شامل يك موضوع گرافيکي است )شکل 4-13(.
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شکل 13-4 قراردادن موضوع گرافيکي در صفحه اصلي

ــتن پنجره صفحه اصلي ويژگي ها و صفحه هاي Master Page در پنل Library قابل  با بس
مشاهده است.

)Child Page( 2-3-4 اضافه كردن يك صفحه فرعي

روش اول:
1- گزينه Add pages را از منوي كنترلي پنل Document برگزينيد )شکل 4-14(.

2- گزينه Make child of Master Page را انتخاب كنيد )شکل 4-15(.
3- يکي از Master Page  هاي موجود را انتخاب و روي OK كليك كنيد)شکل 4-15(.
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Document از پنل Add pages شکل 14-4 انتخاب گزينه

شکل 15-4 اضافه كردن صفحه فرعي

ــه Duplicate در پنل  ــك روي گزين ــه Child و كلي ــا انتخاب يك صفح  نكت�ه: ب
Document نيز مي توانيد يك صفحه فرعي به صفحه Master Page اضافه كنيد.

روش دوم:
با استفاده از ابزار Page صفحه Child را انتخاب كرده سپس آن صفحه را همزمان با نگه 
ــتن كليد Alt در فضاي چركنويس سند درگ كنيد. اين عمل سبب اضافه شدن صفحه  داش

فرعي به سند مي شود.

ــت، اس  Master Pageاز  Child Page ــك  ي ــاري  ج ــه  صفح ــر  اگ توج�ه:   
ــت كه مي توانيد آن ها را از  Master Page جديد تنظيمات Master Page اصلي را خواهد داش

طريق پنل Document تغيير دهيد.
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ــواه ايجاد كرده و به آن دو صفحه  تمريـن 4: يك صفحه اصلي با محتويات دلخ
فرعي )Child( اضافه كنيد.

3-3-4 تبديل يك صفحه به يك Master Page جديد

ــند را به Master Page تبديل كنيد به ترتيب اين مراحل را  اگر مي خواهيد يك صفحه س
انجام دهيد:

1- صفحه اي را كه مي خواهيد به صفحه اصلي تبديل شود، انتخاب كنيد.
 Convert to Master Page كليك كرده و گزينه Document ــل ــوي كنترلي پن 2- روي من

را انتخاب كنيد )شکل 4-16(.

شکل 16-4 تبديل يك صفحه به يك  Master Page جديد

ــند قابل ويرايش  ــدن در صفحه هاي س ــود در صفحه اصلي پس از ظاهر ش ــر موج عناص
ــد بايد آن ها را از صفحه  ــند اصلاح كني ــتند. اگر مي خواهيد اين عناصر را در صفحه س نيس

اصلي خارج )Release( كنيد.

ــل آن به يك  ــت، براي تبدي ــي )Child Page( اس ــما فرع ــر صفحه ش  نكت�ه: اگ
Master Page ابتدا آن را Release كنيد.

Release 4-3-4 صفحه فرعي

1- صفحه يا صفحه ها را با استفاده از ابزار Page انتخاب كنيد.
2- گزينهRelease Child Page  را از منوي كنترلي پنل  Documentبرگزينيد.

در اين صورت مي توان عناصر صفحه اصلي را در سند ويرايش كرد.
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Library 5-3-4 نمايش و عدم نمايش صفحه اصلي در پنل

 اگر بخواهيد آيکن صفحه مادر در ليست پنل Library مشاهده شود طبق شکل 17-4 گزينه
Show Master Pages را در حالت فعال قرار دهيد. نداشتن علامتP نشانه پنهان بودن صفحه 

اصلي در ليست است.

شکل 17-4 نمايش و عدم نمايش صفحه اصلي

6-3-4 اعمال Master Page به صفحه سند

Library با استفاده از پنل
1- صفحه يا صفحه هاي موردنظر را با استفاده از ابزار Page  انتخاب كنيد.
2- ابتدا بررسي كنيد كه نمايش صفحه اصلي در پنل Library فعال باشد.

3- آيکن Master Page را از پنل Library درگ كرده و داخل صفحه قرار دهيد.
 Document با استفاده از پنل

صفحه يا صفحه هاي موردنظر را با استفاده از ابزارPage  انتخاب كنيد.
از ليست Master Page در پنل Document، صفحه اصلي را انتخاب كنيد تا عناصر صفحه 

اصلي در سند ظاهر شوند.

ــده به Master Page نسبت  ــندهاي چندصفحه اي، صفحه انتخاب ش  نكته: در س
ــتر باشد، با ابزار Page صفحه هاي  ــود و اگر تعداد صفحه هاي انتخابي از يکي بيش داده مي ش

مورد نظر را به عنوان صفحه هاي فرزند صفحه Master Page در نظر بگيريد.
Master Page 7-3-4 ويرايش

1- يکي از موارد زير را انجام دهيد:
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روي آيکن Master Page در پنل Library دابل كليك كنيد.
  Edit ــاب كرده و روي دكمه ــل Document يك صفحه اصلي )Master Page( انتخ در پن

كليك كنيد.
2- تغييرات مورد نظر را در Master Page اعمال كنيد.

3- پنجره Master Page را ببنديد. 

ــه Samples واقع در برنامه  ــل Gel Buttons از پوش ــتفاده از فاي  تمريـن 5: با اس
ــپس رنگ دكمه هاي موجود در  FreeHand، يك صفحه اصلي با نام Buttons1 ايجاد كرده، س

صفحه را تغيير دهيد.
Master Page 8-3-4 حذف

براي حذف صفحه اصلي از يك صفحه سند مراحل زير را انجام دهيد:
1- صفحه هاي موردنظر را انتخاب كنيد.

2- از ليست Master Page پنل Document    گزينه None را برگزينيد. بدين ترتيب عناصر 
صفحه اصلي از صفحه حذف مي شوند.

ــراي تغيير نام صفحه اصلي، روي نام Master Page در پنل Library دابل   توج�ه: ب
كليك كنيد.

Master Page يك Export و Import 4-3-9

براي وارد كردن يك صفحه اصلي در فايل مورد نظر، به ترتيب زير عمل كنيد.
1- گزينه Import را از منوي كنترلي در پنل Library انتخاب كنيد.

ــاوي Master Pages را انتخاب و روي  ــل ح ــاوره اي Import Symbols فاي 2- در كادر مح
دكمه Open كليك كنيد.

ــده، روي دكمه  ــاوره  ظاهر ش ــر از كادرمح ــه اصلي موردنظ ــاب صفح ــس از انتخ 3- پ
ــود  ــان داده مي ش ــده در پنل Library نش "Import كليك كنيد. در اين صورت صفحه وارد ش

)شکل 4-18(.
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Import Symbols شکل 18-4 انتخاب صفحه اصلي از كادرمحاوره

 ،)Export( براي اين كه بتوانيد از صفحه اصلي ايجاد شده در فايل هاي ديگر استفاده كنيد
مراحل زير بايد اجرا شود:

1- گزينه Export را از منوي كنترل در پنل Library انتخاب كنيد.
2- صفحه هايي را كه مي خواهيد Export كنيد، برگزينيد )شکل 4-19(.

3- روي دكمه Export كليك كنيد.
4- در كادرمحاوره اي كه ظاهر مي شود، پوشه Symbol هاي صادر شده را انتخاب كنيد. 

 

شکل 19-4 انتخاب صفحه اصلي از كادرمحاوره Export Symbols و ذخيره آن در پوشه موردنظر براي صادر كردن آن در فايل هاي 

ديگر

ــرده و روي دكمه Save كليك  ــردن Master Pages درج ك ــل را براي صادر ك ــام فاي 5- ن
كنيد.
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 Shift توجه: براي انتخاب چند صفحه مي توانيد، همزمان با انتخاب صفحه ها كليد 
را نگه داريد.

)Page Rulers( 4-4 كار با خط  كش
ــات مختلف را اندازه گيري  ــي و عمودي مي توانيد موضوع ــتفاده ازخط كش هاي افق با اس

كنيد )شکل 4-20(.

Guides وGrid  ،Page Rulers شکل 20-4 نمايش

ــهView→Page Rulers→Show  را انتخاب كرده يا از كليد  ــراي نمايش خط كش ها گزين ب
تركيبي Ctrl+Alt+R استفاده كنيد.

 توجه: براي انتخاب واحد اندازه گيري خط كش، از منوي بازشو Units واقع در نوار  

وضعيت استفاده كنيد.

1-4-4 تغيير محل نقطه صفر خط كش

ــمت چپ بالاي خط كش )محل تقاطع دو خط كش( نشانگر  ــه س علامت بعلاوه در گوش
 نقطه  صفر خط كش است. مي توانيد براي كمك به اندازه گيري موضوعات روي صفحه، محل 
ــت بعلاوه را به محلي كه مي خواهيد نقطه  ــن نقطه را تغيير دهيد، به اين صورت كه علام اي

صفر از آن جا شروع شود، درگ كنيد.
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ــت نقطه صفر به جاي اول خود روي علامت بعلاوه دابل كليك   توجه: براي برگش
كنيد.

تمرين 6: خط كشي با واحد ميلي متر روي صفحه، نمايش دهيد.

)Guides( 5-4 خط هاي راهنما
ــي مختلف و نيز تنظيم دقيق موضوعات  ــيم صفحات به نواح خط هاي راهنما، براي تقس
ــکال به كار مي رود. خطوط راهنما در چاپ ظاهر نخواهند شد و رنگ  ــده و تراز  اش ــم ش رس

پيش فرض اين خطوط آبي است )شکل 4-20(. 
1-5-4 ترسيم خط هاي راهنما

ــبي انجام مي شود كه به ترتيب به شرح  ــيم خط هاي راهنما به دو روش دقيق و نس ترس
زير است:

ترسيم دقيق 	

براي ترسيم دقيق خط هاي راهنما در صفحه، مسير View→Guides→Edit را اجرا كرده و 
از دكمه Add كه در كادرمحاوره Guides قرار دارد، استفاده كنيد )شکل 4-21(.

با كليك روي  دكمه Add، كادرمحاوره  Add Guides مطابق با شکل 22-4 ظاهر مي شود 
كه عملکرد گزينه هاي آن در جدول 3-4 آمده است:

                      

                      

Add Guides شکل  22-4 كادرمحاوره                     Guides شکل  21-4 كادرمحاوره             
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جدول 4-3

Guides

Horizontalبراي افزودن خطوط راهنماي افقي

Verticalبراي افزودن خطوط راهنماي عمودي

Add by

Countبراي وارد كردن تعداد خطوط راهنما در صفحه

Increment
براي وارد كردن عددي به عنوان فاصله خطوط راهنما كه نرم افزار

 با محاسبه فاصله، تعداد خطوط را مشخص مي كند.

Position

Firstتعيين نقطه شروع خطوط راهنما

Lastتعيين نقطه انتهاي خطوط راهنما

Page Range
در صورت داشتن بيش از يك صفحه در سند، مي توانيد مشخص كنيد خطوط راهنما از چه 

صفحه اي شروع و تا چه صفحه اي ادامه يابد. 

Add دكمه
با كليك روي اين دكمه به كادرمحاوره Guides باز

مي گرديد و مي توانيد خطوط تعريف شده را مشاهده كنيد.

ترسيم نسبي 	

 View→Page Rulers→Show براي ترسيم خط هاي راهنماي افقي يا عمودي ابتدا از مسير
ــاره گر ماوس را روي خط كش افقي يا عمودي قرار  خط كش را فعال كنيد. حال مي توانيد اش

داده و آن را به داخل صفحه درگ كنيد.
ــاي راهنماي افقي و  ــند، در زمان درگ خط ه ــم پيمايش )Scroll( پنجره س ــراي تنظي ب

عمودي بخصوص در زماني كه تعداد صفحه ها زياد است؛ به طريق زير عمل كنيد:
 General باز كنيد سپس زبانه Edit→Preferences را از مسير Preferences 1- كادرمحاوره

را فعال كنيد.
2- گزينه Dragging a Guide Scrolls the Window را انتخاب كنيد.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : كاربر

شماره : 15/7- ف - هـ
86

ــند غير فعال  ــرض، Scroll خط هاي راهنما در پنجره س ــت پيش ف  توج�ه: در حال
است.

ــط راهنما و تنظيم Scroll مراحل بعد را  ــم خ مثال 3: براي درك بهتر روش رس
انجام دهيد:

ــمت بالاي  ــل ايجاد كنيد. در اين صورت  قس 1- يك صفحه به اندازه 2000×800 پيکس
صفحه را مشاهده نمي كنيد. 

ــتفاده از روش ترسيم دقيق 5 خط راهنماي افقي و 4 خط راهنماي عمودي در  2- با اس
صفحه قرار دهيد.

 Dragging a Guide گزينه General ــرده و در زبانه ــاوره Preferences را باز ك 3- كادر مح
Scrolls the Window را انتخاب كنيد.

4- حال با استفاده از خط كش 2 خط راهنماي افقي در بالاي صفحه رسم كنيد. براي اين 
ــمت بالاي صفحه،  كار بايد خط راهنما را از خط كش، به صفحه درگ كنيد و همزمان به س
ــود تا شما خط را در  ــمت بالا Scroll  مي ش ماوس را حركت دهيد. مي بينيد كه صفحه به س

محل مناسب قرار دهيد. 
2-5-4 نمايش خط هاي راهنما

براي نمايش خطوط راهنما گزينه View→Guides→Show  را انتخاب كنيد.
3-5-4 قفل كردن خط هاي راهنما

براي قفل كردن خطوط راهنما گزينه View→Guides→Lock را برگزينيد.
4-5-4 خاصيت آهنربايي خط هاي راهنما

 View→Guides→Snap To Guides ــوط راهنما گزينه براي ايجاد خاصيت آهنربايي خط
ــيم وقتي موضوعي به خط  ــد، با انجام اين عمل، در هنگام جابه جايي يا ترس ــاب كني را انتخ
ــلي آن را به سوي  ــود مانند يك آهنربا عمل كرده و از فاصله چند پيکس راهنما نزديك مي ش

خود جذب مي كند.
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5-5-4 حذف خط هاي راهنما

براي حذف خط هاي راهنما، ابتدا بايد ابزار Pointer را انتخاب كرده، سپس خط راهنماي 
 Guides در كادر محاوره Remove ــه ــا از دكم ــه خارج از صفحه درگ كنيد ي ــر را ب موردنظ

استفاده كنيد.

 نكته: براي تغيير رنگ خط هاي راهنما و نقاط شبکه اي، از زبانه Colors واقع در 
كادر محاوره Preferences استفاده كنيد.

6-5-4 ويرايش خط هاي راهنما

ــه View→Guides→Edit را برگزينيد يا روي يکي  ــراي ويرايش خط هاي راهنما، گزين ب
ــکل  ــود )ش ــوط راهنما دابل كليك كنيد، بدين ترتيب كادرمحاوره Guides باز مي ش از خط

.)4-23
عملکرد گزينه و دكمه هاي كادر محاوره Guides در جدول 4-4 آمده است.

شکل 23-4 نمايش مشخصات خطوط راهنماي روي صفحه
با وارد كردن شماره  صفحه، صفحه  موردنظر براي  ويرايش  خط هاي  راهنما انتخاب مي شود. Page

خط هاي راهنماي انتخاب شده در ليست به خط واقعي تبديل مي شود. Release

خط  راهنماي انتخاب شده در ليست را حذف مي كند. Remove

Add براي  افزودن خط هاي راهنما به طور دقيق به صفحه به كار مي رود.

براي تغيير موقعيت قرارگيري خط راهنماي انتخاب شده در ليست به كار مي رود. Edit

جدول 4-4
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ــد كادر محاوره Guides يعني كليك  ــده بعد از تأيي  توجه: همه كارهاي گفته ش
دكمه OK، در صفحه جاري قابل مشاهده خواهد بود.

ــه گرافيکي را از خطوط راهنماي افقي با فواصل   مثـال 4: مي خواهيم يك صفح
نيم  سانتي متري پر كنيم، براي اين منظور مراحل زير را انجام دهيد:

1- ابتدا واحد اندازه گيري صفحه را به سانتي متر تغيير دهيد.
ــرده و از كادرمحاوره Guides روي دكمه  ــه View→Guides→Edit را انتخاب ك 2- گزين

Add كليك كنيد.

3- در كادر باز شده، گزينه Horizontal را برگزينيد.
4- در قسمت Increment عدد 0/5 را وارد كنيد.

ــپس OK را كليك كنيد  ــرده و س ــرات را تأييد ك ــه Add تغيي ــك روي دكم ــا كلي 5- ب
)شکل4-24(.

شکل 24-4 افزودن خطوط راهنماي افقي 

تمرين 7:
1- يك سند حاوي يك صفحه A4 در جهت افقي ايجاد كنيد.
2- هفت خط راهنماي عمودي موازي روي صفحه ايجاد كنيد.

3- سه خط راهنماي افقي موازي نيز در صفحه ايجاد كنيد.
4- خطوط راهنما را قفل كنيد.
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5- اولين خط افقي را حذف كنيد.
)Grid( 6-4 خطوط شبكه

خطوط شبکه بندي، خط هاي نقطه چين افقي و عمودي هستند كه قابل چاپ نبوده، براي 
ــاختاري شبيه  به  ــياء با هم و تعيين موقعيت موضوعات به كار مي روند. اين خطوط س تراز اش
كاغذ شطرنجي را نشان مي دهند و در هنگام ترسيم شکل ها و جابه جايي دقيق اشياء بسيار 

مفيد هستند )شکل 4-25(.
1-6-4 نمايش خط هاي شبكه

ــبکه راهنما، گزينهView→Grid→Show  را انتخاب كنيد تا نقاط  ــاختن ش براي فعال س
مشبك روي صفحه ظاهر شوند.

 توجه: كليد تركيبي Ctrl+Alt+G نقاط شبکه اي را فعال مي سازد.

2-6-4 ويرايش خط هاي شبكه

ــري جاري از گزينه  ــاس واحد اندازه گي ــبکه اي بر اس براي تغيير فاصله هاي بين نقاط ش
ــتفاده كنيد، در اين صورت كادرمحاوره Edit Grid ظاهر مي شود. در  View→Grid→Edit اس

قسمت Grid size فاصله موردنظر را وارد كرده و روي OK كليك كنيد )شکل 4-25(. 

شکل 4-25 

3-6-4 چسبنده كردن نقاط شبكه

ــبك حالت آهنربايي خواهند  با انتخاب گزينه View→Grid→Snap to Grid  خطوط مش
ــت و با نزديك  كردن اشياي ترسيمي به خطوط شبکه اي، موضوعات جذب اين خطوط  داش

مي شوند.
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 توجه: كليد تركيبي Ctrl+Alt+Shift+G قابليت Snap to Grid را فعال مي سازد.

 Snap7-4 ابزار
با استفاده از اين ابزارها امکان چسباندن موضوع هاي گرافيکي و نقاط مسيرها به يکديگر 
ــود. همچنين مي توانيد ميزان اين  در زمان جابه جايي و حركت آن ها در صفحه فراهم مي ش

چسبندگي را تعيين كنيد )شکل 4-26(.

شکل 4-26

1-7-4 چسباندن يك موضوع گرافيكي يا يك نقطه به يك نقطه ديگر

يکي از موارد زير را انجام دهيد:
1-از جعبه ابزار، دكمه   Snap to Point را برگزينيد.

2- مسيرView→Snap to Point  را پيگيري كنيد.
3- با استفاده از ابزار Pointer موضوع گرافيکي را انتخاب و به نزديکي يا روي نقطه اي كه 

به عنوان هدف در نظر گرفته ايد درگ كرده و در محل مناسب رها كنيد )شکل 4-27(.

شکل 27-4 چسباندن يك موضوع گرافيکي يا يك نقطه به يك نقطه ديگر

2-7-4 چسباندن يك موضوع گرافيكي يا يك نقطه به يك مسير

يکي از موارد زير را انجام دهيد:
1- از جعبه ابزار، دكمه   Snap to Object را برگزينيد.

2- مسيرView→Snap to Object  را پيگيري كنيد.
3- با استفاده از ابزار Pointer موضوع گرافيکي را انتخاب و به نزديکي يا روي مسيري كه 

به عنوان هدف در نظر گرفته ايد درگ كرده و در محل مناسب رها كنيد )شکل 4-28(.
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شکل 28-4 چسباندن يك موضوع گرافيکي يا يك نقطه به يك مسير

3-7-4 فاصله چسبندگي

 Preferences را در كادرمحاوره General را اجرا كرده و زبانه Edit→Preferences 1- مسير
انتخاب كنيد.

ــورد نظر براي فاصله  ــکل، حداقل مقدار م ــيSnap distance   مطابق ش 2- در كادر متن
چسبندگي را وارد كنيد )شکل 4-29(.

3- روي دكمه OK كليك كنيد.

شکل 29-4 تغيير فاصله چسبندگي

 مثال كاربردي: مي خواهيم با استفاده از مثال كاربردي كه در آخر هر واحد كار 
ارايه مي شود يك نمونه كارت ويزيت طراحي كنيم. در اين واحد كار به ايجاد صفحه موردنظر 
خواهيم پرداخت، سپس در واحد كارهاي بعدي به طراحي آرم و كارت ويزيت مي پردازيم. 

1- يك صفحه جديد باز كنيد و واحد اندازه گيري آن را ميلي متر قرار دهيد.
ــاب كنيد و مقادير 35  ــه Custom را براي ابعاد كاغذ انتخ ــل Document گزين 2- در پن

ميلي متر را براي عرض و 50 را براي طول صفحه وارد كرده، كليد Enter را بفشاريد.
3- با ابزارZoom  صفحه را در حالت بزرگنمايي قرار دهيد.

4- خط كش ها را ظاهر كرده، خطوط راهنماي مورد نياز را به داخل صفحه بياوريد.
5- فايل ايجاد شده را در قالب يك فايل گرافيکي با فرمت FH11 و با نام Project ذخيره 

كنيد.
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واژه نامه
Bleedبريدن كاغذ، ناحيه برش كاغذ

Guideراهنما

Gridشبکه

Master Pageصفحه اصلي )صفحه با اولويت بالا، صفحه مادر(

Modifyتغيير دادن

Page Childصفحه فرعي )صفحه با اولويت پايين(

Relativeنسبي

Scrollلغزنده

خلاصه مطالب 
ــان New	 يك صفحه  ــه FreeHand، ابتدا بايد از طريق فرم ــروع كار با برنام براي ش
طراحي جديد ايجاد كنيد سپس به ترسيمات بپردازيد. براي تغيير تنظيمات صفحه 
ــيمات دقيق و ترازكردن  ــود. همچنين براي ترس ــتفاده مي ش از پنل Document اس
اشياء به ابزارهاي Guide )خطوط راهنما(، Ruler )خط كش( و Grid )خطوط شبکه( 

نياز داريم.
 	Master Page مي توانيد از امکان ايجاد  Libraryو Document ــتفاده از پنل هاي با اس
ــريع پس زمينه در صفحه هاي پروژه هاي چند  ــکل گيري س ــتفاده كنيد كه در ش اس

صفحه اي و ارائه هاي گرافيکي Flash مفيد است.
ابزار Snap نيز براي جابه جايي دقيق موضوع هاي گرافيکي به كار مي رود.	
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعيين كنيد.

1- با نگه داشتن كليدSpacebar  همزمان با درگ صفحه در ناحيه چركنويس مي توانيد، 
صفحه را جابه جا كنيد.

ــك صفحه Child  انتخاب كرده و  ــراي ويرايش Master Page در پنل Document ي 2- ب
روی دكمه View كليك كنيد.

ــيم خط هاي راهنماي افقي يا عمودي اين است كه اشاره گر ماوس  3- تنها راه براي ترس
را روي خط كش افقي يا عمودي قرار داده و آن را به داخل صفحه درگ كنيد.

معادل گزينه  هاي سمت  راست را از ستون سمت  چپ انتخاب كرده و مقابل هر عبارت بنويسيد.

4- براي تنظيم ناحيه اضافي يا حاشيه در اطراف صفحه گرافيکي استفاده مي شود
 Release

                       Bleed                         .ايجاد كنيد Master Page 5- با استفاده از اين پنل، مي توانيد يك
6- اگر صفحه سند فرعی باشد، براي تبديل آن به يك Master Page قبل از انتخاب گزينه              
                                Snap Distance                    .اين فرمان روي آن انجام مي شود Convert to Master Page

Library    .به كار مي رود  Preferences 7- براي تنظيم فاصله چسبندگي در كادر محاوره
گزينه صحيح را انتخاب كنيد.

8- با استفاده از پنل Document كدام امکانات در دسترس شما قرار مي گيرد؟
الف- تنظيم اندازه صفحه              ب- تنظيم حالت نمايش صفحه   
د- همه گزينه ها صحيح هستند. ج- تنظيم كيفيت چاپ           

9- كدام گزينه نادرست است؟
الف- تغيير اندازه صفحه بر اندازه موضوع ترسيمي تأثير مي گذارد.  

ب- FreeHand يك نرم افزار برداري است.  
ج- واحد اندازه گيري وضوح تصوير )dpi( به معني نقطه در اينچ است.  

د- كليد تركيبي Ctrl+Alt+G نقاط شبکه اي را فعال مي سازد.  
10- براي تعريف ابعاد كاغذ به صورت اختياري از كدام گزينه استفاده مي شود؟

  A4 -د              Custom-ج               Legal -ب   Letter -الف
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ــتفاده  ــپکتيو، از كدام  كليد اس ــتفاده از ابزار پرس ــي  موضوع در حين اس ــراي  كپ 11- ب
مي شود؟

Alt -د     Shift-ج            Ctrl-ب       Tab  -الف
12- كدام مورد صحيح است؟

الف- براي استفاده از خطوط راهنما، فعال بودن خط كش ها الزامي است.
ب- خطوط راهنما به محض نزديك شدن موضوعات، آن ها را از خود دور مي كنند.

ج- خطوط شبکه قابل چاپ هستند.
د- رنگ و تعداد خطوط شبکه سه بعدي را نمي توان تغيير داد.

13- كدام گزينه از صفحه مشابه يك كپي مي گيرد؟
Hide  -د   Duplicate -ج  Remove  -ب  Bleed -الف

14- كدام عبارت درست است؟
الف- تنظيمات صفحه اصلي را نمي توان تغيير داد.

ــده  درسندهاي  ديگر FreeHand  آن ها  را  ــتفاده  از Master Page  هاي  ايجاد ش ب- براي  اس
Export مي كنند.

ج- هر سند فقط يك صفحه اصلي دارد.
د- با چرخش صفحه، جهت محتويات آن تغيير مي كند.

15- براي چسباندن يك موضوع گرافيکي يا يك نقطه به يك مسير، كدام گزينه مناسب 
است؟

   View→Snap to Object-ب                Edit→Snap to Point-الف
 View→Snap to Point-د             Edit→Snap to Object -ج

در جاي خالي عبارت مناسب را بنويسيد.

ــده در ليست را به  16- دكمه ............. در كادر محاوره Guides، خط هاي راهنماي انتخاب ش
خط واقعي تبديل مي كند.

ــتفاده از ابزار  Page Tool همزمان با درگ صفحه و نگه داشتن كليد Ctrl، سبب  17- اس
........... در فضاي چركنويس بدون محتويات صفحه مي شود.

به سؤالات زير پاسخ تشريحی دهيد.

18- ابزار جابه جايي صفحه گرافيکي چيست و كليد ميانبر آن را نام ببريد؟
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19- خط هاي راهنما به چه منظور به كار مي روند؟
20- كاربرد Snap to Grid چيست؟

آزمون عملي
1- يك سند به نام Azmoont4 - 1. Fh11  ايجاد كنيد، سپس:
يك صفحه خالي  به ابعاد 25×20	 سانتی متر ايجاد كنيد.

از صفحه ايجاد شده يك كپي مشابه تهيه كنيد. 	
سه صفحه به اندازه B5	 به سند بيفزاييد.

كليه صفحات را در محيط كار نمايش دهيد. 	
فقط صفحه 3	 را در بزرگ ترين حالت ممکن نمايش دهيد.

صفحه 4 را به 5	 بچسبانيد.
صفحه 5	 را حذف كنيد.

ــند با نامAzmoont4 - 2.Fh11 مطابق شکل بعد كه شامل مشخصات زير است  2- يك س
 ،FreeHand برنامه Samples در پوشه ،Slide Show ايجاد كنيد. )راهنمايي: با استفاده از فايل

صفحه اصلي را ايجاد كنيد.(
Total Pages: 4

مشخصه هر صفحه سند:
Page 1
Origin X: 67.31, Origin Y: 71.195
Page 2
Origin X: 79.935, Origin Y: 71.195
Page 3
Origin X: 67.31, Origin Y: 58.57
Page 4
Origin X: 79.935, Origin Y: 58.57

مشخصات مشترك صفحه ها:
Width: 12.6245, Height: 12.6245
Bleed Size: 0
Orientation: Portrait
Page Type: Custom
Master Page: Slideshow Page
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ــکل زير خط هاي  ــده در ش 3- در فايل Azmoont4 - 2.Fh11 با توجه به تنظيمات داده ش
راهنما را قرار دهيد.
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كليات
ــروع کنيد.  بعد از ايجاد صفحه جديد و انتخاب واحد اندازه گيري مي توانيد طراحي را ش
با توجه به نوع شکلي که مي خواهيد آن را ترسيم نماييد در جعبه ابزار FreeHand مي توانيد 
ــيمي در  FreeHand MX مي توان  ــتفاده از ابزارهاي ترس ابزار مورد نظر را انتخاب کنيد. با اس
ــکال و تصاوير مختلفي را ايجاد کرد. هر کدام از  اين ابزارها، قابليت هاي مختلفي دارند که  اش

در اين جا به شرح کامل آن ها خواهيم پرداخت.   
1-5 ابزار Pen و تنظيمات آن 

براي رسم خطوط صاف و منحني از ابزار  Pen استفاده مي شود. هنگام استفاده از اين ابزار 
در هر قسمتي از صفحه که کليک کنيد يک گره )لنگر( ايجاد مي شود و با متصل شدن اين 

گره ها به يکديگر مسير مورد نظر به وجود مي آيد.
Pen 1-1-5 ترسيم مسير صاف با استفاده از ابزار

1- از جعبه ابزارTools  ابزار Pen را برگزينيد.
 توجه: P کليد ميانبر ابزار Pen است.

ــروع خط باشد، کليک کنيد  ــمتي از صفحه که مي خواهيد نقطه ش 1- با ماوس روي قس
در اين حالت يک مستطيل توخالي نمايان مي شود.

2- در قسمتي از صفحه که مي خواهيد نقطه دوم خط باشد، کليک کنيد.
ــا کليد Tab  را  ــت فقط دابل کليک کنيد ي ــير پايان يافت، کافي اس ــم مس 3- وقتي رس

بفشاريد تا مسير از حالت انتخاب خارج شود.

Pen شکل 1-5 رسم مسير صاف با ابزار

ــتن کليد Shift مي توانيد خطوطي با زاويه °45 يا عمود ايجاد   نکته: با نگه داش
کنيد.

Pen 2-1-5 ترسيم مسير منحني با استفاده از ابزار

1- از جعبه ابزار Tools ابزار Pen را انتخاب کنيد.
ــد کليک کرده  ــمتي از صفحه که مي خواهيد نقطه اول منحني باش 2- با ماوس روي قس
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ــتگيره هاي  و درگ کنيد و بدون اين که آن را رها کنيد، ماوس را جابه جا کنيد در نتيجه دس
کنترل ايجاد مي شود. 

3- مکان بعدي را انتخاب کرده و مجدداً مانند مورد 2 عمل کنيد تا نقطه دوم )گره فعال( 
ايجاد شود. به اين صورت مي توانيد مسير منحني را با هر تعداد انحنا داشته باشيد.

شکل 2-5 ترسيم يک منحني

ــوس انحنا را تغيير دهيد  ــاره گر ماوس مي توانيد جهت و ق ــا درگ و تغيير مکان اش 4- ب
)شکل 5-3(.

5- هنگامي که مسير پايان يافت کليد Tab را بفشاريد يا کليد Ctrl را نگه داشته و کليک 
کنيد تا مسير از حالت انتخاب خارج شود.                                                                                           

شکل 3-5  تغيير جهت و قوس منحني   

 نکته:  با استفاده از ابزار Pen مي توانيد يک مسير بسته نيز ايجاد کنيد، براي اين 
ــاره گر را روي نقطه شروع قرار دهيد تا يک دايره  منظور بايد پس از تعيين نقطه انتهايي، اش

کوچک در کنار اشاره گر ظاهر شود سپس کليک کنيد )شکل 5-4(.
هنگام حذف يگ گره، همراه با اشاره گر ماوس يک علامت منفي )-( و هنگام اضافه کردن 

گره، کنار اشاره گر ماوس علامت مثبت )+( نمايان مي شود.
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ــتگيره هاي  ــي برآمده هنگامي که مي خواهيد دس ــراي ايجاد يک منحن  نکت�ه: ب
کنترل را تغيير اندازه يا تغيير جهت دهيد، از کليد Alt  استفاده کنيد )شکل 5-5(.

  

شکل 4-5 ايجاد يک مسير بسته با ابزار Pen              شکل 5-5 رسم منحني برآمده

 نکته:  براي رس��م تصاوير وارد شده به محيط FreeHand )تصاوير اسکن شده( از 
ابزار Pen نيز مي توان استفاده کرد.

 نکته: 
براي ويرايش يک مسير منحني پس از رسم آن، توسط ابزارPointer  روي هريک از 

نقاط منحني کليک کنيد تا دستگيره هاي کنترل آن نقطه نمايان شوند.

ــير  ــبب کپي مس ــتفاده از ابزار Pointer، س ــردن کليد Alt هنگام اس  نکت�ه: فش
مي شود.

 زماني که براي قرار دادن نقطه روي صفحه با ابزار Pen کليک مي کنيد، يک نقطه گوشه
)Corner Point( ايجاد مي شود که به شکل مربع است.

ــتفاده از ابزار Pen وقتي درگ مي کنيد يک نقطه منحني )Curve Point( ايجاد  هنگام اس
ــت به يک  ــت. به نقاطي که براي اتصال هموار يک خط راس ــکل دايره اس ــود که به ش مي ش
ــود، نقاط اتصال دهنده )Connector Point( مي گويند که با گرفتن کليد  منحني ايجاد مي ش
ــت به وجود مي آيد و به شکل مثلث ديده مي شود ولي بعد از خارج شدن از  Alt و کليک راس

حالت انتخاب به مربع تبديل مي شود )شکل 5-6(.
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شکل 6-5 نمايش انواع نقاط 

مثال 1: به منظور آشنايي بيشتر با نقاط اتصال دهنده شکل 7-5 را رسم کنيد.

شکل 7-5 رسم شکل با کمک نقطه اتصال دهنده

مراحل انجام کار به صورت زير است:
ــپس در نقطه b کليک  ــرار داده و درگ کنيد، س ــا کليک روي صفحه ق ــه a را ب 1- نقط

کنيد.
2- مانند مرحله قبل درگ کرده روي نقطه c کليک کنيد.

3- براي رسم مسير منحني cd روي نقطه d کليک کرده و بدون رها کردن کليد ماوس 
با حرکت دادن دستگيره هاي کنترل، منحني را به وجود آوريد.

4- براي رسم پاره خط بعدي به يک خط صاف نياز داريد. اگر روي نقطه e کليک کنيد، 
يک خط منحني به وجود مي آيد. در اين قسمت براي رسم يک خط صاف به يک نقطه اتصال 
ــير منحني cd در نقطه d کليک کنيد، بايد کليد ــم مس دهنده نياز داريد؛ چنانچه براي رس

 Alt را همزمان پايين نگه داريد تا اين نقطه به نقطه اتصال دهنده تبديل شود؛ در اين لحظه 

ــپس در نقطه e کليک کرده و مسير را  ــتگيره کنترل در سمت راست ناپديد مي شود؛ س دس
ببنديد.

ــيرها قابل تبديل به يکديگر هستند يعني مي توان يک نقطه  گره هاي موجود در مس 	
ــه را به نقطه منحني و برعکس تبديل کرد. همچنين مي توان کمان ها را نيز به  گوش
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ــتفاده مي شود. اين  ــتقيم تبديل کرد؛ براي اين منظور از پنل Object اس خطوط مس
پنل، اطلاعاتي در مورد نقطه و مسير انتخاب شده ارايه مي دهد.                                                                                                                    

 مثال 2: شکل 8-5 را با استفاده از ابزار Pen رسم کنيد.

شکل 5-8

1- ابتدا يک مسير بيضي با 8 گره توسط ابزار Pen رسم کنيد.
ــمت دم ماهي قرار دهيد تا يک  2- ابزار Pen را روي گره هاي س
ــود. حال با کليک ماوس گره  ــت منفي )-( در کنار آن ظاهر ش علام

مربوطه را حذف کنيد. چنين شکلي خواهد شد. 
براي دم مي توانيد با کليک و درگ به سمت بالا از روي انتهاي دم رسم کنيد.

ــاره گر  Penرا در  ــمت دهان ماهي بايد گره اضافه کنيد، براي اين منظور اش 3- براي قس
قسمت موردنظر روي مسير قرار دهيد تا يک علامت مثبت )+( در کنار آن ظاهر شود. اکنون 
کافي است کليک کنيد تا يک گره به مسير اضافه شود و با درگ کردن، دهان ماهي را رسم 

کنيد.
Pen 3-1-5 تنظيمات ابزار

ــود. انتخاب  ــکل 9-5( باز مي ش ــا دابل کليک روي ابزار Pen کادرمحاوره Pen Tool )ش ب
ــيم با ابزار Pen پيش نمايشي از مسير  ــود تا هنگام ترس گزينهShow Pen Preview باعث مي ش

نشان داده شود.

Pen Tool شکل 9-5 کادر محاوره
تمرين 1: شکل 10-5 را با استفاده از ابزار Pen رسم کنيد.

  

شکل 5-10 
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 نکته: با استفاده از ابزارهاي انتخاب )Pointer و Sub Select( مي توانيد نقاط گره اي 
را انتخاب و سپس اصلاح کنيد.

Bezigon 2-5 ابزار ترسيم
ــم خط صاف يا منحني مورد  ــروه ابزارهاي Pen قرار دارد و براي رس ــزار Bezigon در گ اب
ــط ابزار  ــتفاده قرار مي گيرد. اين ابزار همانند ابزار Pen عمل مي کند با اين تفاوت که توس اس
 Bezigon با کليک و درگ کردن مي توان منحني رسم کرد اما هنگام رسم منحني با ابزار Pen

ــيم، هر گره اي را که نياز به  بايد کليد Alt را پايين نگه داريد و بعد کليک کنيد؛ پس از ترس
انحنا دارد، انتخاب کرده و تغيير دهيد )شکل 5-11(.

Bezigon رسم منحني با ابزار                       Pen رسم منحني با ابزار

شکل 5-11

Bezigon 1-2-5 ترسيم مسير صاف با استفاده از ابزار
1- ب��ا اس��تفاده از ماوس روي ابزار Pen واقع در جعبه اب��زار Tools کليک کرده و از منوي 

ظاهر شده گزينه Bezigon tool را انتخاب کنيد.                                 

Bezigon شکل 12-5  ابزار 

ــمتي از صفحه که مي خواهيد نقطه شروع خط باشد، کليک کنيد؛  2- با ماوس روي قس
در اين حالت يک مستطيل توخالي نمايان مي شود.

ــتفاده از ماوس در قسمتي از صفحه که مي خواهيد نقطه دوم خط باشد، کليک  3- با اس
کنيد.

Bezigon 2-2-5 ترسيم مسير منحني با استفاده از ابزار
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ــده گزينه ــزار  Toolsکليک کرده و ازمنوي ظاهر ش ــع در جعبه اب ــزار Pen واق 4- روي اب
 Bezigon tool را انتخاب کنيد. 

ــمتي از صفحه که مي خواهيد نقطه شروع خط باشد، کليک کنيد؛  5- با ماوس روي قس
در اين حالت يک مستطيل توخالي نمايان مي شود.

ــمتي از صفحه که مي خواهيد نقطه  ــته و با ماوس در قس 6- کليد Alt را پايين نگه داش
دوم خط باشد، کليک کنيد.

ــه گره b ،a و c روي مسير ايجاد  ــکل 13-5 مشاهده مي کنيد، س 7- همان طورکه در ش
شده اند حال مي توانيد به وسيله ماوس هر يک از اين گره ها را انتخاب کرده و درگ کنيد تا 

منحني موردنظر ايجاد شود )شکل 5-14(.

   
        شکل 13-5 رسم منحني با ابزار Bezigon          شکل 14-5 تغيير گره b و ايجاد منحني

پس از ايجاد يک مسير با اين ابزار، همانند ابزار Pen	 مي توانيد با کليک روي يک گره 
واقع در مسير، آن گره را حذف کنيد و با يک بار کليک روي قسمتي از مسير، در آن 

قسمت يک گره ايجاد کرده، سپس مسير موردنظر را ويرايش کنيد.
Bezigon 3-2-5 تنظيمات ابزار

ــکل 15-5( باز مي شود.  با دابل کليک روي ابزار  Bezigon کادرمحاوره Bezigon Tool )ش
ــود تا هنگام ترسيم با ابزار Bezigon، شئ به طور  انتخاب گزينه Auto constrain باعث مي ش
ــت  ــود. به عبارت ديگر خطوط در زواياي 0، 45 و90 درجه به صورت راس خودکار محدود ش
ترسيم مي شوند و مانند اين است که کليد Shift   را هنگام ترسيم نگه  داشته ايد. در اين زوايا 
ــود که نشان مي دهد شئ محدود )constrain( شده  ــاره گر ظاهر مي ش دايره کوچکي کنار اش

است.

Bezigon Tool شکل 15-5 کادرمحاوره

 مثال 3: شکل 16-5 را با ابزار Bezigon رسم کنيد.
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شکل 5-16 

1- ابتدا ابزار Bezigon را از جعبه ابزار برگزينيد.
2- قسمت بدنه فلفل را رسم کنيد. به ميزان انحناي مسير براي رسم بدنه توجه کنيد و 

هنگام ترسيم، براي ايجاد اين انحنا ماوس را به اندازه لازم درگ کنيد.         
3- قسمت سر فلفل را رسم کنيد.

 تمرين 2: شکل 17-5 را با ابزار Bezigon و Pen رسم کنيد.    

شکل 5-17

3-5 ابزار ترسيم خط )Line( و تنظيمات آن 
ــتقيم و ايجاد اشکال دلخواه يا متصل کردن چند شکل به  ــم خطوط مايل و مس براي رس

يکديگر از ابزار Line استفاده مي شود.
1-3-5 ترسيم خط

1- ابزار Line را از جعبه ابزار Tools انتخاب کنيد.
2- اشاره گر ماوس را در نقطه اي از صفحه قرار دهيد.

3- ماوس را در جهت و زاويه موردنظر به اندازه دلخواه درگ کنيد.
4- به محض اين که کليد ماوس را رها کنيد، ترسيم خط تمام مي شود.

ــت )افقي و  ــم خط با زاويه° 45 )خط مايل( يا °90 يا خط راس  توج�ه: براي رس
عمودي( هنگام استفاده از ابزار Line کليد Shift را پايين نگه داريد.
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ــم خط کليدهاي Shift و Alt را همزمان پايين نگه داريد، خط به صورت  اگر هنگام رس
صاف و از مرکز رسم مي شود.

2-3-5 مشاهده خواص خط در هنگام رسم
با اس��تفاده از نوارابزار Info واقع در من��وي Windows→Toolbars→Info مي توانيد هنگام 
رس��م خط، قبل از رها ک��ردن کليد ماوس در نقطه انتهايي، مختص��ات، طول و زاويه خط را 

مشاهده کنيد.

                      

Info شکل 18-5  نوار

Line 3-3-5 تنظيمات ابزار
 با دابل کليک روي ابزار Line کادرمحاوره Line Tool )شکل 19-5( باز مي شود. انتخاب گزينه
Auto constrain باع��ث مي ش��ود تا هنگام ترس��يم با ابزار Line در زواي��اي 45، 0 و90 درجه 

خطوط به اين زوايا محدود شده و به صورت راست رسم شوند.                        

Line Tool شکل 19-5 کادر

 مثال 4: شکل 20-5 را با ابزار Line رسم کنيد.
1- ابتدا از محل مشخص شده در شکل شروع کنيد )محل شروع دلخواه است(.

2- ابزار  Lineرا از جعبه ابزار برگزينيد.                                                     

شکل 5-20
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 3- اشاره گر ماوس را در نقطه اي از صفحه قرار داده و به طور مورب به سمت بالا درگ کنيد
)زاويه در حدود 35°(، قبل از رها کردن کليد ماوس در نقطه انتهايي، طول و زاويه خط را از 

نوار ابزار Info مشاهده کنيد. 
4- اکنون اشاره گر ماوس را روي نقطه پاياني خط اول قرار داده و به طور مورب به سمت 

پايين درگ کنيد، توجه کنيد که طول و زاويه خط به اندازه خط اول باشد. 
5- خطوط بعدي را هم با روش ذکر شده، رسم کنيد.

تمرين 3: شکل هاي بعد را با کمک ابزار Line رسم کنيد.
 

شکل 5-21  

4-5 ابزار Pencil و تنظيمات آن 
ــکل هاي به صورت آزاد را به شما مي دهد به طوري که به نظر  ــيم ش اين ابزار امکان ترس
مي رسد يک مداد واقعي را در دست داريد و مي توانيد اشکال مورد نظر خود را رسم کنيد. 

  Pencil 1-4-5 ترسيم مسير با استفاده از ابزار
1- از جعبه ابزار Tools ابزار Pencil را برگزينيد.

2- با ماوس روي قسمتي از صفحه که مي خواهيد نقطه شروع خط باشد، کليک کنيد و 
بدون رها کردن کليد سمت چپ ماوس عمل درگ را انجام دهيد. 

3- براي رسم خطوط راست در حين ترسيم با ماوس، کليد Alt را پايين نگه داريد و براي 
ادامه مسير کليد Alt را رها کنيد ولي کليد ماوس را رها نکنيد.

Pencil شکل 22-5 رسم مسير با ابزار
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4- وقتي رسم مسير پايان يافت، کليد سمت چپ ماوس را رها کنيد.
ــزار Tools روي اين ابزار دابل کليک  ــور انجام تنظيمات ابزار Pencil، در جعبه اب ــه منظ ب

کنيد. کادر محاوره Pencil Tool مطابق شکل 23-5 ظاهر مي شود.
ــمت Precision مي توانيد با حرکت دادن دکمه لغزنده عددي بين 1 تا 10	 را  در قس
تعيين کنيد. انتخاب اعداد بزرگ تر باعث مي شود تا هنگام ترسيم، روي مسير رسم 
ــتفاده از اين گره ها شکل  ــتري وجود داشته باشد و بتوانيد با اس ــده گره هاي بيش ش
ــتفاده از اين گزينه مي توانيد ميزان دقت کار خود و تبعيت  را ويرايش نماييد. با اس

مسير از حرکت مکان نما را تعيين کنيد.

Pencil Tool شکل 23-5 کادرمحاوره

ــم، خطوط به  ــود در پيش نمايش رس ــاب گزينه Draw dotted line	 باعث مي ش انتخ
ــوند اما بعد از رسم،  ــريع تر ترسيم ش ــيرها س ــوند و مس صورت نقطه چين نمايان ش

خطوط به صورت رنگ توپر نمايش داده مي شوند.

مثال 5: شکل 24-5 را با ابزار Pencil رسم کنيد.
 

ــم نماييد. براي رسم خطوط صاف از  ــکل مورد نظر را رس ابزار Pencil را انتخاب کرده ش
کليد Alt استفاده کنيد.

ــير، ابزار Pencil را روي نقطه پاياني مسير قرار دهيد؛ علامت بعلاوه  براي ادامه دادن مس
)+( نمايان مي شود. در همان نقطه کليک کرده و مسير را ادامه دهيد. 

شکل 5-24
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5-5 ابزار Variable Stroke Pen tool و تنظيمات آن 
براي ترسيم خطوط با ضخامت هاي متغير مي توانيد از اين ابزار استفاده کنيد.

Variable Stroke Pen tool 1-5-5 ترسيم مسير با استفاده از ابزار
 Variable Stroke Pen tool ــده ابزار ــزار Pencil کليک کرده و از منوي ظاهر ش 1- روي اب

را انتخاب نماييد.

Variable Stroke Pen tool شکل 25-5  ابزار

ــرار داده و همان طورکه کليد  ــاوس را در محل مورد نظر روي صفحه ق ــاي م 2- مکان نم
ماوس را نگه داشته ايد مسير مورد نظر را با درگ کردن رسم نماييد.

3- به منظور اعمال تنظيمات روي اين ابزار در جعبه ابزار دابل کليک کنيد. در اين صورت 
کادر محاوره  Variable Stroke Pen مطابق شکل 26-5 نمايان مي شود.

Variable Stroke Pen شکل 26-5 کادرمحاوره

گزينه Precision: اين گزينه به شما امکان بالا بردن دقت کار را مي دهد.	
گزينه Auto remove overlap:	 با انتخاب اين گزينه به صورت اتوماتيک قسمت هايي 

از شکل که روي هم قرار دارند، حذف مي شوند.
اين قسمت داراي دو گزينه است که به شما امکان تنظيم پهنا براي  	 :Width قسمت

نازک ترين و ضخيم ترين قسمت خط از 1 تا 72 را مي دهد.

Auto remove overlap شکل 27-5 نتيجه حاصل از فعال و غيرفعال بودن گزينه
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ــط  ــزار Variable Stroke Pen tool مي توانيد توس ــير با اب ــم مس  توجه: هنگام رس
کليدهاي جهت دار صفحه کليد، ضخامت مسير را تغيير دهيد.

6-5 ابزار خوشنويسي Calligraphic Pen tool و تنظيمات آن
با استفاده از اين ابزار مي توانيد خطوط هنري ايجاد کنيد.

Calligraphic Pen tool 1-6-5 ترسيم خطوط هنري با استفاده از ابزار
ــزار Calligraphic Pen tool را  ــده اب ــزار Pencil کليک کرده و از منوي ظاهر ش 1- روي اب

انتخاب نماييد. 

 Calligraphic Penشکل 28-5  ابزار

ــر روي صفحه قرار داده و همان طور که کليد  ــاي ماوس را در محل مورد نظ 2- مکان نم
ماوس را نگه داشته ايد مسير مورد نظر را با درگ کردن رسم نماييد.

Calligraphic Pen toolشکل 29-5 ايجادخطوط هنري به وسيله  ابزار

3- به منظور اعمال تنظيمات روي اين ابزار در جعبه ابزار دابل کليک کنيد. در اين صورت 
کادر محاوره Calligraphic Pen مطابق شکل 30-5 نمايان مي شود.

بعضي از گزينه هاي اين کادر محاوره  قبلا توضيح داده شده است، در ادامه به توضيح ساير گزينه ها 
مي پردازيم:

قسمت Width: توسط گزينه هاي اين قسمت مي توانيد يک ضخامت ثابت )Fixed(	  يا 
متغير )Variable( را براي نوک قلم تعيين کنيد.

ــيله  ــمت مي توان زاويه قلم را به صورت عددي يا به  وس قس�مت Angle:	 در اين قس
دايره کناري کنترل کرد.
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 Calligraphic Pen 3-5 کادرمحاوره شکل 

 Variable Strokeو Pencil ،Calligraphic Pen tool  تمرين 4: شکل 31-5 را با ابزار

Pen tool رسم کنيد. 

شکل 5-31

  )Rectangle( 7-5 ابزار ترسيم چهارگوش
ــتفاده  ــکال چهارگوش اس ــتطيل، مربع و به طورکلي اش ــيم مس ــن ابزار براي ترس از اي

مي کنيم.          
1-7-5 ترسيم مستطيل 

1- روي ابزار Rectangle واقع در جعبه ابزار Tools کليک کنيد.                                      
2- اشاره گر ماوس را )که با علامت + نمايش داده مي شود( روي صفحه قرار داده و کليد 
ماوس را نگه داشته و به سمت چپ يا راست درگ کنيد. در اين حالت مربع هاي کوچکي در 

اطراف چهارضلعي ظاهر مي شود که به آن ها مربع هاي انتخاب مي گويند. 
ــري )مورب(  ــاره گر را درامتداد خط قط ــزار Pointer، اش ــط اب ــکل توس پس از انتخاب ش

بين دوگوشه درگ کنيد.
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شکل 32-5 جهت حرکت اشاره گر براي رسم مستطيل

 توجه: براي رسم مستطيل از نقطه وسط )مرکز( کليد Alt را نگه داريد.      
در صورت لزوم مي توانيد بعد از رسم مستطيل، ابعاد آن را از طريق پنل Object واقع در 

منوي Window تغيير دهيد.

2-7-5 ترسيم مربع

1- براي رسم مربع مانند مراحل قبل عمل کنيد.
2- در هنگام درگ ماوس کليد Shift را پايين نگه داريد.

ــاي Shift و Alt را همزمان  ــط )مرکز( کليده ــم مربع از نقطه وس  توجه: براي رس
فشار دهيد.

ــه هاي منحني )گرد( رسم کرد. ميزان  مي توان با ابزار Rectangle چهارضلعي هايي با گوش
انحناي گوشه ها به گزينه Corner radius )شعاع گوشه ها( بستگي دارد )شکل 5-33(.

تنظيمات Corner radius باعث انحنا يا تيزي گوشه هاي چهارگوش مي شود.

شکل 33- 5

تنظيم شعاع هاي گوشه اي چهارضلعي
 Rectangle دابل کليک کنيد تا کادرمحاوره Rectangle روي ابزار Tools 1- در جعبه ابزار
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 Tool باز شود.

به طور پيش فرض شعاع انحناي گوشه ها صفر است. هر چه اين عدد بزرگ تر باشد، ميزان 
انحناي گوشه هاي چهارضلعي بيشتر خواهد شد. 

ــده مي توانيد مقدار مورد نظر جهت شعاع گوشه را در مقابل  2- در کادرمحاوره ظاهر ش
گزينه  Corner radius   تايپ کرده يا از دکمه لغزنده استفاده کنيد.

3- روي دکمه OK کليک کرده و شکل را رسم کنيد.

Rectangle Tool شکل 34-5 کادر محاوره

 نکته: واحد انحناي گوشه ها بر اساس واحد صفحه است.

تغيير ابعاد مستطيل
1-مستطيل مورد نظر را انتخاب کنيد.

2- به پنل Object برويد و مراحل بعد را انجام دهيد.
3- با استفاده از گزينه Corners مي توان مقدار انحناي گوشه ها را تغيير داد.

4- براي اعمال تغييرات کليد Enter را فشار دهيد.

 توجه: براي ايجاد تنظيمات مختلف براي هر گوشه مستطيل، گزينه Uniform را 
غيرفعال کنيد و در هر فيلد مقدار شعاع گوشه را وارد کنيد.
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Object شکل 35-5  پنل

 مثال 6: شکل 36-5 را با ابزار Rectangle رسم کنيد.  

Rectangleشکل 36- 5 ترسيم شکل با ابزار

1- ابتدا يک مستطيل بزرگ رسم کنيد.
2- در بالاي اين مستطيل يک مستطيل ديگر رسم کنيد.

3- براي پنجره هاي اين خانه دو مربع هم اندازه و هم مرکز رسم کنيد.
ــتطيل کوچک تر قرار  ــم کرده و داخل آن يک مس ــتطيل براي در خانه رس 4- يک مس

دهيد. 

تمرين 5: شکل هاي زير را توسط ابزار مستطيل ايجاد کنيد.

شکل 37-5 مربع هاي هم مرکز، آدم آهني و نردبان                
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 Ellipse 8-5 ابزار ترسيم
از اين ابزار براي رسم بيضي يا دايره استفاده مي کنيم.

1-8-5 ترسيم بيضي يا دايره

1- در جعبه ابزار  Tools روي ابزار Ellipse کليک کنيد.
ــمت مقابل درگ  ــل موردنظر از صفحه قرار داده و به س ــاره گر ماوس را روي مح 2- اش

کنيد.

ــتن کليد Shift مي توان از ابزار Ellipse براي رسم دايره استفاده   توجه: با نگه داش
کرد.

هنگام استفاده از ابزار Ellipse اگر کليد Alt را پايين نگه داريد، بيضي از مرکز رسم مي شود.

براي رسم دايره از مرکز هنگام استفاده از ابزار Ellipse کليدهاي Alt وShift را پايين نگه داريد.

با استفاده از پنل Object مي توان ابعاد بيضي رسم شده را تغيير داد.
ــم  ــط ابزارهايي که تاکنون آموخته ايد، رس ــکل هاي بعدي را توس تمرين 6: ش

کنيد. 

شکل 5-38

)Polygon( 9-5 ابزار ترسيم چندضلعي
ــود. ابزار ترسيم چندضلعي  ــتاره استفاده مي ش ــيم چندضلعي و س از اين ابزار براي ترس

همراه با ابزار ترسيم مستطيل در يک گروه قرار دارند.
1-9-5 ترسيم يک چند ضلعي

1- روي ابزار Rectangle واقع در جعبه ابزار Tools کليک کرده و از منوي ظاهر شده ابزار 
Polygon tool را انتخاب کنيد.
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Polygon tool شکل 39-5 ابزار

ــک کنيد تا کادرمحاوره ــزار Polygon واقع در نوار ابزار Tools دابل کلي ــال روي اب 2- ح
 Polygon Tool باز شود.

3- در اين کادرمحاوره، گزينه Number of Sides مشخص کننده تعداد اضلاع چند ضلعي 
اس��ت. تعداد اضلاع چند ضلعي بيشتر مي ش��ود تا به عدد 20 برسد که در اين صورت شکل 

حاصله دايره خواهد بود.       

         

Polygon Tool شکل 40-5 کادرمحاوره

ــخص کننده نوع چند ضلعي است که امکان انتخاب شکل را از بين ستاره  Shape -4 مش

)Star( يا چند ضلعي )Polygon( مي دهد )در اينجا Polygon انتخاب مي شود(.
5- روي دکمه OK کليک کنيد.

ــز چند ضلعي در آن  ــمتي از صفحه که مي خواهيد مرک ــاوس را روي قس ــاره گر م 6- اش
قسمت قرار گيرد، بگذاريد و به سمت خارج درگ کنيد.

7- با چرخش ماوس مي توانيد چندضلعي را نيز بچرخانيد.
تمرين 7: شکل 41-5 را رسم کنيد.

 

شکل 5-41
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10-5 ابزار ترسيم ستاره  
از ابزار Polygon براي ترسيم ستاره استفاده مي شود.

ترسيم ستاره
1- در جعبه ابزار Tools روي Polygon دابل کليک کنيد تا کادرمحاوره Polygon Tool باز 

شود.
2- در قسمت Shape گزينه Star را برگزينيد.

3- در قسمت Number of Sides تعداد اضلاع ستاره را وارد کنيد.
4- با فعال کردن گزينه Automatic ستاره اي رسم مي شود که زاويه بين اضلاع آن به طور 

اتوماتيک تنظيم شده است.
5- با فعال کردن گزينه Manual مي توانيد زاويه بين اضلاع ستاره را به صورت دستي به 

کمک دکمه لغزنده واقع در قسمت  Star Pointsتنظيم کنيد.

شکل 42-5 کادر محاوره Polygon Tool براي رسم ستاره

 نکته: انتخاب گزينه Star به شما امکان رسم يک شکل سه وجهي )شبيه مثلث 
متساوي الاضلاع( تا يک شکل 20 وجهي يعني شکلي مشابه دايره را مي دهد.

ــکال 43-5 را رسم کنيد، براي رسم ستاره مشخص شده مراحل بعد  مثال 7: اش
را انجام دهيد: 

1- روي گزينه Polygon از نوار ابزار دابل کليک کنيد.
2- در کادرمحاوره Polygon Tool گزينه Star را برگزينيد.

ــکل 6 است، وارد  ــتاره را که در اين ش ــمت Number of Sides تعداد اضلاع س 3- در قس
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کنيد.

شکل 5-43 

ــمت ــمت Star Points را به س 4- با فعال کردن گزينه Manual، دکمه لغزنده واقع در قس
acute ببريد تا زاويه بين اضلاع ستاره مطابق شکل شود. 

5- بقيه ستاره ها مشابه روش ذکر شده، رسم مي شوند.
تمرين 8: شکل 44-5 را با استفاده از ابزارهايي که آموخته ايد، رسم کنيد.

شکل 5-44

ــم  ــي از آرم مثال کاربردي را رس مثال کاربردي: در اين  مثال مي خواهيم بخش
 

کنيم، براي اين منظور مراحل زير را انجام دهيد:

شکل 5-45

1- فايل Project مثال کاربردي واحد کار 4 را باز کنيد. 
 w يک چهارگوش با ابعاد Pen ــتفاده از ابزار 2- در صفحه اي که قبلًا ايجاد کرديد؛ با اس
ــپس کليد Enter را بفشاريد. چهارگوش مطابق شکل  ــم کنيد، س برابر 7 و h برابر 26/5 رس

46-5 به يک مستطيل 26/5×7 عمودي تبديل مي شود.
ــتطيل را گرد کنيم. از آن جا که  ــت پايين مس ــمت راس ــه س 3- اکنون مي خواهيم گوش
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ــه نقطه لنگر دارد با توجه به دو نقطه لنگر پايين مستطيل؛ يک  ــيم يک کمان نياز به س ترس
نقطه لنگر روي مستطيل ايجاد  کنيد. براي اين کار به وسيله ابزار Pen در نقطه تعيين شده در 

شکل 47-5 روي ضلع سمت راست مستطيل کليک کنيد تا يک نقطه به آن اضافه شود.
4- تغييرات را ذخيره کنيد.

               

 شکل 46-5                                     شکل 5-47

واژه نامه
Angleزاويه

Bezigonبزيه

Calligraphicخوشنويسي

Ellipseبيضي

Overlapهمپوشاني

Precisionدقت

Shapeشکل

Strokeخط

Variableمتغير

خلاصه مطالب
براي ترسيم اشکال در FreeHand MXa از جعبه ابزار Tools استفاده مي شود.	
ابزار Bezigon براي رسم خط صاف يا منحني مورد استفاده قرار مي گيرد.	
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 	Line ــم خط به کار مي رود، با اين تفاوت که با ابزار Line و Bezigon هر دو براي رس
فقط مي توان پاره خط رسم کرد اما نمي توان خطوط را به هم متصل کرد.

 	Variable Stroke Pen ــد از ابزار ــيم خطوط با ضخامت هاي متغير مي تواني براي ترس
tool استفاده کنيد.

با استفاده از ابزار Calligraphic Pen tool مي توانيد خطوط هنري ايجاد کنيد.	
از ابزار Rectangle	 به منظور ترسيم اشکال چهارگوش استفاده مي شود.          

از ابزار Ellipse براي رسم بيضي يا دايره استفاده مي شود.	
از ابزار Polygon براي ترسيم چندضلعي و ستاره استفاده مي شود.	
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعيين کنيد.

1- براي ترسيم اشکال در FreeHand MXa از جعبه ابزار Tools استفاده مي شود.
2- با استفاده از ابزار Variable Stroke Pen tool مي توانيد خطوط هنري ايجاد نماييد.

3- از ابزار Polygon براي ترسيم چندضلعي و ستاره استفاده مي شود.
4- از ابزار Rectangle براي رسم بيضي يا دايره استفاده مي شود.

معادل گزينه  هاي سمت  راست را از ستون سمت  چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

      Line                   .1- از اين ابزار به منظور ترسيم اشکال چهارگوش استفاده مي شود
Pen                     .2- اين گزينه به شما امکان رسم يک شکل سه وجهي را مي دهد
Rectangle             .3- براي رسم خطوط مايل و مستقيم از اين ابزار استفاده مي شود

                  Star                     .4- براي رسم خطوط صاف و منحني از اين ابزار استفاده مي شود
گزينه صحيح را انتخاب کنيد.

5- در چه مواقعي از ابزار Ellipse در جعبه ابزار استفاده مي کنيد؟
ب- رسم دايره و بيضي الف- رسم چندضلعي           

ج- رسم کمان              د- رسم چهارگوش
ــيم از مرکز به اطراف گسترش يابند از کدام  ــکال گرافيکي هنگام ترس 6- براي اين که اش

کليد استفاده  مي کنيد؟
                          Alt -د                Shift -ج               Ctrl  -ب            Tab -الف

7- براي رسم ستاره )Star( از کدام ابزار استفاده مي کنيد؟
 Ellipse -ب          Rectangle -الف
 Bezigon -د        Polygon -ج

8- در کادرمحاوره Polygon گزينه Number of Sides چه کاربردي دارد؟
الف- زاويه بين اضلاع چند ضلعي را مشخص مي کند.

ب- تعداد اضلاع چندضلعي را مشخص مي کند.
ج- مشخص  کننده نوع چندضلعي است.

د- باعث رسم شکل با لبه هاي هموار مي شود.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - هـ
122

9- کدام  يک از ابزارهاي زير، فقط امکان رسم خطوط مستقل از هم را فراهم مي آورد؟
Rectangle -د               Bezigon -ج               Pen -ب              Line  -الف 

10- براي ترس��يم خط صاف و ° 45 به هنگام استفاده از ابزار Line از کدام کليد مي توان 
استفاده کرد؟

Alt -د               Shift  -ج                Ctrl -ب               Space -الف
11- کدام گزينه صحيح است؟

ــد Shift را پايين نگه  ــم منحني بايد کلي ــتفاده از ابزار Bezigon براي رس الف- هنگام اس
داريد.

ب- با استفاده از ابزار Rectangle مي توان اشکالي به شکل ستاره رسم کرد.
ــه روي صفحه، کليک مي کنيم يک نقطه  ــورت فعال بودن ابزار  Penهنگامي ک ج- درص

گوشه به وجود مي آيد.
د- با ابزار Line مي توان خطوط منحني رسم کرد.

در جاي خالي عبارت مناسب را بنويسيد.

12- انتخاب  گزينه  Precision در کادرمحاوره Variable Stroke Pen tool به شما ................ 
را مي دهد.

ــا عمود ايجاد  ــد خطوطي با زاويه 45 درجه ي ــد ......... مي تواني ــتن کلي 13- با نگه داش
کنيد.

14- براي رسم مستطيل از نقطه وسط )مرکز( کليد ........ را نگه داريد.
15- ابزار Bezigon براي ........................... مورد استفاده قرار مي گيرد.

به سؤالات زير پاسخ تشريحی دهيد.

16- تفاوت ابزار Pen با ابزار Bezigon چيست؟
17- چگونه مي توان مربعي با گوشه هاي گرد رسم کرد؟

18- چند نوع نقطه روي يک مسير موجود است، نام ببريد.
19- تفاوت ابزار Line با ابزار  Pen چيست؟
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آزمون عملي  
1- شکل هاي زير را رسم کنيد.

2- شکل هاي زير را با ابزارهاي خطوط هنري ترسيم کنيد.
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كليات
ــتفاده از ابزارهاي ترسيمي در FreeHand MXa مي توان اشکال و تصاوير مختلفي را  با اس
ايجاد کرد. در واحد کار 5 با تعدادي از ابزارها براي طراحي و ترسيم مسيرها آشنا شديد؛ در 

اين واحد کار به معرفي ابزارهاي ترسيمي ديگر خواهيم پرداخت.   
  Arc1-6 ابزار

براي ترسيم کمان )باز، بسته، محدب و مقعر( يا منحني از اين ابزار استفاده مي شود.
Arc 1-1-6 روش كار با ابزار

ــمت چپ ماوس را نگه داريد تا کادري مطابق شکل 1-6 باز  1- روي ابزار Line، کليد س
شود، سپس ابزار Arc را انتخاب کنيد.

Arc tool شکل 1-6 انتخاب ابزار

ــل درگ را انجام دهيد. مي توانيد  ــي از صفحه، کليک کرده و عم ــمت دلخواه 2- در قس
ــم کنيد. براي  ــيم کمان را تغيير دهيد و کمان را به صورت باز، محدب يا مقعر رس نحوه ترس

اين منظور ابتدا بايد ابزار Arc را تنظيم کنيد.
Arc 2-1-6 تنظيمات ابزار

1- روي ابزار  Arcدابل کليک کنيد تا کادر محاوره Arc مطابق شکل 2-6 باز شود.

Arc شکل 2-6 کادر محاوره

ــده  ــان داده ش ــکل 3-6 نش نتيجه انتخاب  هر يک از گزينه هاي کادرمحاوره Arc در ش
است.

2- روي دکمه OK کليک کنيد.
3- حال در نقطه اي دلخواه از صفحه، کمان را رسم کنيد.
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شکل 3-6 رسم سه نوع کمان

 مثال 1: يک کمان بسته محدب رسم کنيد.
1- روي ابزار  Arcدابل کليک کنيد تا کادرمحاوره Arc باز شود.

2- از کادرمحاوره باز شده، گزينه Create flipped arc را انتخاب کنيد تا کمان به صورت 
بسته با قوس محدب ترسيم شود.

3- روي دکمه OK کليک کنيد.
4- در نقطه دلخواهي از صفحه، کمان را رسم کنيد.

ــيم، کليد  ــتاي افقي و عمودي، پس از ترس  نکته: براي تغيير جهت کمان در راس
 Shift ــته يک چهارم دايره از کليد ــيم کمان به صورت قوس بس Alt را نگه داريد. براي ترس

استفاده کنيد.

تمرين 1: کاربرد کليد Ctrl را در حين ترسيم هر يک از کمان ها بررسي کنيد.
 Spiral 2-6 ابزار

براي ترسيم خطوط مارپيچ از اين ابزار استفاده مي شود.
Spiral 1-2-6 روش كار با ابزار

1- از منوي بازشوي Line در جعبه ابزار روي ابزار  Spiral کليک کنيد.
ــرده و عمل درگ را انجام دهيد. مي توانيد  ــمت دلخواهي از صفحه کليک ک 2- روي قس

نحوه ترسيم مارپيچ را تغيير دهيد.
Spiral 2-2-6 تنظيمات ابزار

ــکل 4-6 ظاهر  ــا کادرمحاوره Spiral مطابق ش ــک کنيد ت ــزار Spiral دابل کلي 1- روي اب
شود.
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در اين کادر محاوره گزينه هايي وجود دارد که روي مارپيچ و نوع آن اثر مي گذارند.
2- گزينه Spiral type  نوع مارپيچ را تعيين مي کند )شکل 6-5(.

                                   

شکل 5-6 انواع مارپيچ  Spiral شکل 4-6 کادرمحاوره                 

ــيم  ــترش يافته ترس ــي )Expanding(، مارپيچ به صورت گس ــا انتخاب مارپيچ گسترش ب
مي شود يعني فاصله ميان حلقه ها از مرکز به سمت خارج به تدريج افزايش مي يابد.

ــي )Non-expanding( که به آن مارپيچ ساده هم مي گويند فاصله  در مارپيچ غيرگسترش
ميان حلقه ها يکسان است.

گزينه هاي بعدي با توجه به نوع مارپيچ تغيير مي کنند.
ــترش يافته انتخاب  ــود که مارپيچ از نوع گس ــن گزينه وقتي ظاهر مي ش Expansion: اي

ــيله حرکت دادن دکمه لغزنده يا وارد کردن عدد در کادر  ــده باشد. در اين قسمت به وس ش
مقابل Expansion، مقدار فاصله بين حلقه هاي مارپيچ برحسب درصد تعيين مي شود )شکل 

 .)6-6

 

Expansion شکل 6-6 مقايسه مقادير وارد شده در کادر

Draw by: اين کادر بازشو داراي دو حالت انتخابي است: 

 	Number of ــوع مارپيچ، گزينه حال�تRotations : با انتخاب اين حالت در هر دو ن
ــتفاده از دکمه لغزنده يا وارد کردن عدد در کادر  ــود که با اس rotations ظاهر مي ش

مربوطه مي توان تعداد حلقه هاي مارپيچ يا تعداد چرخش هاي آن را تعيين کرد.
غيرگسترشي، فاصله بين حلقه ها  حالت Increments: با انتخاب اين گزينه در مارپيچ 	
ــبب رسم مارپيچ با  فواصل يکسان  ــود که س در کادر Increment Width  وارد مي ش
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 Starting( در چرخش ها خواهدشد. درمارپيچ گسترشي، شعاع آغازين براي رسم مارپيچ
radius( تعيين مي شود.  

Draw from:	 اين کادر بازشو چگونگي آغاز ترسيم مارپيچ را مشخص مي کند که در 

ــروع  ــه حالت انتخاب وجود دارد که در صورت انتخاب حالت Center نقطه ش آن س
ــروع مارپيچ از لبه و در  مارپيچ از مرکز خواهد بود و با انتخاب حالت Edge نقطه ش

حالت Corner نقطه شروع مارپيچ از گوشه خواهد بود )شکل 6-7(.
      پيکان هاي رسم شده در مارپيچ، نقطه شروع و جهت رسم آن ها را نشان مي دهند.

  Draw fromشکل 7-6 مقايسه سه حالت انتخابي در منوي بازشو

Direction: با انتخاب آيکن 	 مارپيچ در خلاف جهت عقربه هاي ساعت و با فعال 

کردن آيکن  مارپيچ در جهت عقربه هاي ساعت ترسيم مي شود.
روي دکمه OK کليک کنيد.

ــپس آن را در طراحي حاشيه ترسيم شده  ــکل 1-8-6 را رسم کنيد س مثال 2: ش
درشکل 2-8-6 به کار بريد.      

                              

                   
شکل 1-8-6                                    شکل 6-8-2

1- روي ابزار Spiral دابل کليک کنيد تا کادرمحاوره Spiral ظاهر شود.
2- نوع مارپيچ را غيرگسترشي )ساده( انتخاب کنيد.

3- در منوي بازشوDraw by  نوع ترسيم مارپيچ را Rotations )پيچشي( انتخاب کنيد.
4- در کادرNumber of rotations  تعداد چرخش هاي مارپيچ را 4 قرار دهيد.

5- در قسمت Direction آيکن  را انتخاب کنيد تا مارپيچ در خلاف جهت عقربه هاي 



Free Hand پيمانه مهارتی : کاربر
FreeHand  MXa 129واحد کار ششم: توانايی ترسيمات ديگر در نرم افزار

ساعت ترسيم شود.
6- روي OK کليک کنيد.

7- شکل را روي صفحه رسم کنيد.
 )Pointer( 3-6 ابزار انتخاب

 FreeHandواقع در جعبه ابزار )شکل 12-6(، يکي از کاربردي ترين ابزارها در Pointer ابزار
MXa است و در موارد زير از آن استفاده مي شود:

ــردن کليد Ctrl سبب   ــد، فش  نکته: اگر ابزار ديگري از ToolBox انتخاب شده باش
انتخاب  ابزار Pointer  مي شود.

1-3-6 انتخاب، جابه جايي و حركت دادن موضوعات گرافيکي 

ــزار Pointer روي موضوع مورد نظر کليک کنيد؛ در اين حالت نقاطي در  ــه کمک اب 1- ب
کناره هاي شکل ظاهر مي شود و موضوع مطابق شکل 9-6 به حالت انتخاب درمي آيد.

2- با کمک ماوس به  آرامي درگ کنيد، در  اين  حالت اشاره گر  ماوس به  شکل يک  پيکان 
ــکل 10-6 پيش نمايشي از  (. حال مي توانيد مانند ش ــود )  چهار طرفه نمايش داده مي ش

حرکت موضوع انتخاب شده را ببينيد.
3- کليد ماوس را در محل دلخواه رها کنيد. شکل به محل موردنظر انتقال مي يابد. 

                                     
شکل 9-6 انتخاب شکل با ابزار Pointer        شکل 10-6 پيش نمايشي از حرکت شکل انتخاب شده

 نکته: براي تنظيم پيش نمايش حرکت موضوعات هنگام درگ آن ها، بايد در کادر 
ــه Redraw مقداري را وارد کنيد.  ــي Preview drag در کادر محاوره Preferences در زبان متن
توجه داشته باشيد وارد کردن عدد بزرگ سبب آهسته شدن پيش نمايش حرکت موضوعات 

خواهد شد.
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مثال 3: شکل 16-6 را رسم کنيد و سپس آن را به محل ديگري منتقل کنيد.
 

1- شکل را با استفاده از ابزار Pen  رسم کنيد. 
2- حال شکل را با ابزار Pointer انتخاب کنيد.

ــکل 6-16  ــپس روي ش براي اين کار ابتدا ابزار Pointer را از جعبه ابزار انتخاب کرده، س
کليک کنيد.                                                               

 شکل 11-6 ترسيم شکل   

3- حال شکل انتخاب شده را تغيير مکان دهيد.
ــاره گر ماوس به  ــراي اين منظور با کمک ماوس به آرامي درگ کنيد )در اين حالت اش ب
ــود( و در محل مورد نظر کليد ماوس را رها  ــکل يک پيکان چهار طرفه نمايش داده مي ش ش

کنيد، شکل به محل جديد انتقال مي يابد.
2-3-6 جابه جايي گره هاي يک مسير 

ــزار Pointer  انتخاب کنيد  ــا اب ــوند ب ــير را که مي خواهيد جابه جا ش ــاط روي مس  1- نق
)شکل 6-12(.

ــير تغيير  ــکل مس ــور را به موقعيت جديدي انتقال دهيد، بدين ترتيب ش ــه مزب 2- نقط
مي کند )شکل 6-13(.

 

شکل 12-6  انتخاب گره روي مسير توسط ابزار Pointer         شکل 13-6 جابه جايي گره هاي يک مسير
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3-3-6 تغيير اندازه موضوعات گرافيکي

1- با ابزار Pointer روي شکل مورد نظر دابل کليک کنيد. با انجام اين کار دستگيره هاي 
تغيير شکل )Transform handles( در اطراف شکل ظاهر مي شود.

                                                                   

شکل 14-6 ظاهر شدن کادر مرزي

ــمت داخل يا خارج مي توانيد  ــتگيره ها و درگ به س 2- با قرار دادن ماوس روي اين دس
اندازه)Scale(  شکل را تغيير دهيد )شکل 6-15(.

شکل 15-6 تغيير مقياس تصوير

ــکل را در  ــاره گر مي توانيد ش ــتگيره ها و چرخش اش 3- با قرار دادن ماوس روي اين دس
جهت دلخواه بچرخانيد.

مثال 4: آرم شکل 16-6 را رسم کنيد.
 

1- براي رسم آرم بايد از ابزار Pen استفاده کنيد و در نقاط گوشه شکل، استفاده از کليد
Alt  را فراموش نکنيد.

ــکل مورد نظر دابل کليک کنيد تا دستگيره هاي تغيير شکل،  2- با ابزار Pointer  روي ش
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در اطراف شکل ظاهر شود )شکل 6-17(.
3- حال با درگ ماوس به سمت داخل، شکل را کوچک کنيد.

                     

شکل 16-6       شکل 17-6 ظاهر شدن دستگيره هاي تغييرشکل

4-3-6 انتخاب چندين موضوع گرافيکي به صورت همزمان

ــيله ابزار Pointer و نگه داشتن کليدShift ، مي توان چندين موضوع را با هم در  1- به وس
حالت انتخاب قرار داد.

2- با انتخاب ابزار Pointer و کشيدن کادري توسط ماوس به دور همه موضوعات مي توان 
چندين موضوع را انتخاب کرد )شکل 6-18(.

شکل 18-6 انتخاب چند موضوع گرافيکي با يکديگر

 مثال 5: شکل هاي 19-6 را رسم کنيد.
1- براي رسم اين اشکال از ابزار Pen و Bezigon و براي رسم دايره هاي موجود در شکل 

از ابزار Ellipse به همراه کليد Shift استفاده کنيد.
2- کليه اشکال 19-6 را با هم انتخاب کنيد.

شکل 6-19 

دو روش براي اين کار وجود دارد:
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ــتن کليد Shift روي هر موضوع  ــيله ابزار Pointer و نگه داش روش اول: مي توانيد به وس
کليک کنيد و آن ها را با هم در حالت انتخاب قرار دهيد.

ــط ماوس به دور همه موضوعات  روش دوم: مي توانيد ابزار Pointer را انتخاب کرده توس
کادري رسم کنيد. در اين حالت تمام موضوعات در حالت انتخاب قرار مي گيرند.

5-3-6 حذف موضوعات گرافيکي

1- موضوع گرافيکي را با ابزار Pointer انتخاب کنيد.
2- کليدDelete  روي صفحه کليد را فشار دهيد.

 توجه: با استفاده از گزينه Clear  واقع در منوي Edit  مي توانيد موضوع  يا موضوعات 
انتخاب  شده  را حذف کنيد.

با دابل کليک روي ابزار Pointer کادر محاورهPointer Tool  ظاهر مي شود.

Pointer Tool شکل 20-6 کادر محاوره

ــط ابزار  Pointer بايد اشکال کاملًا درون کادر رسم  ــکال گرافيکي توس هنگام انتخاب اش
شده توسط اين ابزار قرار گيرند تا انتخاب شوند، اما فعال کردن گزينه Contact sensitive از 
ــمتي از آن ها در کادر  ــود موضوعاتي هم که فقط قس کادر محاوره Pointer Tool باعث مي ش

رسم شده توسط ابزار Pointer قرار گرفته، به حالت انتخاب درآيند.

Contact sensitive شکل 21-6 عملکرد گزينه

 FreeHand روش هاي مختلفي براي انتخاب موضوعات گرافيکي در  Pointerعلاوه بر ابزار
MXa وجود دارند که عبارتند از:

ــان Edit→Select→All براي انتخاب همه  1- فرم�انAll  )کليد ميانبر Ctrl+A(: از فرم
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ــات موجود در صفحه به کار مي رود. اين فرمان موضوعات خارج از صفحه گرافيکي را  موضوع
در حالت انتخاب قرار نمي دهد.

 :)Ctrl+Shift+A  کليد ميانبر(  All In Document 2- فرمان
ــانSelect→All In Document از منوي Edit براي انتخاب تمام موضوعاتي که در کل  فرم
 FreeHand ــند وجود دارند، به کار مي رود )شکل 22-6(. )توجه داشته  باشيد که اسناد در س

مي توانند شامل چندين صفحه باشند.(

شکل 22-6 انتخاب تمام موضوعات داخل سند

ــان Select→None  از منوي Edit باعث  3- فرم�انNone  )کليد ميانبر Ctrl+D(: فرم
مي شود موضوعات گرافيکي انتخاب شده، از حالت انتخاب خارج شوند. 

ــراي  ــوي Edit ب ــان Select→Invert Selection از من 4- فرم�ان Invert Selection: فرم
ــي رود. به طوري که موضوعات  ــردن موضوعات انتخابي در داخل صفحه به کار م ــوس ک معک
ــکل  ــاير موضوعات به حالت انتخاب در مي آيند )ش ــده و س انتخابي از  حالت  انتخاب خارج ش

.)6-23

Invert Selection شکل 23-6 نتيجه استفاده از فرمان

5- فرمان Subselect: فرمان Select→Subselect از منوي Edit باعث مي شود همه اجزاي 
قرار گرفته در يک گروه به حالت انتخاب درآيند. همچنين در صورت اجراي اين فرمان روي 



Free Hand پيمانه مهارتی : کاربر
FreeHand  MXa 135واحد کار ششم: توانايی ترسيمات ديگر در نرم افزار

يک مسير انتخاب شده، گره ها و دستگيره هاي کنترلي آن مسير نمايان مي شوند.

ــوع موجود در يک  ــاص از ميان چند موض ــاب يک موضوع خ  توج�ه: براي انتخ
ــروه به جاي اجراي فرمان Subselect، مي توانيد از ابزار Subselect موجود در جعبه ابزار نيز  گ

استفاده کنيد.
    

شکل 24-6 انتخاب تمام اجزاي موجود در يک شکل يا مسير    

ــزار Pointer  کل مجموعه گروه را انتخاب مي کند و اجزاي گروه از اين   نکت�ه: اب
طريق انتخاب نمي شوند، براي انتخاب اجزاي يک گروه، از ابزار Subselect  استفاده کنيد.

Subselect شکل 25-6 ابزار

Subselect شکل 26-6 انتخاب يک جزء از يک گروه توسط ابزار

6- فرمان Superselect: انتخاب گزينه Select→Superselect از منوي Edit باعث مي شود 
ــمتي( از يک گروه توسط Subselect انتخاب شده باشد، کل گروه به حالت  اگر موضوعي )قس

انتخاب درآيد. با انتخاب فرمان Superselect دستگيره هاي شکل ناپديد مي شوند.
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Superselect شکل 27-6 عملکرد فرمان

تمرين 2: پنج مدل برگ را به دلخواه رسم کنيد و روش هاي انتخاب را روي آن 
بررسي کنيد.

تمرين 3: تصاوير 28-6 را رسم کنيد.

شکل 6-28       

 Freeform 4-6  ابزار

ــياري است و در جعبه ابزار قرار  ــکل آزاد( داراي کاربردهاي بس ابزار Freeform )تغيير ش
ــيرهاي  ــيرها به راحتي جابه جا کرد و مس ــک اين ابزار مي توان گره ها را در مس ــه کم دارد. ب
ــکل داد. اين ابزار با هل دادن،  ــکال دلخواه ويرايش کرده و تغيير ش ــده را به اش ــيم ش ترس
ــکل آن ها مي پردازد و  ــيرها به ويرايش و تغيير ش ــيدن، افزودن گره يا حذف گره از مس کش

شکل جديدي را به وجود مي آورد.
ــتفاده از ابزار Freeform در  ــيرها از طريق نقاط گره، اگر با اس ــکل مس علاوه بر تغيير ش
ــير کليک کنيد و کليد ماوس را پايين نگه داريد، اشاره گر  نقطه اي از صفحه  در خارج از مس
ــود و اگر آن را به لبه هاي مسير نزديک کنيد، خطوط آن را  ماوس به يک دايره تبديل مي ش

به سمت بيرون هل مي دهد.



Free Hand پيمانه مهارتی : کاربر
FreeHand  MXa 137واحد کار ششم: توانايی ترسيمات ديگر در نرم افزار

Freeform شکل 29-6 استفاده از ابزار

ــت. گزينه Push/Pull به  ــزار Freeform داراي دو حالت Push/Pull وReshape Area  اس اب
ــما امکان مي دهد تا به منظور افزودن پاره خط هاي جديد به يک مسير، آن ها را بکشيد يا  ش

به داخل هل دهيد. انتخاب گزينهReshape Area  باعث تغيير شکل موضوع مي شود.

 مثال 6: شکل الف را رسم کرده سپس با ابزار Freeform آن را به شکل ب تبديل 
کنيد )شکل 6-30(.

ــزار انتخاب کرده، کليد Shift را پايين نگه داريد و  ــدا ابزار Rectangle را از جعبه اب 1- ابت
روي صفحه يک مربع رسم کنيد. 

ــزار انتخاب کرديد با  ــزار Freeform که از جعبه اب ــتفاده از اب ــون مي توانيد با اس 2- اکن
کشيدن و هل دادن اضلاع مربع، شکل مورد نظر را ايجاد کنيد. 

شکل 6-30 

Push/Pull 1-4-6 تنظيم عمليات ابزار

 Freeform Tool در جعبه ابزار دابل کليک کنيد تا کادر محاوره Freeform 1- روي گزينه
مطابق شکل 31-6 باز شود.

2- از قسمت Tool Operation گزينه Push/Pull را انتخاب کنيد.
ــتفاده از کادر  ــتفاده از کادر Size  اندازه ابزار و با اس ــمت Push Settings با اس 3- در قس
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Precision ميزان حساسيت ابزار را تعيين کنيد. 

4- در قسمت Pull Settings نوع کشيدن مسير براي ابزار Freeform تعيين مي شود.

                                 

Push Settings شکل 32-6 تنظيمات قسمت          Freeform Tool شکل 31-6 کادر محاوره

 ، By Lengthدو حالت براي انتخاب وجود دارد. با انتخاب حالت  Bendــو 5- در کادر بازش
ــاس پهنايي که توسط دکمه لغزندهLength  تعيين مي شود،  ــيرها را براس ابزار Freeform مس
ــير را که بين گره ها قرار دارد،  ــمتي از مس  تغيير مي دهد. انتخاب Between Points فقط قس

مي کشد.   

                                                         

Length شکل 34-6 تنظيمات دکمه لغزنده         Pull Settings شکل 33-6 تنظيمات قسمت

 Push/Pull 2-4-6 اصلاح موضوعات در حالت

1- موضوعي را که مي خواهيد اصلاح شود، برگزينيد.
2- اشاره گر ماوس را در موقعيت هاي زير قرار دهيد:

ــتقيماً روي مرز موضوع قرار دهيد تا يک شکل s	 کوچک در  ــاره گر ماوس را مس اش
ــود. اين شکل نشان مي دهد که در حالت کشيدن )Pull( هستيد و  کنار آن ظاهر ش

تنها کافي است لبه موضوع مربوطه را به داخل يا خارج درگ کنيد.
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Pull و Push شکل 35-6 نمايش اشاره گر در حالت

ــاره گر ماوس را به داخل يا خارج موضوع انتقال دهيد تا شکل o	 کوچک در کنار  اش
آن ظاهر شود. اين شکل نشان مي دهد که شما در حالت )Push( هستيد.

3- براي اصلاح موضوع، ماوس را بکشيد؛ در حالت Push دايره اي ظاهر مي شود که اندازه 
ــمت Push Settings تنظيم کرده ايد. وجود يک پيکان  ــتفاده از کادر Size در قس آن را با اس

نشان دهنده اين است که در حالت Pull قرار داريد.
درحالت Reshape	 اثر هل دادن يا کشيدن مسيرها به صورت ظريف تري انجام مي شود 
ــاقه گياهان و ... مفيد  ــتر تصاويري مثل موي سر، س ــيم جزييات بيش که براي ترس

خواهند بود.

Pull و Push شکل 36-6 نمايش اشاره گر هنگام اصلاح شکل در حالات

Reshape Area 3-4-6 تنظيم عمليات گزينه

 Freeform Tool ــه ابزار دابل کليک کنيد تا کادر محاوره ــزار Freeform در جعب 1- روي اب
باز شود.

2- از قسمتTool Operation  گزينه Reshape Area را برگزينيد )شکل 6-37(.       
ــوک ابزار از کادر Size و براي تنظيم ميزان  ــمت Settings، براي تنظيم اندازه ن 3- در قس
ــتفاده کنيد. گزينه Precision  تعداد گره هاي  ــش ابزار از کادر  Strength اس يا مدت زمان کش

لازمي را که در طول مسير تحت تأثير قرار مي گيرد، تعيين مي کند )شکل 6-38(.
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Settings شکل 38-6 تنظيمات قسمت        Freeform Tool شکل 37-6 کادر محاوره

شکل 39-6 استفاده از ابزار Reshape Area براي اصلاح شکل

ــد، حساسيت ابزار شما به جابه جايي  ــتر باش  نکته: هر قدر مقدار Precision بيش
ماوس بيشتر شده و پس از استفاده از ابزار، تعداد نقاط گره بيشتري ايجاد مي شود.

  Push/Pull آن را بين دو حالت  Freeform هنگام استفاده از ابزار Alt  توجه: کليد 
و Reshape Area جابه جا مي کند.

ــم کرده و تصاوير شماره 1 را به تصاوير شماره 2  ــکال 40-6 را رس تمرين 4: اش
تبديل کنيد. 

'            

شکل 6-40 
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 Knife 5-6 ابزار
ــزار، مانند چاقو عمل مي کند. اين ابزار موضوعات را برش  ــزار Knife موجود در جعبه اب اب
ــکال را پاک  ــي از اش مي زند و حفره هايي درون آن ها به وجود مي آورد و حتي مي تواند بخش

کند.
Knife 1-5-6 تنظيمات ابزار

ــاوره Knife Tool باز  ــل کليک کنيد تا کادر مح ــزار روي ابزار Knife داب ــه اب 1- در جعب
شود.

2- در قسمت Tool Operation با استفاده از گزينه Freehand  مي توانيد برش هاي موجي 
 Straight شکل ايجاد کنيد يا بر اساس حرکت ماوس شکل را برش بزنيد، اما با انتخاب گزينه

مي توانيد موضوعات را به طور خطي مستقيم و صاف برش بزنيد.

                
Straight و   Freehand در حالت  Knifeشکل 42-6 نحوه برش با ابزار      Knife Tool  شکل 41-6 کادرمحاوره

ــمت Width مي توانيد فاصله بين برش ها يا پهناي نوک چاقو را هم به صورت  3- در قس
دستي و هم با اهرم کناري آن تنظيم کنيد )شکل 6-43(.

شکل 43-6 فاصله برش

 نکته: زماني که مي خواهيد شکل خود را به صورت مسير بسته ببريد، بهتر است 
پهنا را صفر بدهيد تا دو شکل بريده شده به هم بچسبند و از هم جدا نشوند.
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ــود مسيرهاي برش خورده،  ــمت Options باعث مي ش 4- گزينه Close cut paths در قس
ــود ابزارKnife  دقيقاً از حرکت  ــکل 44-6(. گزينه Tight fit نيز سبب مي ش ــته شوند )ش بس

ماوس پيروي کند.

Close cut paths      شکل 44-6 عملکرد گزينه

Knife 2-5-6 استفاده از ابزار

1- موضوعي را که مي خواهيد برش بزنيد، انتخاب کنيد.
2- ابزار Knife را روي موضوعات بکشيد.

  Alt از کليد Straight و Freehand ــت ــريع بين دو حال  توج�ه: براي جابه جايي س
استفاده کنيد. 

مثال 7:  شکل 45-6 را رسم کنيد.
 Ellipse و براي رسم چشم ها از ابزار Bezigon و Pen ــم اين شکل از ابزارهاي 1- براي  رس

استفاده کنيد.
ــکل را به صورت موجي شکل، برش بزنيد به طوري که فاصله بين برش ها 3 باشد  2- ش

و پس از برش مسيرهاي ايجاد شده بسته باشند.            

 شکل 6-45 

ــل کليک کنيد تا کادر محاوره  ــن منظور ابتدا در جعبه ابزار روي ابزار Knife داب ــراي اي ب
ــود، سپس در قسمت Tool Operation گزينهFreehand  را انتخاب کنيد تا  Knife Tool باز ش

ــکل ايجاد شود. بعد در قسمت Width فاصله بين برش ها را برابر  برش ها به صورت موجي ش
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3 قرار دهيد و در قسمت Options گزينه Close cut paths را انتخاب کنيد تا مسيرهاي برش 
خورده، بسته شوند و در انتها ابزار Knife را روي تصوير بکشيد.

تمرين 5: شکل 46-6 را ايجاد کرده و برش هاي لازم را انجام دهيد.                            

شکل 6-46 

ــزار، ابزار  ــد در جعبه اب ــکال مي تواني ــزي موضوعات و اش ــراي رنگ آمي  توج�ه: ب
ــکل و Fill Color   را براي رنگ آميزي  ــگ خطوط دور ش ــراي رن را ب   StrokeColor

داخل شکل استفاده کنيد1.

 Eraser 6-6 پاک كردن مسير با ابزار
با استفاده از ابزار Eraser مي توانيد قسمت هايي از مسير انتخابي يا اشکال را پاک کنيد.

 Eraser 1-6-6 پاک كردن مسير انتخابي با ابزار

1- شکل يا مسير مورد نظر را انتخاب نماييد.
2- از جعبه ابزار Tools روي ابزار Eraser کليک کنيد.
3- ابزار Eraser را روي مسير مورد نظر درگ نماييد.

Eraser 2-6-6 تنظيم گزينه هاي ابزار

در جعبه ابزارTools  روي ابزار Eraser دابل کليک کنيد.
در قسمت Min و Max مي توانيد با وارد کردن عددي بين 0 تا 72 يا با حرکت نوار لغزنده 

حداقل و حداکثر پهنا را تعيين نماييد.

1- با روش هاي ديگر رنگ آميزي در واحدکار 7 آشنا خواهيد شد. 
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Eraser شکل 47-6 کادر تنظيمات ابزار

ــکل 48-6 را رسم و سپس با تنظيم پهناي پاک کن، قسمت  مياني  تمرين 6: ش
شکل را پاک کنيد.

شکل 6-48

 Lasso 7-6 انتخاب اشکال با  ابزار
مي توان توسط ابزارهايSubselect، Pointer  و  Lassoو کليک روي اشکال، آن ها را انتخاب 

نمود. 
ــکل يا  ــما اين امکان را مي دهند تا با کليک روي ش ابزارهاي Pointer و Subselect به ش
ــتطيل آن را انتخاب نماييد اما با ابزارLasso  مي توان  ــکل يا نقطه به صورت مس درگ روي ش

به صورت آزاد )Freeform( اشکال يا نقاط مورد نظر را انتخاب کرد.
Lasso 1-7-6 تنظيمات ابزار

با دابل کليک روي ابزار Lasso کادرمحاورهLasso Tool  باز مي شود )شکل 49-6(. هنگام 
ــط ابزار Lasso توجه داشته باشيد که اشکال کاملًا درون کادر  ــکال گرافيکي توس انتخاب اش
 Contact ــوند، اما فعال کردن گزينه ــط اين ابزار قرار گيرند تا انتخاب ش ــده توس ــم ش رس
ــوند که فقط  ــود موضوعاتي انتخاب ش ــث مي ش ــاوره Lasso Tool  باع sensitive از کادر مح

قسمتي از آن ها )نه همه اجزاي شکل( درون کادر Lasso قرار گرفته است.

Lasso Tool شکل 49-6 کادر
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در شکل 50-6 انتخاب با ابزار Lasso در هنگام فعال بودن گزينه Contact sensitive نشان  
داده شده است.

Contact sensitive در هنگام فعال بودن گزينه Lasso شکل 50-6 نحوه عملکرد ابزار

 Connector 8-6 ابزار
ــکال به يکديگر توسط اين ابزار مي توان خطوط اتصال دهنده را بين  به منظور اتصال اش

آن ها ترسيم کرد.

شکل 51-6 استفاده از خطوط اتصال 

ــت دهيد، خطوط  ــره Documents حرک ــم را در پنج ــکال متصل به ه ــي که اش هنگام
Connector به طور خودکار نسبت به وضعيت جديد تنظيم مي شوند.

1-8-6 رسم يک خط اتصال بين دو شئ 

1- صفحه جديدي ايجاد کرده و دو شکل در قسمت هاي مختلف صفحه رسم کنيد.
2- از جعبه ابزار Tools روي  ابزار Connector کليک کنيد.

ــت( روي يکي از اشکال قرار دهيد  ــکل آن تغيير کرده اس 3- مکان نماي ماوس را )که ش
ــروع شود. حال يک دايره کوچک کنار آن نمايان        که مي خواهيد خط اتصال دهنده از آنجا ش

مي شود. 
ــکلي بکشيد که  ــمت بالا، پايين يا وجوه ش 4- در اين حالت کليک کرده و ماوس را به س

مي خواهيد به آن متصل شويد.
5- پس از مشاهده دايره کوچک، کليد ماوس را رها کنيد. يک خط به شکل دوم ترسيم 



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - هـ
146

مي شود.

 )Start( مي توانيد تنظيمات مربوط به نقاط ابتدا Object ــتفاده از پنل  نکته: با اس
و انتهاي )End( خطوط Connector را انجام دهيد.

2-8-6 تغيير اندازه و تغييرشکل خط اتصال دهنده 

براي تغيير اندازه خط اتصال دهنده، هنگامي که ابزار Connector در حال انتخاب است، 
مکان نما را روي خط قرار دهيد تا به شکل پيکان دو سر به همراه علامت بعلاوه ديده شود، 

سپس خط را به دلخواه درگ کنيد، در اين صورت شکل خط و اندازه آن تغيير مي کند.

ــال دهنده به طور  ــط ابزار انتخاب، خط اتص ــياء توس  توجه: هنگام جابه جايي اش
خودکار تغيير شکل مي دهد تا دو شئ را به هم وصل کند.

تمرين 7: شکل 52-6 را رسم کنيد.

شکل 6-52

 Edit 9-6 برخي از فرمان هاي منوي
همان طورکه می دانيد منوی Edit به منظور کارهای ويرايشی نظير کپی، برش و چسباندن 
ــئ روی صفحه به کار می رود. در اين بخش به فرمان های تخصصی ويرايشی پرداخته  يک ش

شده است.
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Edit شکل 53-6 منوي
Cut Contents 1-9-6 فرمان

ــود. به  ــتفاده مي ش اين گزينه براي جدا کردن موضوعاتي که داخل هم قرار گرفته اند، اس
عبارت ديگر اين گزينه عکس عمل Paste Contents را انجام مي دهد. براي اجراي اين گزينه 

ابتدا بايد فرمانPaste Contents را انجام دهيد.
Paste Contents  فرمان

ــخه FreeHand MXa موجود است و باعث کپي کردن و چسباندن يک  اين فرمان در نس
شکل به درون يک مسير يا شکل ديگر مي شود به طوري که شکل چسبانده شده در لبه هاي 

مسير برش بخورد.
به عبارت ديگر چسباندن شئ در داخل شئ ديگر به شما امکان می دهد تا اشيای مزبور 
ــده، يک  ــئ پر ش ــود. اين ش را به نحوی پر کنيد که تمام بخش های خارج از آن ها ديده نش
ــود. برای انجام ماسک گذاری اشياء به  ــک ناميده می ش ــير برش )Clipping Path( يا ماس مس

روش زير عمل کنيد:
1- ابتدا بايد تصوير يا اشيای مورد نظر را روی شيئی قرار دهيد که به عنوان مسير برش 

عمل می کند، سپس آن ها را انتخاب کنيد )شکل 6-54(.
ــرار دهيد، در اين صورت  ــياء را در کليپ بورد ق ــتفاده از فرمان Edit→Cut  اش ــا اس 2- ب

مطابق شکل 73-6 فقط مسير روی صفحه می ماند.
3- حال مسير برش را انتخاب نماييد سپس فرمان Edit→Paste Contents  را اجرا کنيد 

تا اشياء در مسير برش چسبانده شوند )شکل 6-56(.
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شکل 54-6 قرار گرفتن اشياء روی مسير برشی    شکل 55-6 نمايش مسير پس از انتقال اشياء به کليپ بورد

ــتگيره در  ــل Object روي گزينه Content کليک کنيد يک دس  نکت�ه: اگر در پن
ــتگيره در جهت های مختلف، اشياء در مسير برش  ــکل ظاهر می شود که با درگ اين دس ش

جابه جا می شوند.

        

شکل 56-6 نمايش نتيجه فرمان Paste Contents      شکل 57-6 نمايش دستگيره در مسير برشی

ــير برشي  ــکال از مس ــاهده مي کنيد که اش حال فرمان Cut Contents را اجرا نماييد، مش
خارج مي شوند.

Cut Contents شکل 58-6 نمايش اجراي فرمان

 )Clipping Path( ــي ــير برش  نکته: در واقع فرمان Cut Contents براي حذف مس
به کار مي رود.

Paste Special 2-9-6 فرمان

اين گزينه براي چسباندن شئ مورد نظر از يک برنامه کاربردي به برنامهFreeHand  به کار 



Free Hand پيمانه مهارتی : کاربر
FreeHand  MXa 149واحد کار ششم: توانايی ترسيمات ديگر در نرم افزار

مي رود.
براي انجام اين عمل مراحل بعد را انجام دهيد:

1- موضوع مورد نظر در برنامه کاربردي را کپي کنيد.
ــير Edit→Special  فرمان Paste Special را اجرا کنيد. کادر  2- در برنامه FreeHand از مس

محاوره Paste Special باز خواهد شد )شکل 6-59(.

Paste Special شکل 59-6 کادرمحاوره

3- از کادر  As:فرمت موردنظر را انتخاب کرده و دکمه OK را کليک کنيد.
ــم کرديد، کپي کنيد و سپس در  ــکلي را که در برنامه فتوشاپ رس تمرين 8: ش

برنامه FreeHand آن را Paste Special نماييد.
 Duplicate  3-9-6 فرمان

ــه موضوعات مورد نظر را  ــما قرار مي گيرد ک ــه FreeHand  فرماني در اختيار ش در برنام
ــد که در کليپ بورد قرار نمي گيرد و اصطلاحاً به آن مضاعف کردن هم  ــه نحوي کپي مي کن ب

مي گويند. براي انجام فرمان Duplicate مراحل بعد را انجام دهيد:
1- موضوع مورد نظر را انتخاب کنيد.

ــان کليدترکيبي  ــا مي توانيد همزم ــد ي ــه Duplicate را برگزيني ــوي Edit گزين 2- از من
Alt+Ctrl+D را بفشاريد. در اين صورت يک کپي از شکل ايجاد مي شود به طوري که دورتر از 

شکل اصلي قرار مي گيرد. سه بار عمل Duplicate انجام شده است.
Clone  4-9-6 فرمان

ــت روي خود موضوع انتخابي يک رونوشت از شئ ايجاد مي کند و معادل  اين گزينه درس
ــت. در اين صورت مي توان به کمک کليد Shift شکل کپي شده  کليدي آن Ctrl+Shift+D اس

را در راستاي شکل اصلي جابه جا کرد.

ــاي Duplicate ،Copy و  ــم کرده و تفاوت فرمان ه ــکل 60-6 را رس تمرين 9: ش
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Clone را بررسي کنيد.

شکل 6-60

ــد کار 5، فايلProject. fh11 را که   مث�ال کاربردي: در ادامه مثال کاربردي واح
قبلًا ايجاد کرده ايد، باز کنيد و موارد بعد را انجام دهيد. 

1- با استفاده از ابزار Subselect روي نقطه لنگر پايين ضلع سمت راست چهارگوش کليک 
 کنيد تا انتخاب شود. نقاط لنگر پس از انتخاب به صورت مربع توخالي نمايش داده مي شوند 

)شکل 6-61(.
ــده نمايش داده مي شود. با انتخاب  ــخصات گره انتخاب ش 2- اکنون در پنل Object مش
آيکن نقطه منحني در اين پنل، نقطه گوشه به يک نقطه منحني تبديل مي شود. حال گزينه
Automatic  را هم فعال کنيد تا خطوط متصل به نقطه انتخاب شده به کمان تبديل شوند.

ــکل منتقل کنيد تا کمان، شکل  ــتفاده از ابزار Pointer کمي به داخل ش 3- نقطه را با اس
ــه 45 درجه حرکت کند، کليد Shift را  ــود را پيدا کند. براي اين که نقطه در زاوي ــب خ مناس

نيز پايين نگه داريد.

                      

شکل 61-6                                         شکل 62-6                                  شکل 6-63

4- با ابزار Ellipse يک بيضي با ابعاد دلخواه ترسيم کنيد. 
ــي وارد کنيد تا بيضي به  ــراي قطرهاي بيض ــاد 22/5×22/5 را ب ــه Object ابع 5- در زبان
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ــتفاده از کليدهاي  ــزار Pointer يا با اس ــتفاده از اب ــود. با اس ــره اي با قطر 22/5 تبديل ش داي
جهت دار صفحه کليد دايره را حرکت داده و بر رأس بالا و سمت چپ مستطيل از قبل ترسيم 

شده، مماس کنيد )شکل 6-64(.

شکل 6-64 

6- تغييرات را ذخيره کنيد.
واژه نامه

Createايجادکردن

Connectorاتصال دهنده

Concaveمقعر

Directionمسير، جهت

Expansionگسترش

Eraserپاک کن

Incrementافزايش

Knifeچاقو

Lassoکمند

Pointerاشاره گر

Radiusشعاع

Rotationچرخش

Spiralمارپيچ

Straightيکسره، مستقيم

Subselectزير انتخاب

خلاصه مطالب 
ــتفاده  ــا منحني از ابزار Arc	 اس ــته، محدب و مقعر( ي ــيم کمان )باز، بس ــراي ترس ب
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مي شود.
براي ترسيم خطوط مارپيچ از ابزار Spiral	 استفاده کنيد.

به منظور انتخاب، جابه جايي و حرکت دادن و تغيير اندازه موضوعات  	 Pointer  از ابزار
گرافيکي استفاده مي شود.

 	All براي انتخاب همه موضوعات موجود در صفحه به کار مي رود و فرمان All  ــان فرم
ــود دارند، به کار  ــند وج ــراي انتخاب تمام موضوعاتي که در کل س In Document ب

مي رود.
فرمان None موضوعات گرافيکي انتخاب شده را از حالت انتخاب خارج مي کند.	

ــان  Invert Selection	 براي معکوس کردن موضوعات انتخابي در داخل صفحه و  فرم
فرمان Subselect باعث مي شود همه اجزاي قرار گرفته در يک گروه به حالت انتخاب 
درآيند. همچنين انتخاب فرمان Superselect باعث مي شود اگر موضوعي )قسمتي( از 

يک گروه توسط  Subselect انتخاب شده باشد، کل گروه به حالت انتخاب درآيد.
ــي جابه جا کرد و  ــيرها به راحت ــزار Freeform	 مي توان گره ها را در مس ــه کمک اب ب

مسيرهاي ترسيم شده را به اشکال دلخواه ويرايش کرده و تغيير شکل داد.
، مانند چاقو عمل مي کند. اين ابزار موضوعات را برش مي زند و حفره هايي  	Knife ابزار

درون آن ها به وجود مي آورد و حتي مي تواند بخشي از اشکال را پاک کند.
ــمت هايي از مسير انتخابي يا اشکال را پاک  ــتفاده از ابزار Eraser	 مي توانيد قس با اس

کنيد.
ــکال آن ها را  و کليک روي اش 	 Lasso و  Subselect ، Pointer ــط ابزارهاي مي توان توس

انتخاب کرد. 
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعيين کنيد.

ــتفاده  ــا منحني از ابزار Arc اس ــته، محدب و مقعر( ي ــان )باز، بس ــيم کم 1- براي ترس
مي شود.

ــيرها به ويرايش و  ــيدن، افزودن گره يا حذف گره از مس 2- ابزارSpiral  با هل دادن، کش
تغيير شکل آن ها مي پردازد و شکل جديدي را به وجود مي آورد.

3- براي ترسيم خطوط مارپيچ از ابزار Subselect استفاده کنيد.
ــي درون آن ها به وجود مي آورد و  ــزار Knife، موضوعات را برش مي زند و حفره هاي 4- اب

حتي مي تواند بخشي از اشکال را پاک کند.
معادل گزينه  هاي سمت  راست را از ستون سمت  چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

Alt                                                         .5- اين ابزار مانند چاقو عمل مي کند
ــتفاده   6- از اين ابزار به منظور انتخاب، جابه جايي و حرکت دادن موضوعات گرافيکي اس
Knife                                                                                              .مي شود
7- براي جابه جايي سريع بين دو حالت Freehand و Straight از اين کليد استفاده کنيد.                                                                                                                                            
                               Pointer                                                                                                    
8- به کمک اين ابزار مي توان مسيرهاي ترسيم شده را به اشکال دلخواه ويرايش کرده و 
 Freeform                                                                               .تغيير شکل داد

گزينه صحيح را انتخاب کنيد.

9- توسط ابزار Spiral چه عملي را مي توان انجام داد؟
ب- رسم مارپيچ الف- ايجاد سايه محو براي موضوع گرافيکي  

د- رنگ آميزي خطوط پيرامون                                  ج- رنگ آميزي داخل موضوع گرافيکي       
                                                                موضوع گرافيکي

10- چه مواقعي از ابزار Arc استفاده مي شود؟
ب- مقعر کردن شکل  الف- سه بعدي کردن شکل  

د- رسم کمان ج- قرينه کردن شکل  
11- براي رسم کمان باز هنگام استفاده از ابزار Arc از کدام گزينه استفاده مي شود؟
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Create Flipped Arc -ب                Create Open Arc -الف
Create Arc -د  Create Concave Arc -ج
12- از ابزارKnife به چه منظور استفاده مي شود؟

ب- قرينه کردن تصاوير الف- چرخاندن تصاوير  
د- جابه جا کردن گره ها ج- برش زدن تصاوير  

13- کدام يک از عمليات زير توسط ابزار Pointer انجام مي گيرد؟
الف- تغيير اندازه تصوير           ب- جابه جا کردن تصوير

ج- انتخاب چند تصوير همزمان            د- تغيير اندازه، جابه جايي و انتخاب هم زمان 
                                                    چند تصوير

ــاي موجود در کادر  ــاف کدام يک از گزينه ه ــرش تصاوير به صورت خط ص ــراي ب 13- ب
محاوره Knife Tool بايد فعال باشد؟

Tight fit -د         Width -ج     Straight -ب         Freehand -الف
14- فرمان ................... کپي شکل را روي خودش قرار مي دهد.

Duplicate -د        Clone -ج     Contents Cut  -ب           Copy  -الف
در جاي خالي عبارت مناسب را بنويسيد.

15- براي انتخاب اجزاي يک گروه، از ابزار....................استفاده کنيد.
16- به وسيله ابزار Pointer و نگه داشتن کليدShift ، مي توان ........................ .

17- ابزار Connector به منظور ......................... مورد استفاده قرار مي گيرد.
18- براي تغيير جهت کمان در راستاي افقي و عمودي، پس از ترسيم، کليد .................. 

را نگه داريد.
به سؤالات زير پاسخ تشريحی دهيد.

19- تفاوت بين مارپيچ گسترشي و غيرگسترشي چيست؟
20- کاربرد ابزارPointer  را نام ببريد.

21- دو روش جابه جايي و انتقال موضوعات را نام ببريد.
22- براي تغيير شکل موضوع از کدام گزينه Freeform استفاده مي شود؟

23- تفاوت فرمان Cut Contents و Duplicate در چيست؟
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آزمون عملي 
1- شکل هاي زير را رسم کنيد سپس به وسيله ابزار Pointer آن ها را تغيير اندازه دهيد.

ــم نماييد سپس به وسيله ابزارهاي انتخاب قسمتي از آن ها را به  ــکل هاي زير را رس 2- ش
دلخواه انتخاب کنيد.

ــا گزينه Duplicate و دو  ــکل  فيل را در اطراف آن قرار دهيد )يک کپي ب ــه کپي از ش 3- س
.)Clone کپي با فرمان

4- يک کمان به صورت قوس بسته يک چهارم دايره رسم کنيد.
5- با استفاده از ابزارهاي Arc و Spiral درياي مواج را ترسيم کنيد.
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كليات
ــش بايد توجه کرد، يکي ترکيب و تضاد رنگ ها  ــث رنگ در FreeHand به دو بخ در مبح
ــت؛ چرا که تنها در  ــاختار و مواد رنگ هاس ــناخت س براي ايجاد يک اثر هنري و ديگري ش
صورت استفاده صحيح از سيستم مدل هاي رنگ، مي توان خروجي مناسبي از اثر تهيه کرد.

ــه نمايش را بيان مي کند؛  ــاي گوناگون ارائه رنگ روي کاغذ و صفح ــدل رنگ، روش ه م
ــود. در اين واحد کار ابتدا به بررسي  ــتفاده مي ش به طور کلي مدل ها براي معرفي رنگ ها اس
ــزي موضوعات گرافيکي گفته  ــپس نحوه ايجاد و رنگ آمي ــواع مدل هاي رنگ پرداخته و س ان

مي شود.
1-7 مدل هاي رنگ و كاربردهاي آن ها

ــاس طول موج نوري که به آن مي رسد، درک مي کند. رنگ  ــم انسان رنگ ها را براس چش
سفيد، نوري است که همه رنگ هاي اصلي طيف رنگ را در برمي گيرد.

چندين مدل رنگ در FreeHand وجود دارد که اساس کار همه آن ها طيف نور يا انعکاس 
نور تابيده شده از جسم رنگي است.

ــک رنگ براي صنعت چاپ و  ــاس تفکي  نکت�ه: مدل هاي رنگ در FreeHand، اس
ذخيره سازي اسناد در قالب هاي مختلف گرافيکي است.

 RGB مدل
ــبز )Green( و آبي )Blue( تشکيل شده  ــه رنگ اصلي قرمز )Red(، س طيف نور مرئي از س

است و رنگ ها در اين مدل از ترکيب اين سه رنگ حاصل مي شوند )شکل 7-1(. 
ــار در صفحات وب از مدل رنگي  ــراي ايجاد تصوير در تلويزيون، صفحه نمايش يا انتش ب

RGB استفاده مي شود. در مدل RGB دانستن نکات زير ضروري است:

1- هر يک از رنگ ها با عددي بين 0 تا 255 نشان داده مي شوند.
2- رنگ سفيد در اين مدل به معناي آن است که هر سه رنگ اصلي به طور کامل با هم 

ترکيب شده اند.
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FreeHand در RGB شکل 1-7 مدل رنگ

3- رنگ سياه در RGB عدم وجود نور براي چشم انسان است، يعني اين که هر سه مؤلفه 
رنگ صفر باشند.

4- رنگ هاي از نوع RGB رنگ هاي افزايشي هستند؛ چرا که اگر سه رنگ اصلي همزمان 
با هم جمع شوند و به نقطه اي بتابند، رنگ سفيد را نتيجه مي دهند.

RGB شکل 2-7 نمايش مدل رنگ

 CMYK مدل
ــوند، ساخته  ــفيد جذب مي ش ــاس جوهرهاي چاپ که روي کاغذ س اين مدل رنگ بر اس
ــت که تصوير را مي سازد )شکل  ــت رنگ به سوي چشم اس ــود؛ به عبارت ديگر بازگش مي ش

.)7-2
رنگ ها در مدل CMYK از ترکيب چهار رنگ انعکاسي ساخته مي شود که عبارتند از:

آبي فيروزه اي )Cyan(، ارغواني )Magenta(، زرد )Yellow( و سياه )BlacK(. رنگ سفيد در 
اين مدل يعني اين که هر چهار رنگ مقدارش صفر باشد و نور را منعکس کند.
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FreeHand در  CMYKشکل 3-7 نمايش مدل رنگ

 توجه: در مدل CMYK تمامي رنگ ها از ترکيب چهار رنگ اصلي ساخته مي شوند 
)شکل 7-4(.

CMYK شکل 4-7 نمايش مدل رنگ

در مدل CMYK بايد به نکات زير توجه داشته باشيد: 
ــود، زيرا صفحه  ــدل CMYK در صفحه نمايش هرگز به صورت صحيح ديده نمي ش 1- م
ــر و رنگ هايي که در FreeHand براي چاپ در  ــت و تصاوي نمايش منبع توليد رنگ RGB اس
ــازگاري  ــوند تا با جوهرهاي چاپ س ــوند؛ بايد در مدل CMYK پردازش ش نظر گرفته مي ش

داشته باشند.
ــي نيز مي گويند که از ترکيب کامل همه  2- به رنگ هاي از نوع CMYK رنگ هاي کاهش
ــود و اگر تمام رنگ ها از هم کم شوند سطح سفيد  ــياه ساخته مي ش آن ها با يکديگر رنگ س

کاغذ نمايان مي شود و نور را منعکس مي سازد.
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 HLS مدل
ــامل نوع و مايه  ــت. اين مدل رنگ ش ــتم رنگ RGB اس ــي از انواع سيس ــدل HLS يک م
ــت ــباع يا غلظت رنگي )Saturation( اس ــنايي )Lightness( و اش ــزان روش ــگ )Hue(، مي  رن

)شکل 7-5(.

FreeHand MX در HLS شکل 5-7 نمايش مدل رنگ

ــخص مي کند و مقدار آن بر اساس  ــاس چرخه رنگ مش در اينجا Hue، رنگ پايه را بر اس
 L .ــت ــخص کننده رنگ روي چرخه رنگ اس ــت که مش درجه و عددي بين صفر تا 360 اس
ــت که 0% معرف رنگ سياه و 100% نشانه رنگ سفيد  ــني رنگ اس معرف درصد نور و روش

است.
S ميزان خلوص رنگ است، رنگ هاي خالص رنگ هايي هستند که هيچ مقدار خاکستري 
ــويم درصد غلظت  ــت. هرچه به مرکز چرخه رنگ نزديک ش ندارند و غلظت آن ها 100% اس

رنگ کاهش مي يابد. 
تمرين 1:  بررسي کنيد، به چه دليل مدل رنگ CMYK براي صفحه ها و سندهاي 

وب مناسب نيست؟  

تمرين 2: مدل System Color Picker را بررسي کنيد.

2-7 پنل هاي رنگ 
ــت. براي  ــورت پنل در نظر گرفته اس ــزي به ص ــراي رنگ آمي ــي را ب FreeHand ابزارهاي

رنگ آميزي مسيرهاي بسته معمولاً از پنل  Color Mixer و  Swatches استفاده مي شود.
اين دو پنل به روش هاي زير در صفحه نمايش ظاهر مي شوند:

Window 1- انتخاب پنل ها از منوي
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ــل Color Mixer و کليک روي آيکن   ــک روي آيکن  براي باز کردن پن 2- کلي
Main از نوار ابزار اصلي يا  Swatches براي باز کردن پنل

3- کليد ميانبر Shift+F9 پنل Color Mixer و Ctrl+F9 پنل Swatches را در دسترس قرار 
مي دهد.

 Color Mixer 1-2-7 ايجاد رنگ با پنل

اين پنل که با عنوان Mixer ديده مي شود براي ساختن رنگ هاي ترکيبي مورد نياز به کار 
مي  رود. 

Color Mixer شکل 6-7 پنل

ــده و اصلي مطابق شکل 6-7 قابل مشاهده است، در سمت  در پايين پنل، رنگ ايجاد ش
ــتفاده  چپ اين پنل مي توانيد از چهار حالت مختلف براي ميکس يا ترکيب کردن رنگ ها اس
ــگ مورد نظر را  ــت؛ حالت )mode( رن ــاختن رنگ ها لازم اس ــروع به س کنيد که پيش از ش
ــد از HLS ،RGB ،CMYK وColor  System )رنگ هاي آماده   ــن کنيد. اين حالت ها عبارتن تعيي

.)Windows

 Main را با استفاده از نوار ابزار  Color Mixerتمرين 3: نمايش و عدم نمايش پنل
در صفحه نشان دهيد.

CMYK كار با رنگ
ــد براي کارهاي چاپي از مدل CMYK استفاده مي شود، رنگ مورد  همان طورکه گفته ش

نظر را مي توانيد هم به صورت عددي و هم با استفاده از دکمه لغزنده کنار آن ايجاد کنيد.
ــت. حال مي توانيد رنگ را از  ــاهده اس ــده در نوار پايين پنجره قابل مش ــاخته ش رنگ س

جوهردان، درگ کرده و روي موضوع مورد نظر قرار دهيد )شکل 7-7(.
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شکل 7-7 نحوه رنگ  آميزي موضوع

RGB كار با رنگ
ــتفاده مي کنند. نحوه استفاده از  ــي و اينترنتي از مدل رنگ RGB اس براي کارهاي نمايش

رنگ RGB مانند رنگ CMYK است.
 HLSكار با رنگ

ــت و ميزان  ــتم رنگ RGB اس ــد، مدل HLS يکي از انواع سيس همان طورکه قبلًا گفته ش
ــورت درصدي با درج در  ــق دکمه لغزنده يا به ص ــنايي و مايه رنگ را از طري ــت و روش غلظ

کادرهاي عددي مشخص مي کند.
System Color Picker  كار با رنگ

اگر بخواهيد از رنگ هايي که براي سيستم عامل در نظـر گرفته شده استفاده کنيد،
System Color Picker امکان استفاده از 48 رنگ اصلي ويندوز را فراهم مي کند.

ــتفاده از پنل Color Mixer، رنگي با مدل RGB بسازيد که درصد  تمرين 4: با اس
رنگ آن مطابق شکل 8-7 باشد. 

شکل 7-8

Swatches 2-2-7 اضافه كردن رنگ به پنل

ــه Add to swatches قرار دارد که با کليک روي آن مي توانيد  ــن پنل Mixer، دکم در پايي
ــده را به پنل Swatches اضافه کنيد يا روي رنگ ساخته شده کليک راست  ــاخته ش رنگ س
 Add to Swatches را انتخاب کنيد در اين صورت کادر محاوره Add to swatches کرده و گزينه
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مطابق شکل 9-7 ظاهر مي شود.
در کادر محاوره Add to Swatches شماره هاي رنگ انتخابي و نمونه رنگ آن نمايش داده 

مي شوند که مي توانيد شماره را پاک کرده و نامي براي اين رنگ انتخاب کنيد.

Add to Swatches شکل 9-7 کادرمحاوره

هم چنين نوع رنگ را مي توانيد از بين دو گزينه Process )رنگ هاي پردازشي يا ترکيبي( 
 Swatches رنگ موردنظر به پنل ، Add تک رنگ( انتخاب کنيد و با کليک روي دکمه( Spot و

اضافه مي شود.

 توجه: مي توانيد رنگ ساخته شده را از روي نوار رنگي در پايين پنل Mixer درگ 
کرده و مستقيماً آن را به پنل Swatches اضافه کنيد.

ــتند که با استفاده از رنگ هاي فيروزه اي، ارغواني،  رنگ هاي Process	 رنگ هايي هس
زرد و سياه ساخته مي شوند.

رنگ هاي Spot	 رنگ هايي هستند که با استفاده از رنگ ها و جوهرهاي خاصي ساخته 
ــن شدن مطلب مثلًا اگر به رنگ سبز يک مجله چاپ شده نگاه  ــوند. براي روش مي ش
کنيد؛ متوجه خواهيد شد که آن رنگ، ترکيبي از رنگ هاي فيروزه اي و زرد است در 
ــبز به صورت نقطه اي )Spot( باشد فقط به وسيله جوهر  صورتي که اگر اين رنگ س

خالص سبز ايجاد مي شود.
ــاي ويژه نظير رنگ  ــاي تک رنگ، دورنگ و ايجاد رنگ ه ــتر در کاره رنگ هاي Spot بيش

مهتابي و متاليک استفاده مي شود. 
ــا در نظر گرفتن آن به صورت رنگ  ــده در تمرين 4 را ب تمرين 5: رنگ ايجاد ش

پردازشی به ليست رنگ هاي پنل Swatches اضافه کنيد.
)Change Attribute Color( 3-7 تغيير خصوصيت رنگ ها

اگر خصوصيات رنگ هايي که در رنگ آميزي موضوعات از آن استفاده کرده ايد، تغيير داده 
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ــت. در پنل Color Mixer دکمه ــود؛ اين تغييرات در رنگ موضوعات هم اثر خواهد گذاش ش
ــن امکان را فراهم مي کند که بتوانيد خصوصيت رنگ ها را تغيير  Change Attribute Color اي

بدهيد )شکل 7-10(. 

Color Mixer در پنل Change Attribute Color شکل 10-7 دکمه

 مثال 1: خصوصيت رنگ شکل 11-7 را با استفاده از پنل Color Mixer به رنگي 
که ايجاد کرده ايد، تغيير دهيد.

 Color Mixer در پنل  C :34 و M :27 ، Y :0 ، K :0 ــخصات 1- رنگي با مدل CMYK و مش
ايجاد کنيد.

2- شکل 11-7 را رسم کنيد.

 شکل 7-11

ــت،  ــخصات آن G:200 ، B:255 و R:255 اس ــدل RGB که مش ــا رنگ م ــکل را ب 3- ش
رنگ آميزي کنيد.

ــک کنيد تا خصوصيت رنگ RGB به رنگ  ــه  Change Attribute Colorکلي 4- روي دکم
CMYK  تبديل شود.

تمرين 6: چرخه رنگ را با مد CMYK ايجاد کنيد )با طراحي دلخواه(.
 )Tints( 4-7 ايجاد تناليته هاي رنگ

 Window→Tints ــوان آن را از طريق ــده که مي ت ــن پنل در کنار پنل Mixer واقع ش اي
ــر کرد. اين پنل، تناليته يا ته رنگ هايي با درصدهاي 10% تا 90% از رنگ  ــه ظاه روي صفح
ــه مي دهد و امکان انتخاب و افزودن آن ها را به پنل Swatches براي کاربر فراهم  ــي را ارائ اصل
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مي سازد )شکل 7-12(.

Tints شکل 12-7 پنل
ــي و 100% زرد  ــا ترکيب 45% ارغوان ــک رنگ نارنجي ب ــوان مثال فرض کنيد ي ــه عن ب
ساخته ايد اما مي خواهيد اين رنگ را با نسبت هاي کمتري از آن در صفحه امتحان کنيد. اين 
امر در پنل Color Mixer مستلزم صرف وقت زيادي است، درحالي که در پنل Tints مي توانيد 

نسبت هاي متفاوتي از يک رنگ را در صفحه امتحان و رنگ دلخواه را انتخاب کنيد.
1-4-7 روش ايجاد ته رنگ )تناليته( يک رنگ 

1- رنگ دلخواهي را در Color Mixer ايجاد کنيد.
2- در پنل Tints درصد ته رنگ را با يکي از روش هاي زير انتخاب کنيد:

تنظيم درصد رنگ با استفاده از دکمه لغزنده ته رنگ	
تايپ درصد مورد نظر در کادر ته رنگ 	
کليک روي يکي از نمونه هاي ته رنگ 	

ــل Swatches ذخيره کنيد. مي توانيد  ــس از ايجاد ته رنگ ها مي توانيد آن ها را در پن 3- پ
ــوي رنگ ها و انتخاب  از طريق دکمه Add to Swatches در پنل Tints يا از طريق منوي بازش

گزينه Add to Swatches رنگ را به پنل Swatches اضافه کنيد.

ــا به عبارتي آن را به  ــه رنگي را به پنل Swatches مي افزاييد ي  توج�ه: هنگامي ک
مجموعه رنگ هاي FreeHand اضافه مي کنيد؛ اين رنگ در منوي رنگ ها در پنل Tints قابل 

دسترسي است.

 G:152 ،B:189 از رنگي با مشخصات Color1 مثال 2: ته رنگ 40 درصدي به نام
و R:243 ساخته و ذخيره کنيد.
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براي ايجاد اين رنگ مراحل زير را انجام دهيد:
1- ابتدا پنل Color Mixer را باز کرده و دکمه RGB را انتخاب کنيد.

2- عددهاي رنگ را در کادرهاي مربوطه وارد کنيد.
ــد يا روي نمونه40% ته رنگ،  ــه Tints رابرگزيده و 40% را درکادرته رنگ واردکني 3- زبان

کليک کنيد.
4- روي دکمه  Add to Swatches در پنل Tints کليک کنيد.

ــرده و نام Color1 را وارد  ــماره رنگ را پاک ک ــاوره  Add to Swatches ش 5- در کادر مح
ــل Swatches ذخيره  ــن صورت رنگ در پن ــه Add را کليک کنيد. در اي ــپس دکم کنيد؛ س

مي ش
تمرين 7: عمليات زير را انجام دهيد:

 Color رسم کرده و با استفاده از پنل paint1 به نام ،A4 1- شکل 14-7 را در يک صفحه
Mixer و Tints رنگ آميزي کنيد.

2- رنگي با مشخصات M : 70 ،Y : 80 ،K : 0 و C : 2 ايجاد کنيد، سپس آن را به ليست 
رنگ ها اضافه کنيد.

ــپس ته رنگ هايي از اين  ــخصات G :200 ،  B : 8 و R : 16 ايجاد کنيد، س 3- رنگي با مش
رنگ با درصدهاي 80، 60 و 10 ايجاد کنيد و به ليست رنگ ها بيفزاييد.

ــپس غلظت آن را %80  ــخصات G: 90 ،B: 50 و R: 155 تعريف کنيد، س 4- رنگي با مش
و روشنايي آن را نيز به 75% تغيير دهيد.

شکل 7-13

تمرين 8: طيف رنگ يا تناليته  هاي مختلف رنگ آبي را ترسيم کنيد.

شکل 14-7 تناليته هاي رنگ آبي
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 Swatches 5-7 پنل
 Swatches پنل ،FreeHand MXa يکي از پرکاربردترين پنل ها، براي رنگ آميزي اشکال در

است )شکل 7-15(. 

Swatches شکل 15-7 پنل

پس از تعريف يک رنگ در Color Mixer براي استفاده مجدد آن در رنگ آميزي طرح هاي 
ديگر، بايد آن را درSwatches  ذخيره کرد.

از طريق يکي از روش هاي ذکر شده در بخش 2-7، پنلSwatches  باز مي شود. 
ــده و رنگ هاي مورد استفاده در سند، قرار  ــاخته ش ــتي از رنگ هاي س در اين پنل فهرس
گرفته است. يکي از رنگ هاي پيش فرض در پنل Swatches رنگ Registration ناميده مي شود. 
ــد و براي يک کار  ــت که در تمام صفحات، چاپ خواهد ش ــده اس اين رنگ طوري تعريف ش
ــود زيرا در چاپ، جوهر زيادي مصرف مي کند.  ــتفاده ش هنري معمولي نبايد از اين رنگ اس
معمولاً رنگ Registration به صورت سياه نشان داده مي شود ولي مي توانيد رنگ آن را تغيير 

دهيد. يکي از کاربردهاي اين رنگ، علامت گذاري براي برش زدن )Trim( صفحات است.

ــز رنگ آميزي موضوعات جديد مي توانيد   توج�ه: براي تغيير رنگ موضوعات و ني
ــتفاده  ــاختن دوباره آن ها در Color Mixer از نمونه هاي موجود در پنل Swatches اس بدون س

کنيد.

 Swatches 1-5-7 رنگ آميزي به وسيله پنل

1- شکل مورد نظر را ترسيم کرده و آن را به حالت انتخاب در آوريد.
2- پنل Swatches را باز کنيد.

3- از رنگ هاي ليست شده در اين پنل )Color List(، رنگ موردنظرتان را انتخاب کرده و 
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آن را به روي شکل درگ کنيد يا رنگ را درگ کرده و روي دکمه نشان داده شده در شکل 
15-7 رها کنيد تا داخل موضوع رنگ آميزي شود.

ــت  ــورد نظر در ليس ــگ م ــک روي رن ــد Alt و کلي ــتن کلي ــه داش ــا نگ  نکته:ب
ــود  ــا RGB نمايش داده مي ش ــورت CMYK ي ــگ به ص ــات رن ــل Swatches جزيي ــگ پن  رن

)شکل 7-16(.

Swatches شکل 16-7 نمايش جزييات رنگ در پنل

تمرين 9: رنگي با مشخصــات G : 195 ،B : 140 و R : 243 با استفـاده از پنـل 
Color Mixer  ايجاد کرده، سپس آن را به نام Color2 به ليست رنگ هاي Swatches اضافه 

کنيد، ترتيبي دهيد که جزييات رنگ نمايش داده شود.
2-5-7 اعمال رنگ )خط - پركننده( به موضوع 

عملکرد دکمه هاي بالاي پنل Swatches به شرح زير است:
ــزي داخل موضوع به کار مي رود که روش  دکم�ه Fill  :	 اين گزينه براي رنگ آمي

ديگر استفاده از آن به صورت زير است: 
1- ابتدا موضوع را انتخاب کنيد سپس روي دکمه Fill کليک کنيد.

2- روي يکي از نمونه رنگ هاي موجود در ليست Swatches کليک کنيد تا رنگ انتخاب 
ــده، داخل شکل قرار گيرد. انتخاب گزينه None از ليست رنگ هاي Swatches، رنگ داخل  ش

شکل را خالي مي کند.
ــتفاده  آميزي خطوط دور موضوع اس ــراي رنگ 	 ــن گزينه ب دکم�ه Stroke  : از اي
ــتفاده از آن مانند دکمه Fill است. انتخاب گزينه None از  ــود و روش هاي اس مي ش
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ليست رنگ ها، خط دور موضوع را محو مي کند.
ــت پنل Swatches	 را به داخل  ــده از ليس دکمه Fill & Stroke   : رنگ انتخاب ش
مسير انتخاب شده و هم به خط دور موضوع مي دهد. انتخاب گزينه None از ليست 

رنگ ها منجر به محوکامل موضوع مي شود اما مسير هم چنان قابل انتخاب است. 
 	 Swatchesــت، رنگ را از پنل دکمه تکثير رنگ  : براي کپي از يک رنگ کافي اس

به سمت اين دکمه درگ کنيد.
ــده را با  ــم کرده و رنگ هاي داده ش ــکل هاي 17-7 و 18-7 را رس تمرين 10: ش
استفاده از پنل Color Mixer ايجاد کرده و به وسيله پنل Swatches به خط دور شِکل 7-17 
رنگ 1، به داخل شکل 17-7 رنگ 2 و به دور و داخل شکل 18-7 رنگ 3 را اعمال کنيد. 

رنگ 1: مدل RGB، رنگ سفيد
 RGBرنگ2: مدل

CMYK رنگ3: مدل

              
CMYK شکل 18-7  مدل                                   RGB شکل 17-7  مدل          

3-5-7 ايجاد، حذف، جابه جايی و كپی كردن رنگ

با استفاده از فرمان هاي منوي کنترل در پنل Swatches مي توانيد رنگ جديدي به ليست 
ــت حذف يا رنگ  ــخه کپي تهيه کرده، رنگ را از ليس ــه کرده و از رنگ هاي موجود نس اضاف
ــرل  در پنل Swatches، منويي  ــن آن کنيد. با کليک روي منوي کنت ــري را جايگزي ديگ
ــري مجموعه رنگ )آلبوم رنگ( است، اين  ــود که حاوي تعدادي فرمان و يک س ظاهر مي ش

فرمان ها عبارتند از:
کند. New: رنگ ساخته شده در پنل Color Mixer را به پنل Swatches اضافه مي 	

ــل Swatches	 به کار  ــده در پن ــراي تهيه کپي و تکثير رنگ انتخاب ش Duplicate: ب

مي رود.
Remove: انتخاب اين گزينه باعث حذف رنگ انتخابي از پنل Swatches مي شود.	

ــده را جايگزين يکي از نمونه رنگ هاي موجود  Replace:	 اين گزينه، رنگ انتخاب ش
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در ليست رنگ  هاي Swatches مي کند.
روش اجراي جايگزيني رنگ 

1- از ليست پنل Swatches ، رنگي را که مي خواهيد جايگزين کنيد، برگزينيد.
ــا کادر محاوره ــه Replace را انتخاب کنيد ت ــي پنل Swatches گزين ــوي کنترل 2- از من

Replace Color  باز شود.

ــوي Color  library )کتابخانه رنگ( يک مجموعه رنگ را انتخاب کرده  3- از منوي بازش
ــوي Color List رنگ مورد نظر را  ــل آن رنگ مورد نظر را برگزينيد يا از منوي بازش و از داخ

انتخاب کنيد تا عمل جايگزيني انجام گيرد.
4-5-7 پنهان و آشکار كردن نام رنگ

 Show/Hide گزينه ،Swatches براي آشکار و مخفي کردن نام رنگ ها در ليست رنگ هاي
names که از طريق منوي کنترل آن قابل دسترس است به کار مي رود )شکل 7-19(.

Swatches شکل 19-7 پنهان کردن نام رنگ در پنل

تغييرنام رنگ 
براي تغيير نام نمونه رنگ انتخاب شده در پنل Swatches، روي نام رنگ دابل کليک کنيد 

تا علامت چشمک زن مکان نما ظاهر شود و نام جديد را تايپ کنيد.
ــکل 20-7 را رسم کرده آن را با رنگ سفيد مدل RGB رنگ آميزي  تمرين 11: ش
ــا نام color1 در مثال 2 ايجاد  ــي دهيد که رنگ G:152 ،B :189 و R:243 که ب ــد و ترتيب کني

کرده ايد، جايگزين آن شود و نام رنگ را تغيير داده و Color3  بگذاريد.

شکل 7-20
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5-5-7 تبديل رنگ هاي CMYK و RGB به يکديگر 

 Make RGB و Make CMYK ــاي ــل رنگ CMYK به RGB و بالعکس فرمان ه ــراي تبدي ب
به کار مي روند که در منوي کنترلي پنل Swatches قرار دارند.

Make CMYK: براي تبديل رنگ هايRGB  به رنگ هاي CMYK به کار مي رود.	

ــل رنگ هايCMYK  به RGB	 به کار مي رود که به صورت  Make RGB: به منظور تبدي

 ديده مي شود.
 CMYK ــد به مدل ــه در تمرين 11 ايجاد کرده اي تمري�ن 12: رنگ Color3 را ک

تبديل کرده و نام آن را Color4 بگذاريد.
 Process و Spot 6-5-7 ايجاد رنگ هاي

 Add و دکمه Color Mixer ــتفاده از پنل ــد با اس همان طور که در بخش 1-2-7 گفته ش
 Swatches ــازيد. در منوي کنترلي پنل ــي و نقطه اي بس to swatches مي توانيد رنگ پردازش

فرمان هاي تبديل رنگ پردازشي و نقطه اي قراردارد که عبارتند از:
ــلSwatches 	 را به رنگ  ــده در پن ــي )Process( انتخاب ش Make spot: رنگ پردازش

نقطه اي )Spot( تبديل مي کند.
ــده در پنل Swatches	 را  Make process: انتخاب اين گزينه، رنگ نقطه اي انتخاب ش

به رنگ پردازشي تبديل مي کند.

ــتفاده از RGB يا HLS تعريف شده اند، يک آيکن سه   نکته: رنگ هايي که با اس
رنگ کوچک  در سمت راست نام آن ها قرار دارد )شکل 7-21(. 

شکل 7-21

ــگ نقطه اي CMYK، رنگ  ــي CMYK، رن ــکل 21-7 از بالا به پايين: رنگ پردازش در ش
RGB رنگ نقطه اي  ،RGB پردازشي

ــي در پنل Swatches  به صورت ايتاليک مشاهده  ــامي رنگ هاي پردازش  توجه: اس
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مي شوند و رنگ هاي Spot  به صورت معمولي نشان داده مي شوند.

تمرين 13: رنگ Color4 را که در تمرين ايجاد کرده ايد، به رنگ نقطه اي تبديل 
کنيد.

6-7 آشنايي با انواع پالت هاي رنگ 

ــتم عامل  ــزي موضوعات، علاوه بر پالت رنگ سيس ــراي رنگ آمي ــه FreeHand ب در برنام
ــد Web Safe 216 که 216 رنگ در مجموعه  ــاي متعددي وجود دارد مانن Windows، پالت ه

رنگ آن وجود دارد و در مجموعه رنگ هاي کتابخانه رنگ با نام Web Safe Color قراردارد؛ نام 
ــي  تعدادي از پالت ها که در زمان صادر کردن تصوير با فرمت Gif تنظيمات آن قابل دسترس

است، در ادامه نشان داده شده است.
WebSafe 216 -2    Exact Palette -1       

Color 64 -4 WebSnap Adaptive 256, 128, 16 -3       
Color 16 -6    Color 32 -5       

Grays -7       
بعضي تنظيمات Wizard، امکان اضافه کردن بيش از يک پالت به پنل Swatches	 را 

فراهم مي کند.
Library 7-7 استفاده از جدول رنگ هاي فتوشاپ و رنگ هاي

FreeHand MXa به  طور پيش فرض داراي مجموعه رنگ هاي )Library Color( متعددي از 

جمله رنگ هاي آماده  PANTONE است که مي توانيد رنگ مورد نظر را انتخاب کرده و آن را 
ــت. به عبارت  به رنگ هاي Swatches اضافه کنيد. اين رنگ ها از نوع Coated و UnCoated اس
ديگر اين گونه رنگ هاي آماده و استاندارد، مخصوص چاپ روي کاغذهاي بدون پوشش براق 

)UnCoated( يا پوشش دار براق )Coated( است.

ــا آلبوم رنگ مي توانيد با کليد  ــراي انتخاب چند رنگ از مجموعه رنگي ي  توجه:ب
Shift رنگ هاي متوالي و کليد Ctrl رنگ هاي مجزا از هم را انتخاب کنيد )شکل 7-22(.
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شکل Library 7-22 يا مجموعه رنگ

اگر بخواهيد از جدول رنگ فتوشاپ استفاده کنيد، به طريق زير عمل کنيد:
1- مسير Xtras→Colors→Import RGB Color Table را اجرا کنيد.

ــاپ )جدول رنگ مورد نظر( را مشخص کرده  2- در کادر محاوره Open فايل ACT فتوش
و رنگ هاي آن را به پنل Swatches وارد کنيد.

ــه  ــازي جدول رنگ در پوش ــاپ محل ذخيره س  توجه:دربعضي از نسخه هاي فتوش
Presets\Optimized Colors يا Presets\Save for Web Settings  است.

توانيد  با فرمان Import RGB Color Table علاوه بر استفاده از جدول رنگ فتوشاپ مي 	
يک مجموعه رنگ ذخيره شده پوشه Palettes واقع در برنامه FreeHand را به ليست 

رنگ  هاي موجود در پنل Swatches اضافه کنيد. 

 نکته: پسوند فايل هاي جدول رنگ فتوشاپ Act است.

1-7-7 اضافه كردن و صادر كردن رنگ 

ــت که به  ــاي منوي کنترل در پنل Swatches، فرمان Import وExport اس ازديگرفرمان ه
شرح زير هستند:

ــده در پنل Swatches به کار مي رود،	  ــت ذخيره ش Import: به منظور فراخواني ليس

ــاده )مجموعه رنگ( مثل  ــان مي توان رنگ هاي آم ــتفاده از اين فرم همچنين با اس
رنگ هاي PANTONE  را به پنل Swatches اضافه کرد.
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ــتفاده کرده ايد و به پنل  ــر بخواهيد دقيقاً رنگ هايي را که در طراحي اس Export:	 اگ

Swatches افزوديد در سند ديگري نيز استفاده کنيد، مي توانيد ليست رنگ را با اين 

فرمان ذخيره کرده و با فرمان Import آن ها را بازيابي کنيد. به عبارت ديگر با فرمان 
ــي ايجاد کنيد  ــد يک آلبوم رنگ يا کتابخانه اي از رنگ هاي سفارش Export مي تواني

)شکل 7-23(.

شکل 23-7 کادر ساختن آلبومي از رنگ ها

ــواه ايجاد کنيد که  ــا نام Class-Color و نام فايل دلخ تمري�ن 14: آلبوم رنگي ب
ــبز و صورتي از نوع RGB و  3 رنگ آبي و زرد و بنفش از نوع CMYK و يک  حاوي 2 رنگ س

رنگ نارنجي از نوع رنگ هاي آماده ويندوز باشد.
 Swatches8-7 مديريت ليست رنگ ها در پنل

در برنامه FreeHand مي توانيد به صورت زير، مديريت رنگ ها را انجام دهيد:
مرتب کردن رنگ ها بر اساس نام آن ها 	

پنهان و آشکار کردن نام رنگ 	
حذف رنگ هايي که در طرح آماده چاپ استفاده نمي شود. 	

بعضي از اين کارها در بخش 2-7 گفته شده است، در ادامه به نحوه مرتب سازي رنگ ها 
بر اساس نام و حذف رنگ هايي که در طرح آماده چاپ استفاده نمي شود، مي پردازيم.

Sort Color List By Name فرمان
براي اجراي فرمان به طريق زير عمل مي شود:

مسير Xtras→Colors→Sort Color List by Name	 را اجرا کنيد.
با استفاده از اين فرمان رنگ هاي پنل Swatches برحسب نام مرتب مي شوند. 

Unused Named Colors  فرمان
براي اجراي فرمان به طريق زير عمل مي شود:
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1- بررسی کنيد موضوعي در وضعيت انتخاب نباشد.
2- رنگ يا رنگ هاي مورد نظر را انتخاب کنيد.

3- مسيرXtras→Delete→Unused Named Colors  را اجرا کنيد.
با استفاده از اين فرمان رنگ هاي پنل Swatches که در طرح ترسيم شده استفاده نشده اند، 

از فهرست رنگ ها حذف مي شوند.
  Stroke & Fill Color 7-9

هر شئ از يک خط دور )Stroke( و پرکننده درون شئ  )Fill( تشکيل شده است.
رنگ آميزي خط دور و درون موضوع ترسيمي

ــد  مي تواني 	 Swatches و Tint ،Color Mixer ــاي ــگ از پنل ه ــتفاده از درگ رن ــا اس ب
پرکننده درون شئ )Fill( و خط دور )Stroke( موضوع هاي ترسيم شده را رنگ آميزي 

کنيد )شکل 7-24(.

 

Mixer و Tint ،Swatches شکل 24-7 رنگ آميزي موضوع ترسيمي با استفاده از پنل

( نيز امکان  ــکل 7-25	 ــوي پالت رنگ  در جعبه ابزار )ش ــل Object و منوي بازش پن
رنگ آميزي را فراهم مي کنند.

شکل 25-7 رنگ آميزي موضوع ترسيمي با استفاده از پالت رنگ در جعبه ابزار

ــيمي  ــئ ترس ــل و پيرامون ش ــزي داخ ــراي رنگ آمي ــکل 26-7( ب ــل Object )ش در پن
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مي توانيد:
ــيمي و دکمه Add Stroke براي  1- روي دکمه Add Fill براي رنگ آميزي داخل موضوع ترس

رنگ پيرامون موضوع ترسيمي کليک کنيد.
2- گزينه Basic را برگزينيد، با کليک روي کادر رنگي پايين پنل Object، رنگ مورد نظر خود 

را انتخاب کنيد.

Object در پنل Fill شکل 26-7 گزينه هاي

ــبب  ــئ ديگر س ــئ به ش ــتن رنگ از يک ش  توجه: درگ ابزار قطره چکان و برداش
رنگ آميزي موضوعات ترسيمي مي شود.

 Color Mixer حرفه اي ترين روش رنگ آميزي به اين صورت است که رنگ ساخته شده در
ــگ موردنظر را از درون اين پنل  ــپس نمونه رن ــا Tints را به پنل Swatches اضافه کنيد، س ي
ــده نسبت دهيد. اين روش به شما اجازه مي دهد که هميشه بر رنگ ها  به موضوع انتخاب ش
کنترل داشته باشيد و هرگونه تغيير در خصوصيات رنگ ها منجر به ايجاد همان تغييرات در 

رنگ هاي موضوعات خواهد شد.

تمرين 15: پرچم ايران را ترسيم و رنگ آميزي کنيد.

تمرين 16: 
1- طرح يک منظره ساده را رسم کرده و رنگ آميزي نماييد.
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2- رنگ هاي سبز را با استفاده از فرمان Replace به رنگ زرد تغيير دهيد.
10-7 اصول ويرايش رنگ

ــه FreeHand مي توانيد رنگ هاي کار آماده چاپ را با روش هاي مختلف ويرايش  در برنام
کنيد. روشن و تيره کردن رنگ ها، اضافه و کم کردن درصد ميزان رنگ، ايجاد جلوه خاکستري 
و تک رنگ، تبديل رنگ ها به طيف خاکستري و تغيير رنگ ها در طرح و اثر آماده چاپ شما 

از موارد ويرايش رنگ است.
1-10-7 كنترل مقدار رنگ 

با استفاده ازColor Control  مقدار درصد رنگ ها در مدل هاي RGB،CMYK  و HLS کم يا 
ـــود و نام اصـلي رنگي که تغييـر يافتـه در پنـل Swatches باقي مي مـاند. گزينـه زياد مي ش

Color Control  براي کنترل دقيق رنگ ها به کار مي رود.

ــا Color Control در پنل Swatches قرار  ــر بخواهيد رنگ تغيير يافته ب  نکت�ه: اگ
گيرد، بايد براي آن نامي در نظر بگيريد.

Color Control شکل 27-7 تغيير رنگ شئ با استفاده از

Color Control روش استفاده از
براي استفاده از Color Control به ترتيب زير عمل کنيد:

1- شئ گرافيکی را انتخاب کنيد.
 Color Control ــد تا کادرمحاوره ــير Xtras→Colors→Color Control را اجراکني 2- مس

باز شود.
3- يکي از مدل هاي رنگ CMYK ، RGB يا HLS را برگزينيد.
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4- براي مشاهده تغييراتي که در رنگ ايجاد مي کنيد؛ Preview را انتخاب کنيد.
ــراي تغييرميزان رنگ، دکمه  لغزنده مربوط  به آن را درگ کرده يا عددهاي  موردنظر  5- ب

را وارد کنيد.
6- براي اعمال تغييرات روي OK کليک کنيد.

- است. محدوده مورد نظر براي مدل هاي رنگ بين 100%+ تا %100	
- است. ميزان Hue: از360%+ تا %360	

ــت که نشان دهنده عدم  ــکيل دهنده مدل هاي رنگ عدد 0	 اس پيش فرض موارد تش
تغيير در رنگ است.

              

CMYK شکل 28-7 انتخاب شکل   شکل 29-7 تنظيم رنگ در حالت                 

ــود دارد که مي توانيد از آن ها براي  ــه حالت رنگ در کادر محاوره Color Control وج س
تنظيم رنگ ها استفاده کنيد )شکل 7-29(.

ــف و در حالت ديگري آن را تنظيم  ــد رنگ را در يک حالت تعري  نکت�ه: مي تواني
کنيد.

با توجه به اين که رنگ هاي قرمز، سبز و آبي از سيستم RGB و آبي Cyan، ارغواني، زرد 
ــتم CMYK دوبه دو مکمل يکديگر هستند، براي کم يا زياد کردن يک رنگ  ــياه از سيس و س
ــراي کم کردن رنگ آبي در يک  ــگ مکمل آن را کم يا زياد کرد. به طور مثال ب ــوان رن مي ت
شکل مي توان به مقدار رنگ زرد که رنگ مکمل آن در چرخه رنگ است، اضافه کرد يا براي 
ــت کم کرد.  ــبز در تصوير مي توان از ميزان رنگ ارغواني که مکمل آن اس زياد کردن رنگ س

اعداد مثبت به مقدار رنگ اضافه مي کند و اعداد منفي رنگ را کاهش مي دهد.
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مثال 3: شکل 30-7 را رسم کرده و آن را به دلخواه رنگ کنيد.

شکل 7-30

1- ميزان اشباع رنگ را کم کرده و روشنايي شکل را افزايش دهيد. 
2- براي  اين کار  بايد  فرمانXtras→Colors→ Color Control  را اجرا کنيد. در کادرمحاوره 
ــپس با تنظيم دکمه لغزنده مربوط به S ميزان  Color Control زبانه HLS را انتخاب کرده س

ــکل را افزايش دهيد   ــنايي ش ــم و با تنظيم دکمه لغزنده مربوط به L روش ــباع رنگ را ک  اش
)شکل 7-31(.

HLS شکل 31-7 تنظيم رنگ در حالت

ــم کرده و آن را رنگ آميزي کنيد؛ با استفاده از  ــکل 32-7 را رس تمرين 17: ش
Color Control رنگ آن را تغيير دهيد.
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شکل 7-32

2-10-7 تبديل رنگ شئ به خاكستري 

براي تبديل رنگ موضوعات به خاکستري از فرمان: 
Xtras→Colors→Convert to Grayscale استفاده کنيد.

روش تبديل رنگ به خاكستري
1- موضوع يا موضوعات مورد نظر را انتخاب کنيد.

ــير Xtras→Colors→Convert  to Grayscale را اجرا کنيد. رنگ شکل خاکستري  2- مس
مي شود.

               

Grayscale شکل 33-7 انتخاب موضوع گرافيکي      شکل 34-7 نتيجه حاصل از تأثير فرمان

ــم و به دلخواه رنگ آميزي کنيد، سپس رنگ آن  ــکل 34-7 را رس  تمرين 18: ش
 را خاکستري کنيد.

شکل 7-35
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3-10-7 تيره و روشن كردن رنگ 

با استفاده از گزينه Colors در منوي Xtras مي توانيد مقدار رنگ را با هر بار اعمال فرمان، 
يک درجه تيره يا روشن کنيد. 

ــوارد Saturate، Darken، Lighten وDesaturate به رنگ هاي spot اعمال   نکت�ه: م
نمي شود.

روش اجرا:
1- ابتدا شئ را انتخاب کنيد.

ــرده و يکي از موارد زير را با توجه به تغييری که  ــير Xtras→Colors را انتخاب ک 2- مس
مي خواهيد در رنگ ايجاد کنيد، برگزينيد.

Lighten Colors: رنگ شئ انتخابي را يک درجه روشن تر مي کند.

Darken Colors: به رنگ سياه شئ، اضافه کرده و آن را تيره تر مي کند.

Saturate Colors: ميزان غلظت رنگ )اشباع رنگ( را افزايش مي دهد.

Desaturate Colors: رنگ را تيره و کدر کرده و اشباع آن را کم مي کند.

ــه بالاترين ميزان  ــود که رنگ، ب ــده تا زماني اعمال مي ش ــوارد گفته ش  نکت�ه: م
تأثيرش برسد.

Lighten Colors مثال 4: فرمان
1- موضوع گرافيکي مورد نظر را انتخاب کنيد.

2- فرمان Xtras→Colors→Lighten Colors را اجرا کنيد. با هر بار اجراي اين فرمان رنگ 
شکل يک درجه روشن تر مي شود.

Darken Colors مثال 5: فرمان
1- موضوع گرافيکي مورد نظر را انتخاب کنيد.
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2- فرمان Xtras→Colors→Darken Colors را اجرا کنيد. با هر بار اجراي اين فرمان رنگ 
شکل يک درجه تيره تر خواهد شد.

شکل 7-36

تمرين 19: شکل 37-7 را رسم و به دلخواه رنگ کنيد سپس شکل را دو درجه 
تيره تر کنيد.

شکل 7-37

Saturate Colors مثال 6: فرمان 
1- موضوع گرافيکي مورد نظر را انتخاب کنيد.

ــد. با هر بار اجراي اين فرمان  ــان Xtras→Colors→Saturate Colors را اجرا کني 2- فرم
غلظت رنگ شکل يک درجه بيشتر مي شود )شکل 7-37(.

                                

Saturate Colors شکل 38-7 انتخاب موضوع گرافيکي         شکل 39-7 نتيجه حاصل از تأثير فرمان

Desaturate Colors مثال 7: فرمان 
1- موضوع گرافيکي را که مي خواهيد اشباع رنگ آن کم شود، انتخاب کنيد.

2- فرمانXtras→Colors→Desaturate Colors  را چند بار اجرا کنيد تا اشباع رنگ شکل، 
کم تر شود.
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شکل 40-7 انتخاب موضوع گرافيکي

 نکته: براي ادامه اشباع رنگ يا خارج کردن رنگ ها از حالت اشباع در صورت لزوم 
فرمان مزبور را چندبار تکرار کنيد.

 تمرين 20: 
1- رنگين کمان را اجرا کنيد.
2- درجه اشباع را کم کنيد.

3- تناليته هاي سه رنگ اصلي را تا 10 درجه بسازيد.
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واژه نامه  
Convertتبديل کردن، معکوس کردن

Coatedپوشش براق

Cyanآبي فيروزه اي

Darkenتيره تر

Desaturateکم کردن اشباع رنگ

Exactدقيق

Grayscaleخاکستري

Magentaارغواني

Mixerمخلوط کن

Pickerانتخاب کننده

Presetsتنظيم شده، پيش تنظيمات

Randomizeاتفاقي، تصادفي

Xtrasاضافي

Swatchنمونه

Trimبرش زدن صفحات

خلاصه مطالب
ــگ RGB ،CMYK و HLS	 به ترتيب براي چاپ يا  ــه مدل رن در برنامه FreeHand س
کارهاي نمايشي و وب در نظر گرفته شده اند. در مدل هاي رنگ امکان حذف، اضافه، 

تغيير نام و ويرايش رنگ ها وجود دارد.
ــرح  ــتيد که می توانيد رنگ هاي کار آماده چاپ را با روش  هاي مختلف به اين ش دانس 	
ــردن رنگ ها 2- اضافه و کم کردن درصد ميزان  ــن و تيره ک ويرايش کنيد: 1- روش
ــتري  ــتري و تک رنگ 4- تبديل رنگ ها به طيف خاکس رنگ 3- ايجاد جلوه خاکس

5- تغيير رنگ ها در طرح و اثر آماده چاپ
ــي شده در اين واحد کار مديريت ليست رنگ مي باشد از جمله:  از ديگر موارد بررس 	
1- مرتب کردن رنگ ها بر اساس نامشان 2- پنهان و آشکار کردن نام رنگ 3- حذف 

رنگ هايي که در طرح آماده چاپ استفاده نمي شود. 
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعيين کنيد.

1- پنل Color Mixer براي ساختن رنگ هاي ترکيبي مورد نياز به کار مي رود. 
2- در مدل RGB، هر يک از رنگ ها با عددي بين 0 تا 100 نشان داده مي شوند.

3- پنل تناليته ته رنگ هايي با درصدهاي 10% تا 90% از رنگ اصلي ارائه مي دهد. 
ــتفاده از رنگ هاي فيروزه اي، ارغواني، زرد  ــتند که با اس 4- رنگ هاي Spot رنگ هايي هس

و سياه ساخته مي شوند. 
معادل گزينه  هاي سمت راست را از ستون سمت چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

Replace   .به کارمي رود Swatches 5- براي تهيه کپي و تکثير رنگ انتخاب شده در پنل
                     Duplicate    .مي شود Swatches 6- انتخاب اين گزينه باعث حذف رنگ انتخابي از پنل
ــت  ــده را جايگزين يکي از نمونه رنگ هاي موجود در ليس 7- اين گزينه، رنگ انتخاب ش
Remove                                                                  .مي کند Swatches رنگ هاي

گزينه صحيح را انتخاب کنيد.

ــتفاده  ــود از کدام فرمان اس ــباع تر ش ــده اش ــد رنگ موضوع انتخاب ش ــر بخواهي 8- اگ
مي کنيد؟

Saturate Colors -ب  Desaturate Colors -الف
Lighten Colors -د   Darken Colors -ج

9- با استفاده از کدام فرمان مي توان رنگ موضوع انتخاب شده را تيره تر کرد؟
  Darken Colors -ب   Convert to Grayscale -الف

 Desaturate Colors -د    Lighten Colors  -ج
10- کدام يک از گزينه هاي زير، از موارد ويرايش رنگ نيست؟

Color Control  -ب  Desaturate Colors  -الف
Websafe 216  -د   Lighten Colors  -ج

ــده از ليست پنل Swatches را هم به  11- کدام دکمه در پنل Swatches، رنگ انتخاب ش
داخل مسير انتخاب شده و هم به خط دور موضوع مي دهد؟

الف-                  ب-                  ج-                     د-  
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 Swatches 12- با نگه داشتن کليد ......... و کليک روي رنگ موردنظر در ليست رنگ پنل
جزييات رنگ به صورت CMYK يا RGB نمايش داده مي شود. 

Alt+Shift -د               Ctrl -ج                Alt  -ب               Shift -الف
13- رنگ پايه، اشباع رنگ و ميزان روشنايي رنگ، در اين حالت رنگ تنظيم مي شود.

CMYK  و HLS  -د               HLS  -ج           RGB  -ب            CMYK  -الف
14-  براي آشکار و مخفي کردن نام رنگ ها در ليست  رنگ هاي Swatches، از اين گزينه  

استفاده مي شود.
 Restore-ب                   Remove Color -الف

Show color -د    Show/Hide names  -ج

در جاي خالي عبارت مناسب را بنويسيد.

15- در مدل ........... تمامي رنگ ها از ترکيب چهار رنگ اصلي ساخته مي شوند.
16- به رنگ هاي از نوع CMYK رنگ هاي .......... نيز مي گويند.

ــند را که داراي هيچ نامي  ــده در س ــتفاده ش 17- فرمان ....................... تمام رنگ هاي اس
نيستند، به پنل Swatches اضافه کرده و به آن ها يک نام اختصاص مي دهد. 

18-  ميزان Hue ........ تا .......... است. 
ــاي ................. و ................... و ايجاد رنگ هاي ويژه  ــتر در کاره ــاي Spot بيش 19- رنگ ه

نظير رنگ مهتابي و متاليک استفاده مي شود.
 

به سؤالات زير پاسخ تشريحی دهيد.

20- چه مواقعي از گزينه Lighten Colors استفاده مي شود؟
21- رنگ هاي مکمل سيستم RGB و CMYK را نام ببريد.

ــوند،  ــفيد جذب مي ش ــاس جوهرهاي چاپ که روي کاغذ س 22- کدام مدل رنگ بر اس
ساخته مي شود؟

23- رنگ هاي Spot و Process چه تفاوتي با يکديگر دارند؟
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آزمون عملي
ــتري به مناسبت برپايي نمايشگاه کتاب طراحي کنيد که شکل روبه رو به عنوان  1- پوس

آرم اين پوستر باشد.

2- شکل زير را رسم و رنگ آميزي کنيد سپس رنگ هاي به کار رفته در تصوير را به پالت 
Swatches اضافه کنيد و فرمان Randomize Named Color را روي آن اجرا کنيد.

3- شکل هاي زير را رسم و با استفاده از پالت هاي رنگ آن ها را رنگ آميزي کنيد.

             

4- شکل هاي بعد را رسم کرده و رنگ هاي آن ها را به پالت Swatches اضافه کنيد، سپس 
نام رنگ هاي پالت را مرتب و درجه رنگ شکل ها را روشن تر کنيد.
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كليات
نرم افزار FreeHand امکانات مختلفي را براي پرکردن اشکال و طرح ها در اختيار شما قرار 

مي دهد که اين پرکننده ها در جذاب تر شدن پروژه هاي هنري تأثير به سزايي دارند.
ــردن رنگ داخل  ــه Fill براي پر ک ــد از گزين ــه در واحد کار قبل گفته ش ــور ک همان ط
ــوان از طرح ها و الگوهاي  ــود. اما علاوه بر رنگ ها مي ت ــتفاده مي ش ــيرها اس موضوعات و مس
ديگري نيز براي پر کردن داخل موضوعات استفاده کرد. البته رنگ الگوها و طرح ها بر اساس 

رنگ انتخاب شده در پنل Swatches تعيين مي شود.
Object در پنل Add Fill 1-8 دكمه

ــد و به صورت  ــرار گرفته ان ــل Object ق ــواص Fill و Stroke در پن در FreeHand MXa خ
مستقل ديده نمي شوند.

ــکل 8-1  ــدن پنل Object مطابق ش ــت که با باز ش Fill زيرمجموعه اي از پنل Object اس

.)Ctrl+F3 روي صفحه ظاهر مي شود )کليد ميانبر

Object در پنل Fill  شکل 1-8 گزينه هاي

ــت، کليک کنيد تا گزينه هاي  ــطل رنگ اس ــبيه س در پنل Object روي دکمه اي که ش
تنظيمي مربوط به رنگ هاي داخل موضوعات ظاهر شود.

در اين قسمت تعيين مي شود که موضوع موردنظر با يکي از رنگ هاي پنل Swatches پر 
شود )حالت Basic( يا از طرح ها و الگوهاي ديگري براي پرکردن داخل شکل استفاده شود.
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 توجه: فعال بودن گزينه OverPrint سبب مي شود که رنگ انتخاب شده با رنگ هاي 

زيرين خود ادغام شود، مثلًا اگر رنگ شکل آبي فيروزه اي )سايان( باشد و رنگ زمينه آن زرد 
باشد در چاپ، شکل به رنگ سبز چاپ مي شود.

Add Fill نحوه استفاده از دكمه
ــا کليک روي دکمه Add Fill در پنل Object گزينه هاي تنظيمي مربوط به Fill ظاهر  1- ب

مي شود.
2- شکل يا متن مورد نظر را انتخاب کنيد.

ــکل(، يکي از گزينه هاي آن را انتخاب  ــوي انواع Fill )پر کننده داخل ش 3- از منوي بازش
نماييد.

در اين بخش به شرح گزينه هاي منوي بازشوي انواع Fill مي پردازيم.
2-8 انواع طرح ها

 Basic 8-2-1

اين  نوع طرح به منظور رنگ آميزي يکدست و خالص خط دور و محتواي داخل موضوعات 
 انتخابي به کار  مي رود.

 Basic روش هاي اعمال طرح
اعمال طرح Basic با استفاده از منوي بازشو Fill در پنل Object )شکل 8-2(.	

اعمال طرح Basic با استفاده از جعبه ابزار Tools	 که همان انتخاب  رنگ از پالت  رنگ
Fill  است.

ــل Swatches	 صورت  ــاب رنگي که از پن ــتفاده از انتخ ــال رنگ نوع Basic  با اس اعم
مي گيرد.

ــکل 2-8 را که چرخه دوازده رنگ پيشنهادي ايتن است ترسيم کرده  تمرين 1: ش
و رنگ آميزي نماييد.
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شکل 8-2

 Color ــا درگ رنگ از پنل هاي ــورت انتخاب طرح Basic از انواع Fill مي توانيد ب  نکت�ه: در ص
Tints ،Mixer يا Swatches به داخل پالت رنگ Fill، شکل را رنگ آميزي کنيد.

Gradient 8-2-2

ــروع و به رنگ هاي ديگر تبديل  ــت که از يک رنگ ش منظور از Gradient، طيف رنگي اس
مي شود.

ــيماتي نظير رنگ آميزي آسمان، خورشيد،  گاهي اوقات براي زيبايي در رنگ آميزي ترس
رنگين کمان، سايه، افق و موارد ديگر نياز به اين نوع طرح است.

Gradient روش اعمال
ــه Gradient را برگزينيد. در اين  ــل Object، گزين ــوي انواع Fill در پن ــوي بازش 1- از من

صورت گزينه هاي تنظيمي آن ظاهر مي شود )شکل 8-3(.

 Gradient شکل 3-8  گزينه هاي تنظيمي 

2- از منوي بازشوي Gradient type مي توانيد انواع شيب هاي گراديان را انتخاب کنيد.
Gradient انواع

ــمت مي توان انواع رنگ ها را به  ش�يب خطي )Linear(:	 به کمک نوار رنگي اين قس
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ــيب گراديان، زاويه داد  صورت تدريجي و خطي در يکديگر محو کرد همچنين به ش
و بر موضوع انتخابي اعمال کرد )شکل 8-4-1(.

ــتگيره و درصد  ــروع )Start(، زاويه دس گزينه هاي کنترلي اين طيف براي تعيين محل ش
طول گراديان در Handle1  و انتخاب رنگ هاي مختلف در طيف به کار مي رود.                                                    

شکل 8-4-1

ــتفاده از دستگيره هاي Gradient )يک نقطه شروع و يک نقطه پايان(   نکته: با اس
ــروع، زاويه و طول گراديان را به طور دستي تنظيم کنيد. اين  ــکل، مي توانيد محل ش روي ش

دستگيره ها همچنين با نگه داشتن کليد Ctrl     ظاهر مي شوند )شکل 8-5-1(.

 توجه: اگر دستگيره هاي گراديان را نمي بينيد، روي ابزار Subselect يا Pointer دابل کليک کنيد 

و در کادر محاوره باز شده گزينه Show Fill Handles را فعال نماييد.

، رنگ داخل موضوع  	Gradient با انتخاب اين نوع :)Radial( شيب کروي يا شعاعي
ــروع مي شود و يک کره ايجاد مي کند، اين شيب يک شيب  ــده از مرکز ش انتخاب ش

مدور است )شکل 8-4-2(.

شکل 8-4-2

اعمال  	 Gradient تغيير رنگي که در اين نوع :)Contour( ش�يب انعکاسي يا تابعي
مي شود بر اساس شکل مسيري است که انتخاب کرده ايد )شکل 8-4-3(.
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ــت و گزينه Taper جهت تنظيم ميزان نفوذ  گزينه هاي کنترلي مانند طيف هاي قبلي اس
رنگ هاي طيف در يکديگر به کار مي رود.

شکل 8-4-3

اين نوع طيف مانند طيف رنگ خطي است با اين  	 :)Logarithmic( شيب لگاريتمي
تفاوت که تغيير رنگ ها به طور نامساوي صورت مي گيرد )شکل 8-4-4(.

اين طيف نيز مانند طيف رنگ شعاعي است، با اين  	 :)Rectangle( شيب مستطيلي
تفاوت که طيف از مرکز شروع و يک مستطيل ايجاد مي کند )شکل 8-4-5(.

تغيير رنگ در اين طيف به شکل، حالت برجستگي شبيه  	 :)Cone( شيب مخروطي
هرم يا يک مخروط سه بعدي مي دهد )شکل 8-4-6(.

          

شکل 4-4-8                       شکل 5-4-8                    شکل 8-4-6

ــط گراديان  ــکل را توس ــدن ش ــوي Behavior type مي توانيد نحوه پرش 1- از منوي بازش
تنظيم کنيد. اين گزينه ها عبارتند از: Normal )معمولي(، Repeat )تکرار(، Reflect )انعکاس( 

و Auto Size )اندازه اتوماتيک(.
ــد  ــخص کني ــروع را مش ــه ش ــات x و y نقط ــد مختص ــاي Start مي تواني  2- در کادره

)شکل 8-5(.
3- در کادرهاي Handle مي توانيد زاويه گراديان و فاصله بين دورنگ يا طول گراديان را 

به طور دلخواه تنظيم کنيد )شکل 8-5(.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - هـ
194

شکل 5-8 گزينه هاي گراديان

ــن پنل Object، يک نوار رنگي وجود دارد که رنگ هاي موجود در طيف رنگ  4- در پايي
ــتند که مي توانيد تعداد  را نمايش مي دهد. به طور پيش فرض گراديان ها حاوي دو رنگ هس

رنگ ها را تغيير داده و اضافه کنيد.
ــع قرار دارد که نمايانگر رنگ ابتدا و انتهاي گراديان  ــدا و انتهاي نوار رنگي، دو مرب در ابت
ــده و از داخل آن رنگ  ــت. براي تغيير رنگ، روي مربع ها کليک کنيد تا پالت رنگ باز ش اس

موردنظر خود را انتخاب کنيد.

ــر کدام از مربع ها کليک کرده و   نکت�ه: براي اضافه کردن رنگ مي توانيد روي ه
ــت مربع را به  ــمت داخل نوار رنگي درگ کنيد و براي حذف يک رنگ، کافي اس آن را به س

خارج از پنل درگ کنيد.

ــتفاده از انواع Gradient نشان داده شده، رسم کنيد  ــکل 6-8 را با اس مثال 1: ش
 

)رنگ دلخواه(.

شکل 8-6
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1- از خط کش ها و Guides براي رسم دقيق استفاده کنيد.
2- ابتدا طراحي و ترسيمات شکل را انجام دهيد.

3- کوه ها و دامنه آن را انتخاب کرده و گراديان خطي را به رنگ دلخواه، روي آن اعمال 
کنيد.

ــعاعي براي آن در نظر بگيريد،  ــيد را به حالت انتخاب درآورده و طيف رنگ ش 4- خورش
سپس خط دور آن را حذف کنيد.

5- شعاع هاي خورشيد را با گراديان لگاريتمي رنگ کنيد.
ــگ اضافه کرده و آن را  ــان خطي رنگ کنيد. به نوار رنگي، رن ــواج دريا را با گرادي 6- ام

تغيير دهيد.
7- جزيره را انتخاب کرده و گراديان انعکاسي را به آن اعمال کنيد.

8- پايه چتر را با گراديان مستطيلي و سر آن را با گراديان مخروطي رنگ کنيد.
تمرين 2: 

 
1- يک برش پرتقال را با توجه به گراديانت ها طراحي کنيد.

2- شکل 7-8 را رسم کرده و با گراديان هاي مناسب رنگ کنيد.

شکل 8-7

3- تصويري از پاييز را رسم کرده و با گراديان هاي مناسب رنگ آميزي کنيد.
Textured 8-2-3

پرکننده Textured تصاوير گرافيکي آماده اي هستند که به جاي رنگ دادن به موضوعات 
به آن ها نماي بافت مي دهند. اين پرکننده ها در صفحه مانيتور قابل رؤيت نيستند و تنها در 

کارهاي چاپي مشاهده مي شوند.
)بافت( 	 Textured روش اعمال

1- گزينه Textured را از منوي بازشوي انواع Fill انتخاب کنيد، در اين صورت گزينه هاي 
تنظيمي آن ظاهر مي شود )شکل 8-8(.
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Fill از انواع Textured شکل 8-8 گزينه

ــوي انواع بافت ها، بافت موردنظر خود را انتخاب کنيد که در اين حالت  2- از منوي بازش
در پنجره پيش نمايش، بافت انتخابي نشان داده مي شود.

3- امکان تغيير رنگ بافت انتخابي نيز در فهرست Color اين گزينه وجود دارد.
ــده به جاي مشاهده بافت، يک سري حرف c مي بينيد که شکل  ــکل انتخاب ش 4- در ش
را پر کرده است )شکل 9-8(. همان طور که گفته شد اين پرکننده ها در چاپ قابل مشاهده 

هستند.

شکل 9-8 نمايش بافت در صفحه نمايش

 توجه: روش کار با گزينه Custom از انواع Fill نيز مشابه Textured است.
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Pattern 8-2-4

پرکننده هاي Pattern، الگوهايي هستند که مي توانيد در ترسيمات به جاي رنگ از آن ها 
استفاده کنيد. اين الگوها را مي توان پيکسل به پيکسل و به سادگي ويرايش نمود تا به صورت 
ــاهده  ــط مانيتور قابل مش ــده به موضوعات بلافاصله توس دلخواه درآيند. الگوهاي اعمال ش

هستند.
	Pattern روش اعمال

1- موضوع ترسيمي را انتخاب کنيد.
ــد. در اين صورت، گزينه هاي  ــوي انواع Fill برگزيني ــه Pattern را از منوي بازش 2- گزين

تنظيمي الگوها ظاهر مي شوند )شکل 8-10(.
ــتفاده  ــاهده و انتخاب Pattern موردنظر از دکمه لغزنده اين کادر محاوره اس 3- براي مش
ــي از آن را  کرده و يک الگو را انتخاب کنيد. با کليک روي هر Pattern مي توانيد پيش نمايش

در کادر سمت چپ دکمه لغزنده کادر محاوره مشاهده کنيد. 
ــه با کليک کردن روي  ــپ کادر پيش نمايش، کادر ويرايش قرار دارد ک ــمت چ 4- در س

پيکسل ها يا خانه هاي آن مي توانيد الگوي مورد نظر را ويرايش کنيد.
5- رنگ Pattern را مي توانيد از ليست رنگ هاي موجود در فهرست Color تغيير دهيد.

ــتفاده از دکمه Clear، الگوي   توجه: به منظور طراحي الگوي جديد مي توانيد با اس

پيش فرض را پاک کرده و يک صفحه خالي ايجاد کنيد.

شکل 10-8 گزينه هاي Pattern و نمونه هايي از چند شکل پر شده با الگو
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ــفيد و بالعکس تبديل  ــياه را به س ــل هاي س  توج�ه: دکمه Invert، نقاط يا پيکس

مي کند.

ــرار مي گيرند، از طريق فضاي  ــت پرکننده Pattern ق  نکت�ه: موضوعاتي که در پش
سفيد Pattern قابل مشاهده نيستند.

ــاير اشکال، گزينه زير را به کار  ــت س  نکته: براي قرار دادن موضوع انتخابي در پش
ببريد.

Modify→Arrange→Send to back

ــده، طراحي  ــتفاده از الگوهاي نمايش داده ش ــکل 11-8 را با اس تمري�ن 3: ش
کنيد.

شکل 8-11

PostScript 8-2-5

ــتفاده  ــکال با الگوهاي مبتني بر بردارهاي رياضي از PostScript اس به منظور پرکردن اش
ــوند؛ زماني قابل مشاهده مي شوند که با يک  ــکالي که با اين نوع طرح پر مي ش ــود. اش مي ش
  Object در پنل Fill از منوي بازشوي انواع PostScript ــوند. گزينه چاپگر PostScript چاپ ش

قابل انتخاب است.
Custom  8-2-6

ــتي از الگوهاي آماده را براي  ــوي انواع Fill، قرار دارد که ليس ــن گزينه در منوي بازش اي
ــان مي دهد )شکل 12-8(. در اين صورت با انتخاب هر يک از اين  ــکل نش پر کردن داخل ش
ــود. همچنين رنگ الگوها را مي توانيد با انتخاب  ــده با آن پر مي ش الگوها، موضوع انتخاب ش
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رنگ از پنل Swatches تغيير دهيد.

ــتند و بعد از  ــط مانيتور قابل ديدن نيس  توجه: الگوهاي آماده گزينه Custom توس

چاپ قابل مشاهده خواهند بود.

 Custom Fills 8-12 شکل

  Tiled  8-2-7

ــيمات ديگر استفاده  نوع ديگري از طرح هاي پرکننده که براي پرکردن موضوعات از ترس
مي کند، گزينه Tiled است. همچنين گاهي اوقات در طراحي لازم است که يک شکل از قبل 
ــود مانند جعبه دستمال کاغذي، کاغذ کادو،  ــده در داخل يک طرح ديگر تکرار ش طراحي ش
ــرکت در زمينه برگه هاي تبليغاتي آن شرکت و نيز موارد  ــتي يا تکرار آرم يک ش ــاک دس س

ديگر.
براي ايجاد و اعمال اين پرکننده مراحل زير را انجام دهيد:

ــتفاده کنيد، ترسيم کرده و  ــکلي را که مي خواهيد جهت تکرار در موضوع ديگر اس 1- ش
.)Ctrl+C( از آن کپي بگيريد

 توجه: مي توانيد يک متن را نوشته، سپس به موضوع تبديل کرده و در شکل ديگر 

تکرار کنيد.
1- موضوعي که مي خواهيد باTiled  پر شود، انتخاب کنيد.

ــد و روي دکمه Paste in  کليک  ــواع Fill  گزينه Tiled را برگزيني ــوي ان 2- از منوي بازش
ــده و موضوع با آن پر مي شود )شکل  ــکل کپي شده در کادر پيش نمايش ظاهر ش کنيد. ش
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.)8-13
3- براي تغيير اندازه پرکننده Tiled از کادرهاي x و y در قسمت مقياس)Scale( استفاده 
کنيد، با دادن مقادير کوچک  تر يا بزرگ تر از 100 ابعاد پرکننده کوچک تر يا بزرگ تر مي شود. 
ــاني به کار  ــده، در هر دو کادر x  و y مقادير يکس ــر مقياس يکنواخت پرکنن ــه منظور تغيي ب

بريد.
 y و x ــي را در کادرهاي ــا کردن پرکننده مي توانيد مقادير مثبت و منف ــراي جابه ج 4- ب

مربوط به Offset وارد کنيد.

              

شکل 13-8 گزينه Tiled و نمونه اي از تأثير آن

ــتفاده کنيد  5- براي زاويه دار کردن پرکننده يا چرخش آن مي توانيد از اهرم چرخش اس
يا زاويه دقيق را در کادر Angle وارد کنيد.

ــند و شامل تصاوير گرافيکي   نکته: طرح هاي پرکننده Tiled حتماً بايد برداري باش
پيکسلي نمي شوند.

تمرين 4: کاغذ کادو نشان داده شده در شکل 14-8 را به ابعاد 18×30 سانتي متر 
طراحي کنيد.
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شکل 8-14

Lens 8-2-8

با استفاده از اين پرکننده مي توان ظاهر شکل را با معکوس کردن رنگ ها، تغيير شفافيت، 
رنگ، روشني، تيرگي يا بزرگنمايي تغيير داد.  

براي اعمال اين پرکننده مراحل زير را انجام دهيد:
1- گزينه Lens )لنز( را از منوي بازشوي انواع Fill انتخاب کنيد، در اين صورت گزينه هاي 

تنظيمي آن ظاهر مي شود )شکل 8-15(.

شکل 15-8 گزينه هاي پر کننده عدسي

2- يکي از شش نوع پرکننده Lens را به دلخواه انتخاب نماييد.
ــه منظور تغيير تنظيمات نمايش  ــده گزينه هاي متفاوتي ب ــا توجه به نوع لنز انتخاب ش ب
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داده مي شوند.
3- براي  لنزهاي Transparency و Monochrome با استفاده از منوي بازشو با کادر رنگ، 

مي توان رنگي را انتخاب نمود.
4- در  لنز Magnify براي تنظيم بزرگنمايي شکل زير لنز مقدار بين 1 تا 20 را وارد کرده 

يا دکمه لغزنده را جهت تنظيم مقدار درگ نماييد.
ــاي Lighten ،Transparency و Darken با وارد نمودن مقادير دلخواه يا درگ  5- در  لنزه

کردن دکمه لغزنده مي توان تنظيمات زير را انجام داد:
براي پر کننده Transparency، حدود مقادير بين صفر )کاملًا شفاف( تا 100	 )کاملًا 

کدر( مي باشد )شکل 8-16(.
ــفيد کاملًا  ــير لنز را از س براي پر کنندهLighten ، مقدار صفر، بي اثر و عدد 100	 مس

پر مي کند )شکل 8-17(.
ــير لنز را از مشکي کاملًا  براي پر کنندهDarken ، مقدار صفر، بي اثر و عدد 100	 مس

پر مي کند )شکل 8-18(.

                   

شکل 16-8                       شکل 17-8                             شکل 8-18

ــه Centerpoint را انتخاب  ــده، گزين ــتگيره در مرکز لنز انتخاب ش ــور نمايش دس به منظ
نماييد در اين صورت با استفاده از ابزار Pointer مي توانيد نقطه مرکز را جابه جا کنيد.

 نکته: به منظور بازگرداندن نقطه مرکز به مرکز لنز کليد Shift را پايين نگه داشته 
و روي نقطه کليک کنيد.

انتخاب گزينه Objects Only باعث مي شود تا لنز مورد نظر تنها روي شکل انتخاب شده 
تأثير داشته باشد و روي نواحي انتخاب نشده تغييري ايجاد نکند.

انتخاب گزينه Snapshot باعث مي شود تا زماني که روي هر قسمت از شکل انتخاب شده 
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لنز را قرار دهيد، تصويري از آن قسمت گرفته شود.
کليک کنيد، پرکننده داخل موضوع  	 Object در زبانه Remove Item ــر روي دکمه اگ

حذف مي شود.
ــمتي از آن را به صورتي که در شکل  ــکل 19-8 را رسم کنيد و قس تمرين 5: ش

مشاهده مي نماييد طوري تصويربرداري کنيد که بزرگ تر نمايش داده شود.

شکل 8-19

Object در پنل Add Stroke 3-8 دكمه
منظور از Stroke ضخامت خطوطي است که دور موضوعات را احاطه مي کند، Stroke نيز 
ــت که خطوط دور مسيرها را کنترل مي کند )شکل  يکي از زير مجموعه هاي پنل Object اس

.)8-20

Object در پنل Stroke شکل 20-8 گزينه هاي

ــم  ــوي انواع Stroke علاوه بر گزينه Basic، طرح هاي ديگري نيز براي رس در منوي بازش
ــل Swatches قابل  ــتفاده از پن ــود دارد که همه اين خطوط با اس ــيرها وج ــوط دور مس خط

رنگ آميزي هستند.
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 )Stroke( نحوه استفاده از خط دور
1- تصوير دلخواهي رسم کرده و آن را انتخاب کنيد. 

2- روي دکمه Add Stroke از پنل Object کليک کنيد.

ــکل  ــي از گزينه هاي Stroke را انتخاب کنيد )ش ــوي انواع Stroke يک ــوي بازش 3- از من
ــاس نوع خط دور انتخاب شده، تغيير  21-8( که در اين صورت، تنظيمات پنل Object براس

مي کند.      

Stroke شکل 21-8 گزينه هاي منوي

 Basic 1-3-8 گزينه

با نسبت دادن رنگ از پنل Swatches به دور موضوعات، خطوط با رنگ ساده رنگ آميزي 
مي شوند. 

ــزار Tools نيز مي توانيد رنگ  ــتفاده از جعبه رنگ  Stroke در جعبه اب  توج�ه: با اس

خط دور را انتخاب کنيد.
Stroke گزينه هاي كنترلي خطوط مرزي موضوعات در

ــه رنگ ها براي خط دور  ــا کليک روي مربع رنگي، امکان انتخاب هم جعب�ه رنگ:	 ب
مسير فراهم مي آيد؛ همچنين با باز کردن منوي بازشوي کنار آن، رنگ هاي موجود 

در پنل Swatches نشان داده مي شوند.
ــن آن ادغام  هاي زيري ــا رنگ 	 ــه رنگ خط دور ب ــاب اين گزين ــا انتخ Overprint: ب

مي شود.
ــب واحد  ــدازه موردنظر برحس من�وي بازش�و Width:	 با انتخاب ان
ــمت مي توانيد ضخامت خط دور را  ــت موجود در اين قس اندازه گيري صفحه، از ليس

تغيير دهيد يا عددي بين صفر تا Point( 288( را در کادر مربوطه تايپ کنيد.
ــه هاي خط را  ــير يا نوع گوش ــت انتهاي خطوط مس :	 وضعي  Cap

تعيين مي کند.
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  Capانواع شيوه هاي
Butt: انتهاي خط دور را با خط مستقيم پايان مي دهد.	

Round: انتهاي خط دور را با منحني ختم مي کند.	

Square: انتهاي خط دور را با مربع پايان مي دهد.	

                                            

شکل 22-8 انواع شيوه هاي Cap اعمال شده به مسير

ــکل محل تلاقي پاره خط ها با يکديگر در اين  Join  :	 وضعيت و ش

قسمت تعيين مي شود.

ــيوه هاي Join، بزرگنمايي خط يا   توجه: براي ديدن تفاوت هاي موجود در انواع ش

عرض خط دور را افزايش دهيد.

 Join انواع شيوه هاي
براي اعمال هر کدام از شيوه ها روي آيکن مربوطه کليک کنيد )شکل 8-23(. 

شکل 23-8 شيوه هاي Join اعمال شده به مسير

Miter: در محل تقاطع دو پاره خط، گوشه نوک تيز ايجاد مي کند.	

Round: در محل تلاقي دو پاره خط، منحني تشکيل مي دهد.	

Bevel: محل تلاقي دو پاره خط را برش مي زند، اصطلاحاً پخ مي کند.	

ــي پاره خط ها، گزينه Miter	 )نوع تيز(  ــي براي نقاط تلاق Miter  : وقت

انتخاب مي شود؛ عدد داده شده دامنه کشش تيزي را تعيين مي کند.
ــو مي توانيد  ــوي بازش ــتفاده از اين من ــا اس  ان�واع Dash:	 ب
ــن دو و .... تعيين کنيد ــي از اي ــا ترکيب ــا نقطه چين ي ــاظ خط چين ي ــط را از لح ــواع خ  ان

)شکل 8-24(.
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Arrowheads و dash شکل 24-8 انواع

با استفاده از اين منوي بازشو مي توان انواع پيکان ها را  	 :Arrowheads منوي بازش�و
براي ابتدا و انتهاي خط انتخاب شده، تعيين کرد. 

Brush 2-3-8 گزينه

ــواع قلم هاي موجود تغيير  ــاس ان ــتفاده از اين گزينه مي توان نوع خط دور را بر اس با اس
ــده اند و داراي انواع  ــوي Modify ايجاد ش ــط فرمان Brush در من ــا قبلًا توس ــن قلم ه داد. اي
ــتند. اين قلم ها در منوي بازشوي مربوطه که شامل انواع طرح ها  طرح هاي گرافيکي زيبا هس

و الگوهاست قابل مشاهده و انتخاب هستند.
بعد از انتخاب قلم موي موردنظر، مي توانيد براي انتخاب نمونه هاي ديگر قلم روي دکمه 

Options کليک کنيد تا منويي مطابق شکل 25-8 باز شود.

Options شکل 25-8 منوي مربوط به دکمه



Free Hand پيمانه مهارتی : کاربر
207واحد کار هشتم: توانايی استفاده از پرکننده ها و فرمان های ويرايش اشياء

ــت فايل هاي مربوط به قلم هاي آماده يک فايل  با انتخاب گزينه Import مي توانيد از ليس
را انتخاب کنيد.

در کادر محاوره Import Symbols مي توانيد قلم مورد نظر را انتخاب و وارد ليست مجموعه 
قلم ها کنيد. حال خطوط دور شکل انتخاب شده با طرح قلم انتخابي طراحي مي شود )شکل 

.)8-27
: اين گزينه براي تعيين اندازه قلم به کار مي رود.

 نکته: مي توانيد با استفاده از گزينه New مربوط به دکمه Options يک قلم جديد 
تعريف کنيد.

  

Brush شکل 26-8 کادرانتخاب نوک قلم مو                                 شکل 27-8 نحوه تأثير گزينه

 نکته: براي تبديل يک موضوع ترسيمي انتخاب شده، به قلم مو کافي است فرمان 
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زير را اجرا کنيد:
Modify→Brush→Create Brush 

Custom 3-3-8 گزينه

اين گزينه امکان انتخاب مدل ها و شکل هاي آماده را براي خطوط دوراشکال فراهم مي سازد 
)شکل 28-8(. اين مدل ها در مانيتور قابل مشاهده نيستند و فقط در چاپ ديده مي شوند. 
ــکل هاي آماده را تعيين مي کند و کادر  در اين بخش کادر Length	 بلندي يا طول ش

Spacing فاصله بين شکل  هاي آماده Custom را تنظيم مي کند.

Stroke در انواع Custom شکل 28-8 گزينه

Pattern 4-3-8 گزينه

ــتند که مي توانيد آن ها را ويرايش کرده و به صورت دلخواه  الگوهاي از قبل آماده اي هس
درآوريد و به لبه ها و خطوط دور موضوعات نسبت دهيد.

 Postscript 5-3-8 گزينه

ــما امکان مي دهد تا از الگوهاي مبتني بر بردارهاي رياضي براي خطوط   اين گزينه به ش
دور اشکال استفاده کنيد.

ــير )Stroke( حذف  ــط دور مس ــل Swatches، خ ــه   از پن ــا انتخاب گزين  نکت�ه: ب
مي شود.

تمرين 6:
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1- شکل 29-8 را طراحي کرده و به عنوان قلم مو تعريف کنيد.  
2- براي افزايش مهارت کار با انواع Stroke، شکل 30-8 را رسم کنيد. 

           

                                         شکل 29-8                                       شکل 8-30

      Eye Dropper4-8 ابزار
ــتفاده در رنگ آميزي موضوعات ديگر  اين ابزار براي نمونه برداري از رنگ موضوعات و اس

کاربرد دارد.
ــمت دلخواه شکل 31-8 )سمت چپ( نمونه برداري کرده و  تمرين 7: از رنگ قس

شکل سمت راست را با آن رنگ کنيد. 

شکل 31-8 نمونه برداري از رنگ شکل

Create 5-8 فرمان
ــوي Xtras مي توانيد روي کار جلوه هايي به وجود  ــتفاده از فرمان هاي موجود در من با اس
ــه فرمان Emboss ، Blend و Trap است  ــد. اين منو شامل س آوريد که کار زيباتر به نظر برس

)شکل 8-32(.

Create شکل 32-8 فرامين موجود در منوي
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Blend 1-5-8 فرمان

ــتفاده مي شود.  ــاندن دو موضوع انتخابي اس از اين فرمان براي ترکيب کردن يا به هم رس
چون اين فرمان از گزينه هاي Combine نيز است بنابراين در واحد کار 10 با جزييات بيشتر 

آن آشنا خواهيد شد.
Emboss 2-5-8 فرمان

ــتفاده از اين فرمان مي توان انواع جلوه هاي برجسته سازي را روي موضوعات انتخاب  با اس
شده نمايش داد.

Emboss روش كار با فرمان
1- موضوع گرافيکي مورد نظر را انتخاب کنيد.

ــکل  ــانXtras→Create→Emboss  را اجرا کنيد. کادر محاوره Emboss مطابق ش 2- فرم
33-8 ظاهر مي شود.

ــامل Ridge ، Chisel، Deboss، Emboss و  ــتگي که ش 3- از پنج نوع جلوه مربوط به برجس
Quilt مي شود، يکي را انتخاب کنيد )شکل 8-34(.

 Emboss شکل 33-8 کادر محاوره

شکل 34-8 انواع برجستگي

ــان داده شده  ــتگي نش ــکل 35-8 نتيجه حاصل از تأثير انواع جلوه هاي برجس 4- در ش
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است.
5- در منوي بازشوي Vary دو گزينه Contrast وColor  قرار دارد )شکل 8-36(.

    

Vary شکل 35-8 نتيجه حاصل از تأثير انواع جلوه هاي برجستگي            شکل 36-8 گزينه

ــتگي را در لبه هاي  ــده Depth عمق فرورفتگي يا ضخامت برجس ــه لغزن 6- کادر و دکم
موضوع گرافيکي انتخاب شده تعيين مي کند.

7- با استفاده از کادر Angle مي توانيد سايه را با زاويه دلخواه  روي شکل ايجاد کنيد.
ــتگي در لبه هاي موضوع  ــه جلوه برجس ــود ک ــاب گزينه Soft Edge باعث مي ش 8- انتخ

گرافيکي انتخاب شده، هموارتر و نرم تر نشان داده شود.
ــاهده نحوه تأثيرگذاري تنظيمات روي موضوع گرافيکي انتخاب شده، روي  9- براي مش

دکمه Apply کليک کنيد و اگر از نتيجه راضي هستيد روي دکمه OK کليک کنيد.

 مثال 2: شکل 37-8 را رسم کنيد و به آن برجستگي با سايه اي به رنگ قرمز و 
لبه هاي نرم و هموار بدهيد.  

شکل 8-37

پس از رسم، براي دادن جلوه برجستگي به شکل ابتدا آن را انتخاب کنيد، سپس فرمان 
 Vary ــوي ــرا کنيد. در کادر محاوره Emboss در منوي  بازش Xtras→Create→Emboss را اج
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ــکل 38-8 قرمز قرار  ــمتShadow  مطابق ش گزينه Color را انتخاب کنيد و رنگ را در قس
دهيد. براي هموار بودن سايه بايد گزينه  Soft Edge فعال باشد.

                                                                                                                                                                                                                                 

شکل 38-8 تنظيم رنگ قرمز براي ايجاد سايه                  شکل 8-39

Trap 3-5-8 فرمان

ــود. زماني که تصويري با رنگ  ــتفاده مي ش اين فرمان هنگام چاپ گرفتن از يک کار، اس
سياه روي تصاوير رنگي ديگر قرار گرفته باشد، اين فرمان رنگ هاي زير ناحيه سياه را حذف 

مي کند به صورتي که در مصرف جوهر پرينتر صرفه جويي مي شود.
همچنين اين فرمان رنگ ها را به شکل مناسب روي هم قرار مي دهد به طوري که هنگام 

چاپ، زمينه کاغذ معلوم نباشد. 

Trap شکل 40-8 کادر محاوره

Distort 6-8 فرمان
ــت که به منظور اضافه  ــامل دو فرمان Add Points و Fractalize اس ــوي Distort ش زيرمن
کردن گره هاي جديد روي مسير و تغيير شکل دادن موضوعات گرافيکي انتخاب شده به کار 

مي روند )شکل 8-41(.
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Distort شکل 41-8 گزينه

Add Points 1-6-8 فرمان

ــير يا موضوع گرافيکي انتخاب  ــتري به مس با اجراي اين فرمان مي توانيد تعداد گره بيش
شده، اضافه کنيد.

براي استفاده از فرمان Add Points مراحل زير را انجام دهيد:
1- موضوع دلخواهي را انتخاب کنيد.

2- فرمـان Xtra→Distort→Add Points را اجـرا کنيد يا روي  آيکـن  از نـوار ابزار
Xtra Operations کليک کنيد.

ــکل  ــود )ش ــن يک جفت از نقاط موجود اضافه مي ش ــورت نقاط جديدي بي ــن ص در اي
.)8-42

Add Points شکل 42-8 شکل سمت راست، نتيجه اجراي فرمان

Fractalize 2-6-8 فرمان

ــاد کرد. معمولاً از  ــاده يا پيچيده اي را ايج ــتفاده از اين فرمان مي توان الگوهاي س ــا اس ب
اجراي مکرر فرمان Fractalize روي يک موضوع، الگوهاي جالبي ايجاد مي شود.

 مثال 3: 1- يک ستاره مطابق شکل 43-8 رسم و آن را انتخاب کنيد.

شکل 43-8 رسم و انتخاب شکل

ــاهده  کنيد  ــرده و نتيجه را مش ــار اجراک ــان Xtras→Distort→Fractalize را 3 ب  2- فرم
)شکل 8-44(.
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Fractalize شکل 44-8 نتيجه 3 بار اجراي فرمان

تمرين 8: شکل 45-8 را رسم کرده و فرمان Fractalize را 5 بار روي آن اعمال 
کنيد.

 
شکل 8-45

ــين مراحل زير را انجام   مث�ال کاربردي: در ادامه مثال کاربردي واحد کار پيش

دهيد:
1- اکنون براي ايجاد کارت ويزيت صفحه جديدي باز کنيد. 

2- ابعاد کارت ويزيت 5×9 سانتي متر است، اما چون مي خواهيم واحد صفحه را ميلي متر 
در نظر بگيريم، ابعاد صفحه را به صورتw = 50 وh = 90 وارد کنيد. 

ــت بزرگنمايي قرار دهيد تا کار در صفحه  ــتفاده از ابزار Zoom صفحه را در حال 3- با اس
براي شما آسان تر شود.

     ، w = 50 و  h = 7 ،Object ـــم کنيد و ابعـاد آن را در پنل ــي در صفحه رس 4- چهارگوش
x =0 و y = 83 قرار دهيد، سپس داخل چهارگوش را با رنگ سياه پر کنيد.

شکل 8-46
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5- تغييرات را در فايلProject.fh11  ذخيره کنيد.
واژه نامه

Bevelکج کردن، اريب

Blendآميختن، مخلوط کردن 

Brushقلم مو

Combineترکيب کردن

Coneمخروطي شکل کردن

Eye dropperقطره چکان

Gradientطيف رنگ

Hatchهاشورزدن

Lensلنز، عدسي

Magnifyذره بين

Miter limitگردکردن خط

Patternالگو

Reductionکاهش

Removeحذف کردن

Transparencyشفافيت

خلاصه مطالب 

از گزينه Fill در پنل Object	 براي پر کردن رنگ داخل موضوعات و مسيرها استفاده 
مي شود.

ــل موضوعات انتخابي به کار  ــراي رنگ آميزي خط دور و محتواي داخ ــرح Basic	 ب ط
مي رود.

ــروع و به رنگ هاي ديگر  ــت که از يک رنگ ش ، طيف رنگي اس 	Gradient ــور از منظ
تبديل مي شود.

ــتند که به موضوعات نماي بافت  ــده Textured	 تصاوير گرافيکي آماده اي هس پرکنن
مي دهند. 
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ــتند که مي توانيد در ترسيمات به جاي رنگ از  ، الگوهايي هس 	Pattern پرکننده هاي
آن ها استفاده کنيد. 

 	Tiled ليستي از الگوهاي آماده را براي پر کردن داخل شکل و گزينه Custom گزينه
از طرح هاي پرکننده است و زماني به کار مي رود که در طراحي لازم است يک شکل 

از قبل طراحي شده در داخل يک طرح ديگر تکرار شود.
ــکل را با معکوس کردن رنگ ها، تغيير  ــتفاده از پر کننده لنز مي توان ظاهر ش با اس 	

شفافيت، رنگ، روشني، تيرگي يا بزرگنمايي، تغيير داد.  
منظور از Stroke ضخامت خطوطي است که دور موضوعات را احاطه مي کند.	

ــتفاده در رنگ آميزي  ــزار Eye dropper	 براي نمونه برداري از رنگ موضوعات و اس اب
موضوعات ديگر کاربرد دارد.

با استفاده از فرمان Emboss	 مي توان انواع جلوه هاي برجسته سازي را روي موضوعات 
انتخاب شده نمايش داد.

ــب روي هم قرار مي دهد به طوري که هنگام  ــکل مناس رنگ ها را به ش 	Trap  فرمان
چاپ،  زمينه کاغذ معلوم نباشد.
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعيين کنيد.

ــاي دادن رنگ به  ــتند که به ج ــي آماده اي هس ــر گرافيک ــده Gradient تصاوي 1- پرکنن
موضوعات به آن ها نماي بافت مي دهند.

2- از گزينه Fill براي پرکردن رنگ داخل موضوعات و مسيرها استفاده مي شود.
ــتفاده در رنگ آميزي  ــراي نمونه برداري از رنگ موضوعات و اس ــزار Eye dropper ب 3- اب

موضوعات ديگر کاربرد دارد.
ــت؛ با اين تفاوت که تغيير رنگ ها به طور  4- طيف مخروطي مانند طيف رنگ خطي اس

نامساوي صورت مي گيرد.
معادل گزينه  هاي سمت  راست را از ستون سمت  چپ انتخاب کرده و مقابل هر عبارت بنويسيد.

5- با انتخاب اين نوع Gradient، رنگ داخل موضوع انتخاب شده از مرکز شروع مي شود 
و يک کره ايجاد مي کند. اين شيب يک شيب مدور است.                           شيب تابعي

ــود براساس شکل مسيري است که  6- تغيير رنگي که در اين نوع Gradient اعمال مي ش
انتخاب کرده ايد.                                                                            شيب کروي
  Trap      .7- با استفاده از اين فرمان مي توان الگوهاي ساده يا پيچيده اي را ايجاد کرد
                                  Fractalize                 .8- اين فرمان هنگام چاپ گرفتن از يک کار، استفاده مي شود

گزينه صحيح را انتخاب کنيد.

9- در قسمت Fill براي پرکردن مسير انتخاب شده از الگوهاي آماده، کدام گزينه استفاده 
مي شود؟

Postscript -ب   Tiled -الف
Pattern -د   Gradient -ج

 Fill ــدام گزينه انواع ــده از ک ــکال انتخاب ش ــراي اعمال طيف رنگي در داخل اش 10- ب
استفاده مي شود؟

 Gradient-ب   Basic -الف
 Postscript  -د   Textured -ج
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11 کدام يک از پرکننده مسيرها روي صفحه نمايش ديده نمي شود؟
 Pattern-ب   Textured -الف

د- گزينه هاي الف و ج صحيح هستند.   Custom -ج
12- گزينه Cap در قسمت Stroke چه کاربردي دارد؟

ب- تعيين گردي گوشه هاي موضوعات  الف- تعيين نوع زاويه بين دو خط 
د- تعيين رنگ انتخابي خطوط در مسيرها  ج- تعيين وضعيت انتهاي خطوط 

13- براي رنگ برداري از کدام ابزار استفاده مي شود؟
Stroke -د      Postscript -ج  Lens  -ب   Eye Dropper-الف

14- کدام نوع Gradient در شکل زير به کار رفته است؟
الف- خطي   
ب- تابعي    
ج- کروي    
د- مخروطي

در جاي خالي عبارت مناسب را بنويسيد.

15- ضخامت خطوطي که دور موضوعات را احاطه کرده است .............. ناميده مي شود.
ــاندن دو موضوع انتخابي  ــراي ترکيب کردن يا به هم رس ــان ........................ ب 16- از فرم

استفاده مي شود.
17- با استفاده از فرمان Emboss مي توان ................. را روي موضوعات نمايش داد.

به سؤالات زير پاسخ تشريحی دهيد.

18- براي حذف ضخامت خطوط مسيرها چه بايد کرد؟
19- چگونه مي توان به جاي رنگ، موضوعات را از الگوها و بافت ها پر کرد؟

20- با انتخاب کدام گزينه مي توان قلم از قبل تعريف شده را به خطوط موضوعات نسبت 
داد؟

آزمون عملي
1- غروب خورشيد )در کنار دريا( را ترسيم کنيد و تأثير Lens را در آن بررسي کنيد.

2- براي شعر زير تصويرسازي کنيد. توجه داشته باشيد که از انواع پرکننده هاي گرافيکي 



Free Hand پيمانه مهارتی : کاربر
219واحد کار هشتم: توانايی استفاده از پرکننده ها و فرمان های ويرايش اشياء

ــکل  ــازي و تغيير ش ــت، الگوهاي آماده، تکرار طرح، جلوه برجسته س ــر طيف رنگ، باف نظي
موضوعات گرافيکي )Fractalize( در ترسيم استفاده کنيد.

دو تا کفتر
نشسته اند روي شاخه سدر کهنسالي

که روييده غريب از همگنان در دامن کوه قوي پيکر
پس از اين کوه تشنه دره اي ژرف است،

در او نزديک غاري تار و تنها، چشمه اي روشن
ازينجا تا کنار چشمه راهي نيست.

                                                           "اخوان ثالث"
3- شکل يک دکمه )Button( را با عنوان START  براي شروع اجراي يک برنامه طراحي 

کنيد سپس با استفاده از جلوه برجستگي مناسب، فشرده شدن دکمه را نمايش دهيد.
4- شکل زير را رسم کرده و به عنوان طرح روي جعبه دستمال کاغذي به ابعاد 20×30 

قرار دهيد.

ــان داده شده، انجام  ــکل نش ــب )Label( روي CD را به طوري که در ش 5- طراحي برچس
دهيد.
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كليات
یک��ي از موارد مهم��ي که در طراحي اهميت دارد، حروف نگاري و تایپ متون اس��ت. در 
طراحي موضوعاتي نظير کاتالوگ، س��ربرگ، طرح بس��ته بندي و ... علاوه  بر تصویر، نيازمند 
عناصر متني نيز هستيد.   FreeHand توانایي هاي بسياري در زمينه تایپ، ترازبندي و ایجاد 
جلوه ه��اي بصري دارد و یکي از ویژگي هاي برجس��ته این برنام��ه، کيفيت بالاي چاپ متون 

نسبت به نرم افزارهاي پيکسلي است. 
در  FreeHandنمي توان متون فارس��ي را تایپ کرد، بنابراین کاربران باید براي دسترسي 

به امکان تایپ فارسي از برنامه هاي جانبي استفاده کنند.
Text 1-9 ابزار

ب��ه ط��ور کل��ي در برنام��ه FreeHand MX متن به دو ص��ورت س��اده و پاراگرافي ایجاد 
مي شود. 

1-1-9 نگارش متن ساده

براي شروع به تایپ متن ساده مراحل زیر را دنبال کنيد:
1- صفحه جدیدي ایجاد کرده و ابزار متن )Text( را از جعبه ابزار انتخاب کنيد.

2- در محل موردنظر از صفحه کليک کنيد تا مکان نماي چش��مک زن به همراه خط کش 
ویژه تایپ نمایان شود )شکل 9-2(.

                       

شکل 2-9 متن ساده  Text شکل 1-9 انتخاب ابزار              

 نكت�ه: خط ک��ش متن براي افزای��ش دقت عمل در هنگام تای��پ از طریق منوي 
View   Text Rulers یا کليد ميانبر /  +  Ctrl   قابل دسترسي است.

3-  اکنون مي توانيد متن موردنظر را تایپ کنيد یا متن تایپ ش��ده در برنامه دیگري را 
وارد این محل کنيد.
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4- براي خاتمه دادن به کار تایپ کافي است توسط ابزار Pointer  در نقطه اي خارج 
از محيط تایپ، کليک کنيد.

2-1-9 نگارش متن پاراگرافي

براي ایجاد متن پاراگرافي به صورت زیر عمل کنيد:
1- ابزار Text را از جعبه ابزار انتخاب کنيد.

2- یک کادر مس��تطيل با درگ ماوس )بلوک متن( ایجاد کنيد. فاصله کش��يدن ماوس 
اندازه بلوک متني را تعيين مي کند. 

 3- پ��س از ره��ا ک��ردن م��اوس بل��وک متن��ي و خط کش مت��ن را مش��اهده مي کنيد 
)شکل 9-3(.

4- متن را تایپ کنيد. 

شکل 3-9 متن پاراگرافي

3-1-9 اعمال تنظيمات روي متن 

مي توانيد قبل یا بعد از تایپ متن تنظيمات مختلفي را روي متن اعمال کنيد، براي این 
منظور یکي از سه روش بعد را برگزینيد:

 Text 1- استفاده از نوار ابزار
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Text شکل 4-9 نوار ابزار

براي ظاهر کردن این نوار ابزار در بالاي صفحه، دو روش وجود دارد:
	Window→Toolbars→Text انتخاب گزینه
	Text کليک راست در محدوده خالي نوار ابزارهاي دیگر و انتخاب گزینه

Text 2- استفاده از منوي
تنظيمات متون، جلوه هاي ویژه متن و سایر فرامين در این منو قرار دارند.

 Object 3- استفاده از پنل
با انتخاب ابزار Text و کليک روي صفحه یا انتخاب متن نوشته شده، گزینه هاي کنترلي 
آن ب��ه طور خودکار در پنل Object ظاهر مي ش��وند. این پن��ل کامل ترین تنظيمات را براي 

کنترل متون سطري و پاراگرافي در خود جاي داده است )شکل 9-5(.       

     شکل 5-9 پنل Object مربوط به خواص متن
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2-9 انتخاب و تنظيمات متن  
قبل از تایپ متن مي توانيد تنظيماتي نظير تغيير اندازه و نوع قلم را انجام دهيد و در صورتي 

که بخواهيد بعد از تایپ متن به ویرایش آن بپردازید، باید ابتدا متن را انتخاب  کنيد.
روش هاي انتخاب متن

1-2-9 انتخاب محدوده اي از متن

1- توس��ط ابزار Pointer روي متن دابل کليک کنيد تا علامت چشمک زن در متن ظاهر 
شود.

2- با استفاده از کليد  Shift در محلي که مي خواهيد انتخاب متن تمام شود، کليک کنيد 
یا با کشيدن نشانگر ماوس روي متن، آن را به حالت انتخاب درآورید.  

2-2-9 انتخاب كل متن 

توس��ط ابزار Pointer روي متن کليک کنيد تا دس��تگيره هاي کنترلي در اطراف آن ظاهر 
شود در این صورت کل متن در حالت انتخاب قرار مي گيرد.

پ��س از انتخاب متن مي توانيد تنظيماتي نظير تغيير نوع و اندازه قلم را روي متن اعمال 
کنيد.

3-2-9 تنظيمات متن 

تغيير تنظيمات از طریق یکي از روش هاي ذکر ش��ده در بخش 3-1-9 انجام پذیر اس��ت 
که به طور نمونه با اس��تفاده از پنل Object به توضيح آن مي پردازیم. توجه داشته باشيد که 

دکمه Character  در حالت انتخاب باشد.
تغییر نوع قلم: از منوي بازشويFont  Name در پنل Object	 قلم    موردنظر را انتخاب 

کنيد. تعداد  این قلم ها به تعداد فونت هاي نصب شده در ویندوز بستگي دارند.  
تغییر اندازه قلم: از منوي بازش��وي Type Size در پنل Object	 اندازه قلم را تعيين 

کنيد.
 : Text از منوی Size نكته: در انتخاب گزینة 

با اس��تفاده از گزینة smaller یا فش��ردن کليد ) , + Ctrl + Shfit	 ( اندازه قلم یک سایز 
کوچکتر می شود.

با اس��تفاده از گزینة smaller یا فش��ردن کليد ) . + Ctrl + Shfit	 ( اندازه قلم یک سایز 
کوچکتر می شود.
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. با استفاده از گزینة other برای تایپ اندازه دلخواه به کار می رود	

 
 

                 شکل 6-9 تغيير نوع قلم                    شکل 7-9 تغيير اندازه قلم

مي توانيد ب��ا وارد کردن مق��دار مثبت یا منفي  تغیی�ر فاصله بین ح�روف کلمات: 	
برحس��ب درصد در کادر Kerning واقع در پنل Object، فاصله بين حروف را افزایش 

یا کاهش دهيد.

شکل 9-8

اگر دس��تگيره هاي کنترلي وسط در س��مت چپ یا راست کادر را بکشيد، مي توانيد  	
فاصله بين حروف متن )Kerning( را افزایش یا کاهش دهيد )شکل 9-9(.

شکل 9-9 تغيير فاصله بين حروف متن

 ، 	Object در پنل Baseline Shift انتقال خط مبنا: با وارد کردن مقادیر مثبت در کادر
حرف به بالاي خط مبناي مربوط به متن منتقل مي شود و مقادیر منفي، حرف را به 
پایين خط مبنا انتقال مي دهد.شکل10-9 نحوه عملکرد این کادر را نشان مي دهد.

شکل 9-10
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4-2-9 اعمال رنگ به متن

براي این منظور عمليات زیر را انجام دهيد:
1- متن موردنظر را انتخاب کنيد.

2- رنگ موردنظر را از ابزارهاي رنگ واقع در جعبه ابزار Tools برگزینيد.
اب��زارFill Color ، داخل متن و اب��زار Stroke Color، خطوط پيرامون متن را رنگ مي کند. 
براي مش��اهده تغييرات رنگ بهتر است اندازه متن را بزرگ کنيد )توضيحات بيشتر در مورد 

انواع روش هاي رنگ آميزي در واحد کار 7 ذکر شده است(. 

 مثال 1: براي بالا بردن توانایي عمليات روي متن، مراحل زیر را انجام دهيد:
1- صفحه جدیدي به اندازه A5 با واحد سانتي متر ایجاد کنيد.

2- نوار ابزار Text را نمایش دهيد.
3- قل��م Arial  را از من��وي Text→Font انتخ��اب کرده و اندازه 36 را ب��راي آن تعيين 

کنيد.
FreeHand MX is Vector based drawing                   .4- جمله روبه رو را تایپ کنيد

5- با استفاده از پنل Object سبک قلم را پررنگ )Bold( کنيد.
6- با استفاده از پنل Object فاصله ميان حروف کلمه FreeHand را 10% افزایش و کلمه 

Vector را 20-% کاهش دهيد، سپس به حالت اوليه بازگردید.

7- کل سطر را در زیر سطر جاري کپي کنيد.
8- ب��ا اس��تفاده از نوار ابزار Text ان��دازه قلم کلمه drawing س��طر دوم را به 14 کاهش 

دهيد.
 Object یا قلم نازک را از پنل Plain را از سطر اول انتخاب کرده و سبک Vector 9- کلمه

برگزینيد.

تمرين 1: براي کلمه "خرد" طراحي حروف کنيد.
 Text 3-9 منوي

با اس��تفاده از من��وي Text و زیرمنوهاي آن مي توانيد علاوه ب��ر تنظيمات مربوط به نوع 
فونت، اندازه، سبک )Style( و ترازبندي متن، جلوه هاي ویژه اي نيز به متن اعمال کنيد.
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)Text Effects( 1-3-9 جلوه هاي متن

در FreeHand MXa ب��راي زیبات��ر و هنري ش��دن کار از جلوه هاي ویژه متني اس��تفاده 
مي شود. روش هاي دسترسي به این جلوه  ها به صورت زیر است:

	Text در منوي Effect استفاده از گزینه
	Object در پایين پنل Effect استفاده از منوي بازشوي

Object واقع در پنل Effect شکل 11-9 گزینه هاي موجود در منوي

Inline 1-1-3-9 جلوه
این جلوه براي رسم خط یا قاب، دور حروف متن انتخابي به کار مي رود. گاهي در طراحي 
براي برجسته شدن متن یا تمایز بهتر حروف از زمينه زیر آن، لازم است از این جلوه استفاده 

شود.
ايجاد جلوه Inline روي متن

1- متن موردنظر را برگزینيد.
  Effectرا از منوي بازشوي Inline را انتخاب کنيد )گزینه Text→Effect→Inline 2- گزینه
 در پن��ل Object برگزیني��د.( تا کادر مح��اوره Inline Effect روي صفحه نمایش ظاهر ش��ود 

)شکل 9-12(.
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Inline Effect شکل 12-9 کادر محاوره

این کادر شامل قسمت هاي زیر است:
Count: تعداد خطوطي را که در اطراف حروف متن قرار مي گيرد، تعيين مي کند.	

Stroke: در این قسمت ضخامت و رنگ خط دور متن تعيين مي شود.	

، فاصل��ه بين خط دور تا لبه حروف  	Width ب��ا این گزینه در قس��مت :Background

تعيين مي ش��ود و با انتخاب رنگ در این قس��مت، فضاي بين خط تا حروف از این 
رنگ پر مي شود.

تمرين 2:
1- در چه صورت خط به دور حروف مي چسبد؟

2- متن شکل 13-9 را تایپ کنيد.

شکل 9-13

 Highlight 2-1-3-9 جلوه
این جلوه یک کادر رنگي در پشت متن انتخابي قرار مي دهد که به منظور شاخص کردن 
متن ب��ه کار مي رود. با اجراي این گزینه از مس��ير Text→Effect→Highlight، کادر محاوره 

مربوط به این جلوه روي صفحه نمایش ظاهر مي شود )شکل 9-14(.
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شکل 14-9 کادر محاوره Highlight Effect  و دو نمونه کاربرد این جلوه

این کادر شامل قسمت هاي زیر است:
Position:	 مح��ل قرار گيري کادر را در زیر متن به صورت عددي تعيين کرده، اعداد 

مثب��ت  کادر را از مت��ن بالات��ر مي برد و اعداد منف��ي کادر را پایين ت��ر از متن قرار 
مي دهد.

ای��ن منوي بازش��و کادر رنگي زمينه را به صورت خطوط هاش��ور مش��خص  	 :Dash

مي کند.
توس��ط گزینه هاي این قسمت مي توانيد ضخامت، رنگ پس زمينه یا هاشور  	 :Stroke

را تعيين کنيد.

 توجه: گزینه Overprint روشي است براي جبران خطاي ترکيب رنگ که در زمان 
چاپ رخ مي دهد.

 Shadow3-1-3-9 جلوه
یک��ي  دیگر از جلوه هاي  جالب��ي که مي توانيد روي  متن و حروف اعمال  کنيد، س��ایه دار 
 کردن آن هاس��ت. با اجراي گزینه Text→Effect→Shadow کادرمحاوره Shadow Effect ظاهر 

مي شود )شکل 9-15(.

شکل 15-9 کادرمحاورهShadow Effect  و تأثير آن روي متن
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این کادر شامل گزینه هاي زیر است:
Offset: در کادرهاي x و y	 محل دقيق قرار گرفتن سایه براساس محورهاي مختصات 

تعيين مي شود.
Color:	 در این قسمت رنگ سایه تعيين شده و توسط دکمه لغزنده ميزان تيرگي و 

روشني سایه تنظيم مي شود.
مثال 2: جلوه هاي نشان داده شده در شکل 16-9 را اعمال کنيد.

شکل 9-16

1- ابتدا متن را تایپ کنيد به طوري که اندازه قلم 120 باشد.
2- کل متن را انتخاب کرده و جلوه Highlight را با تنظيمات ش��کل 17-9 به آن اعمال 

کنيد.
3- ح��روف C و R را جداگان��ه انتخاب کرده، جلوه Shadow را همراه با تنظيمات ش��کل 

17-9 به آن ها اعمال کنيد.

شکل 9-17

 Strikethrough 4-1-3-9 جلوه
این جلوه خطي رسم مي کند که از روي متن مي گذرد. 

با اجراي گزینه Text→Effect→Strikethrough کادر محاوره این جلوه مطابق شکل 9-18 
نمایش داده مي شود که در این شکل، جلوه نقطه چين و خط، نشان داده شده است.      
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شکل 18-9 کادر محاوره Strikethrough Effect  و تأثير آن روي متن

این کادر محاوره شامل قسمت هاي زیر است:
Position: محل قرار گيري خط را در روي متن تعيين مي کند.	

Dash: نوع خط را تعيين مي کند.	

Stroke: در این قسمت ضخامت و رنگ خط تعيين مي شود.	

 Underline 5-1-3-9 جلوه
 از ای�ن جل��وه ب��راي کشيدن خط در زیر متن استف�اده م�ي شود. بدین منظور کافي است گزین�ه
"Text→Effect→Underline را انتخاب کنيد تا کادر محاوره آن مطابق شکل 19-9 ظاهر شود. در 

ش��کل 19-9 دو نوع جلوه زیرخط به صورت خط- نقطه و خط، نش��ان داده شده است. کليه 
گزینه هاي کنترلي این کادر مانند تنظيمات کادر محاوره Strikethrough Effect است.

شکل 19-9 کادر محاوره Underline Effect  و تأثير آن روي متن

 Zoom 6-1-3-9 جلوه
یک��ي از جلوه هایي که تا حد زیادي در زیبای��ي متن و حروف در یک کار تبليغاتي تأثير 
مي گ��ذارد، جلوه Zoom اس��ت که این جلوه به متن و عبارت حالت پرس��پکتيو س��ه بعدي 
مي بخشد. براي اعمال این جلوه کافي است گزینه Text→Effect→Zoom را انتخاب کنيد تا 

کادر محاوره آن مطابق شکل 20-9 ظاهر شود.
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شکل 20-9 کادر محاوره Zoom Effect  و تأثير آن روي متن

این کادر محاوره شامل قسمت هاي زیر است:
کوچکي حالت سه  بعدي را برحسب در صد تعيين  Zoom To: این قس��مت بزرگي و 	

مي کند. به عبارت دیگر درصد بزرگنمایي و پخش شدگي جلوه سه بعدي را مشخص 
مي کند.

قرار دارند که توس��ط آن ه��ا مي توانيد محل  	 y و x در ای��ن قس��مت دو کادر :Offset

دقيق قرار گيري این جلوه را تعيين کنيد. اعداد بزرگ تر به عمق س��ه بعدي حروف 
مي افزاید.

From: این قسمت رنگ شروع جلوه سه بعدي را مشخص مي کند.	

To: این قسمت رنگي را تعيين مي کند که جلوه سه بعدي به آن خاتمه مي یابد. 	

رنگ در حالت پيش فرض از سياه به سفيد است.

 توج�ه: انتخاب گزینه None از مس��ير Text→Effect هر نوع جلوه متني را از بين 

مي برد.

تمرين 3:
1- مت��ن Working with text blocks را تایپ کرده، س��پس اثرجلوه هاي  متني  را روي  آن 

بررسي کنيد.
2- طرح زیر را همراه با جلوه هاي متني آن رسم کنيد )شکل 9-21(.
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 شکل 9-21 

 Attach To Path2-3-9 گزينه
یکي از جلوه هاي هنري در طراحي، متصل کردن متن به مس��ير رس��م ش��ده اس��ت؛ از 
این ویژگي براي پيچ و تاب دادن متون در مس��يرهاي منحني، بيضي و نظير این ها اس��تفاده 

مي شود. براي این منظور مراحل بعد را انجام دهيد:
1- متن موردنظر را تایپ کرده و به وسيله ابزار Pen مسير دلخواهي را روي  صفحه رسم 

کنيد )از اشکال دایره، بيضي، چند ضلعي و ... نيز مي توان استفاده کرد(.
2- ابتدا متن را انتخاب کرده، سپس کليد Shift را نگه دارید و مسير را برگزینيد.

3- دستورText→Attach To Path  را اجرا کنيد یا روي آیکن  از نوار ابزار Text کليک 
 کنيد. در این صورت متن به مسير مي چسبد و با آن تراز مي شود و مسير حذف خواهد شد 

)شکل 9-22(.

شکل 22-9 نحوه اتصال متن به مسير     

 Text on a path در س��اختار درختي بخش Object نكت�ه: در صورت��ي که در پنل 
را انتخاب کنيد، گزینه Show Path ظاهر مي ش��ود ، ب��ا فعال کردن این گزینه مي توانيد پس 
از اجراي فرمان Attach To Path مس��ير را همراه متن داشته باشيد و از حذف آن جلوگيري 

کنيد.

تمرين 4: طرح شکل 23-9 را رسم کنيد.
براي حرکت دادن متن در امتداد مس��ير، ابتدا با ابزار Pointer مسير را انتخاب کنيد؛ در 
این صورت یک مثلث سفيد رنگ کوچک ظاهر مي شود. اکنون مي توانيد مثلث کنار متن را 

بکشيد تا متن در امتداد مسير حرکت کند.
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         شکل 23-9                               شکل 24-9 نمایش مثلث کنار متن

 نكته: کليد ميانبر گزینه Ctrl+Shift+Y ،Attach To Path است.

 Detach From Path3-3-9 گزينه

براي جدا کردن متن از مس��ير، فرمان Detach From Path در منوي Text یا آیکن  
در نوار ابزار Text را انتخاب کنيد.

 توجه: براي تغيير جهت متن در روي مسير کافي است کليد Alt را نگه داشته و با 

 Modify→Alter Path→Reverse Direction مسير را انتخاب کنيد سپس فرمان Pointer ابزار
را اجرا کنيد )شکل 9-25(.

شکل 25-9 تغيير جهت متن

 مثال 3: شکل 26-9 را رسم کنيد.
1- صفحه جدیدي را باز کنيد.

2- عبارت زیر را تایپ کنيد.
Macromedia Freehand MX With Attach To Path

3- ابزار رسم ستاره را انتخاب کرده و یک ستاره سه پر رسم کنيد.
4- اکن��ون روي ابزار Pointer کليک کرده و کليد Shift را پایين نگه دارید و روي متن و 

ستاره کليک کنيد تا هر دو انتخاب شوند.
5- ح��ال فرمان Attach To Path را از منوي Text یا از نوار ابزار Text اجرا کنيد. با انجام 
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این عمل متن به مسير مي چسبد.

شکل 9-26

تمرين 5: آرم زیر را طراحي کنيد.

 شکل 9-27 

تمرين 6: یک بروش��ور تبليغاتي در کاغذ A4 براي "هنرس��تان کاردانش گلشن" 
طراحي کنيد و آرم شکل 27-9 را در آن استفاده کنيد.

Convert To Path 4-3-9 گزينه

گاهي اوقات در هنگام طراحي لازم است یک متن از حالت نوشته خارج شده و به مسير 
یا ش��کل تبدیل ش��ود. در این صورت خصوصيات یک شکل را پيدا مي کند. براي این منظور 

مراحل زیر را انجام دهيد: 
1- متن موردنظر را تایپ کرده و آن را انتخاب کنيد.

2- از منوي Text گزینه Convert To Path یا آیکن  را از روي نوار ابزار Text انتخاب 
کنيد، در این صورت متن به مسير یا موضوع تبدیل مي شود )شکل 9-28(.

شکل 9-28
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 توجه: کليد ميانبر این گزینه Ctrl+Shift+P  است.

 نكته: پس از تبدیل متن به مس��ير، متن تمام خصوصيات متني خود را از دست 
مي دهد و دیگر قابل ویرایش )نظير تغيير قلم( نخواهد بود.

ب��راي تغيير دادن و جابه جایي ح��روف به صورت جداگانه در مت��ن مي توانيد متن  	
 ungroup آن را Modify تبدیل شده به مسير را انتخاب کرده، سپس از طریق منوي
ک��رده یا کليد Alt را در هنگام کليک روي هر مس��ير مج��زا نگه دارید تا یک حرف 

انتخاب شود، سپس بعد از اعمال تغييرات دوباره آن ها را Modify→Group کنيد. 
 تمرين 7: نشانه هاي بعدي را رسم کنيد.

شکل 9-29

Editor 5-3-9 گزينه

به منظور ویرایش متون و نوشته ها مي توانيد به دو صورت عمل کنيد: 
1- روي متن تایپ ش��ده توس��ط ابزار Pointer دابل کليک کنيد ت��ا علامت مکان نماي 

چشمک زن ظاهر شود، در این صورت مي توانيد به اصلاح متن بپردازید.
 Text روي متن کليک کنيد تا انتخاب ش��ود، س��پس از منوي Pointer 2- ابت��دا با ابزار
گزین��هEditor  را اجرا کنيد یا روي آیکن  از نوار ابزار Text کليک کنيد. در این صورت 

کادر محاوره Text Editor ظاهر مي شود و مي توانيد متن را به سادگي ویرایش کنيد.
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 توجه: اگر به وس��يله ابزار انتخ��اب subselect  روي متن دابل کليک کنيد، کادر محاوره 

Text Editor  به طور خودکار باز مي شود.

اگر گزینه 12Pt Black	 انتخاب ش��ود، متن به اندازه واقعي نمایش نمي یابد یعني در 
حقيقت متن کوچک مي شود تا تمامي آن در صفحه قابل مشاهده باشد.

اگ��ر گزین��ه Show Invisibles	 انتخاب  ش��ود، باعث نمایش کاراکتره��اي مجازي و 
غيرقابل چاپ مثل Space ،Tab و Enter مي شود ) شکل 9-30(.

Text Editor شکل 30-9 محيط

 Flow Inside Path6-3-9 گزينه

از این گزینه براي قرار دادن متن در داخل ش��کل یا درون یک مس��ير استفاده مي شود، 
به طوري که متن، قالب محيط شکل را به خود مي گيرد. این جلوه بيشتر براي زیباتر کردن 

ترکيب بندي متن و شکل در طراحي کاتالوگ و بروشور به کار مي رود.
نحوه اجراي این گزینه به صورت زیر است: 
1- متن پاراگرافي دلخواهي را تایپ کنيد.

2- شکل یا مسيري را ترسيم کنيد.
3- شکل و متن موردنظر را با هم انتخاب کنيد.

4- از منوي Text گزینه Flow Inside Path یا آیکن  را از نوارابزار Text انتخاب  کنيد 
)شکل 9-31(.                             
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Flow Inside Path شکل 31-9 تأثير فرمان 

 توجه: کليد ميانبر این گزینه Ctrl+Shift+U است.

نکاتي در مورد كادر لينک
ب��ه مربع کوچکي که در پایين، س��مت راس��ت کادر متن قرار گرفت��ه، کادر لينک گفته 

مي شود.
یک��ي از کاربردهاي آن زماني اس��ت که متن در کادر مت��ن جاي نمي گيرد و داخل کادر 
لين��ک دای��ره توپر قرار مي گي��رد. در این حال��ت مي توانيد با کليک روي دای��ره توپر داخل 
کادر لينک و کش��يدن آن به طرف ش��کل دیگر، ادامه متن را در آن شکل وارد کنيد )شکل 

.)9-32

شکل 9-32

در صورتي که کادر لينک سفيد باشد، نشان دهنده این است که کل متن در شکل  	
جا گرفته و قابل مشاهده است )شکل 33-9 سمت راست(.

در صورتي که یک دایره توپر در داخل کادر لينک وجود داش��ته باش��د نشانگر این  	
است که متن موجود در داخل کادر جا نمي گيرد یا به عبارتيOverflow  است )شکل 
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33-9 سمت چپ(.
در صورتي که علامت 	 در کادر لينک وجود داش��ته باش��د، نشانگر این است که 

کادر به کادر یا شکل دیگري مرتبط یا لينک شده است )شکل بالا 9-32(.

         

شکل 9-33

تمرين 8: شکل زیر را با استفاده از قابليت Flow Inside Path طراحي کنيد.

 

شکل 9-34

 Flow Around Selection 9-3-7

به منظور قرار دادن متن پاراگرافي در اطراف یک ش��کل رس��م ش��ده یا وارد شده به کار 
مي رود )شکل 9-35(. 
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Flow Around Selectionشکل 35-9 تأثير فرمان

روش کار به صورت زیر است: 
1- ابزار تایپ را انتخاب کرده و با انجام عمل درگ یک کادر مستطيلي براي نوشتن متن 

پاراگرافي روي صفحه ایجاد کنيد، سپس متن موردنظر را  داخل آن تایپ کنيد.
2- یک تصویر را وارد FreeHand کرده یا یک ش��کل دلخواه را ترس��يم کنيد. بهتر است 
ش��کل را رنگ کنيد تا تغيير مشخص تر شود، سپس شکل را به محلي که قرار است در متن 

قرار گيرد، منتقل کنيد. توجه داشته باشيد که شکل جلوي بلوک متني قرار گيرد.
 Flow Around Selection فرمان Text 3- متن و ش��کل را با هم انتخاب کرده و از منوي
 را برگزیني��د ی��ا روي  آیکن در نوار  ابزار Text کليک  کني��د. در  این  صورت کادرمحاوره

Flow Around Selection ظاهر مي شود.

4- در ب��الاي ای��ن کادر محاوره دو دکمه براي تعيين وضعيت قرارگيري ش��کل در متن 
و ح��ذف این ویژگي وجود دارد. در این کادر مي توانيد با انتخاب آیکن Text Wrap )س��مت 
راست( و با استفاده از کادرهاي موجود در قسمت  Standoff)فاصله متن از شکل( فاصله هاي 

چپ، راست، بالا و پایين متن از شکل را تعيين کنيد )شکل 9-36(.
5- روي دکمه OK کليک کنيد. متن به طور خودکار در  اطراف  ش��کل قرارمي گيرد )شکل 

.)9-35

 توجه: براي حذف این ویژگي ابتدا موضوع را انتخاب کنيد، سپس از کادر محاوره

Flow Around Selection دکمه Remove Text Wrap را برگزینيد.
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Flow Around Selection شکل 36-9 کادر محاوره

Remove Transforms 9-3-8

 اجراي گزینه Text→Remove Transforms سبب حذف برخي از جلوه هاي متن انتخابي نظير
Attach To Path و Flow Inside Path مي ش��ود و مت��ن ب��ه حال��ت اوليه خ��ود باز مي گردد. 

 Scale ،Skew ،Rotate اعمال شده به متن مانند )Transform( همچنين همه تغيير شکل هاي
و Reflect بجز Move را حذف مي کند.

براي انجام این عمل مراحل زیر را پيگيري کنيد:
1- با استفاده از ابزار Pointer بلوک متني را انتخاب کنيد.

2- گزینه Remove Transforms  را از منوي Text برگزینيد.

 Remove هایي ک��ه در جعبه ابزار وجود دارد ب��ا فرمانTransform نكت�ه: کلي��ه 
Transforms حذف مي شود.

Special Characters 9-3-9

درج کاراکترهاي ویژه در هنگام تایپ متن سبب کنترل نماي متن مي شود.

شکل 9-37

براي استفاده از کاراکترهاي ویژه مراحل بعد را انجام دهيد:
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1- در محل مورد نظر در متن، کليک کنيد تا نقطه درج مشخص شود.
2- گزین��ه Text→Special Character را انتخ��اب کرده س��پس از زیر منوي ظاهر ش��ده 

کاراکتر ویژه را برگزینيد.
Spelling 10-3-9 گزينه

اگر بخواهيد اطمينان یابيد که متن سند موردنظر از لحاظ املایي صحيح است، مي توانيد 
.)Text→Spelling(استفاده نمایيد )Spelling( از غلط گير کلمات تایپ شده

شکل 9-38
Leading 11-3-9 فرمان

گاه��ي براي زیبایي مت��ن یا کمبود فضا لازم اس��ت به تنظيم فاصله س��طرها در متون 
پاراگراف��ي بپردازی��د. ب��راي این منظور از من��وي Text  گزین��ه Leading  را انتخاب کنيد یا 
دستگيره هاي کنترلي وسط در سمت بالا یا پایين کادر انتخاب متن را بکشيد تا فاصله بين 

سطرها کاهش یا افزایش یابد          

شکل 9-39

در این گزینه سه زیرمجموعه به صورت زیر وجود دارد:
با توجه به  اندازه  فونت انتخاب شده در متن جاري، فاصله را به صورت  خودکار  	 :Solid

تنظيم  مي کند. 
Auto: فاصله سطرها را 120% بيشتر از حالت Solid در نظر مي گيرد.	
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Other: با انتخاب این گزینه کادر محاوره Leading مطابق شکل 40-9	 ظاهر مي شود 

که مي توان با اس��تفاده از گزینه هاي منوي بازش��وي آن براي س��طرها فاصله ایجاد 
کرد.

شکل 9-40

گزينه Extra:	 به ميزان عدد وارد شده، به فاصله سطرها مي افزاید. این گزینه معادل 
علامت + در نوار ابزار Text  است.

گزينه Fixed:	 فاصله س��طرها را دقيقاً بر اس��اس عدد وارد شده تنظيم مي کند. این 
گزینه نيز معادل علامت = در نوار ابزار Text  است.

گزين�ه Percentage: فاصل��ه را 100% در نظر مي گيرد. اع��داد کوچک تر از %100	 
باع��ث کاهش فاصله و اعداد بزرگ تر از 100% منجر به افزایش فاصله س��طر جاري 

مي شوند. این گزینه معادل علامت % در نوار ابزار Text  است.

 نكت�ه: از گزین��ه Leading  در پنل Object  مربوط به Text نيز براي تغيير فاصله 
بين خطوط متن استفاده مي شود )شکل 9-41(.

شکل 9-41

Convert Case 12-3-9 فرمان

ب��ه کم��ک این گزینه مي توانيد حالت حروف انگليس��ي را از بزرگ به کوچک یا برعکس 
تبدی��ل کني��د. این تبدیل مي توان��د روي همه حروف صورت گيرد ی��ا از قواعد جدول 9-1 

پيروي کند. 
گزینه Convert Case را از منوي Text انتخاب کنيد. منو شامل این زیرمجموعه هاست:
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جدول 9-1

 Upper.کل حروف متن انتخاب شده را به حروف بزرگ انگليسي تبدیل مي کند

 Lower.کل حروف متن انتخاب شده را به حروف کوچک انگليسي تبدیل مي کند

Small Caps
حروف کوچک متن انتخاب شده را به حروف بزرگ با اندازه کوچک تبدیل مي کند )به طور 

پيش فرض 75% اندازه فونت جاري است(.

 Title.حروف ابتداي همه کلمات را در متن انتخاب شده به حروف بزرگ تبدیل مي کند

 Sentence
متن انتخاب شده را به عنوان یک جمله در نظر مي گيرد و فقط حرف اول جمله را به حرف 

بزرگ تبدیل مي کند.

Settings
در این گزینه مي توان توسط دکمه Add کلمه اي را وارد ليست کرد تا در صورت تغييرات متن 

توسط گزینه Convert Case بدون تغيير باقي  بماند و کلمه  موردنظر تغيير نکند.

             

تمرين 9:
1- جملات زیر را تایپ کنيد.

To copy from another application and paste into FreeHand,
to specify a size for small caps.                                        

2- حرف اول کلمات دوم و پنجم سطر اول را به حروف بزرگ تبدیل کنيد.
3- کليه حروف کلمهFreeHand  را به حروف بزرگ تبدیل کنيد.

4- نخستين حرف کلمه اول سطر دوم را به حرف بزرگ تبدیل کنيد.
5- ح��روف ابت��داي کلمات س��طر دوم را بجز کلمهsize  و caps به ح��روف بزرگ تبدیل 

کنيد.
6- فاصله بين 2 سطر را دقيقاً 40 تعيين کنيد.

Object در پنل Text Block 9-4
در صورتي که متني نوش��ته باش��يد در پنلObject  بخش��ي به نام  Text Blockبه صورت 
س��اختار درختي نمایان مي ش��ود. با کليک روي این بخش، کنترل هايText Block  مطابق با 

شکل 42-9 نشان داده مي شوند.
فيلدهاي Dimensions به صورت زیر تنظيم مي شوند:

l: موقعيت لبه چپ بلوک متني را کنترل مي کند.	
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t: موقعيت لبه بالایي بلوک متني را کنترل مي کند.	
این فيلدها به شما امکان مي دهند تا بلوک متني را به محل خاصي جابه جا کنيد.

عرض بلوک متني را تنظيم مي کند. 	 :w
ارتفاع بلوک متني را تنظيم مي کند. 	 :h

این فيلدها براي تغيير اندازه بلوک متني به کار مي روند.
اگر به بلوک متن حاش��يه داده اید براي اضافه کردن فضاي س��فيد بين متن و حاشيه از 

قسمت Inset استفاده کنيد. 

Object در پنل  Block Text  9-42شکل

left( l( از س��مت چپ، t )top( بالا، r )right( س��مت راس��ت و b )bottom( پایين حاشيه 
ایجاد مي کند.

 : وقتي این آیکن برجس��ته است یعني در حالت انتخاب نيست، براي تنظيم عرض 
بلوک متني در حالت اندازه ثابت )Fixed-Size( به کار مي رود.

وقتي این آیکن به صورت فرورفته یعني در حالت انتخاب است، براي تنظيم عرض بلوک 
متني در حالت گسترش خودکار )Auto-Expand( استفاده مي شود.

 : وقتي این آیکن برجسته است و در حالت انتخاب نيست، براي تنظيم ارتفاع بلوک 
متني در حالت اندازه ثابت )Fixed-Size( به کار مي رود.

وقت��ي این آیک��ن در حالت فرورفته و در وضعيت انتخاب ق��رار دارد، براي تنظيم ارتفاع 
بلوک متني در حالت گسترش خودکار )Auto-Expand( استفاده مي شود.

فعال بودن کادر علامت Display border	 به شما امکان مي دهد که حاشيه بلوک متن 
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را مشاهده کنيد ولي خط دور )Stroke( ایجاد نمي کند.

 توجه: براي اعمال حاش��يه به بلوک متني انتخاب شده، روي Add Stroke در پنل

Object  کليک کنيد، سپس یکي از انواع خط دور را براي حاشيه برگزینيد.

FreeHand MXa 5-9 فارسي نويسي در
یکي از مسایلي که کاربران فارسي زبان FreeHand با آن مواجه هستند؛ نوشتن متون به 

زبان فارسي است، زیرا در این برنامه امکان فارسي نویسي وجود ندارد.
براي فارسي نوشتن در FreeHand MX ابتدا باید در یک برنامه فارسي نویس، متن موردنظر 

.)Paste( بچسبانيد FreeHand را تایپ کنيد، سپس متن را کپي کرده و در
براي این منظور مراحل زیر را دنبال کنيد:

1- برنامه فارسي ساز را اجرا کنيد و متن موردنظر را تایپ کنيد )شکل 9-43(.
2- متن تایپ شده را انتخاب کرده و آن را کپي )Ctrl+C( کنيد.

3- برنامه FreeHand را باز کرده و ابزار تایپ متن را از جعبه ابزار انتخاب کنيد.
4- روي صفحه کليک کنيد تا علامت مکان نماي چشمک زن ظاهر شود، اکنون متن کپي 

.)Ctrl+V( شده را در صفحه بچسبانيد
توجه داش��ته باشيد که نام فونت در FreeHand باید همان نام فونت در برنامه فارسي ساز 

باشد.

شکل 9-43  
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FreeHand MX شکل 44-9 نمایش متن فارسي در محيط 

 مث�ال کاربردي: در ادامه مثال کاربردي واحد کار پيش��ين مراحل زیر را انجام 
دهيد:

1- فایل Project.fh11 را باز کنيد.
2- با اس��تفاده از ابزار Text عبارت متني ش��کل را در کارت به رنگ دلخواه تایپ کنيد، 

سپس آدرس و تلفن مورد نظر خود را در کارت وارد کنيد.
3- فایل را ذخيره کنيد.                                                           

شکل 9-45
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واژه نامه
Attachمتصل کردن، الصاق کردن

Effectجلوه

Pathمسير

Plainساده، عادي

Positionموقعيت

Spellهجي کردن

Specialمخصوص، ویژه

 
 
 

خلاصه مطالب 
به طور کلي در FreeHand	 مي توانيد از قابليت تایپ متن به عنوان یک برنامه واژه پرداز 

یا یک برنامه صفحه بندي استفاده کنيد.
موارد زیر از قابليت هاي این نرم افزار براي انجام عمليات روي متن است: 	

تغيير تنظيمات متن از جمله اندازه و نوع قلم 	
	)Leading( تغيير فاصله بين حروف و سطرها
	Effect ایجاد جلوه هاي متني با استفاده از گزینه
	)Attach To Path( قرار دادن متن در داخل یا خارج یک مسير
	)Flow Inside Path( قرار دادن متن در داخل یک موضوع یا مسير
	 )Convert To Path( تبدیل متن انتخابي به موضوع یا مسير
	)Special Characters( درج کاراکترهاي ویژه در متن
	)Spelling( غلط گيري کلمات تایپ شده
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعیین کنید.

1- گزینه Leading از نوار ابزار Text، براي تغيير نوع قلم به کار مي رود.
2- جلوه Zoom براي سه بعدي کردن حروف در متن به کار مي رود.

Spelling -3 بررسي مي کند که متن سند موردنظر از لحاظ املایي صحيح است یا خير.

En Dash -4 فاصله اي معادل نصف عرض اندازه فونت در متن درج مي کند.

معادل گزينه  هاي سمت  راست را از ستون سمت  چپ انتخاب کرده و مقابل هر عبارت بنويسید.

                                Flow Around Selection                     .است  FreeHand 5- ویرایشگر متن در برنامه
Attach To Path          .6- جلوه هاي متني را حذف و آن را به حالت اوليه برمي گرداند
Remove Transform                                     .7-  متن را روي مسير قرار مي دهد

 Text Editor                                     .8- متن را در اطراف یک مسير قرار مي دهد
گزينه صحیح را انتخاب کنید.

9-گزینه Strikethrough چه کاربردي دارد؟
ب- در روي متن خط رسم مي کند. الف- در زیر متن  خط ایجاد مي کند. 

د- متن را به مسير مي چسباند. ج- در پشت متن خط رسم مي کند. 
10-گزینه Plain در بخش Text از پنل Object چه عملي را انجام مي دهد؟
ب- ایجاد سبک مایل براي قلم  الف- ایجاد سبک پر رنگ براي قلم  

د- ایجاد سبک مایل و پررنگ براي قلم ج- ایجاد سبک قلم نازک و معمولي 
11- براي چسباندن متن به یک مسير منحني از کدام فرمان استفاده مي شود؟

Text از منوي Attach To Path -ب               Edit از منوي Pointer -الف
د- کشيدن متن روي مسير   Text از منوي Detach From Path -ج

12- ک��دام گزینه به منظ��ور ایجاد فاصله بين س��طرها با مقدار دلخواه کاربر اس��تفاده 
مي  شود؟

 Text→Leading→Solid -ب         Text→Leading→Other -الف
Text→Leading→Settings -د           Text→Leading→Auto -ج

13- کدام یک از جلوه هاي زیر براي حروف متن سایه ایجاد مي کند؟
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Shadow -د            Highlight -ج   Zoom -ب       Inline -الف
14- کدام گزینه براي قرار دادن متن درون یک مسير بسته استفاده مي شود؟

 Ctrl+Shift+U -ب    Flow Inside Path -الف
د- گزینه هاي الف و ب صحيح هستند.   Attach  To Path -ج

15- فرمان Convert Case  در منوي Text به چه منظور استفاده مي شود؟
الف- تنظيم فاصله سطرها در متن پاراگرافي

ب- تبدیل نوع کلمات متن
ج- تبدیل حروف کوچک و بزرگ به یکدیگر در متون انگليسي

د- تبدیل مسير به متن 
16- گزینه Title در Convert Case چه کاربردي دارد؟

الف- براي بزرگ کردن حروف با اندازه کوچک استفاده مي شود. 
ب- حرف اول همه کلمات متن انتخابي را بزرگ و بقيه را کوچک مي کند.

ج- حروف متن انتخابي را به حروف کوچک تبدیل مي کند.
د- حرف اول جملات را بزرگ مي کند.

17- گزین��ه .............. ح��رف اول جم��لات را ب��زرگ و بقيه را به ح��روف کوچک تبدیل 
مي کند.

Sentence -ب               Upper -الف
Lower -د                       Small Caps -ج

در جاي خالي عبارت مناسب را بنويسید.

 Leading 18- علام��ت % در ایجاد فاصله بين س��طرها مع��ادل ................... از گزینه هاي
است.

19- گزینه Convert To Path  ..............................  تبدیل مي کند.
به سؤالات زير پاسخ تشريحی دهید.

FreeHand MX -20 از چند طریق خصوصيات متون را کنترل مي کند؟

Stroke Color -21 در متن چه کاربردي دارد؟

22- آیا تغيير اندازه متني که به مسير تبدیل شده، تأثيري در کيفيت آن دارد؟ چرا؟
23- گزین��ه Fixed چگون��ه فاصل��ه بين س��طرها را تنظيم مي کند و از چ��ه طریق قابل 
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دستيابي است؟
24- کدام جلوه به متن حالت س��ه بعدي مي دهد و آیا جلوه هاي ویژه )Effect( علاوه بر 

متون براي سایر موضوعات نيز قابل اجراست؟
آزمون عملي

1- نشانه هاي زیر را ترسيم کنيد.

 

2- یک جلد مجله با مشخصات زیر طراحي کنيد.
مجله علمي به نام "راهي به سوي فردا" در کاغذ A4 طراحي کنيد.

با رعایت نکات صفحه آرایي، نام مجله، تعداد صفحه، قيمت، ش��ماره چاپ و دو مورد  	
از عناوین مقالات داخل مجله را در محل مناسب روي جلد بنویسيد.

یک نشانه مرتبط با موضوع مجله نيز براي آن طراحي کنيد و در محل مناسب قرار  	
دهيد.
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كليات
در این واحد کار به بررس��ي امکانات ویرایشي   FreeHand و تکنيک هاي اصلاح ترسيمات 
خواهيم پرداخت. عمليات اصلاحي نه تنها پس از پایان ترس��يم مورد استفاده قرار مي گيرد، 
بلک��ه در حي��ن انجام کار نيز به آن نياز پيدا خواهيد ک��رد چون با کپي کردن، ادغام و برش 
زدن اجزاي موجود مي توان به س��رعت اجزاي دیگر را ایجاد کرد، بدون این که مس��تقيماً به 

ترسيم آن ها بپردازیم.
Group 1-10 گزينه

هنگامي که توس��ط ابزارهاي ترسيمي اش��کالي را ایجاد مي کنيد، اجزاي این شکل ها هر 
یک منفرد بوده و مس��تقلًا قابل ویرایش یا جابه جایي هس��تند. ش��ما مي توانيد براي  حفظ 
ش��کل موضوع گرافيکي، جا به جایي دقيق تمامي عناصر یا انتخاب راحت تر موضوعات، آن ها 

را گروه بندي کنيد.
1-1-10 گروه بندي موضوعات

1- موضوع موردنظر را توسط ابزار Pointer انتخاب کنيد )شکل 10-1(.
2- فرمانModify→Group  را اجرا کنيد، در این صورت اش��کال به جاي گره هاي متعدد 

و مجزا داراي چهار گره مي شوند )شکل 10-2(.

     

 شکل 1-10 انتخاب شکل       شکل 2-10 گروه بندي یک شکل

 نكته: با کليد ترکيبي Ctrl+G نيز مي توان موضوعات گرافيکي را گروه بندي  کرد.
وقتي یک موضوع گروه بندي ش��ده را انتخاب مي کنيد، اهرم هاي کنترلي در اطراف کل 
گروه ظاهر مي شوند و امکان تغيير اندازه، جابه جایي و تکثير کل اشکال گروه شده را فراهم 
مي کنند. در این حالت نيز با ابزار Subselect مي توان قس��متي از اجزاي یک گروه را انتخاب 

کرد.
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 نكت�ه: به منظور لغو گروه بندي یک موضوع فرم��ان Modify→Ungroup را اجرا 
کنيد.

 مثال 1: 
1- سه شکل ساده رسم کنيد.

2- توسط ابزارPointer  و نگه داشتن کليد Shift هر سه شکل را انتخاب کنيد.
3- فرمان Modify→Group  را اجرا کنيد تا همه ترسيمات در قالب یک موضوع واحد با 

هم در یک گروه قرار  گيرند.
تمرين 1:

1- اش��کال 3-10 را رسم کرده، س��پس هر کدام را به صورت جداگانه در یک گروه قرار 
دهيد.

شکل 10-3

Ungroup 2-10 گزينه
درصورتي که موضوعات را در یک گروه قرار داده باشيد، به طور مجزا قابل انتخاب نيستند. 
ممکن است بخواهيد آن ها را تغيير داده و روي جزیيات آن ها بيشتر کار کنيد، بنابراین براي 
انتخاب و جداس��ازي قسمت هاي مختلف موضوع مورد نظر باید آن ها را از حالت گروه خارج 

.  )Modify→Ungroup(کنيد
تمرين 2:

1- آرمي نظير شکل 4-10 رسم کنيد. 

شکل 10-4 
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2- تمام شکل را انتخاب کرده و تصویر را گروه بندي کنيد.
3- یک کپي از تصویر را 60 درجه بچرخانيد.

4- تصویر را از حالت گروه خارج کرده و رنگ گوش��ه بالاي س��مت راست تصویر را قرمز 
کنيد. 

 Lock 3-10 گزينه
گاهي اوقات که چندین موضوع روي یکدیگر یا درون هم رسم شده اند، هنگام انتخاب، به 
اش��تباه انتخاب مي شوند. براي جلوگيري از این امر، برخي از موضوعات باید به طور ثابت در 
صفحه قرار گيرند تا امکان تغيير مکان یا ویرایش نداشته باشند. براي رسيدن به این هدف، 
مي توانيد موضوع گرافيکي را قفل کنيد. هدف از این کار، جابه جا نش��دن موضوع و اطمينان 

از عدم انتقال و ویرایش آن است.
1-3-10 قفل كردن يک موضوع گرافيکي

1- موضوعي را که مي خواهيد قفل شود، انتخاب کنيد.
2- فرمانModify→Lock  را اجرا کنيد. آیکن  )Lock( در نوار ابزارInfo  نشان مي دهد 

که موضوع قفل شده است. 
موضوعات گرافيکي قفل شده فقط قابل انتخاب و کپي هستند.

 نكته: با کليد ترکيبي Ctrl+L مي توان موضوعات گرافيکي را در صفحه قفل کرد.

 مثال 2: شکل 5-10 را رسم کنيد.
1- ابتدا تصویر سيب را به همراه سایه آن رسم کنيد.

2- براي تغيير ش��کل دقيق س��ایه، تصویر اصلي را انتخاب کرده و سپس با فشردن کليد 
ترکيبي Ctrl+L، آن را قفل کنيد.

شکل 10-5
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 Unlock4-10 گزينه
اگر بخواهيد روي موضوعات گرافيکي قفل شده، ویرایشي انجام دهيد، باید آن را از حالت 

قفل خارج کنيد.
1-4-10 خارج كردن قفل يک موضوع گرافيکي

1- موضوعي را که مي خواهيد از حالت قفل خارج شود، انتخاب کنيد.
2- فرمانModify→Unlock  را اجرا کنيد. 

 نكت�ه: با کليد ترکيبي Ctrl+Shift+L مي توان موضوعات گرافيکي را از حالت قفل 
خارج کرد.

Join 5-10 گزينه
معمولاً خطوطي که پش��ت سرهم با ابزارLine  ترسيم مي شوند، باز هستند. در این مواقع 

براي اتصال دو پاره خط به یکدیگر، از فرمانJoin  استفاده مي شود.
همچنين براي این که دو یا چند مس��ير به صورت واحد یا اصطلاحاً یک مس��ير ترکيبي 

درآیند، مي توانيد از فرمان Join  استفاده کنيد.
1-5-10 اتصال دو پاره خط به يکديگر 

1- دو پاره خطي را که مي خواهيد به هم متصل شوند، انتخاب کنيد.
2- فرمانModify→Join  را اجرا کنيد.

        

  شکل 6-10 انتخاب دو پاره خط      شکل 7-10 اتصال دو پاره خط

2-5-10 ايجاد يک مسير تركيبي 

1- مس��يرهاي گرافيکي را که مي خواهيد به صورت واحد درآیند، انتخاب کنيد )ش��کل 
.)10-8

  

   شکل 8-10 انتخاب مسير

2- فرم��انModify→Join  را اجرا کنيد، در صورتي که مس��ير مرکب، روي هم افتادگي 
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داشته باشد مي توان نوع هم پوشاني بخش هاي روي هم افتاده را با گزینه Even/odd fill واقع 
در پنل Object کنترل کرد )شکل 10-9(.

شکل 9-10 ایجاد مسير ترکيبي

 توج�ه: رن��گ مس��ير ترکيبي از رنگ اولين مس��ير تبعيت مي کند. اولين مس��ير 
موضوعي است که قبل از همه ترسيم شده است.

 نكته: با کليد ترکيبي Ctrl+J مي توان عمل اتصال را انجام داد.

تمرين 3: چند مس��ير رسم کرده و داخل آن ها را با رنگ هاي متفاوت پر کنيد، 
سپس آن ها را به صورت مسير ترکيبي درآورید و به رنگ مسير مرکب دقت کنيد. 

Split 6-10 گزينه
از این گزینه براي شکس��تن موضوعات بس��ته، جدا کردن گره ها از یکدیگر، جدا کردن 
خطوط به هم چس��بيده اي که با ابزار Pen و Bezigon ترسيم شده اند و جدا کردن موضوعات 

Join شده، استفاده مي شود.

1-6-10 جدا كردن دو پاره خط از يکديگر

 1- با ابزار Pointer روي نقطه اتصال دهنده دو خط )گره( کليک  کنيد تا گره انتخاب شود
)ش��کل 10-10(. وقت��ي یک گره انتخاب مي ش��ود، به صورت چهارگ��وش توخالي یا دایره 

توخالي دیده مي شود.
2- فرم��انModify→Split  را اجرا کني��د. پاره خط ها در نقاط عطف )همان گره ها( از هم 

جدا مي شوند )شکل 10-11(.

            

Split شکل 10-10 انتخاب گره                شکل 11-10 جدا کردن خطوط  متصل با فرمان
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3- سپس در فضاي خالي کليک و بعد گره ها را از هم جدا کنيد.
4- حال مي توانيد هر پاره خط را به تنهایي ویرایش کنيد.

 
 نكته: با کليد ترکيبي Ctrl+Shift+J مي توان عمل Split  را انجام داد.

Arrange 7-10 فرمان
فرمان Arrange که در منويModify  قرار دارد، براي تعيين  موقعيت موضوعاتي که روي 

یکدیگر قرار مي گيرند، استفاده مي شود و داراي چهار گزینه است:
Bring To Front:	 ب��راي ق��رار دادن موض��وع انتخابي روي تم��ام موضوعات به کار 

مي رود.
Move Forward:	 موض��وع انتخ��اب ش��ده را به ان��دازه یک موضوع ب��ه جلو انتقال 

مي دهد.
Move Backward:	 موضوع یا موضوعات انتخاب شده را به اندازه یک موضوع به عقب 

مي برد.
Send To Back:	 موض��وع ی��ا موضوعات انتخاب ش��ده را زیر تم��ام موضوعات قرار 

مي دهد.
Align 8-10 گزينه

به وس��يله این گزینه مي توانيد چندین موضوع را نس��بت به هم یا نس��بت به صفحه در 
راستاي دلخواه قرار دهيد، به طوري که نسبت به یکدیگر مرتب و هم تراز به نظر برسند.

Align 1-8-10 استفاده از زير منوي

1- موضوعاتي را که مي خواهيد هم تراز شوند، مطابق شکل 12-10 انتخاب کنيد.

شکل 12-10 انتخاب اشکال

2- در زیر منوي حاصل از اجراي فرمان Modify→Align یکي از گزینه هاي زیر را انتخاب 
کنيد:
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 Top:	 تمام موضوعات انتخاب شده را نسبت به بالاترین شکل و از بالا با هم تراز مي کند 

)شکل 10-13(.
Bottom:	 تمام موضوعات انتخاب شده را نسبت به پایين ترین شکل و از پایين با هم 

تراز مي کند )شکل 10-14(.

                                  

 Bottom شکل 14-10 اعمال گزینه              Top شکل 13-10 اعمال گزینه                   

Center Horizontal:	 خ��ط افقي مرکزي را نس��بت به بالاترین و پایين ترین لبه هاي 

تصاویر مش��خص ک��رده و تمام موضوعات انتخاب ش��ده را در جهت افقي هم مرکز 
مي کند )شکل 10-15(.

Center Vertical:	 خط عمودي مرکزي را نسبت به منتهي اليه لبه هاي راست و چپ 

تصاوی��ر تعيين کرده و تمام موضوعات انتخاب ش��ده را در جهت عمودي هم مرکز 
مي کند )شکل 10-16(.

                                             

Center Vertical شکل 16-10 اعمال گزینه     Center Horizontal  شکل 15-10 اعمال گزینه          

Left:	 تمام موضوعات انتخاب شده را نسبت به اولين تصویر از سمت چپ و در امتداد 

لبه چپ، با هم تراز مي کند )شکل 10-17(.
Right:	 تمام موضوعات انتخاب ش��ده را نس��بت به اولين تصویر از سمت راست و در 

امتداد لبه راست، باهم تراز مي کند )شکل 10-18(.

                                          

Right شکل 18-10 اعمال گزینه             Left شکل 17-10 اعمال گزینه

تمرين 4: اش��کال 19-10 را رس��م کرده و آن ها را نس��بت به هم، تراز راس��ت 
کنيد.
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شکل 10-19

Align 2-8-10 استفاده از پنل

1- موضوعاتي را که مي خواهيد هم تراز شوند، انتخاب کنيد.
2- گزینه Align را از منوي Window برگزینيد تا پنلAlign  مطابق شکل 20-10 ظاهر 

شود.

Align شکل 20-10 پنل

3- ب��ا اس��تفاده از من��وي بازش��وي Horizontal مطابق ش��کل 21-10، هم ترازي افقي 
موضوعات را تنظيم کنيد. 

4- ب��ا اس��تفاده از منوي بازش��وي Vertical مطابق ش��کل 22-10، هم ت��رازي عمودي 
موضوعات را تنظيم کنيد.

5- اگ��ر مي خواهي��د موضوعات با صفحه هم تراز ش��وند، گزین��ه Align to page را فعال 
کنيد.

6- روي دکمه Apply کليک کنيد تا موضوعات به محل مورد نظر انتقال یابند.
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شکل 21-10 گزینه هاي موجود در منوي 

  Horizontal بازشوي

شکل 22-10 گزینه هاي موجود در منوي 

  Vertical بازشوي

 مثال 3: شکل 23-10 را رسم کرده و نسبت به هم کاملًا هم مرکز کنيد.
1- براي این که دایره ها هم مرکز شوند ابتدا آن ها را انتخاب کنيد.

2- از منويWindow  گزینه Align را برگزینيد.                                        

شکل 10-23

 Horizontal 3- سپس از کادر محاوره ظاهر شده مطابق شکل 24-10 در منوي بازشوي
و Vertical گزینه Align center را انتخاب کنيد.

4- پس از انجام تنظيمات، شکل 23-10 به صورت زیر تراز مي  شود )شکل 10-25(.
           

             

Align شکل 25-10 هم  ترازي از طریق پنل                 Align شکل 24-10 کادر محاوره        
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 )Transform( 9-10 تغيير در اشياء
هنگامي که یک ش��ئ را ایجاد مي کنيد ممکن اس��ت بخواهيد شکل آن را تغيير دهيد. با 

جابه جایي و تغيير شکل اشياء مي توانيد شکل هاي ساده را به پيچيده تبدیل کنيد.
در FreeHand روش هاي متنوعي براي تغييرش��کل اش��ياء وجود دارد، نظير تغيير شکل 
به صورت دس��تي یا وارد کردن مقادیر عددي براي به دس��ت آوردن نتایج دقيق تر که در این 

بخش به بررسي آن ها مي پردازیم.
 )Scale( 1-9-10 تغيير مقياس

براي  ایجاد تغيير  در  مقياس یا اندازه موضوعات س��ه روش وجود دارد که برحس��ب نياز 
مي توان از آن ها استفاده کرد.

Scale استفاده از ابزار
این ابزار واقع در مجموعه ابزار Rotate در جعبه ابزار قرار دارد.

 نكته: استفاده از کليد Shift  هنگام تغيير مقياس باعث مي شود که تناسب شکل 
به هم نخورد.

Pointer استفاده از ابزار
1- توس��ط ابزار Pointer روي موضوع دابل کليک کنيد تا دس��تگيره هاي تغيير مقياس 

)اندازه( ظاهر شوند.
2- با درگ ماوس به داخل یا خارج، شکل را کوچک یا بزرگ کنيد.

 Transform استفاده از پنل
1- موضوع موردنظر را انتخاب کنيد.

2- از منوي Window پنل Transform را انتخاب کنيد.
3- در پنل Transform مطابق شکل 26-10 روي آیکن Scale کليک کنيد.

4- درصد تغيير مقياس )اندازه( موضوع را در کادرScale %  وارد کنيد.
5- فعال کردن گزینهUniform  باعث مي شود که تغيير اندازه طول شکل نسبت به عرض 

آن به صورت متناسب انجام شود.
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Transform از زبانه Scale شکل 26-10 گزینه

 نكت�ه: اگ��ر گزین��ه Uniform  را غيرفعال کنيد، کادره��اي  vوh براي وارد کردن 
درصدهاي مربوط به تغيير مقياس )اندازه( موضوع باز مي شوند. در این حالت براي دستيابي 
 v افقي( و ( h مقاب��ل Scale ب��ه ی��ک مقياس غيریکنواخ��ت، مقادیر موردنظر را در قس��مت

)عمودي( وارد کنيد.
 Center 1- براي تغييرمکان نقطه تغيير مقياس از مرکز، مختصات موردنظر را در قسمت

مقابل x و y وارد کنيد.
2- اگر مي خواهيد هنگام تغيير مقياس ش��کل، اندازه تمام اجزاي چس��بيده به شکل نيز 

تغيير کند، گزینهContents  را فعال کنيد.
 )Stroke( 3- اگر مي خواهيد هنگام تغيير مقياس شکل، مقياس خط رسم شده دور شکل

نيز با شکل تغيير کند، گزینه Strokes را فعال کنيد.
 )Tiled( فعال باش��د مقياس تمام زمينه ها مانند کاشي کاري Fill 4- در صورتي که گزینه

تغيير مي یابد.
5- گزینه Strokes را فعال کنيد تا اندازه خطوط دور به همراه مسير تغيير کند.
6- کادر Copies به منظور تکثير و تغيير اندازه شکل تکثير شده به کار مي رود.

7- روي دکمه Scale کليک کنيد )یا کليد Enter را بفشارید(.

 توج�ه: اس��تف�اده از ک���ادر Copies در اب�زار Transform منجر به ایجاد اش��کال 

گرافيکي جالبي در کنار هم مي شود.

تمرين 5: مقياس شکل را طوري تغيير دهيد که شکل دو برابر شود و متناسب 
اندازه طول و عرض شکل تغيير نکند.
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شکل 10-27
)Move( 2-9-10 جابه جايي اشکال

یکي از راه هاي جابه جایي اش��کال استفاده از پنل Transform است. در این پنل دکمه اي 
به نام Move قرار دارد که موضوعات را با استفاده از مقياس جابه جا مي کند. 

با استفاده از این پنل ضمن جابه جا کردن موضوع، امکان تکثير آن نيز وجود دارد )شکل 
                   .)10-28

                  

Transform از پنلMove  شکل 28-10 انتخاب دكمه 

 نكته: اگر هنگام درگ شئ با استفاده از ابزار Pointer کليد Alt را نگه دارید یک 
کپي از شئ ایجاد مي شود.

 توجه: تفاوت اس��تفاده از پنل Transform نسبت به پنل Object هنگام جابه جایي 

موضوعات در این است که اعداد در پنل Transform نسبي هستند یعني موضوع را به اندازه 
عددي که در قسمت x و y وارد کرده اید )نسبت به موقعيت کنوني موضوع( جابه جا مي کند، 
اما در پنل Object مقادیر ورودي مطلق هستند، یعني مقادیر ورودي هميشه نسبت به نقطه 

صفر خط کش محاسبه مي شوند.
تمري�ن 6: آرم 29-10 را طراح��ي کرده و آن را یک بار با پنل Object  و یک بار 

با پنل Transform به اندازه دلخواه در صفحه جابه جا کنيد.
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شکل 10-29
)Rotate( 3-9-10 چرخش

بيش��تر مواقع هنگام رس��م اشکال، لازم اس��ت براي رسيدن به ش��کل موردنظر تمام یا 
قس��متي از شکل را بچرخانيد. براي چرخش موضوعات از چند روش استفاده مي شود که به 

شرح آن ها مي پردازیم:
استفاده از دستگيره هاي تغيير شکل

1- ب��ا اب����زار Pointer روي  م��وض��وع  م��ورد نظر دابل کليک  کني��د تا دس��تگيره هاي 
تغييرشکل )Transform handles( ظاهر شوند.

2- اش��اره گر ماوس را به دس��تگيره ها نزدی��ک کنيد، در این صورت اش��اره گر ماوس به 
فلش هاي چرخش��ي تبدیل مي شود. حال با چرخش اشاره گر ماوس، موضوع انتخاب شده به 

اندازه دلخواه دوران مي کند.

                 

شکل 30-10 دستگيره هاي تغيير شکل       شکل 31-10 چرخش اشکال به کمک دستگيره هاي تغيير شکل

 نكته: با استفاده از کليد Shift  چرخش با زاویه 45 درجه انجام مي شود.

 Rotate نحوه استفاده از ابزار
1- با ابزار Pointer روي  موضوع  موردنظر کليک  کنيد تا شکل انتخاب شود.

2- ابزار Rotate را از جعبه ابزار انتخاب کنيد.
3- در ی��ک  نقطه کليک ک��رده و کليد  ماوس را نگه  دارید تا خ��ط  راهنماي  تعيين کننده 
راستاي چرخش ظاهر شود. اکنون با حرکت دادن ماوس مي توانيد شکل را درجهات مختلف 
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بچرخانيد.

     

Rotate شکل 33-10 مراحل انجام کار با ابزار       Pointer شکل 32-10 انتخاب با ابزار

 نكت�ه: اگر مي خواهيد به طور همزمان چند موضوع را با هم چرخش دهيد، بهتر 
است ابتدا آن ها را با کليد ترکيبي Ctrl+G  در یک گروه قرار دهيد.

 توجه: هنگام  اس��تفاده از  ابزار Rotate نقطه کليک به منزله محور  چرخش اس��ت، 

بنابراین اگر مي خواهيد ش��کل را به دور خودش بچرخانيد، بهتر است نقطه کليک در حوالي 
مرکز شکل باشد.

 نكته: نگه داش��تن کليد Shift هنگام چرخش باعث مي شود که شکل با زاویه 45 
درجه بچرخد.

مثال 4: شکل 34-10 را رسم کنيد.
1- به منظور رسم این شکل مي توانيد از ابزار Bezigon براي رسم خطوط صاف و از ابزار 

Pen براي رسم خطوط منحني استفاده کنيد.

2- شکل را با استفاده از ابزار Rotate به اندازه دلخواه بچرخانيد.                          

شکل 10-34

ب��راي ای��ن کار ابتدا با ابزار Pointer روي موضوع موردنظر کليک کنيد تا ش��کل انتخاب 
شود، سپس ابزار Rotate را از جعبه ابزار برگزینيد و در یک نقطه کليک کرده، کليد ماوس را 
نگه دارید تا خط راهنماي تعيين کننده راس��تاي چرخش ظاهر شود. اکنون با حرکت دادن 
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ماوس شکل را در جهات مختلف بچرخانيد.

 نكته: در هنگام چرخاندن شکل، هر قدر که اشاره گر ماوس از مرکز دوران دورتر 
باشد، تغيير زاویه با گام هاي آهسته تري صورت مي پذیرد.

 Transformاستفاده از پنل
این روش دقيق تر از روش هاي قبل است، زیرا در این روش از مقياس استفاده مي شود.

1- موضوع مورد نظر را انتخاب کنيد.
2- گزینه  Modify→Transform→Rotateرا برگزینيد.    

3- پنل Transform در حالي که دکمه Rotate انتخاب شده باز مي شود.
4- زاویه اي که مي خواهيد موضوع را برحس��ب آن بچرخانيد به صورت عدد در قس��مت
Rotation angle  تای��پ کني��د و با انتخاب گزینه ه��ايContents  و Fills مش��خص کنيد که 

محتویات موضوع، همراه با آن چرخانده شود.
5- براي تغيير دادن مرکز چرخش، مختصات مورد نظر خود را در قس��مت Center وارد 

کنيد.
6- روي دکمه Rotate کليک کنيد.

Transform شکل 35-10 پنل

 نكته: اگر در کادرCopies  عدد صفر را وارد کنيد، خود شکل با زاویه موردنظر چرخش  مي کند 
اما اگر عددي غير از صفر وارد کنيد، ش��کل اصلي بدون چرخش باقي مي ماند و کپي هاي ایجاد ش��ده با زاویه 

دلخواه چرخش مي کنند.
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 ، Window→Transform مي توانيد از  Transform نكت�ه: براي ظاهر کردن پن��ل 
کليد ميانبرCtrl+M  یا دابل کليک روي ابزار Rotate  در جعبه ابزار استفاده کنيد.

 توجه : برای دوران در خلاف جهت عقربه های س��اعت می توانيد یک عدد منفی 
در کادر Rotating angle وارد کنيد.

مثال 5: شکل 36-10 را رسم کنيد.
1- براي ایجاد ش��کل 36-10 ابتدا با ابزار Ellipse یک بيضي عمودي رس��م کنيد، سپس 
از قسمت Modify→Transform  گزینه Rotate را انتخاب کنيد.                                                            

شکل 10-36

2- در کادر متن��ي Rotation angle عدد 20 را وارد کرده و در کادر متني Copies عدد 8 
را درج کنيد، سپس روي دکمهRotate  کليک کنيد.
تمرين 7: اشکال 37-10 را رسم کنيد.

شکل 10-37
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 )Reflect( 4-9-10 قرينه سازي

براي ایجاد قرینه از یک موضوع یا انعکاس آن روي یک س��طح، از ابزار Reflect اس��تفاده 
کنيد. این ابزار در مجموعه ابزارRotate  در جعبه ابزار قرار دارد.                                

Reflect استفاده از ابزار
1- موضوعي را که مي خواهيد قرینه کنيد، برگزینيد.

2- ابزار Reflect را از جعبه ابزار انتخاب کنيد.
3- اش��اره گر ماوس را روي صفحه قرار داده و در نقطه اي که مي خواهيد شکل در اطراف 
آن قرینه ش��ود، کليک کنيد )نقطه تغيير ش��کل(. در این حالت کلي��د ماوس را رها نکنيد، 
به این ترتيب یک خط از محل اش��اره گر به س��مت خارج گس��ترش مي یابد )این خط محور 

بازتابش ناميده مي شود(.
 4- وقتي موضوع قرینه شده در موقعيت دلخواه  شما قرارگرفت، کليد ماوس را رها کنيد 

)شکل 10-39(.

        

                      شکل 38-10 محور بازتابش                                 شکل 39-10 قرینه موضوع انتخاب شده

 نكت�ه: اگر هنگام اس��تفاده از ابزار Reflect کلي��د Shift را پایين نگه دارید، باعث 
مي شود قرینه سازي در زوایاي 45، 90 و 180 درجه صورت گيرد.

 نكت�ه: اگر هنگام اس��تفاده از اب��زار Reflect کليد Alt را پایي��ن نگه دارید، باعث 
مي شود از موضوع انتخاب شده کپي گرفته شود و سپس قرینه سازي صورت گيرد.

مثال 6: ش��کل 40-10 را رس��م کرده، س��پ�س قرینه آن را مطابق شکل ایجاد 
کنيد. 

1- ابتدا تصویر یک ماهي را مطابق شکل 41-10 رسم کنيد.
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2- ابزار Reflect را از جعبه ابزار انتخاب کرده و اشاره گر ماوس را روي صفحه قرار دهيد 
و در نقطه اي که مي خواهيد شکل در اطراف آن قرینه شود، کليک کنيد. در این حالت کليد 
م��اوس را رها نکنيد و با حرکت دادن ماوس و حرک��ت محور بازتابش هنگامي که قرینه در 
جاي مشخص شده در شکل 40-10 قرار گرفت، کليد Alt را نگه داشته )براي ایجاد کپي از 

شکل( سپس کليد ماوس را رها کنيد.

             

                      شکل 40-10 ترسيم شکل به همراه قرینه   شکل 10-41 

Transform استفاده از پنل
1- موضوعي را که مي خواهيد قرینه کنيد، برگزینيد.

2- روي دکمه Reflect از پنل Transform کليک کنيد. شکل 42-10 ظاهر مي شود.

Transform از پنل Reflect شکل 42-10 دکمه

 Reflect axis 3- زاویه چرخش موضوع را برحسب درجه براي قرینه شدن، در مقابل  کادر
وارد کنيد.

4- براي جابه جایي نقطه تغيير ش��کل از مرکز موضوع، مختصات موردنظر را در قس��مت 
Center مقابل کادرهاي x و y وارد کنيد.

  Copies 5- براي این که خود شکل را همراه با قرینه آن داشته باشيد، کافي است در کادر
شکل 42-10 عدد 1 را وارد کنيد.
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تمرين 8: شکل 43-10 را رسم کنيد.

      

 شکل 10-43 

 Skew 5-9-10 ابزار

از ابزار Skew واقع در گروه ابزارهاي Rotate در جعبه ابزار، براي مورب کردن موضوعات و 
 Transform زیاد دقيق نيست ولي پنل Skew مورب کردن متون استفاده مي شود.کارکرد ابزار

به علت این که تغييرات را با مقياس انجام مي دهد، دقيق تر عمل مي کند. 
براي مورب کردن )کج کردن( موضوعات از دو روش استفاده مي شود:

 Skew استفاده از ابزار
1- موضوعي را که مي خواهيد مورب کنيد، برگزینيد.

2- در جعبه ابزار، ابزارSkew  را انتخاب کنيد س��پس اش��اره گر ماوس را در نقطه اي که 
مي خواهي��د موض��وع را از آن نقطه کج کني��د، قرار دهيد )به این نقطه، نقطه تغيير ش��کل 

مي گویند( و کليد ماوس را رها نکنيد )شکل 10-44(.

         

شکل 44-10 انتخاب شکل

3- اش��اره گر را دورتر از نقطه تغيير ش��کل بکشيد. با انجام این عمل، شکل، مطابق شکل 

45-10 تغيير پيدا مي کند.

Skew شکل 45-10 مورب کردن شکل با ابزار
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Transform استفاده از پنل
1- موض��وع موردنظر را برگزینيد، س��پس در پن��ل Transform روي دکمه Skew کليک 

کنيد.
2- در کادر h از قسمت Skew angles  زاویه افقي و در کادر v زاویه عمودي را براي مقدار 

کج شدن  وارد کنيد.
  Center3- براي جابه جایي نقطه تغيير شکل از مرکز شکل، مختصات جدید را در قسمت

وارد کنيد.
4- روي دکمه Skew کليک کنيد.

Transform شکل 46-10 پنل

Combine 10-10 فرمان هاي
در FreeHand MXa قابليت ترکيب ساده و پيچيده اشکال و مسيرها وجود دارد که در زیر 
 Modify→Combine فرمان ،Combine به آن  ها اشاره شده است. براي دسترسي به گزینه هاي

را انتخاب کنيد.
Blend 1-10-10 فرمان

از این فرمان براي ترکيب کردن یا به هم رس��اندن دو یا چند موضوع انتخابي اس��تفاده 
مي ش��ود. در صورتي که دو موضوع مختلف را انتخاب کرده، س��پس این فرمان را اجرا کنيد، 
بين موضوعات انتخاب شده اشکالي ایجاد  مي شود؛ به طوري که به نظر مي رسد موضوعي به 

تدریج و طي چند مرحله به موضوع دیگر تبدیل شده است.
 Blend استفاده از فرمان

 1- دو ی��ا چن��د موضوع گرافيک��ي را که مي خواهي��د باهم ترکيب ش��وند، انتخاب کنيد 
)شکل 10-47(.

2- فرمان Modify→Combine→Blend را اجرا کنيد )شکل 10-48(.
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همان طور که در شکل 49-10 مشاهده مي کنيد، با استفاده از کادر متني Steps  مي توان 
تعداد مراحل تبدیل موضوعات انتخابي در فرمان Blend را تنظيم کرد.

کادر Range، محدوده توليد اشکال مياني بين دو موضوع انتخاب شده را براساس درصدي 
از فاصله ميان دو موضوع اصلي تعيين مي کند.

                                        

Blend شکل 48-10 نتيجه حاصل از فرمان      Blend شکل 47-10 دو موضوع گرافيکي انتخاب شده براي

 

Blend هنگام استفاده از فرمان Object شکل 49-10 پنل

 نكته: با کليد ترکيبي Ctrl+Shift+B مي توان عمل Blend   را انجام داد.

مثال 7: شکل 50-10 را با استفاده از Blend رسم کنيد.
1- یک دایره با ابزار Ellipse رسم کنيد.

2- یک بيضي در وسط دایره ترسيم کنيد.
3- بيضي و دایره را باهم انتخاب کنيد.

4- فرمان Modify→Combine→Blend را اجرا کنيد.     
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شکل 10-50

5- در پنل Object در کادر Steps عدد 15 را وارد کنيد.

 توجه: براي جدا کردن موضوعات ترکيبي تکرار ش��ده )Blend( مي توانيد دو بار از 

فرمان Modify→Ungroup یا کليد ترکيبي Ctrl+Shift+G  استفاده کنيد.

تمرين 9: دو شکل بعد را در صفحه ترسيم و رنگ آميزي کرده )شکل 10-51(، 
سپس اعمال  زیر را انجام دهيد:

1- دستور Blend را روي آن ها اجرا کنيد.
2- رنگ هر یک از شکل ها را تغيير داده و تغييرات را مشاهده کنيد.

3- تعداد مراحل تبدیل دو شکل به یکدیگر را 10 قرار دهيد. 

  

شکل 10-51 

Join Blend To Path  2-10-10 فرمان

از این فرمان براي فرم دادن موضوعات Blend شده استفاده مي شود. وقتي دو موضوع را 
توسط فرمان Blend با هم ترکيب مي کنيد شکل هاي مياني، بين دو موضوع و در یک راستا 
تش��کيل مي ش��وند. براي این که بتوانيد اشکال مياني را با یک مسير دلخواه هم تراز کنيد از 

فرمان Join Blend To Path استفاده کنيد.
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Join Blend To Path استفاده از فرمان
1- دو موضوع گرافيکي مانند ش��کل 52-10 ترس��يم کرده و آن ها را با دستور Blend با 

هم ترکيب کنيد.
2- یک مسير دلخواه رسم کنيد )شکل 10-53(.

                                

شکل 52-10 دو شکلBlend  شده                           شکل 53-10 رسم مسير

3- هر دو موضوع را انتخاب کنيد.
4- فرمان Modify→Combine→Join Blend To Path را اجرا کنيد )شکل 10-54(.

Join Blend To Path شکل 54-10 اعمال

تمرين 10: شکل 55-10 را ترسيم کنيد.

 Join Blend To Path شکل 55-10 نتيجه فرمان
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 توجه: براي جدا کردن موضوعات Blend ش��ده از یک مس��ير، مي توانيد از گزینه 

Split در منوي Modify استفاده کنيد.

Union 3-10-10 فرمان

این فرمان براي ترکيب یا یکپارچه کردن چند مس��ير یا موضوع گرافيکي و تبدیل آن ها 
به یک موضوع واحد به کار مي رود. این مس��يرها طوري با هم ترکيب مي ش��وند که خطوط 
مشترک بين آن ها حذف مي شوند. با کمک این توانایي، مي توانيد مسيرهاي پيچيده اي را با 

استفاده از اشکال ساده توليد کنيد.
Union استفاده از فرمان

1- دو ی���ا چن�د موض��وع را که روي ه�م قرار گرفته اند، مطابق ش��کل 56-10 انتخاب 
کنيد.

2- فرمان Modify→Combine→Union را اجرا کنيد.   

 توجه: رنگ درون مس��ير ترکيب ش��ده، از رنگ اولي�ن مسي�ري که ت�رسيم شده 

تبعيت خواهد کرد )شکلي که نسبت به بقيه اشکال عقب تر قرار گرفته است(.

                           

Union شکل 57-10 نتيجه حاصل از فرمان      Union شکل 56-10 انتخاب اشکال براي فرمان

 نكته: چنانچه مس��يرها با یکدیگر هم پوشاني نداشته باشند، نتيجه فرمان Join  و 
Union یکسان بوده و منجر به توليد یک مسير یکپارچه خواهد شد.
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تمرين 11: اش��کال 58-10 را رس��م ک��رده و فرم��ان Union را روي آن ها اجرا 
کنيد.

شکل 10-58

Divide 4-10-10 فرمان

این فرمان قس��مت هاي مش��ترک موضوع��ات را برش مي دهد و از آن یک ش��کل مجزا 
مي سازد. در واقع نواحي مشترک از هم جدا مي شوند، بدون آن که موضوعات اصلي حذف شوند؛ 

همچنين موضوعات به قطعات کوچک تر تقسيم مي شوند.
Divide استفاده از فرمان

1- دو یا چند موضوع را که روي هم قرار گرفته اند مطابق شکل 59-10 انتخاب کنيد.
2- فرمان Modify→Combine→Divide را اجرا کنيد )شکل 10-60( .   

                                                     

Divide شکل 59-10 انتخاب سه شکل                   شکل 60-10 اعمال فرمان

Crop 5-10-10 فرمان
این فرمان قس��مت هاي مشترک موضوعات گرافيکي را برش مي دهد. وقتي دو یا چند مسير 
را که با یکدیگ�ر هم پوش��ان�ي و ت�داخل دارند، انتخاب کرده و فرمان Crop را روي آن ه�ا اجرا 
کنيد، قسمت هایي از مسيرهاي زیرین که به داخل مسير بالایي نفوذ کرده، باقي مي مانند و سایر 
قسمت ها که در خارج از مرزهاي شکل بالایي واقع شده اند، حذف مي شوند. در واقع موضوع��ي 
که روي ش��کل یا اش��کال دیگر قرار گرفته به عنوان یک چاقو عمل مي کند تا قس��مت هایي از 
موضوعات زیر که خارج از تصویر بالایي قرار گرفته اند، حذف ش��وند و فقط بخش هاي مش��ترک 
 Union عمل مي کند، با این تفاوت که Union عکس فرمان Crop اش��کال باقي بمانند. فرم�ان
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ویژگي رنگي مس��يرها را تغيير مي دهد اما Crop عمل برش را با حفظ رنگ هاي اوليه مس��ير ها 
انجام مي دهد.

 Crop استفاده از فرمان
1- موضوعات متنوعي را به همراه موضوعي که در بالاي آن ها قرار دارد، انتخاب کنيد.

.)1 2- فرمان Modify→Combine→Crop   را اجرا کنيد )شکل 62-

    
Crop شکل 61-10 انتخاب موضوعات گرافيکي    شکل 62-10 نتيجه حاصل از اجراي فرمان

3- فقط قس��مت هایي از موضوعات انتخاب ش��ده باقي مي مانند که اش��کال زیرین آن با 
شکل بالا تداخل داشته باشد.

Intersect 6-10-10 فرمان

اج��راي این فرمان روي مس��يرهایي که ب��ا هم تداخل دارند، موجب مي ش��ود که فصل 
مشترک موضوعات حفظ شده و سایر قسمت ها حذف شود.

Intersect استفاده از فرمان
1- موضوعاتي را که با هم تداخل دارند، رسم و انتخاب کنيد )شکل 10-63(.

2- فرمان Modify→Combine→Intersect  را اجرا کنيد )شکل 10-64(.

                                            
Intersect شکل 63-10 رسم و انتخاب دو شکل متداخل            شکل 64-10 نتيجه حاصل از فرمان

 توجه: تفاوت بين دس��تور Crop و Intersect  در این اس��ت که فرمان Crop فصل 

 Intersect مش��ترک شکل ها را با ش��کل بالایي نگه مي دارد و بقيه را حذف مي کند اما فرمان
باعث مي ش��ود که فصل مش��ترک همه موضوع��ات باقي بماند. تفاوت بين دس��تور Crop و 
Intersect  در ش��کل 65-10 به صورت تصویري نشان داده شده است. توجه داشته باشيد که 
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در این شکل ابتدا مربع، سپس ستاره و بالاترین شکل بيضي رسم شده است.

Intersect و Crop شکل 65-10 تفاوت

 مثال 8:
1- یک س��تاره، دایره و ش��ش ضلعي متداخل )ش��کل 65-10( رس��م کرده، آن ها را به 

دلخواه رنگ کنيد.                                                                 

شکل 10-66

2- ش��کل قبل را انتخاب ک��رده، دس��تور Modify→Combine→Intersect را اجرا کنيد 
)شکل 67-10(. شکل 66-10 را انتخاب کرده و دستور Modify→Combine→Crop را اجرا 

کنيد )شکل 10-68(.

         Intersect شکل 67-10 نتيجه حاصل از تأثير فرمان

3- به تفاوت دو فرمان Crop و Intersect دقت کنيد.
                                                                 

Crop شکل 68-10 نتيجه حاصل از تأثير فرمان   
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Punch 7-10-10 فرمان

با استفاده از این فرمان مي توانيد توسط موضوعي که در رو قرار گرفته بخشي از موضوع 
دیگر را که در زیر قرار دارد، حذف کنيد. دو شکل را روي هم قرار دهيد به طوري که شکل 
بزرگ تر زیر قرار بگيرد، سپس فرمان Punch را اجرا کنيد، مي بينيد که قسمت هاي مشترک 
دو ش��کل حذف مي شوند. بدین وسيله حفره اي به اندازه و فرم شکل بالایي در شکل  پایيني 
ایجاد ش��ده و شکل رویي حذف مي شود. اگر ش��کلي که در رو قرار دارد با شکلي که در زیر 

واقع است، هم پوشاني داشته باشد، شکل زیر برش مي خورد.
 Punch استفاده از فرمان

 1- موضوعات��ي را ک��ه همه یا قس��متي از آن ها روي هم ق��رار گرفته ان��د، انتخاب کنيد 
)شکل 10-69(.

2- فرمان Modify→Combine→Punch را اجراکنيد )شکل 10-70(.

                                 

Punch شکل 70-10 پس از اعمال فرمان      Punch شکل 69-10 موضوعات گرافيکي براي اجراي فرمان     

3- موضوع بالایي روي موضوع پایيني، سوراخ ایجاد مي کند.

 توج�ه: در هنگام کار با متن )Text( ابتدا باید متن به موضوع گرافيکي )مس��ير( تبدیل 

 ش��ده ، س��پس فرم��ان Join روي آن اعمال ش��ود، پس از آن مي ت��وان فرمان  �� Punch را اجرا کرد 
)شکل 10-71(.

شکل 71-10 نمایش اعمال فرمان Punch روي متن

در شکل 72-10 مي توانيد نتيجه حاصل از سه فرمان Punch ، Crop و Union را مشاهده 
کنيد.
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Punchو Union ،Crop شکل 72-10 مقایسه فرمان هاي

 Punch تمرين 12: شکل 73-10 را با استفاده از سه شکل الف، ب، ج و با فرمان
رسم کنيد.

                                  )الف(                    )ب(                   )ج( 

شکل 10-73

Alter Path 11-10 ويرايش مسير با فرمان هاي
هنگامي که با استفاده از روش هاي مختلف، مسيرهایي را ایجاد کردید، مي توانيد آن ها را 
به روش هاي گوناگون اصلاح کنيد یا تغيير ش��کل دهيد. براي دسترسي به فرمان هاي مزبور 

مسير زیر را اجرا کنيد:
Modify →Alter Path

Correct Direction 1-11-10 فرمان

در ای��ن واحد کار اص��ول ادغام کردن موضوعات گرافيک��ي را آموختيد. هنگامي که چند 
 Even/odd با هم ادغام مي ش��وند، مي توانيد با اس��تفاده از گزینه Join موضوع توس��ط فرمان
fill موجود در پنل Object )ش��کل 74-10( رنگ قسمت هاي روي هم افتاده )هم پوشاني( را  
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تعيين کنيد.
اگر این گزینه فعال باش��د قس��مت هاي روي هم افتاده ش��فاف دیده مي شوند و اگر این 
گزینه فعال نباش��د، قس��مت هاي روي هم افتاده، هم رنگ بقيه قسمت هاي شکل مي شوند 

)شکل 10-75(.

                

        شکل 74-10 گزینه Even/odd fill                شکل 75-10 نتيجه حاصل از فعال و غيرفعال بودن

Even/odd fill گزینه                                               Object موجود در پنل               

حال اگر گزینه Even/odd fill فعال باشد اما قسمت هاي روي هم افتاده شکل ها به صورت 
شفاف دیده نشوند با اجراي فرمانCorrect Direction  قسمت هاي روي هم افتاده موضوعات 
گرافيکي ادغام ش��ده و ش��فاف مي ش��وند. این فرمان را مي توانيد به یک��ي از روش هاي بعد 

انتخاب کنيد:
	 Modify→Alter Path→Correct Direction

	 Xtras→Cleanup→ Correct Direction

	Xtra Operations انتخاب آیکن  از نوار ابزار
 Reverse Direction2-11-10 فرمان

هنگامي که مس��يري را ترس��يم مي کنيد، جهت مس��يرهاي ایجاد شده به همان ترتيبي 
است که نقاط لنگر را ایجاد مي کنيد. اولين نقطه اي که ایجاد مي شود شروع مسير و آخرین 
نقطه، انتهاي مس��ير خواهد بود. گاهي اوقات لازم مي ش��ود که در رسم موضوعات گرافيکي، 
جهت مسيرها را تغيير دهيد؛ براي این کار از فرمان  Reverse Direction استفاده کنيد. براي 

اجراي این فرمان یکي از روش هاي زیر را برگزینيد.
	Modify→Alter Path→Reverse Direction

	Xtras→Cleanup→Reverse Direction

	Xtra Operations انتخاب آیکن  از نوار ابزار
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روش تغيير جهت مسير
1- مسيري را که مي خواهيد جهت آن تغيير کند، انتخاب کنيد )شکل 10-76(.

2- فرم��ان Modify→Alter Path→Reverse Direction را اج��را کني��د؛ نتيجه حاصل در 
شکل 77-10 نمایش داده مي شود.

                    

Reverse Direction  شکل 77-10 نتيجه حاصل از فرمان       شکل 76-10 انتخاب مسير           

 تمرين 13: شکل 78-10 را ترسيم کرده و  به 79-10 تبدیل کنيد.

                    
                                                 

                   

 Reverse Direction  شکل 78-10                     شکل 79-10 نتيجه حاصل از فرمان                

 توج�ه: ب��راي معکوس کردن ن��وک فلش ابت��دا و انتهاي خط��وط متصل کننده 

)Connector( فرمانReverse Direction به کار مي رود.

Remove Overlap 3-11-10 فرمان

ای��ن فرم���ان نواحي را که در یک مس��ير روي ه�م ق�رار مي گي�رن��د، حذف مي کند. به 
عبارت دیگر فرمانRemove Overlap  مس��ير را طوري تغيير مي دهد تا نواحي که با یکدیگر 

هم پوشاني دارند، حذف شوند. براي اجراي این فرمان یکي از روش هاي بعد را برگزینيد.
	Modify→Alter Path→Remove Overlap

	Xtras→Cleanup→Remove Overlap

Xtra Operations انتخاب آیکن  از نوار ابزار      
Remove Overlap استفاده از فرمان

1- موضوع موردنظر را انتخاب کنيد )شکل 10-80(.
2- فرمان Modify→Alter Path→Remove Overlap را اجرا کنيد. نواحي  که روي هم قرار 

گرفته اند مطابق شکل 81-10 حذف مي شوند.
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Remove Overlap شکل 81-10 نتيجه حاصل از فرمان                 شکل 10-80  

 نكت�ه: باید توجه داش��ت که موضوع پس از اجراي فرم��ان Remove Overlap به 
صورت یکپارچه خواهد شد.

در این حالت بخش هاي شفاف محصور در داخل مسير به اشکال قابل انتخاب و ویرایش 
تبدیل مي ش��وند. چنين به نظر مي آید که این موضوعات که کاملًا هم رنگ مس��ير هستند، 
روي مس��ير قرار گرفته و فرمان Punch به صورت خودکار روي موضوع و مس��ير اجرا ش��ده 

است
مثال 9:

  
1- ابتدا شکل 82-10 را ترسيم و انتخاب کنيد.

2- فرمان Remove Overlap را اجرا کنيد )شکل 10-83(.
3- مي توانيد با ابزار Subselect قس��مت داخلي ش��کل را نيز انتخاب و جدا کنيد )ش��کل 

.)10-84

                                          

شکل 82-10                       شکل 83-10                         شکل 10-84

Simplify 4-11-10 فرمان

در بعضي مس��يرها معمولاً تعداد زیادي گره اضافي قرار دارد که باعث مي ش��ود س��رعت 
پردازش و چاپ مسير طولاني شود و در هنگام اصلاح و ویرایش مسير نيز با مشکلاتي مواجه 
شوید. در این صورت مي توانيد با استفاده از فرمانSimplify  تعداد گره هاي اضافي موجود در 
مسير را کم کنيد تا مسير ساده تر و هموارتر شده و ویرایش آن نيز آسان تر شود. براي اجراي 

این فرمان یکي از روش هاي بعدي را برگزینيد.
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	Modify→Alter Path→Simplify

	Xtras→Cleanup→Simplify

	Xtra Operations انتخاب آیکن  از نوار ابزار
Simplify روش استفاده از فرمان

1- موضوع موردنظر را که مي خواهيد تعداد گره هاي آن کم ش��ود، انتخاب کنيد )ش��کل 
.)10-85

شکل 85-10 انتخاب مسير

2- فرم��ان Modify→Alter Path→Simplify را اجرا کني��د، کادرمحاوره Simplify مطابق 
شکل 86-10 ظاهر مي شود.

Simplify شکل 86-10 کادرمحاوره

3- در این کادر محاوره با اس��تفاده از دکمه لغزنده موجود مي توانيد ش��دت تأثير فرمان 
را روي مس��ير انتخاب ش��ده تغيير دهيد. هرچه این مقدار بيشتر باشد، نقاط بيشتري حذف 

مي شوند.
4- براي دیدن نتيجه کار قبل از بستن کادرمحاوره روي دکمه Apply کليک کنيد و اگر 

نتيجه رضایت بخش بود روي دکمه OK کليک کنيد )شکل 10-87(.

Simplify شکل 87-10 نتيجه حاصل از فرمان

 Xtras→Distort→AddPoints نكته: براي اضافه کردن نقاط بيشتر به مسير، از فرمان 
استفاده کنيد.
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 مثال 10:
1- یک چند ضلعي مطابق شکل 88-10 رسم کنيد.

شکل 88-10 رسم چند ضلعي

 2- ب��ا اس��تفاده از فرم��ان Add Points به ش��کل رس��م ش��ده، نقاط��ي را اضافه کنيد 
)شکل 10-89(.

 Add Points  شکل 89-10 نتيجه حاصل از تأثير فرمان

را کاه��ش دهي��د  نق��اط روي ش��کل  Simplify تع��داد  فرم��ان  از  اس��تفاده  ب��ا   -3 
)شکل 10-90(.

Simplify شکل 90-10 نتيجه حاصل از تأثير فرمان

Expand Stroke 5-11-10 فرمان

اجراي این فرمان روي مسيرهاي بسته، باعث افزایش ضخامت خطوط دور مسير مي شود 
به طوري که ش��کل، به یک ش��کل ترکيبي )Composite Path( تبدیل خواهد شد. همچنين 
اجراي این فرمان، مسيرهاي باز را به بسته تبدیل مي کند و باعث گسترش ضخامت خط دور 
مي ش��ود، ضخامت خط از 1 تا 50 قابل تنظيم اس��ت و این ضخامت در واقع به وس��يله یک 

مسير بسته ایجاد مي شود. 
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مي توان پس از اجراي فرمان Expand Stroke، روي مس��يري که به موضوع تبدیل ش��ده،  
ویرایش هاي مربوط به موضوعات )از قبيل تمامي گزینه هاي منوي بازشو در Fill( را اجرا کرد. 

براي اجراي این فرمان یکي از روش هاي زیر را برگزینيد.
	Modify→Alter Path→Expand Stroke

	Xtras→Path Operations→Expand Stroke

Xtra Operations انتخاب آیکن  از نوار ابزار        
Expand Stroke روش استفاده از فرمان

1- مسيري را که مي خواهيد تغيير دهيد، انتخاب کنيد )شکل 10-91(.

شکل 91-10 انتخاب مسير

 2- فرم��ان Modify→Alter Path→Expand Stroke را اج��را کني��د.کادر محاوره ش��کل
92-10 ظاهر مي شود.

Expand Stroke شکل 92-10 کادر محاوره

تمرين 14: شکل 93-10 را رسم کرده و فرمان Expand Stroke را روي آن اجرا 
کنيد.

شکل 10-93
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Inset Path   6-11-10 فرمان

با استفاده از این فرمان مي توان در اطراف مسيرهاي انتخاب شده، به تعداد دلخواه مسير 
اضافي ایجاد کرد. این مسيرها متحدالمرکز بوده و مي توانند به سمت درون یا بيرون موضوع 

انتخاب شده، ایجاد شوند. 
ب��ه عبارت دیگر فرمان Inset Path کپي هاي متع��دد از یک موضوع را ایجاد مي کند. این 
کپي ها مي توانند کوچک تر یا بزرگ تر از موضوع اوليه باش��ند. براي اجراي این فرمان یکي از 

روش هاي بعد را برگزینيد.
	Modify→Alter Path→Inset Path

	Xtras→Path Operations→Inset Path

	Xtra Operations انتخاب آیکن  از نوار ابزار
Inset Path   روش استفاده از فرمان

1- موضوع گرافيکي موردنظر را انتخاب کنيد )شکل 10-94(.
2- فرمان Modify→Alter Path→Inset Path را اجرا کنيد. کادر محاوره ش��کل 10-95 

ظاهر مي شود.
3- در کادر Steps تعداد مسيرهایي )کپي ها( را که مي خواهيد بر اساس مسير اصلي ایجاد 

شوند، تعيين کنيد.
4- منوي بازشوي Steps داراي سه حالت انتخابي است:

حالت Uniform: باعث مي شود فاصله ميان مسيرها یکنواخت باشد.
حالت Farther: با اس��تفاده از این حالت هرچه از موضوع گرافيکي انتخاب ش��ده دورتر 

مي شوید، فواصل بين مسيرها بيشتر مي شود.
حالت Nearer: با اس��تفاده از این حالت هرچه از موضوع گرافيکي انتخاب ش��ده دورتر 

مي  شوید، فواصل بين مسيرها کمتر مي شود. 

                              

Inset Path شکل 94-10 انتخاب موضوع گرافيکي     شکل 95-10 کادر محاوره
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شکل 96-10 تفاوت بين این سه حالت را نشان مي دهد.

Uniform حالت                                 Farther حالت                              Nearer حالت  

Steps شکل 96-10 تفاوت بين حالات موجود در منوي بازشوي

1- در کادر Inset  مي توان مش��خص کرد که مس��يرهاي اضافه شده، در خارج از شکل یا 
داخل شکل قرار گيرند. اگر مقدار وارد شده در این کادر مثبت باشد، مسيرهاي اضافه شده، 
داخل ش��کل و اگر منفي باشد، خارج از ش��کل قرار خواهند گرفت. همچنين در این قسمت 

فاصله ميان مسيرها را نيز مي توان کنترل کرد. 
 در شکل 97-10 نمونه هایي از تأثيرات فرمان  Inset Path   را روي موضوع گرافيکي واقع در شکل
94-10 ب��ه هم��راه تنظيمات��ي که بای��د در کادر محاوره Inset Path وارد ش��ود، مش��اهده 

مي کنيد.
   

 

Inset Path شکل 97-10 نمونه هایي از اثر فرمان

2- روي دکمه OK کليک کنيد.
مثال 11:

 
1- شکل 98-10 را رسم کنيد.

2- دو رونوش��ت از ش��کل 98-10 ایجاد کنيد به طوري که خارج از ش��کل قرار گيرند و 
همان طور که از شکل اصلي دور مي شوند فواصل آن ها کمتر شود.
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 Modify→Alter ب��راي ای��ن کار ابت��دا ش��کل 98-10 را انتخاب کنيد، س��پس فرم��ان
Path→Inset Path را اجرا کنيد. در کادر محاوره Inset Path براي تنظيم تعداد کپي ها مقدار 

Steps را براب��ر 2 قرار دهيد و حال��ت Nearer را برگزینيد، همچنين مقدار Inset را 10- قرار 

دهيد، نتيجه حاصل به صورت شکل 101-10 خواهد بود.

                                        

Inset Path شکل 98-10                    شکل 99-10 نتيجه حاصل از فرمان

 Mirror 12-10 انعکاس اشياء با ابزار
ب�ا استفاده از این ابزار مي توان قرینه )انعکاس( یک موضوع انتخاب شده را در جهت هاي 
افق��ي، عمودي یا چرخش��ي ایجاد کرد. براي اس��تفاده از این ابزار یک��ي از روش هاي بعد را 

انتخاب کنيد.
ابزار Mirror را از جعبه ابزار انتخاب کنيد.	

را  از مس��ير Window→Toolbars نوار ابزار Xtra Tools را باز کرده س��پس ابزار  	
برگزینيد.

Mirror 1-12-10 روش كار با ابزار

1- روي اب��زار Mirror دابل کليک کنيد تا کادر محاوره Mirror مطابق ش��کل 10-100 
باز شود.

Mirror شکل 100-10 کادر محاوره

2- منوي بازشوي موجود در Mirror، شامل حالات زیر براي قرینه سازي است: 
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"Vertical:	 قرین��ه عم��ودي یعني ش��ئ را از س��مت  چپ  به  راس��ت  نش��ان  مي دهد 

)شکل 10-101(.
Horizontal: قرینه افقي یعني شئ را از بالا به پایين  نشان مي دهد. 	

Horizontal & Vertical: قرینه افقي و عمودي.	

شکل 101-10 قرینه عمودي

Multiple: موضوعات را نسبت  به محورهاي مختلف قرینه  مي کند. در این حالت مي توانيد 

از دکم��ه لغزن��ده موجود در کادر محاوره Mirror براي تنظيم تعداد محورهاي قرینه س��ازي 
استفاده کنيد.

 نكته: نگه داشتن کليد Alt  باعث مي شود تا هنگام استفاده از ابزار Mirror محور 
قرینه سازي دوران کند.

تمرين 15: ش��کل 102-10 را رسم کنيد و با ابزار Mirror شکل 103-10 را به 
دست آورید.

                                                      

     شکل 102-10                                     شکل 103-10 رسم شکل

مث�ال کاربردي: فایل Project مثال کارب��ردي را باز کنيد. حال مي خواهيم آرم 
 

را کامل کنيم.
1- به صفحه ترسيم آرم بازگردید و ترسيم آرم را از واحدکار ششم ادامه دهيد.
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2- از دایره یک کپي تهيه کرده، سپس پنلTransform  را ظاهر کنيد. در این پنل دکمه 
Scale را فعال کنيد تا گزینه هاي Scale  در دسترس قرار گيرند.

3- در کادر Scale مقدار 42% را وارد کنيد تا دایره دوم به اندازه 58% کوچک تر شود.

شکل 10-104

4- دایره ه��ا را انتخ��اب ک��رده و از حالت گروهي خارج کنيد تا نقاط لنگر ظاهر ش��وند. 
 Modify نقاط لنگر دایره ه��ا را انتخاب کنيد و از منوي Shift و کليد Subselect توس��ط اب��زار
چند بار فرمان Split را اجرا کنيد تا دایره ها در نقاط لنگر شکس��ته و به چهار قطعه تقس��يم 
ش��وند. نيم کره پایين و قطعات سمت راست هر دو دایره را حذف کنيد تا شکل 105-10 به 

دست آید.
5- اکنون هر دو کمان را انتخاب کرده و از منوي Modify فرمان Join را انتخاب کنيد و 
در پنل Object گزینه Closed را فعال کنيد تا طرف دیگر کمان ها نيز به یکدیگر چسبيده و 

یک شکل بسته حاصل شود.                       
6- هر دو ش��کل را انتخاب کنيد و از من��وي Modify→Combine فرمان Union را اجرا 
کنيد تا یک مس��ير واحد به وجود آید، سپس ش��کل را انتخاب کرده از پنل Swatches رنگ 
سياه را براي دکمهFill  انتخاب کنيد تا شکل از رنگ سياه پر شود. اکنون دکمه Stroke را در 

پنل Swatches فعال و None را انتخاب کنيد تا خط دور شکل حذف شود.

              

شکل 105-10                      شکل 10-106

7- شکل 107-10 را انتخاب کنيد و با استفاده از فرمان Edit→Clone یک کپي از شکل 
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ایجاد کرده و با استفاده از ابزار Mirror آن را به شکل 108-10 تبدیل کنيد.

 

 شکل 107-10                                  شکل 10-108

8- حال با استفاده از خطوط راهنما و ابزار Pen شکل 109-10 را رسم کنيد.
9- داخل ش��کل را س��ياه رنگ کنيد. مطابق ش��کل 110-10 دو دایره در قس��مت هاي 

مشخص شده در شکل رسم کنيد و آن ها را نيز با رنگ سياه پر کنيد.

               

شکل 109-10                                              شکل 10-110

10- تغييرات را ذخيره کنيد.

واژه نامه
Cropبرش

Divideتقسيم کردن

Intersectاز وسط قطع کردن

Lockقفل کردن

Punchسوراخ کردن

Splitاز هم جدا کردن

Ungroupاز گروه خارج کردن

Unionپيوند، اتحاد

خلاصه مطالب 
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فرمان Join	 باعث اتصال دو خط به یکدیگر مي شود.
از فرمان Split	 براي شکستن موضوعات بسته و جدا کردن خطوط و گره ها از یکدیگر و جدا 

کردن موضوعات Join شده استفاده مي شود.
به منظور چرخش موضوعات تحت زاویه اي خاص مي توان از ابزار Rotate	 استفاده کرد.

براي ایجاد قرینه یا انعکاس یک موضوع گرافيکي از ابزار Reflect	 استفاده مي شود.
از ابزار Skew	 براي مورب کردن موضوعات استفاده مي شود.

گزینه هاي Blend و Union	 براي ترکيب گوناگون اشکال به کار مي روند.
از گزینه Join Blend To path	 براي قرار دادن موضوع ترکيب ش��ده روي مس��ير اس��تفاده  

مي شود.
گزینه Divide	 قس��مت مش��ترک موضوعات را ب��رش مي دهد و از موضوع��ات اصلي جدا 

مي کند.
از گزینه Intersect	 براي به دست آوردن قسمت هاي مشترک موضوعاتي که روي یکدیگر 

قرار دارند، استفاده مي شود. 
گزینه Punch	 ش��کلي را که روي بقيه اش��کال قرار دارد همراه با قس��مت مشترک آن با 

اشکال زیر حذف و باقي اشکال را حفظ مي کند.
گزینه Crop	 قسمت مشترک موضوعات را برش مي دهد.

براي ایجاد تصویر قرینه و آینه اشکال از ابزار Mirror استفاده مي شود.	
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعیین کنید.

1- فرمان Split قسمت مشترک موضوعات را برش مي دهد.
2- کاربرد فرمان Group گروه کردن موضوعات است.

3- فرمان Expand Stroke در اطراف یک ش��ئ به سمت داخل، کپي هاي متعددي ایجاد 
مي کند.

4- عملکرد فرمان Mirror با Rotate یکسان است.
معادل گزينه  هاي سمت  راست را از ستون سمت  چپ انتخاب کرده و مقابل هر عبارت بنويسید.

    Punch. براي به دست آوردن قسمت هاي مشترک موضوعاتي که روي یکدیگر قرار دارند
شکل روي بقيه اشکال را همراه با قسمت مشترک آن با اشکال زیر، حذف و باقي اشکال 
     Crop                                                                                   .را حفظ مي کند
     Reverse Direction                               .قسمت مشترک موضوعات را برش مي دهد
                   Intersect                                                       اصلاح جهت قرارگيري مسيرها

گزينه صحیح را انتخاب کنید.

9- فرمانSplit  برعکس کدام فرمان عمل مي کند؟
Align -د  Divide -ج  Crop -ب  Join -الف

10- براي حذف روي هم افتادگي موضوعات از کدام فرمان استفاده مي کنيد؟
Remove Overlap  -ب   Simplify  -الف
Correct Direction  -د   Delete -ج

11- براي هم تراز کردن موضوعات نسبت به یکدیگر، از کدام گزینه استفاده مي شود؟
Join -د    Divide -ج  Crop -ب  Align -الف

12- ازکدام گزین��ه براي واحد کردن چند ش��کل و تبدیل آن ها به یک موضوع اس��تفاده 
مي شود؟

Ungroup -د  Union -ج  Lock  -ب  Punch -الف
13- براي خارج کردن موضوع گرافيکي از حالت قفل، از کدام فرمان استفاده مي شود؟ 

Lock -د  Unlock -ج  Union -ب  Join -الف
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14- براي اتصال دو خط به یکدیگر از کدام فرمان استفاده مي شود؟
Join -د               Blend -ج        Split -ب     Align -الف

15- کدام فرمان باعث افزایش ضخامت خطوط دور شکل مي شود؟
Union    -د  Intersect -ج  Expand Stroke -ب  Inset Path -الف

16- براي برش قس��مت هاي مش��ترک موضوعات، بدون حذف موضوعات اصلي از کدام 
فرمان استفاده مي شود؟

Punch -د             Crop  -ج        Split -ب       Divide -الف
17- براي انتخاب اجزاي یک گروه از کدام ابزار استفاده مي شود؟

 Subselect -ب   Group -الف
Pen -د   Pointer -ج

در جاي خالي عبارت مناسب را بنويسید.

18- هنگام اس��تفاده از فرمان ............ رونوشت هاي ایجاد شده در داخل  شکل اصلي قرار 
مي گيرند.

19- براي قرینه  سازي موضوعات به صورت افقي هنگام استفاده از ابزار Mirror از گزینه 
......... استفاده مي شود.

20- ابزار .............. موضوعات را مورب مي کند.
به سؤالات زير پاسخ تشريحی دهید.

21- بعد از قفل کردن یک شکل چه اعمالي را نمي توان روي شکل انجام داد؟
22- فرمان Blend چه عملي را انجام مي دهد؟

23- چگونه مي توان موضوعات گرافيکي داخل صفحه را نسبت به هم، تراز افقي کرد؟
24- فرمانJoin  Blend To Path چه عملي را انجام مي دهد؟

25- از ابزارReflect  در چه مواقعي استفاده مي شود؟
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 آزمون عملي
1- اشکال زیر را با استفاده از ابزارهاي این واحد کار رسم کنيد.

 
2- شکل الف را ترسيم کرده، سپس آن را با یک فرمان به شکل ب تبدیل کنيد.

بالف 

3- با استفاده از ابزارهاي مناسبي که در این واحد کار با آن ها آشنا شده اید به سليقه خود 
در یک صفحه  به اندازه A3 در مورد رش��ته هاي گرافيک، کامپيوتر و تعمير موبایل هنرستان 

خود تبليغ کنيد.
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كليات 
در واحدکاره��اي قبل با پنل Object  آش��نا ش��دید این پنل نه تنها کنترل بيش��تري بر 
موضوع��ات مختلف دارد، بلکه امکان اف��زودن جلوه هاي ویژه )Special effect( به موضوعات را 

نيز دارا است.
Add effect 1-11 اضافه كردن جلوه هاي ويژه با استفاده از

با اس��تفاده از گزینه Add effect موج��ود در پنل Object مي توان خصوصيات و جلوه هاي 
ویژه اي را به اشکال اضافه نمود.

شئ، مراحل زیر را انجام دهيد: 	 Stroke یا Fill به منظور افزودن جلوه هاي ویژه به
1- موضوع مورد نظر را انتخاب نمایيد.

2- در پن��ل Object روي دکم��ه Add effect کلي��ک کرده و از منوي ظاهر ش��ده جلوه 
موردنظر را انتخاب کنيد)شکل 11-1(.

Add effect شکل 1-11 گزینه هاي
به منظور حذف جلوه ویژه از موضوع انتخابي، مراحل بعد را انجام دهيد: 	

1- در پنل Object جلوه ویژه را انتخاب نمایيد.
2- سپس در همان پنل روي دکمه  )Remove item( کليک کنيد.

در این جا به شرح گزینه هاي موجود درAdd effect  مي پردازیم:

 توجه: برخي از جلوه ها به صورت ابزار در نوار ابزار Xtra Tools قرار دارند.

Bend 1-1-11 جلوه
این گزینه در شکل ها و مسيرهاي رسم شده، پيچ و خم و اعوجاج ایجاد مي کند، به طوري 
که با کشيدن نقاط محيط به سمت نقطه مرکز یا دور نمودن این نقاط از مرکز، پاره خط هاي 
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مسير به سمت داخل یا خارج منحرف مي شوند و حالت شکل تغيير پيدا مي کند.
Bend تنظيم گزينه هاي

1- گزینه Bend را از منوي Effect انتخاب کنيد. 
2- دکم��ه لغزن��ده مربوط به گزینه Size، ميزان فاصله نق��اط از مرکز یا ميزان خميدگي 

اعمال شده به شئ را تعيين مي کند. 
مقادی��ر مثبت، نقاط را از مرکز دورتر و در محل تلاقي کمان ها نقاط نوک تيز ایجاد  	

مي کند.
مقادی��ر منف��ي، نقاط را به مرکز نزدیک تر و انتهاي کمان ها را به مرکز ش��ئ متصل  	

 مي نماید )شکل11-3(.   

Bend شکل 2-11 كادر محاوره

Bend شکل اصلي    مقادیر مثبت در جلوه    Bend مقادیر منفي در جلوه

شکل 11-3

3- با ویرایش مختصات نقاط x و y مي توان مکان نقطه مرکز را تغيير داد.

تمرين 1: ش��کل 4-11 را رس��م کرده و جلوه Bend را روي Stroke دور ش��کل 
اعمال نمایيد )نتایج حاصل از تغيير مقدار Size را مشاهده کنيد(.
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شکل 11-4

Duet 2-1-11 جلوه

این جلوه یک یا چند مدل مش��ابه از ش��کل ساخته، آن ها را با یکدیگر ترکيب مي کند تا 
یک شکل پيچيده واحد ایجاد نماید.

مي توان تعداد مدل هاي مش��ابه را که ایجاد مي ش��وند تعيين کرد و مش��خص نمود که 
مدل هاي مشابه چرخش یابند یا انعکاس یافته شکل اوليه باشند.

Reflect شکل اصلي             گزینه              Rotate گزینه

شکل 11-5

براي اعمال جلوه Duet روي موضوع مورد نظر مراحل زیر را انجام دهيد:
1- پس از انتخاب موضوع موردنظر، از منوي Effect)شکل 1-11( گزینه Duet را انتخاب 

کنيد.
2- به منظور ایجاد تصویر منعکس ش��ده از تصویر اوليه گزینه Reflect  را انتخاب نمایيد 

)شکل 11-6(.
3- به منظور ایجاد کپي چرخش یافته حول نقطه مرکز گزینه Rotate  را انتخاب کنيد.
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Duet شکل 6-11 تنظيم خصوصيات جلوه

4- براي تنظيم موقعيت نقطه مرکزي جلوه و جهت اش��کال، مختصات x و y را اس��تفاده 
نمایيد.

5- براي تعيين تعداد کپي ها از شکل باید تعداد موردنظر را در کادر Copies وارد کرد.
6- اگر بخواهيد ش��کل اوليه با ش��کل هاي ایجاد شده به طور خودکار متصل شوند گزینه 

Joined را در حالت انتخاب قرار دهيد.

7- اگر کپي ها نزدیک به هم هس��تند گزینه Closed باعث بس��تن اش��کال ایجاد شده یا 
مسيرهاي باز مي شود.

8- براي ش��فاف نمودن نواحي همپوش��اني بين کپي ها، گزینه Even/Odd fill را انتخاب 
کنيد.

 مثال 1: براي درک بيشتر جلوه Duet مراحل زیر را انجام دهيد:
1- شکل 7-11 را رسم نمایيد.

2- گزینه Duet را از منوي Add effect انتخاب کنيد. تصویر منعکس شده از شکل اصلي 
همراه با خود شکل به صورت زیر ایجاد مي شود.

3- از قس��مت Style گزینه Rotate را انتخاب کرده، در کادر Copies عدد 6 را وارد نموده 
و گزینه Joined را انتخاب کنيد در این صورت شکل 9-11 به وجود مي آید.
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    شکل 7-11                           شکل 8-11                                                   شکل 11-9                                            

4- گزینه Closed را برگزینيد تا شکل 10-11 ایجاد شود.

      

شکل 11-10

تمرين 2: شکل 11-11را ایجاد کنيد.

شکل 11-11

Expand path 3-1-11 جلوه

این جلوه مس��ير را پهن نموده و طرح کلي )Outline( شکل حاصله را ایجاد مي کند. این 
جلوه تنها ظاهر مسير را تغيير مي دهد و باعث تغيير خود مسير نمي شود.
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Expand Path شکل 12-11 نمایش 
به منظور اعمال جلوه Expand Path روي موضوع موردنظر، مراحل زیر را انجام دهيد:

 Expand 1- پس از انتخاب موضوع موردنظر، از منوي ظاهر ش��ده )ش��کل 1-11( گزینه
Path را انتخاب کنيد.

2- تنظيمات موردنظر را اعمال نمایيد:
باعث گس��ترش مس��ير به س��مت  	    Inside only انتخاب گزینه Direction در من��وي
درون و گزینه Outside only باعث گس��ترش مس��ير به سمت بيرون مي شود. گزینه 
"Both مس��ير را به ط��ور یکس��ان به هر دو ط��رف درون و بيرون گس��ترش مي دهد 

)شکل 11-13(.

Direction شکل 13-11 گزینه هاي منو

در کادر متني Width مقادیر 0 تا 50	 را مي توان وارد نمود. هرچه مقدار وارد شده در 
این قسمت کمتر باشد، مسير کمتر گسترش مي یابد. از دکمه لغزنده در این قسمت 

نيز براي تنظيم اندازه مسير گسترش یافته استفاده مي شود. 
با عملکرد بقيه گزینه ها در واحد کار 9 آشنا شده اید.	

  Ragged4-1-11جلوه
ای��ن جلوه با افزودن نقاط تصادفي جدید، ظاهر ش��کل را تغيي��ر داده و ظاهري ناهموار، 

صاف یا یکدست به شکل مي دهد. این جلوه شبيه ابزار Roughen کار مي کند.

Both شکل اصلی      گزینه       Inside only گزینه     outside only گزینه                 
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Ragged شکل 14-11 جلوه

به منظور اعمال جلوه Ragged روي موضوع موردنظر مراحل زیر را انجام دهيد:
1- پس از انتخاب موضوع موردنظر از منوي ظاهر ش��ده )شکل 1-11( گزینه Ragged را 

انتخاب نمایيد.
2- تنظيمات موردنظر را اعمال نمایيد:

در کادر Size	 یا با کمک لغزنده آن مي توان فاصله نقاط افزوده ش��ده تا  ش��کل اصلي  
را تغيير داد.

در قسمت Frequency مي توان تعداد نقاط افزوده را تعيين نمود.	
در صورتي که بخواهيد از ش��کل موردنظر کپي ایجاد کنيد در قس��متCopy 	 تعداد 

کپي هاي مورد نظر را وارد نمایيد.

Ragged شکل 15-11 تنظيمات جلوه

یکي از گزینه هاي  Edgeکه در زیر بيان شده انتخاب کنيد:	
انتخاب گزینه Rough ، نقاط گوشه تيز را اضافه مي کند )شکل 11-16(.	
انتخاب گزینه Smooth، نقاط انحنادار را اضافه مي کند )شکل 11-16(.	

انتخاب گزینه Uniform باعث مي ش��ود تا جلوه Ragged	 به صورت یکنواخت اعمال 
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شود.

شکل 11-16

تمرين 3: شکل هاي زیر را با استفاده از جلوه هاي Ragged و Expand Path ایجاد 
کنيد.

شکل 11-17

  Sketch 5-1-11 جلوه
این جلوه نمایي از مسير را شبيه سازي مي کند که به نظر مي رسد شکل مورد نظر با مداد 

و به سرعت طراحي شده است.

اعمال جلوه Sketch در صورت                                    شکل اصلي                       اعمال جلوه Sketch در صورت
               بسته بودن خطوط دور شکل                                                                               باز بودن خطوط دور شکل 

Copies با Sketch شکل 18-11 اعمال جلوه

به منظور اعمال جلوهSketch  روي موضوع موردنظر، مراحل زیر را انجام دهيد:
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1- پس از انتخاب موضوع موردنظر، از منوي ظاهر شده گزینهSketch  را انتخاب کنيد.
2- تنظيمات موردنظر را اعمال نمایيد.

وارد کردن عدد بزرگ تر در قسمت Amount	 باعث مي شود که اختلاف شکل با شکل 
اوليه بيشتر شود.

براي ایجاد کپي از ش��کل ایجاد ش��ده، تعداد کپي موردنظر را در قسمت Copy	 وارد 
کنيد. در این صورت مسيرهاي جدیدي به وجود مي آیند که به طور تصادفي با سایر 

کپي ها متفاوتند )شکل 11-19(.

شکل 19-11 مثال هایي از تنظيم کادر کپي روي دو شکل

انتخاب گزینه Closed باعث مي ش��ود تا نقاط انتهایي شکل ایجاد شده به یکدیگر متصل 
شوند و شکل بسته ایجاد شود. 

Close غيرفعال بودن گزینه     Close فعال بودن گزینه                  

شکل 11-20

  Bevel and Emboss6-1-11 جلوه
جلوهBevel  باعث مي ش��ود لبه هاي ش��کل به حالت برجسته نمایش داده شوند و با جلوه 

Emboss  مي توان شکل یا متن را به صورت برجسته نمایش داد.

ب��ا انتخاب جل��وه  Bevel and Emboss )ش��کل 1-11( زیرمنویي به ص��ورت بعد نمایان 
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مي شود. 
انتخ��اب Inner Bevel و Outer Bevel	 باعث مي ش��ود تا لبه هاي ش��کل به ترتيب به 

سمت درون و بيرون شکل متمایل شوند و به حالت برجسته نمایش داده شوند.

 
شکل 22-11                                                                       شکل 11-23  

 ب��ا انتخ��اب Outer Bevel در پن��ل Object	 مي ت��وان تنظيم��ات زیر را انج��ام داد: 
)شکل 11-24(

از پالت رنگ مي توان رنگ مورد  نظر براي برجستگي به سمت خارج شکل  را انتخاب  	
نمود.

در ليست بازشوي Width مقدار مورد نظر براي پهناي برجستگي  را وارد نمایيد.	
مقادیر تعيين ش��ده در ليست بازش��وي Contrast	 ميزان روشني و تيرگي سایه ها را 

معين مي کند.
مي توان مقادیري براي تأثير بر صافي برجستگي، بدون  	  Softness در ليس��ت بازشوي
تأثي��ر ب��ر پهناي آن وارد کرد. ب��ه عبارت دیگر هر خط ضخيم در س��ایه زني حذف 

مي شود.
در ليس��ت بازش��وي Angle	 مي توان با وارد کردن مقدار موردنظر، زاویه تابش نور را 

تنظيم نمود.
در ليست بازشوي Edge shape شکل لبه را مي توان به دلخواه انتخاب کرد.	

در ليس��ت بازش��ويButton Preset 	 پيش تنظيم هایي براي تغيير ظاهر ش��ئ وجود 
دارد.
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شکل 11-24

 Raised اس��تفاده کرد. اگر گزینه Emboss براي برجس��ته کردن ش��کل مي توان از جلوه
Emboss را انتخاب کنيد کادر شکل 25-11 نمایش داده مي  شود.

Raised Emboss شکل 25-11 تنظيمات جلوه

مقدار مشخص شده در ليست بازشوي Width، اندازه عمق را تعيين مي کند.	
مقدار تعيين ش��ده در ليست بازش��وي Contrast	 ميزان روشني و تيرگي سایه ها را 

معين   مي کند.
مي توان مقادیري براي تأثير بر صافي برجستگي، بدون  	 Softness  در ليست بازش��وي

تأثير بر پهناي آن وارد کرد.
در قسمت Angle	 مي توان با وارد کردن مقدار مورد نظر یا استفاده از عقربه کشویي، 

زاویه تابش نور را تنظيم نمود.
در شکل 26-11 نمونه هایي از جلوه Emboss نشان داده شده است.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
310

شکل 11-26

در Inset Emboss برجسته س��ازي به نحوي است که گویي شئ در صفحه فشار داده شده 
است.

در Raised Emboss برجسته سازي به نحوي است که گویي شئ از صفحه بالاآمده   است.
تمرين 4: شکل 27-11 را طوري رسم کنيد که برجسته به نظر آید.

شکل 11-27
Blur 7-1-11 جلوه

این جلوه جزیيات تصویر را تيره و تار مي کند. این جلوه دو حالت دارد.
حال��تBasic ، جل��وه غيرمتمرکز به ش��کل مي دهد و حال��ت Gaussian ظاهري مبهم به 
 ش��کل مي دهد به طوري که به نظر مي آید از پش��ت شيشه نيمه مات به شکل نگاه مي کنيد 

)شکل 11-28(.

شکل 11-28

پ��س از اعمال جلوه Blur در کادر نمایش داده ش��ده )ش��کل 29-11( به منظور تعيين 
ميزان مات شدن شکل، عدد مورد نظر را وارد کنيد.
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     Blur شکل 29-11 تنظيمات جلوه

تمرين 5: ش��کل 30-11 را رس��م کرده و جلوه Gaussian Blur را روي آن اعمال 
کنيد.

شکل 11-30

Shadow and Glow 8-1-11 جلوه
براي ایجاد سایه دور شکل از جلوه Shadow استفاده مي شود و جلوه Glow درون یا بيرون 

شکل هاله ایجاد مي نماید )شکل 11-31(.
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Glow و Shadow شکل 31-11 نتيجه حاصل از تأثير جلوه

به منظور اعمال جلوه Shadow روي شکل مراحل زیر را انجام دهيد:
 Shadow andش��کل 1-11( گزینه( Effect 1- پس از انتخاب موضوع مورد نظر، از منوي

Glow  را انتخاب کرده سپس یکي از جلوه هاي زیر منوي مربوطه را برگزینيد.

) Drop Shadow: جلوه  را به گونه اي ایجاد  مي کند که به شئ سایه  مي دهد )شکل11-32	

جلوه به گونه اي اس��ت که گویي سوراخي از شئ در صفحه به وجود  	 :Inner Shadow

آمده است )شکل 11-32(.
Glow: در بخش بيروني شئ درخشندگي یا هاله ایجاد مي کند )شکل 11-32(.	

Inner Glow: در درون شئ درخشندگي ایجاد مي کند )شکل 11-32(.	

Glowو Shadow شکل 32-11 اعمال جلوه هاي

2- تنظيمات موردنظر را اعمال کنيد.
از قسمت Color	 رنگ موردنظر براي ایجاد سایه یا هاله را انتخاب نمایيد.

ميزان فاصله سایه از لبه شئ را در ليست بازشويOffset 	 تنظيم کنيد.
به منظور تعيين ميزان ش��فافيت س��ایه یا هاله در ليس��ت بازش��وي Opacity	 عدد 

موردنظر را وارد نمایيد.
براي این که س��ایه یکدس��ت و نرم روي تصویر اعمال ش��ود به طوري که پهناي آن  	
تغيير نکند مي توان در ليست بازشوي Softness عدد موردنظر را وارد نمود. به عبارت 

دیگر براي اعمال تارشدگي به لبه سایه استفاده مي شود.
براي تعيين زاویه تابش نور بر جسم، عدد موجود در ليست بازشوي Angle	 را تنظيم 

کنيد.
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Shadow and Glow شکل 33-11 تنظيمات جلوه

در تنظيمات جلوه س��ایه براي پنهان کردن شئ و باقي ماندن سایه، Knock Out	 را 
انتخاب کنيد )شکل 11-34(.

 Shadowدر انواع حالات جلوه Knock Out شکل 34-11 تنظيم گزینه

تمرين 6: ش��کل 35-11 را رس��م کنيد. )به جلوه هاي اعمال ش��ده روي شکل 
توجه کنيد.(

شکل 11-35
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Sharpen 9-1-11 جلوه

این جلوه با تنظيم Contrast پيکسل هاي همجوار در شکل، وضوح یا تيزي لبه هاي شکل 
را افزایش مي دهد )شکل 11-36(.

Sharpen شکل 36-11 نتيجه حاصل از تأثير جلوه

به منظور اعمال جلوهSharpen  روي موضوع موردنظر مراحل زیر را انجام دهيد:
1- پ��س از انتخاب موض��وع موردنظر، از منوي Effect )ش��کل 1-11( جلوه Sharpen را 

انتخاب کنيد، سپس از زیرمنوي آن گزینه هاي زیر را برگزینيد. 
2- تنظيمات موردنظر را اعمال کنيد. )شکل 11-37(

در ليست بازشوي Amount  ميزان شدت اعمال جلوه را تعيين کنيد.	
زماني که Unsharp mask انتخاب ش��ده باش��د از ليست بازشوي Pixel Radius	 براي 
تنظيم اندازه ناحيه اي استفاده کنيد که جلوه Sharpen به آن اعمال شده باشد. اعداد 

بالاتر به معناي اعمال جلوه کمتري به تصویر است.

Sharpen شکل 37-11 تنظيمات جلوه

Transparency 10-1-11جلوه

با اس��تفاده از این جلوه مي توان تمام یا قس��متي از رنگ داخل شکل یا خط دور شکل را 
به صورت واضح یا نيمه کدر نمایش داد.
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شکل 11-38

با انتخاب گزینهTransparency  زیرمنوي زیر نمایش داده مي شود )شکل 11-39(.

شکل 11-39

جلوه Basic Transparency	 تمام شکل را به طور یکنواخت شفاف مي نماید. به طوري که 
موضوعات دیگر از زیر آن دیده شوند.

با انتخاب این جلوه مي توان ميزان ش��فافيت را در کادر Transparency	 با کش��يدن 
دکمه لغزنده تعيين نمود.

جلوه Feather	 موضوع را از داخل به سمت بيرون محو مي کند به طوري که محو شدن 
در  لبه هاي شکل صورت مي گيرد.

در کادر Radius براي تعيين شعاع محوشدگي )Transparency( از مرکز شکل، عدد	 
موردنظر را وارد  نمایيد. 

ه��اي موجود در  جل��وه Gradient Mask باع��ث محو ش��دن موضوع به صورت طيف 	
FreeHand، مي ش��ود. رنگ س��فيد 100% شفافيت و رنگ مش��کي 100% تاري را 

توليد مي کند.
تمري�ن 7: پرچم ایران را رس��م کنيد و بين رنگ ه��ا را Transparency کنيد تا 

رنگ ها بدون مرز باشند.
Envelope 2-11 فرمان

فرمان Envelope امکان فرم دهي به تصاویر و نوشته ها را فراهم مي نماید. با استفاده از این 
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دستور مي توان ظاهر شکل را تغيير داد. 
براي اجراي این دستور از منوي Modify گزینه Envelope را انتخاب نمایيد در این صورت 
 Envelope زیرمنوی��ي نمایش داده مي ش��ود که ش��امل گزینه هاي مورد اس��تفاده در فرمان

است.

 Envelope نوار اب�زار Window → Toolbars → Envelope نكته: با انت�خاب  گزین�ه

 نم�ایش  مي یابد.

)شکل 11-40(.

Envelope شکل 40-11 نوار ابزار

با کليک روي منوي بازشوي موجود در این نوار ابزار، ليست اشکال مختلف نمایش داده 
مي شود. براي تغيير یا فرم دهي شکل مراحل بعد را انجام دهيد:

1- شکل موردنظر را انتخاب کنيد.
2- روي آیک��ن Create  در ن��وار ابزار Envelope کليک نمایيد. گره ها و اهرم هایي در 
اطراف ش��کل نمایش داده مي شود و شما مي توانيد با استفاده از ابزارهاي تغيير مسير، ظاهر 

شکل را به صورت موردنظر تغيير دهيد. 

 مثال 2:
1- شکل 44-11 را رسم نمایيد.

2- از منوي بازشوي نوار ابزار Envelope گزینه Heart را انتخاب کنيد.

   شکل 41-11                شکل 42-11 انتخاب گزینه Heart                    شکل 11-43
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3- روي آیکن )Create(  یا گزینه Envelope→Create از منوي Modify کليک کنيد. 
شکل به این صورت نمایش داده مي شود.

یا   Remove نكت�ه: براي حذف تمام تغييرات انجام ش��ده روي ش��کل، آیکن 
گزینه Envelope→Remove از منوي Modify را کليک کنيد.

 Envelope→Show Map یا گزینه  Show Map توج�ه: با کليک روي آیک��ن 

از منوي Modify مي توانيد س��اختار و خطوط نقش��ه فرم اعمال ش��ده را مشاهده کرده و در 
صورت نياز آن را تغيير دهيد.

1-2-11 اعمال يک مسير دلخواه روي تصوير به عنوان Envelope)پوشش( 
1- مسير موردنظر را رسم نموده روي گزینه Edit→Copy کليک نمایيد.

2- شکلي را که مي خواهيد مسير موردنظر به عنوان Envelope به آن اعمال شود، انتخاب 
کنيد.

 3- روي دکم��ه Paste as envelope  از ن��وار  اب��زار Envelope کلي��ک کنيد یا گزینه
 Envelope→Paste as envelope را از منوي Modify اجرا کنيد.

در این صورت Envelope به شکل موردنظر  اعمال مي شود )شکل 11-44(.

شکل 44-11 اعمال مسير به متن

2-2-11 ذخيره سازي مسير اعمال شده به شکل
هنگامي که یک Envelope جدید ایجاد کردید ممکن اس��ت بخواهيد آن را ذخيره کنيد 
تا روي اش��ياي دیگر اعمال کنيد. به منظور ذخيره س��ازي مس��ير اعمال شده به شئ مراحل 

زیر را انجام دهيد:  
1- شکلي را انتخاب کنيد که داراي Envelope مورد نظر شما براي ذخيره است. 

 Envelope→save as یاگزینه Envelope از نوار اب��زار  save as preset 2- روي دکم��ه
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preset از منوي Modify کليک کنيد.

3- کادر محاوره New Envelope نمایش داده مي ش��ود )ش��کل 45-11(. در کادر متني 
Name نام موردنظر را درج نموده و روي دکمه OK کليک نمایيد تا مسير موردنظر به عنوان 

یک فرم به بالاي منوي بازشوي موجود در نوار ابزار Envelope اضافه شود.

شکل 11-45

 نكته: به منظور حذف یک فرم از منوي بازش��وي نوار ابزار Envelope، نام فرم را 
 Envelope→Delete یا گزینه  Delete preset از ليس��ت انتخاب کرده س��پس روي دکمه

preset از منوي Modify کليک کنيد.

3-2-11 استفاده از يک فرم Envelope براي ساخت مسير 
پس از ایجاد یک Envelope مي توانيد آن را به مسير تبدیل کنيد. در این صورت تغييرات 
قابل اعمال  روي مس��ير را مي توانيد روي آن فرم اعمال نمایيد. براي این منظور مراحل زیر 

را انجام دهيد:
1- ش��کل موردنظر که فرم Envelope را روي آن اعمال نموده اید، انتخاب کنيد )ش��کل 

.)11-46
 Modify از منوي Envelope→Copy as Path یا گزینه  Copy as Path 2- روي دکمه

کليک نمایيد.
3- از منوي Edit گزینه Paste را انتخاب کنيد )ش��کل 47-11(. مي توانيد یک زمينه یا 

خط دور به مسير اضافه نمایيد.

      

                                شکل 46-11         شکل 11-47

 نكته: براي حذف پوشش )Envelope( از روي شکل به طوري که تغييرات اعمال شده 
به ش��کل حفظ ش��ود، روي دکم��ه  Release  یا گزین��ه Envelope→Release  از منوي 

Modify کليک کنيد.
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  Fisheye Lens3-11 ابزار
با اس��تفاده از این ابزار مي توان به موضوعات انتخاب ش��ده، حالت تقعر یا تحدب داد. به 
عبارت دیگر این ابزار مانند لنز چش��م ماهي باعث ایجاد اعوجاج در اش��ياء مي شود به طوري 

که اشياء را برجسته مي بينيد.
Fisheye Lens 1-3-11 روش كار با ابزار

 Fisheye Lens در جعبه ابزار دابل کليک کنيد تا کادر محاوره Fisheye Lens 1- روي ابزار
مطابق شکل 48-11 باز شود.

         

 Fisheye Lens  شکل 48-11 کادر محاوره

2- با استفاده از ماوس، دکمه لغزنده Perspective را درگ کنيد.
Convex )محدب( یا اعداد مثبت، شئ را برجسته مي کند.	

Concave )مقعر( یا اعداد منفي، در شئ تورفتگي ایجاد مي کند.	

3- روي دکمه OK کليک کنيد. 
4- روي ش��کل انتخاب شده، کليک کرده و اشاره گر ماوس را بکشيد تا در ناحيه دلخواه 

شکل مقعر یا محدب شود.
مثال 3:

 
1- متن Freehand MX را مطابق شکل 49-11 روي صفحه تایپ کنيد.                                                                                           

شکل 49-11 تایپ متن

2- رنگ متن را آبي کنيد.
3- روي متن کليک راست کرده، گزینهConvert To Paths  را انتخاب کنيد تا حالت متن 

به مسير تبدیل شود.
4- روي ابزار Fisheye Lens دابل کليک کنيد تا کادر محاوره Fisheye Lens باز شود.

5- در قسمت Perspective نوع لنز را محدب قرار دهيد )شکل 11-51(.
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 شکل 50-11 روش تبدیل حالت متن به مسير               شکل 51-11 تنظيم محدب بودن جلوه

6- اش��اره گر ماوس را روي متن نوش��ته ش��ده در ناحيه اي که مي خواهيد محدب شود، 
بکشيد تا شکل یک بيضي ایجاد شود )شکل 11-52(.

7- کليد ماوس را رها کنيد تا مطابق شکل 53-11 جلوه ایجاد شود. 
     

             

Fisheye Lens شکل 53-11 نتيجه استفاده از ابزار         Fisheye Lens شکل 52-11 اعمال ابزار

 نكته: کليد Alt را نگه دارید تا اعوجاج از مرکز به سمت خارج ایجاد شود.

تمرين 8: اسم خود را بنویسيد و جلوه مقعر به آن بدهيد.
 3D Rotation4-11 ابزار

این اب��زار به موضوع��ات گرافيک��ي ام��کان تغيي��ر ش��کل و دوران به صورت س��ه بعدي 
)چرخش فضایي( را مي دهد.

3D Rotation1-4-11 روش كار با ابزار
 3D Rotation 3 در جعبه ابزار دابل کليک کنيد تا کادر محاورهD Rotation 1- روي ابزار
مطابق شکل 54-11 باز شود. در این کادر مي توانيد خصوصيات چرخش را به دلخواه تغيير 

دهيد.

        

  3D Rotation شکل 54-11 کادر محاوره

2- در این کادر محاوره دو گزینه وجود دارد:
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Easy  )ساده(

Expert )حرفه اي( که داراي گزینه هاي بيشتري نسبت به Easy است.

3- منوي بازش��و Rotate from نقطه ش��روع چرخش را تعيين مي کند که داراي حالات 
زیر است:

Mouse click )کلیک ماوس(:	 محلي را که در آن جا کليک مي کنيد به عنوان نقطه 

چرخش قرار مي دهد )شکل 11-55(.

شکل 55-11 انتخاب Mouse click براي نقطه چرخش

Center Of Selection:	 مرکز شکل انتخاب شده را نقطه چرخش دوران قرار مي دهد 

)شکل 11-56(.

شکل 56-11 انتخاب Center Of Selection براي نقطه چرخش

Center Of Gravity )مرکز جاذبه(:	 هنگام دوران شکل هاي نامسطح، نقطه چرخش 

را در مرکز ثقل شکل قرار مي دهد )شکل 11-57(.

شکل 57-11 انتخاب Center Of Gravity  براي نقطه چرخش

نقطه چرخش را در گوش��ه سمت چپ و پایين ناحيه انتخاب شده،  Origin )مبدأ(: 	

براي دوران قرار مي دهد )شکل 11-58(.
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شکل 58-11 انتخاب Origin براي نقطه چرخش

  )Perspective(ميزان چرخش یا اعوجاج تصاویر به صورت پرسپکتيو Distance 4- در کادر
بزرگ و کوچک تنظيم مي شود )شکل 59-11(. براي ایجاد اعوجاج بيشتر، اعداد پایين تر از 

این ميزان استفاده مي شود.

Distance شکل 59-11 تنظيم کادر

5- اکنون اش��اره گر ماوس به ش��کل + درآمده است، آن را روي قسمت موردنظر از شکل 
قرار داده، کليک و درگ کنيد. با حرکت اش��اره گر، پيش نمایش��ي از چرخش موضوع نمایش 
داده مي ش��ود. همان طور که مشاهده مي کنيد در امتداد محل کليک و حرکت ماوس خطي 
ایجاد مي ش��ود که به آن محور چرخش مي گویند. براي تعيين ميزان چرخش، کافي اس��ت 

اشاره گر را در طول این محور جابه جا کنيد.
6- وقتي چرخش موضوع به دلخواه شما بود، کليد ماوس را رها کنيد.

 توج�ه: اگر در هنگام اس��تفاده از ابزار چرخش س��ه بعدي، کلي��د Shift را به طور 
همزمان فشار دهيد چرخش به صورت 45 درجه درمي آید.

در حالت Expert، منوي بازشوي Project from به کادر محاوره 3D Rotation اضافه مي شود 
که توس��ط این منو مي توانيد نقط��ه گریز موضوع را هن��گام دوران تنظيم کنيد. گزینه هاي 

موجود در این منو عبارتند از:
Center Of Gravity ،Center Of Selection ،Mouse click و Origin که توضيح داده ش��ده 

است. همچنين گزینه دیگري در این منو به صورت زیر قرار دارد:
 	x با انتخاب این گزینه مي توانيد در کادرهاي مربوطه، مختصات :X/Y Coordinates
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و y نقطه گریز را به صورت عددي وارد کنيد.

تمرين 9: ش��کل 60-11 را رسم کرده، س��پس آن را دوران دهيد به طوري که 
نقطه دوران شکل در سمت چپ و پایين شکل قرار گيرد.

شکل  11-60
 Shadow 5-11 ابزار

از این ابزار براي ایجاد س��ایه در پش��ت موضوعات یا متوني که به مس��ير تبدیل شده اند، 
استفاده مي شود.

1-5-11 روش اعمال سايه
1- موضوعي را که مي خواهيد سایه دار شود، انتخاب کنيد.

2- ابزار Shadow را از جعبه ابزار انتخاب کرده )ش��کل 61-11( سپس اشاره گر ماوس را 
روي شکل قرار داده و به سمت پایين بکشيد تا سایه در زیر شکل ایجاد شود

شکل 11-61

3- براي اعمال تنظيمات بيش��تر، روي ابزار Shadow داب��ل کليک کنيد تا کادر محاوره 
Shadow ظاهر شود )شکل 11-62(.

Shadow شکل 62-11 کادر محاوره
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4- در کادر محاوره Shadow ، منوي بازش��وي Type داراي چند حالت انتخابي به ش��رح 
زیر است:

                         

 سایه با لبه هاي سخت                  سایه با لبه هاي نرم                    سایه با بزرگنمایي 

شکل 11-63

هن��گام انتخاب حالت Soft Edge مي تواني��د با درگ رنگ به کادر Stroke، رنگ پس زمينه 
سایه را تنظيم کنيد که به طور پيش فرض سفيد است.

همچنين با انتخاب حالت Zoom مي توانيد رنگ داخل س��ایه و خط دور س��ایه را تعيين 
کنيد.

5- با انتخاب یکي از حالت هاي Hard Edge یا Soft Edge منوي بازش��وي Fill داراي س��ه 
گزینه انتخابي مطابق شکل 64-11 خواهد شد:  

Fill شکل 64-11 حالات موجود در منوي بازشوي
Color:	 ب��ا انتخ��اب این گزینه، س��ایه با رنگ تعيين ش��ده در کادر رنگي زیر آن پر 

مي شود.
Shade:	 با استفاده از دکمه لغزنده یا وارد کردن عدد در کادر مربوطه، سایه اي ایجاد 

مي شود که رنگ آن تيره تر از موضوع اصلي است.
Tint:	 ب��ه کمک دکمه لغزنده ی��ا وارد کردن عدد در کادر مربوطه، س��ایه اي ایجاد 

مي شود که رنگ آن روشن تر از موضوع اصلي است.
6- با استفاده از دکمه لغزنده Scale یا وارد کردن عدد در کادر مربوطه، اندازه سایه از 1 

تا 200% تنظيم مي شود.

 توجه: مقدار کمتر از 100%، س��ایه اي کوچک تر از موضوع اصلي و مقدار بيشتر از 
100%، سایه اي بزرگ تر از موضوع اصلي ایجاد مي کند.
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7- در قس��مت Offset با تنظيمx  و y، محل قرار گرفتن س��ایه یا فاصله س��ایه از موضوع 
اصلي تنظيم مي شود.

8- روي دکمه OK کليک کنيد، سایه دلخواه روي موضوع اعمال مي شود.

  Subselectنكته: پس از اعمال یک سایه به موضوع مي توانيد با استفاده از ابزار 
و درگ ماوس سایه را به محل جدیدي انتقال دهيد.

مثال 4: شکل 65-11 را رسم کرده، سپس سایه اي با لبه هاي سخت در آن ایجاد 
کنيد، به طوري که سایه از تصویر بزرگ تر و رنگ آن روشن تر از موضوع اصلي باشد. 

شکل 11-65

1- ابتدا شکل مورد نظر را انتخاب کنيد.
2- روي ابزار Shadow دابل کليک کنيد تا کادر محاوره Shadow باز شود.

3- در منوي بازشوType  نوع سایه را Hard Edge انتخاب کنيد.
4- در منوي بازشو Fill حالت Tint را انتخاب کرده و در کادر مقابل دکمه لغزنده عدد50 

را وارد کنيد.
5- در کادرScale  عدد 120 را وارد کنيد تا سایه از خود شکل بزرگ تر باشد.

6- در قسمت Offset  محل قرارگيري سایه را مشخص کنيد.
7- روي دکمهOK کليک کنيد، شکل به    دست آمده    مشابه     شکل66-11 خواهد شد.

Shadow شکل 66-11 نتيجه حاصل از اعمال ابزار
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تمرين 10: شکل هاي 67-11 را رسم کرده، به نوع سایه ها دقت کنيد.

شکل 11-67

 Smudge 6-11 ابزار
با استفاده از این ابزار مي توان به موضوعات بعد، عمق یا جلوه حرکت نسبت داد. همچنين 

کاربرد دیگر این ابزار، ایجاد سایه براي شکل و متن تبدیل شده به مسير است.
 Smudge 1-6-11 روش كار با ابزار

1- ابزار Smudge را از جعبه ابزار انتخاب نمایيد.
2- ب��راي اعمال تنظيمات بيش��تر روي ابزار Smudge دابل کلي��ک کنيد تا کادر محاوره 

Smudge مطابق شکل 68-11 ظاهر شود.

Smudge شکل 68-11 کادر محاوره

3- در ای��ن کادرمحاوره براي انتخاب رنگ دلخواه داخل و خطوط دور ش��کل، دو گزینه 
قرار دارد:

براي پر کردن رنگ داخل موضوع گرافيکي به کار مي رود به ش��رطي که  	 :Fill گزينه
قبلًا داخل موضوع با رنگ پر شده باشد.

براي رنگ آميزي خط��وط پيرامون موضوع گرافيک��ي رنگي به کار  	 :Stroke گزين�ه
م��ي رود. با اس��تفاده از این گزین��ه مي توانيد رنگ هاي دلخ��واه را براي خطوط دور 

موضوع یا سایه انتخاب کنيد.
4- روي دکمه OK کليک کنيد.

5- اش��اره گر ماوس ش��بيه به دست مي شود، روي ش��کل کليک کرده و آن را به سمت 
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خارج درگ کنيد.
شکل 69-11 استفاده از این ابزار را روي شکل نشان مي دهد.

    

Smudge شکل 69-11 اعمال ابزار

 توجه: براي افزودن س��ایه به اطراف ش��کل یا رسم س��ایه از مرکز شکل به سمت 

خارج، هنگام استفاده از ابزار Smudge کليد Alt را به طور همزمان نگه دارید.
مثال 5:

1- با استفاده از ابزار Ellipse یک بيضي مطابق شکل 70-11 رسم کنيد. 
2- روي ابزار Smudge از نوار ابزار دابل کليک کنيد.

3- ب��راي ای��ن که رنگ داخ��ل موضوع را قرمز کني��د، در قس��متFill  در کادر محاوره  
Smudgeرنگ قرمز را برگزینيد.

4- براي این که رنگ خطوط دور ش��کل س��بز شود در قس��متStroke  در کادر محاوره 
Smudge رنگ سبز را انتخاب کنيد.

5- روي دکمهOK  کليک کنيد.
6- اش��اره گر ماوس ش��بيه  دست مي شود، آن را روي ش��کل برده و به سمت خارج درگ 

کنيد )شکل 11-71(.

                              

Smudge شکل 70-11                              شکل 71-11 اعمال ابزار   

تمرين 11: ش��کل 72-11 را رس��م کرده، سپس به وس��يله ابزار Smudge به آن 
بعُد دهيد.
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شکل 72-11 رسم شکل
 Bend 7-11 ابزار

این ابزار در ش��کل ها و مسيرهاي رسم ش��ده، تاب خوردگي ایجاد مي کند، به طوري که 
پاره خط هاي مسير به سمت داخل یا خارج  منحرف مي شوند.

Bend 1-7-11 تنظيم گزينه هاي ابزار

1- ابزار Bend را از نوار ابزار Xtra tools انتخاب کنيد )شکل 11-73(.

Bend   شکل 73-11 انتخاب ابزار

2- روي اب��زارBend  دابل کلي��ک کنيد تا کادر محاوره Bend مطابق ش��کل 74-11 باز 
شود.

Bend شکل 74-11 کادر محاوره

Bend 2-7-11 روش استفاده از ابزار
1- شکل 75-11 را رسم کنيد.

2- روي ابزارBend  دابل کليک کنيد و با حرکت دکمه لغزنده Amount، ش��دت عملکرد 
این ابزار را روي شکل تعيين کنيد.

3- اش��اره گر ماوس )+( را روي ش��کل انتخاب شده قرار دهيد، سپس ماوس را به سمت 
پایين درگ کنيد اکنون لبه هاي ش��کل گرد مي ش��ود )شکل 76-11- الف(. اگر ماوس را به 

سمت بالا درگ کنيد، لبه هاي شکل به صورت تيز درمي آیند )شکل 76- 11- ب(.
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 ماوس به سمت بالا کشيده شده                  ماوس به سمت پایين کشيده شده

Bend شکل 75-11 رسم و انتخاب شکل                شکل 76-11 نتایج حاصل از اعمال ابزار

 مثال 6: شکل 77-11 را ایجاد کنيد.
1- ابتدا با ابزار Ellipse و نگه داشتن کليد Shift یک دایره رسم کرده و داخل آن را رنگ 

کنيد )شکل 11-78(.

            

     شکل 77-11               شکل 78-11 رسم دایره

2- ابزار Bend را انتخاب کنيد.
3- با ماوس روي مرکز دایره کليک کرده آن را به س��مت پایين درگ کنيد تا به ش��کل 

موردنظر برسيد.
 Roughen 8-11 ابزار

این ابزار باعث شکستگي خطوط تشکيل دهنده شکل مي شود و مسيرهاي هموار را نوک 
تيز و ناهموار مي سازد.

Roughen 1-8-11 تنظيم گزينه هاي ابزار

1- ابزار Roughen را از جعبه ابزار انتخاب نمایيد.
2- روي ابزار Roughen دابل کليک کنيد تا کادر محاوره Roughen مطابق شکل 11-79 

باز شود.
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Amount  شکل 80-11 نتيجه استفاده از تنظيمات دکمه لغزنده     Roughen شکل 79-11 کادر محاوره    

3- روي دکمهOK  کليک کنيد.
  Roughen 2-8-11 روش استفاده از ابزار

 1- ابت��دا ش��کل دلخواه��ي رس��م کني��د، س��پس اب��زارRoughen  را انتخ��اب کني��د 
)شکل 11-81(.

2- با استفاده از ماوس، ابزار Roughen را در طول موضوع بکشيد.

                                                              

   Roughen  شکل 82-11 نتيجه استفاده از                شکل 81-11 رسم شکل   

تمرين 12: اشکال 83-11را با استفاده از ابزار Roughen رسم کنيد.

شکل 11-83 

  )Perspective( 9-11 ايجاد پرسپکتيو
 گاهي اوقات لازم است براي واقعي جلوه دادن اشياء یا نشان دادن عمق و حجم در ترسيم هاي 

دو بعدي از پرسپکتيو استفاده کنيم.
در FreeHand MXa به سادگي مي توانيد فضاي سه بعدي )شبکه شطرنجي سه بعدي( یا 

پرسپکتيو را در یک محيط دو بعدي بازسازي کنيد.
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بدین منظور مراحل زیر را دنبال کنيد: 
1- گزینه View→Perspective Grid→Show را انتخاب کنيد.

2- ش��کل یا متن موردنظ��ر را انتخاب کرده و اب��زار پرس��پکتيو را از جعبه ابزار انتخاب 
کنيد.

3- اش��اره گر را روي اش��ياي موردنظر قرار داده و از کليدهاي جهت دار صفحه کليد براي 
قراردادن اش��ياء روي محورهاي پرسپکتيو استفاده کنيد. کليد جهت دار را پایين نگه داشته، 

سپس روي موضوع درگ کنيد )شکل 11-84(.

شکل 11-84

زیرمنوي Perspective شامل گزینه هایي است که در جدول 1-11	 آمده است:

  Alt توجه: براي کپي کردن موضوع در حين اس��تفاده از ابزار پرس��پکتيو از کليد 

استفاده کنيد.
جدول 11-1

Show.نماي پرسپکتيو را فعال مي سازد

Define Grid)11-85 تنظيم و ویرایش خطوط شبکه و ایجاد نماي جدیدي از شبکه )شکل

Previous.براي تعویض نماها به کار مي رود

Remove  Perspective.نماي پرسپکتيو شئ را حذف مي کند

 Release With
Perspective

جلوه پرسپکتيو را براي موضوع تثبيت مي کند به طوري که بعد از اجراي این فرمان پرسپکتيو 
داده شده به شئ، قابل ویرایش نخواهد بود.
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Define Grids شکل 85-11 کادر محاوره

 Extrude 10-11 ابزار
با اس��تفاده از این ابزار مي توان اشکال ایجاد ش��ده در FreeHand را به صورت سه بعدي 

نمایش داد. 

شکل 11-86

به منظور سه بعدي کردن اشکال مراحل زیر را انجام دهيد:
1- ابزار Extrude را از جعبه ابزار انتخاب نمایيد.

2- اش��اره گر ماوس را روي ش��کلي که قرار است س��ه بعدي شود قرار داده و آن را درگ 
کنيد.

شکل 11-87

 Modify→Extrude→Remove نكته: به منظور حذف حالت سه بعدي شکل، گزینه 
را انتخاب نمایيد.

1-10-11 ويرايش شکل سه بعدي



Free Hand پیمانه مهارتی : کاربر
333واحد کار يازدهم: توانایی استفاده از جلوه های ویژه  

به منظور ویرایش جلوه س��ه بعدي اشکال از ابزار Extrude استفاده مي شود. این ابزار دو 
حالت ویرایش دارد: 

حالت 1: امکان ویرایش محل، عمق و نقطه تلاقي را فراهم مي کند.
حالت 2: امکان چرخش اشکال سه بعدي را فراهم مي نماید.  

مث�ال کاربردي: فای��ل Project مثال کاربردي واحد کار قبل را باز کنيد و مراحل زیر را 
انجام دهيد:

1- وارد صفحه ایجاد شده براي کارت ویزیت شوید )شکل 88-11( و نشانه طراحي شده 
در صفحه آرم را در نقطه اي از صفحه درج کنيد.

2- آرم را انتخ��اب و گروه بن��دي کنيد و از پانل Transform زبانه Scale، نش��انه را %30 
بزرگ تر کنيد. اکنون با استفاده از پانل Align  آن را به وسط صفحه منتقل کنيد.

3- س��پس آرم را خاکستري کرده و با اس��تفاده از جلوه Transparency آن را به صورت 
محو در وسط صفحه قرار دهيد. 

 

شکل 11-88

4- یک کپي از آرم ایجاد کرده، آن را با Scale 70% کوچک تر کنيد و در جاي مش��خص 
شده در شکل 88-11 قرار دهيد.

5- طراحي کارت ویزیت به پایان رسيد، سعي کنيد کارت هاي زیباتري طراحي کنيد.
واژه نامه
Convexمحدب

Edgeلبه

Expertمتخصص



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
334

Expandگسترش

Envelopeپوشش 

Fisheyeچشم ماهي

Glowبرافروختگي

Raggedناصاف، ناهموار

Raisedبرجسته، برآمده 

Releaseرهایي، واگذاري کردن

Roughenزبرکردن، خشن شدن

Sketchطرح ساده

Sharpenنوک تيز کردن 

Smudgeلکه، سياه شدن

خلاصه مطالب 
جلوه Bend	 در شکل ها و مسيرهاي رسم شده، پيچ و خم و اعوجاج ایجاد مي کند.

جلوه Duet	 یک یا چند مدل مش��ابه از ش��کل س��اخته، آن ها را ب��ا یکدیگر ترکيب 
مي کند تا یک شکل پيچيده واحد ایجاد نماید.

جل��وه Expand Path	 مس��ير را په��ن نم��وده و طرح کلي ش��کل حاصل��ه را ایجاد 
مي نماید.

با افزودن نقاط تصادفي جدید، ظاهر ش��کل را تغيير داده و ظاهري  	 Ragged جل��وه
ناهموار، صاف یا یکدست به شکل مي دهد.

جلوه Bevel 	 باعث مي ش��ود لبه هاي ش��کل به حالت برجسته نمایش داده شوند و با 
جلوه Emboss  مي توان شکل یا متن را به صورت برجسته نمایش داد. 

جلوه Blur جزیيات تصویر را تيره و تار مي کند.	 
جل��وه Sharpen با تنظيم Contrast	 پيکس��ل هاي همجوار در ش��کل، وضوح یا تيزي 

لبه هاي شکل را افزایش مي دهد.
با استفاده از جلوه Transparency	 مي توان تمام یا قسمتي از رنگ داخل شکل یا خط 

دور شکل را به صورت واضح یا نيمه کدر نمایش داد.
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فرمان Envelope امکان فرم دهي به تصاویر و نوشته ها را فراهم مي نماید. 	
با اس��تفاده از ابزار Fisheye Lens	 مي توان به موضوعات انتخاب ش��ده، حالت تقعر یا 

تحدب داد.
از ابزار Shadow	 براي ایجاد س��ایه در پش��ت موضوعات یا متوني که به مسير تبدیل 

شده اند، استفاده مي شود.
مي توان به موضوعات بعد، عمق یا جلوه حرکت نس��بت  	 Smudge با اس��تفاده از ابزار
داد. همچنين کاربرد دیگر این ابزار، ایجاد س��ایه براي ش��کل و متن تبدیل شده به 

مسير است.
باعث شکس��تگي خطوط تش��کيل دهنده شکل مي شود و مسيرهاي  	Roughen  ابزار

هموار را نوک تيز و ناهموار مي سازد.
با ابزار Extrude مي توان به اشکال ایجاد شده در FreeHand، جلوه سه بعدي داد.	
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعیین کنید.

 1- براي واقعي جلوه دادن موضوعات یا نشان دادن عمق و حجم در ترسيمات دو بعدي از ابزار
3D Rotation استفاده مي کنيم.

2- فرمان Envelope امکان فرم دهي به تصاویر و نوشته ها را فراهم مي نماید.
3- جلوه Duet یک یا چند مدل مشابه از شکل ساخته، آن ها را با یکدیگر ترکيب مي کند 

تا یک شکل پيچيده واحد ایجاد کند.
4- جلوه Blur در شکل ها و مسيرهاي رسم شده، پيچ و خم و اعوجاج ایجاد مي کند.

معادل گزينه  هاي سمت راست را از ستون سمت چپ انتخاب کرده و مقابل هر عبارت بنويسید.

Bend 5- جزیيات تصویر را تيره و تار مي کند.                                          جلوه
  Bevel6- در شکل ها و مسيرهاي رسم شده، پيچ و خم و اعوجاج ایجاد مي کند.      جلوه
  Emboss 7- باعث مي شود لبه هاي شکل به حالت برجسته نمایش داده شوند.      جلوه

Blur 8- مي توان شکل یا متن را به صورت برجسته نمایش داد.                      جلوه
گزينه صحیح را انتخاب کنید.

9- هنگام استفاده از ابزار3D Rotation   نقطه چرخش در کدام قسمت تعيين مي شود؟
Expert -د             Rotate from -ج  Easy -ب                  Distance -الف

10- از کدام گزینه براي محدب کردن اشکال استفاده مي شود؟
Shadow -د          Fisheye Lens -ج  Smudge -ب  3D Rotation -الف

11- شکل زیر توسط چه ابزاري طراحي شده است؟
Roughen -الف

 Bend -ب
Smudge -ج

Spiral -د
12- با اس��تفاده از کدام جلوه مي توان تمام یا قس��متي از رنگ داخل ش��کل یا خط دور 

شکل را به صورت واضح یا نيمه کدر نمایش داد؟
Emboss -د       Sharpen -ج  Transparency-ب   Blur -الف
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13- ب��ه منظور اعمال یک مس��ير دلخواه روي تصویر به عنوان ی��ک Envelope  از کدام 
گزینه استفاده مي کنيم؟

Paste as envelope -د        Save as preset -ج       Show map -ب    Release -الف
در جاي خالي عبارت مناسب را بنويسید.

14- جل��وه  ........................... مس��ير را په��ن نم��وده و طرح کلي ش��کل حاصله را ایجاد 
مي نماید.

15- جلوه .............................. با افزودن نقاط تصادفي جدید، ظاهر ش��کل را تغيير داده و 
ظاهري ناهموار، صاف یا یکدست به شکل مي دهد.

16- جلوه ......................... نمایي از ش��کل را شبيه سازي مي کند که به نظر مي رسد شکل 
مورد نظر با مداد طراحي شده است.

به سؤالات زير پاسخ تشريحی دهید.

17-  ابزار Roughen چه عملي انجام مي دهد؟
18-  تفاوت نوعHard Edge  و Zoom هنگام استفاده از ابزار Shadow چيست؟

19-  در چه مواقعي از ابزارهاي زیر استفاده مي کنيد؟
  Perspective-الف
3D Rotation -ب

Roughen -ج
20- از ابزار Extrude به چه منظور استفاده مي شود؟

آزمون عملي
1- تصویر مقابل را با استفاده از ابزارSmudge  طراحي کنيد.
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2- با استفاده از ابزار Fisheye Lens شکل روبه رو را طراحي کنيد.

3- شکل روبه رو را رسم کرده، سپس توسط 3D Rotation  تصویر ب را ترسيم کنيد.

 Expand4- در ش��کل ابتدا تصویر س��مت چپ را طراحي کرده سپس با استفاده از جلوه
Path  آن را به شکل سمت راست تبدیل کنيد.

  Ragged5- در ش��کل روبه رو تصویر سمت چپ را طراحي کرده سپس با استفاده از جلوه
آن را به شکل سمت راست تبدیل کنيد.

6- با استفاده از ابزار Shadow شکل هاي زیر را رسم ک

7- شکل زیر را با استفاده از ابزار Envelope ترسيم کرده سپس آن را سه بعدي کنيد.
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كليات
با پيچيده تر شدن کار هنري نياز به روش هاي دیگري براي سازمان دهي موضوعات پيش 
 Chart و Graphic Hose و ابزارهاي Style ،Library ،Layers مي آید. در این واحد کار پنل هاي

Tool بررسي مي شوند.

 )Layers( 1-12 لايه ها
در برنامه FreeHand MXa هنگام ترس��يم طرح هاي موردنظر براي آس��ان تر کردن کار با 
موضوع هاي ترس��يمي، آن ها را با اس��تفاده از لایه ها از یکدیگر مجزا مي کنند. این کار شبيه 
به این اس��ت که هر موضوع و شئ ترس��يمي در یک صفحه مجزا رسم شود و صفحه ها روي 

یکدیگر قرار گيرند.

Layer شکل 1-12 مجزاسازي موضوع ترسيمي در پنل

 Layers 1-1-12 كار با پنل

پن��ل Layers، هم��ه لایه ه��اي موجود در س��ند ج��اري را نمایش داده و ام��کان اضافه، 
نس��خه برداري، مرتب کردن و حذف لایه ها را فراهم مي کند. با استفاده از این پنل مي توانيد 

لایه ها را انتخاب، ایجاد و حذف کنيد.
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  Layersنمايش پنل
براي ظاهر کردن پنل به یکي از روش هاي زیر عمل کنيد:

از نوار ابزار Main روي دکمه  کليک کنيد.	
از طریق منوي Window، مسير Window→Layers را اجرا کنيد.	
کليد ميانبر F2 را بفشارید.	

همان طورکه در شکل 1-12 نشان داده شده است، در یک سند به صورت پيش فرض سه 
لایه وجود دارد که عبارتند از:

لايه Foreground )پيش زمينه(
ب��ه لایه هایي که در بالاي خط افق��ي جدا کننده قرار مي گيرند، لای��ه پيش زمينه گفته 

مي شود. موضوع هاي ترسيمي که در این لایه ها قرار دارند؛ قابل چاپ هستند.
لايه Guides )خطوط راهنما(

در این لایه خط هاي راهنما که با استفاده از خط کش یا ویرایشگر خطوط راهنما در سند 
ایجاد ش��ده اند، قرار مي گيرند. همچنين مسيرهایي که به خط هاي راهنما تبدیل شده اند، در 
این لایه قرار دارند )شکل 2-12(. در بخش10-1-12 چگونگي تبدیل مسير به خط راهنما 

توضيح داده مي شود.
موضوع هایي که در لایه Guides	 قرار دارند، چه بالاي خط جدا کننده باش��ند یا در 

پایين آن قرار گيرند چاپ نمي شوند.

Guides شکل 2-12 مسير تبدیل شده به خط راهنما با استفاده از لایه

لايه Background )پس زمينه(
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ای��ن لایه ب��ه صورت پيش فرض در زیر خ��ط جداکننده قرار مي گي��رد و غير قابل چاپ 
است.

 توجه: با درگ و جا به جایي لایه هاي انتخاب ش��ده و انتقال آن ها به زیر خط جدا 

کننده، یک لایه Background )پس زمينه ( جدید ایجاد مي شود.

در برنامه FreeHand	 هر شئ طراحي  شده در سند، درون لایه قرار مي گيرد، همچنين 
مي توانيد مجموعه اي از اشياء را در یک لایه قرار دهيد.

2-1-12 ايجاد لايه جديد

با اس��تفاده از پنل Layers مي توانيد یک لایه جدید ایجاد کنيد و موضوع ترس��يمي را در 
لایه ایجاد شده قرار دهيد.

 توجه: مي توانيد قبل یا بعد از ترسيم موضوع هاي گرافيکي، لایه هاي مورد نيازتان 

را ایجاد کنيد.
براي ایجاد لایه جدید مراحل زیر را انجام دهيد:

1- پنل Layers را باز کنيد.
2- منوي کنترلي پنل لایه را انتخاب کرده و روي گزینه New کليک کنيد.

3-1-12 تغيير نام لايه 

براي تغيير نام لایه به روش زیر عمل کنيد:
1- در پنل Layers روي نام لایه مورد نظر دابل کليک کنيد.

2- نام جدید را تایپ و کليد Enter را فشار دهيد یا با ماوس روي پنل کليک کنيد.

 نكته: نام لایه Guides تغيير نمي کند.

 Fish در لایه اي با نام  C:0 و  M:98 ، Y:100 ، K:0 مثال 1: ش��کل 3-12 را با رنگ 
رسم کرده و فایل را با نام Example12 -1 ذخيره کنيد. 

1- در صفحه کاري مورد نظر، ابتدا پنل Layers را فعال کنيد.
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2- یک لایه جدید از طریق منوي کنترلي پنل ایجاد کنيد )شکل 12-4(.

                             

شکل 3-12                                            شکل 4-12 ایجاد لایه جدید

3- روي نام لایه جدید دابل کليک کرده و نام Fish را درج و کليد Enter را فشار دهيد.
4- شکل 3-12 را رسم و فایل را با نام گفته شده ذخيره کنيد.

4-1-12 انتخاب لايه

در پنل Layers، به لایه اي که انتخاب ش��ده و در س��مت راست آن علامت  قرار دارد، 
لایه فعال )Active( مي گویند. مراحل کار در انتخاب لایه به شرح زیر است:

1- مس��ير Edit→Select→None را اجرا کرده یا کليد Tab را فش��ار دهيد تا ش��يئي در 
وضعيت انتخاب نباشد.

2- روي نام لایه کليک کرده تا علامت  را در سمت راست لایه مشاهده کنيد.

 نكته: اش��ياء و موضوع هایي که  ترسيم مي کنيد یا در سند Import مي شوند؛ در 
لایه Active )فعال( قرار مي گيرند.

با نگه داش��تن کليدAlt 	 همراه با کليک روي نام لایه مورد نظر، تمامي اش��ياي لایه 
فعال )Active( در حالت انتخاب قرار مي گيرند.

5-1-12 قفل و عدم قفل لايه

در پنل Layers براي محافظت اشياء درون لایه ها از تغييراتي که بر سایر لایه ها در هنگام 
نمایش محتویات آن ها انجام مي شود؛ روي علامت  )قفل باز( که در سمت چپ لایه قرار 

دارد کليک کنيد تا لایه قفل شود. بر همين اساس تعاریف زیر مطرح مي شود:
لايه قفل شده )Lock(: لایه اي که در سمت چپ آن علامت 	 قرار دارد.

لايه قفل نشده )Unlock(: لایه اي که در سمت چپ آن علامت	 قرار دارد .



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
344

6-1-12 نمايش و پنهان كردن محتويات لايه

 یکي دیگر از امکانات پنل Layers، پنهان کردن محتویات لایه ها بدون نياز به حذف لایه ها است 
)شکل 12-5(.

شکل 5-12 پنهان کردن محتویات لایه

روش اجرا:
1- لایه مورد نظر را انتخاب کنيد.

2- روي علامت P در س��مت چپ لایه کليک کنيد تا  علامت  برداش��ته  شود و محتویات  
لایه  پنهان  شود.

کليک مجدد سبب نمایش و آشکار شدن )Visible( لایه مي شود.	

 نكته: نگه داش��تن همزمان کليد Ctrl و کليک روي اولين س��تون سمت چپ در 
پنل Layers تمام لایه هاي پنل را پنهان مي کند.

اگر لایه فعال پنهان باش��د؛ موضوع گرافيکي جدیدي که ایجاد مي ش��ود نيز نش��ان داده 
نمي شود و براي نمایش آن باید لایه در حالت Visible )آشکار( قرار گيرد.

 توجه: براي ویرایش لایه ها، باید آن ها را در وضعيت قفل نشده )Unlock( و نمایش 

)Visible( قرار دهيد.

7-1-12 ايجاد نسخه كپي از لايه موجود

با استفاده از پنل Layers و منوي کنترل آن مي توانيد از لایه موجود در پنل، یک نسخه 
کپي تهيه کنيد. روش کار به ترتيب زیر است )شکل 12-6(:
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Layers شکل 6-12 منوي کنترلي پنل

1- مس��ير Edit→Select→None را اجرا کرده یا کليد Tab را فش��ار دهيد تا ش��يئي در 
وضعيت انتخاب نباشد.

2- روي نام لایه کليک کنيد.
3- از منوي کنترل در پنل لایه گزینه Duplicate را برگزینيد.

 نكته: لایه Guides حذف نمي شود.

تمرين 1:
1- با اس��تفاده از نوار ابزار Main،پنل Layers را آش��کارکنيد و شکل7-12 را در لایه اي به نام 

Rainbow1 رسم کرده و آن را با نام T12-1 ذخيره کنيد.

شکل 12-7

2- ی��ک لایه مش��ابه لایه Rainbow1 با نام Rainbow2 ایج��اد، آن را قفل کرده و فایل را 
ذخيره کنيد.

3- لایه Rainbow1 را حذف کنيد.
8-1-12 جابه جايي لايه ها و محتويات آن ها

ب��راي ویرای��ش لایه ها مي توانيد ترتيب قرار گرفتن آن ه��ا را در پنل Layers تغيير دهيد 
یا اش��ياء یک لایه را به لای��ه دیگر منتقل کنيد و موضوع ه��اي گرافيکي لایه هاي یک فایل 

FreeHand را کپي کرده و در فایل دیگر، Paste کنيد.
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 توج�ه: اگ��ر گزین��ه Remember layer info در زبان��ه General از کادر مح��اوره

Preferences  انتخاب شده باشد، اطلاعات لایه ها در زمان کپي محتویات آن ها حفظ مي شود 

)شکل 12-8(.

FreeHand در زمان کپي محتویات آن ها در سندهاي دیگر ،FreeHandشکل 8-12 تنظيم مربوط به حفظ اطلاعات لایه هاي یک سند

تغییر ترتیب لايه ها 	
1- در پنل Layers، نام لایه مورد نظر را انتخاب کنيد.

2- نام لایه را به مکان دلخواه در ليست لایه ها درگ کنيد.
3- با رها کردن ماوس، نام لایه از مکان قبلي حذف و در محل جدید پنل Layers ظاهر 

مي شود. در این صورت موقعيت تمام اشياء در سند تغيير مي کند.
انتقال شئ به لايه مورد نظر 	

1- شئ موردنظر را که در شکل 9-12 تصویر ماه است، انتخاب کنيد. در این صورت لایه 
مربوط به شئ انتخاب شده در پنل Layers به طور خودکار انتخاب مي شود.

2- لایه مقصد )لایه اي که مي خواهيد ش��ئ به آن جا منتقل شود( را انتخاب کنيد. بدین 
ترتيب شئ مزبور به لایه جدید انتقال مي یابد. 

   

  شکل 9-12 انتخاب شئ                                     شکل 10-12 انتقال شئ به لایه موردنظر

  Preferencesاگر جابه جایي انجام نشد، بررسي کنيد که طبق شکل 11-12در کادر محاوره
گزین��ه Clicking on a layer name moves selected objects در زبانه Panels در حالت انتخاب 
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قرار گيرد تا جا به جایي اشياء با انتخاب نام لایه انجام شود.
ه��اي گرافيکي مي توانيد آن ه��ا را جا به جا  همان طورک��ه گفته ش��د با درگ موضوع 	

کنيد.

شکل 11-12 تنظيم مربوط به جابه جایي لایه ها با انتخاب نام لایه

 توجه: نمي توان موضوعات را به یک لایه قفل شده، انتقال داد.

 نكت�ه: اگ��ر در زمان جابه جای��ي موضوعات گرافيکي، اش��يایي را که در لایه هاي 
جداگانه هس��تند،  با یکدیگر Group کنيد، در این صورت اش��ياء Group شده به لایه فعال 

منتقل مي شوند.

 توج�ه: انتخاب گزین��ه Remember layer info در زبان��ه General از کادر محاوره 

 Join شده به لایه هایي مي شود که قبل از Split و   Ungroup سبب بازگشت اشياء Preferences

و Group  شدن در آن قرار داشتند.

Guides 9-1-12 كار با لايه

همان طور که گفته شد، خط هاي راهنما در لایه Guides قرار مي گيرند. با استفاده از پنل 
layers مي توانيد مسير انتخابي را به خط راهنما و بالعکس تبدیل کنيد.

تبديل مسير )باز يا بسته( به خط راهنما  	

1- مسير مورد نظر را انتخاب کنيد )شکل 12-12(.
2- روي لایه Guides کليک کنيد تا مس��ير، رنگ خط راهنما را به خود بگيرد و مس��ير 

انتخابي نيز با انتقال به لایه Guides، به خط راهنما تبدیل شود )شکل 12-13(.
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              شکل 12-12 یک مسير بسته                 شکل 13-12 مسير تبدیل شده به خط راهنما

تبديل خط راهنما به مسير معمولي 	

1- روي مس��ير تبدیل ش��ده به خط راهنما یا خط راهنماي ایجاد شده با خط کش، دابل 
کليک کنيد.

2- در کادر مح��اوره Guides روي دکم��ه Release کليک کنيد تا خط راهنما به مس��ير 
تبدیل شود و در لایه معمولي قرار بگيرد.

10-1-12 ادغام لايه ها 

پس از پایان کار در FreeHand مي توانيد لایه ها را با هم یکي کنيد.
روش اجرا:

1- لایه یا لایه هاي مورد نظر را در پنل Layer انتخاب کنيد.
 	Shift ب��راي انتخ��اب بيش از یک لایه  همزم��ان با کليک روي لایه ه��ا از کليدهاي
یا Ctrl اس��تفاده کنيد؛ کليد Shift، لایه هاي پش��ت س��رهم و کلي��د Ctrl، لایه هاي 

غيرمتوالي را انتخاب مي کند.   
2- گزینه Merge Selected Layers را  از منوي کنترلي پنل Layers برگزینيد.

 توج�ه: در هنگام ادغام لایه ها، پایين ترین لایه انتخابي به عنوان لایه ادغام ش��ده 

در نظر گرفته مي شود.

Foreground ادغام لايه هاي 
ب��راي ادغام محتویات لایه هاي بالاي خط جدا کننده با لایه Foreground پس از انتخاب 
لایه ها به روش��ي که در مطالب قبل گفته ش��ده، روي گزینه Merge Foreground Layers، از 
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منوي کنترل پنل Layers کليک کنيد.

 نكته: لایه Guides با سایر لایه ها ادغام نمي شود.

 مثال 2: س��ه موض��وع گرافيکي تصویر آدم��ک، ماهي و س��تاره را به ترتيب در 
لایه های��ي با نام هاي fish ،human و Foreground رس��م کرده و آن ه��ا را در لایه Fish ادغام 

کنيد.
1- ابتدا در صفحه کاري ایجاد ش��ده، لایه اي با نام human رس��م کرده و شکل آدمک را 

در آن رسم کنيد.
2- در لایه اي که به نام fish ایجاد کرده اید، ش��کل ماهي و در لایه Foreground س��تاره 

صورتي رنگ را ترسيم کنيد.
3- لای��ه fish را ب��ه عنوان لایه فعال انتخاب کرده و با فش��ردن همزمان کليد Shift روي 

لایه هاي Foreground و human کليک کنيد.
4- با استفاده از گزینه Merge Foreground Layers، از منوي کنترلي پنل Layers لایه هاي 

Foreground )پيش زمينه( را با یکدیگر ادغام کنيد.

 

 Foreground شکل 14-12 ادغام لایه هاي

تمرين 2: 
 ،Animal 1 1- ش��کل هاي 15-12، 16-12و 17-12را ب��ه ترتي��ب در لایه هایي با ن��ام

Animal 2 و Animal 3 ایجاد کنيد.

2- محتویات لایه Animal 1 را به لایه Animal 2 منتقل کنيد.
3- لایه هاي Foreground را ادغام کنيد.

4- شکل 18-12 را به خط راهنما تبدیل کنيد.
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شکل 15-12          شکل 16-12           شکل 17-12            شکل 12-18

11-1-12 قابل چاپ كردن يا غيرقابل چاپ كردن لايه

همان ط��ور که در بخش 1-12 گفته ش��د جابه جایي لایه ها به بالا و زیر خط جدا کننده؛ 
به ترتيب س��بب چاپ شدن محتویات آن ها و عدم چاپ موضوع هاي گرافيکي قرار گرفته در 

لایه موردنظر مي شوند.
ايجاد لايه چاپي 	

1- در پنل Layers با درگ ماوس لایه غيرچاپي را به بالاي خط جداکننده بکشيد.
2- پ��س از انتقال لایه ب��ه بالاي خط جداکننده، تمام اش��ياي موجود در آن قابل چاپ 

مي شوند )شکل 12-19(.

شکل 19-12 ایجاد لایه چاپي

ايجاد لايه غیرچاپي
1- در پنل Layers با درگ ماوس لایه موردنظر را به زیر خط جداکننده بکشيد.

2- پس از انتقال لایه به زیر خط جداکننده، تمام اش��ياي موجود در آن کم رنگ ش��ده و 
چاپ نمي شوند )شکل 12-20(.
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شکل 20-12 ایجاد لایه غيرچاپي

12-1-12 حالت نمايش چاپي يا خطي محتويات لايه

علامت دایره اي که در دومين س��تون سمت چپ پنل Layers قرار دارد )شکل 21-12(؛ 
محتویات لایه را در حالت نمایش یا Preview )چاپي(  و حالت خطي )KeyLine(  نشان 
مي دهد. این علامت دایره اي به صورت دو وضعيتي اس��ت و کليک روي آن س��بب تغيير آن 

بين دو حالت مي شود.

Keyline شکل 21-12 نمایش لایه به صورت

13-1-12 تغييررنگ لايه ها

همان طورکه در ش��کل 22-12 نش��ان داده شده است؛ براي تش��خيص آسان تر لایه ها و 
محتوی��ات آن ها و ایجاد تمایز بين لایه ها، مي توانيد براي ه��ر لایه، رنگي را در نظر بگيرید. 
ب��ه ای��ن صورت که رنگ را از پنل هاي رنگ یا اب��زار رنگ آميزي درگ کرده و کليد ماوس را 
روي لای��ه موردنظر رها کنيد. بدین ترتيب رنگ موضوعات ترس��يمي نيز به رنگ لایه تغيير 

مي کند.
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شکل 12-22
1 Library2-12 پنل

س��مبل ها )Symbols( و صفحه هاي اصلي )Master Page( براي استفاده در بين سندهاي 
FreeHand، در پنل Library نگهداري مي شوند. موارد کاربرد پنل Library به طور خلاصه به 

شرح زیر است:
ایجاد سمبل از اشياء و متن یا سمبلي ترکيبي از متن و شئ	

) 	Symbols(  حذف و اضافه کردن سمبل ها یا نمادها
وارد ک��ردن و ص��ادر ک��ردن س��مبل ها و صفحه ه��اي اصلي در صفحه هاي س��ند  	

FreeHand

بااس��تفاده از پن��ل Library	 مي توانيد بي��ش  از یک نمونه از س��مبل موردنظر را در 
سندجاري به کار ببرید. این نمونه ها به صورت جداگانه و تکي با ویژگي هاي متفاوت، 

در بين سندهاي FreeHand قابل انتقال هستند.
 Library 1-2-12 نمايش پنل

براي نمایش پنل Library به یکي از موارد زیر عمل کنيد:
مسير Window→Library را پيگيري کنيد.	
در نوار ابزار Main، روي آیکن  )Library(، کليک کنيد.	

در این صورت پنل Library مطابق با شکل 23-12 باز مي شود.

1- کتابخانه
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Libraryشکل 23-12 پنل

2-2-12 ايجاد يک سمبل جديد

همان طورکه گفته ش��د، مي توانيد از یک موضوع گرافيک��ي، متني یا هر دو آن ها که در 
یک گروه قرار گرفته اند، براي ایجاد سمبل استفاده کنيد و با Duplicate سمبل هاي موجود، 

نمونه هایي با ویژگي مشابه نمونه اصلي داشته باشيد.
روش اجرا:

براي ایجاد س��مبل جدید مطابق شکل 24-12، پس از نمایش پنل Library موارد زیر را 
اجرا کنيد:

1- شيئي را که مي خواهيد از آن یک سمبل ایجاد شود، انتخاب کنيد.
2- یکي از کارهاي گفته شده را انجام دهيد:

روي آیکن 	 که در پایين پنل قرار دارد کليک کنيد.
شئ مورد نظر را از صفحه کاري به ليست سمبل ها درگ کنيد. 	

از منوي کنترلي پنل Library گزینه New Graphic	 را انتخاب کنيد.
مسير  Modify→Symbol→Convert to Symbol	 را اجرا کنيد.

مسير  Modify→Symbol→Copy Symbolرا پيگيري کنيد.	
هر کدام از این 5 روش یک سمبل جدید ایجاد مي کند.
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شکل 24-12 ایجاد یک سمبل

3-2-12 ايجاد كپي از نمونه اصلي

پس از باز کردن پنل  Libraryبه طریق زیر عمل کنيد:
1- از فهرست سمبل ها، سمبل مورد نظر را برگزینيد.

2- یکي از دو مورد زیر را انجام دهيد )شکل 12-25(:
3- روي گزینه Duplicate از منوي کنترلي پنل کليک کنيد.

4- کليد Ctrl را نگه داشته و آن را به ليست سمبل ها درگ کنيد.           

 شکل 25-12 ايجاد كپي از نمونه اصلي سمبل

Library 4-2-12 پيش نمايش سمبل در پنل

روش اجرا:
1- بررس��ي کنيد که از من��وي کنترلي پنل Library گزین��ه Preview در حالت انتخاب 

باشد. 
2- سمبل مورد نظر را از فهرست سمبل ها انتخاب کنيد.

3- پيش نمایش آن در پنل Library مانند شکل 25-12 قابل مشاهده است.
5-2-12 گروه بندي سمبل ها

1- یکي از این دو مورد را اجرا کنيد:
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روي آیکن  در پایين پنلLibrary  کليک کنيد.	
گزینه New Group را از منوي کنترل در پنل Library انتخاب کنيد.	

2- نام گروه مورد نظر را وارد کنيد.
3- سمبل هاي مورد نظر را به ليست گروه ایجاد شده وارد کنيد )شکل 12-26(. 

شکل 26-12 قرار دادن سمبل ها در یک گروه

 توجه: براي انتخاب بيش از یک س��مبل و قرار دادن آن ها در ليس��ت گروه مورد 

نظر، از کليد Shift استفاده کنيد.

6-2-12 حذف سمبل ها

1- سمبل مورد نظر را انتخاب کنيد.
2- یکي از دو مورد بعد را انجام دهيد:

روي آیکن  که در پایين پنل Library	 قرار دارد، کليک کنيد.
از منوي کنترل در پنل Library، گزینه Remove	 را برگزینيد.

7-2-12 ايجاد نمونه1 از سمبل

یکي دیگر از امکانات پنل Library ایجاد نمونه هایي از س��مبل اس��ت که با تغيير سمبل، 
نمونه هاي ایجاد شده از آن نيز تغيير مي کنند.

روش اجرا:
به یکي از حالت هاي گفته شده عمل کنيد )شکل 12-28(:

 1-    Instance 
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سمبل مورد نظر را از پنل Library به سند درگ کنيد.	
عمل Copy و Paste یا Duplicate را روي نمونه سمبل موجود، انجام دهيد. 	

شکل 27-12 ایجاد نمونه از سمبل

8-2-12 ويرايش سمبل 

1- براي ویرایش سمبل به ترتيب زیر عمل کنيد:
روي نام سمبل یا پيش نمایش آن در پنل Library دابل کليک کنيد.	
گزینه Edit از منوي کنترلي پنل Library را برگزینيد.	

2- پنجره ویرایش سمبل باز مي شود؛ تغييرات دلخواه را روي آن انجام دهيد. 
3- پنجره ویرایش سمبل را ببندید.

 توجه: در س��مت چپ پنجره ویرایش سمبل، گزینه Auto-Update به صورت پيش فرض فعال 

است و امکان اجرا و مشاهده تغييرات را به صورت همزمان فراهم مي کند.

 نكته: تغييرات انجام ش��ده روي س��مبل ها تا زماني که پنجره ویرایش آن بس��ته نشده است یا 
سند دیگري را فعال نکرده اید، روي آن ها اعمال نمي شود.

، اگ��ر در کادر ظاهر  	Library با درگ یک ش��ئ به محل س��مبل مورد نظ��ر در پنل
ش��ده روي دکمه Replace کليک کنيد، شئ انتخاب ش��ده جایگزین سمبل و همه 

نمونه هاي ایجاد شده از آن در سندهاي FreeHand مي شود.
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9-2-12 جايگزيني سمبل با اشياء و نمونه هاي )Instance( سند

روش اجرا:
1- ابتدا اشياء مورد نظر را انتخاب کنيد )شکل 12-28(.

   

شکل 28-12جایگزیني سمبل با اشياء انتخابي و نمونه هاي ایجاد شده از سمبل 

2- سمبل مورد نظر را از پنل Library انتخاب کنيد.
3- یکي از دو مورد زیر را اجرا کنيد.

روي آیکن    کليک کنيد.	
از منوي کنترلي پنل، گزینه Swap	 را برگزینيد. در این صورت س��مبل با اشياء سند 

جایگزین مي شود )شکل 12-29(.

شکل 29-12 سمبل جایگزین شده با اشياء سند

Release 12-2-10 سمبل

1- در پنل Library سمبل موردنظر را انتخاب کنيد.
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2- مسير Modify→Symbol→Release Instance را پيگيري کنيد.
مثال 3: یک س��ند دوصفحه اي با اندازه دلخواه ایجاد کنيد. ش��کل 30-12 را در 

   Library که در پنل Flower به فهرس��ت گ��روه Fl-red صفحه اول رس��م کرده و آن را با نام
ایجاد کرده اید اضافه کنيد؛ س��پس نمون��ه اي از آن را در صفحه دوم قرار دهيد و رنگ آن را 

تغيير دهيد.

شکل 12-30

2- فایل دو صفحه اي ایجاد کرده و در صفحه اول شکل 30-12 را رسم کنيد.
 Library را از منوي کنترلي در پنل  New Group را فعال کرده و گزینه Library 3- پن��ل

برگزینيد و گروهي با نام Flower در آن ایجاد کنيد.
4- شکل رسم شده را به داخل گروه Flower درگ و نام سمبل را Fl-red قراردهيد.
5- سمبل Fl-red را از پنل Library به صفحه دوم سند درگ کنيد )شکل 12-31(.

6- با استفاده از گزینه Edit در منوي کنترلي پنل، سمبل را ویرایش کرده و رنگ آن را 
تغيير دهيد.

      

 

 

        
شکل 12-31

11-2-12 وارد كردن سمبل ها

1- از منوي کنترلي پنل Library ، گزینه Import را اجرا کنيد.
2- فایل��ي که س��مبل م��ورد نظر در آن ق��رار دارد، انتخاب و روي دکم��ه Open کليک 

کنيد.
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 Import س��مبل موردنظر را انتخ��اب و روي دکمه Import Symbols  3- درکادرمح��اوره
کليک کنيد.

12-2-12 صادر كردن سمبل ها

1- از منوي کنترل در پنل Library گزینه Export را برگزینيد.
2- سمبل یا سمبل هایي را که مي خواهيد صادر کنيد، انتخاب کنيد.

3- روي دکمه Export کليک کنيد.
4- در کادر محاوره Export Symbols، فایل FreeHand را که مي خواهيد سمبلي در آن به 

کار ببرید، مشخص کرده و پس از وارد کردن نام فایل روي دکمه Save کليک کنيد.
مثال 4: ش��کل 32-12 را رسم کرده و با نام fl-green به فهرست گروه flower که 
در پنل Library ایجاد کرده اید اضافه کنيد؛ س��پس آن را به فایلي با نام Example12 -3 صادر 

کنيد.
1- ابتدا شکل 32-12 را رسم و با استفاده از یکي از پنل هاي رنگ، رنگ آميزي کنيد.

2- پنل Library را از طریق منوي Window فعال کنيد.
3- روي آیک��ن  که در پایين پنل اس��ت کليک ک��رده و گروهي با نام Flower ایجاد 

کنيد.

شکل 12-32

 Fl-green درگ و نام آن را Flower 4- ش��کل رسم شده را انتخاب کرده و به داخل گروه
بگذارید.

 Example12 -3 در منوي کنترلي پنل، شکل را به فایلي با نام Export 5- با استفاده از گزینه
صادر کنيد.

 FreeHand ایجاد کرده و یکي از سمبل هاي برنامه T12 -4 تمرين 3: سندي به نام
را به دلخواه انتخاب کرده و در آن وارد کنيد.

  )Style(3-12 سبک
س��بک هاي گرافيکي و متني آماده، یکي از امکانات مهم برنامهFreeHand  اس��ت که این 
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موارد به صورت از قبل تعریف ش��ده و آماده در دس��ترس شماست و مي توانيد از ویژگي هاي 
هر کدام براي ایجاد قالب طرح و سبک مورد نظر استفاده کنيد، این ویژگي ها عبارتند از:

 ) 	strokes(خط هاي دور اشياء
) 	fills( پرکردني هاي داخل موضوع هاي ترسيمي

) 	colors( رنگ ها
) 	effects( جلوه ها

	Halftone ویژگي هاي
س��بک هاي متني نيز امکان قالب بندي و پایه ریزي سبک متني و پاراگرافي را با توجه به 

ویژگي هاي متني موجود، فراهم مي کند.

Halftones و Object شکل 33-12 سبک گرافيکي و ویژگي هاي پيش فرض در پنل

س��بک ها )طرح ها( همچنين امکان ایجاد تغييرات س��ریع در متن و گرافيک سند جاري 
را فراهم مي کنند.

همان طورکه مي توانيد از الگوهاي آماده )Template( در سند بهره بگيرید، امکان ایجاد و 
ذخيره Style و کاربرد آن در سندFreeHand  نيز وجود دارد.

 توج�ه: این م��وارد و ویژگي ها در پنل هاي Object و Halftones  1  قابل دسترس��ي 

1- پنل Halftones براي تنظيم صفحات سفارشي براي اشيایي مانند ته رنگ ها، طيف رنگ ها )Gradients(، ترکيبات و تصاویر اسکن شده 
استفاده مي شود.



Free Hand پیمانه مهارتی : کاربر
   Graphic Hose و Styles  ، 361واحد کار دوازدهم: توانایی استفاده از لایه ها ، سمبل ها

هستند )12-33(.
 Styles 1-3-12 پنل

پن��ل Styles براي نمایش س��بک و طرح گرافيکي و متني ب��ه کار مي رود. همچنين براي 
ایجاد یک س��بک جدی��د )new styles(، حذف )remove(، اضافه ))add، تهيه کپي از س��بک 

موجود duplicate(( و براي ویرایش سبک ها از پنلObject  و Styles استفاده مي شود.

 نكته: اگر ش��ئ یا موضوع گرافيکي در س��ند انتخاب نباش��د و یک سبک از پنل 
Styles در وضعي��ت انتخاب قرار بگيرد؛ آن س��بک به ط��ور پيش فرض به عنوان خصوصيت 

اشياء ترسيمي جدید، در نظر گرفته مي شود.

Styles نمايش پنل
براي نمایش پنل Styles  مسير Window→Styles  را اجرا کنيد.

Styles 1-1-3-12 حالت هاي نمايش
ب��راي انتخاب حالت هاي نمایش Styles روي من��وي کنترلي پنل Styles کليک کنيد و با 

توجه به حالت نمایشي مورد نظر، یکي از موارد زیر را انتخاب کنيد:
Compact List View:	 س��بک ها به صورت پيش نمایش کوچکي از شکل آن ها همراه 

با نام سبک، نشان داده مي شود.
Large List View:	 س��بک ها به صورت پيش نمایش بزرگي از شکل آن ها همراه با نام 

سبک، نشان داده مي شود.
 	Styles سبک ها به صورت پيش نمایش بزرگي از شکل آن ها در پنل :Previews Only

نشان داده مي شود.
Normal 2-1-3-12 اعمال سبک

هر سند FreeHand همراه با سه سبک Normal پيش فرض به صورت زیر ارائه مي شود:
1- سبک مختص ترسيم اشياي جدید

2- ایجاد متن جدید
 )Normal Connector( 3- اعمال نمودن خطوط متصل کننده جدید

2-3-12 ايجاد يکStyle  جديد
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در این بخش موارد مختلف ایجاد سبک بررسي مي شود:
Normal ايجاد سبک يا طرح جديد بر اساس يک سبک گرافيکي

در حالتي که س��بک نرمال در پنل Styles  انتخاب شده است، طبق شکل 34-12 به این 
ترتيب عمل کنيد:

1- روي منوي کنترل در پنل Styles کليک کنيد.
2- گزینه New را برگزینيد.

شکل 34-12 ایجاد سبک نرمال

ايجاد سبک جديد بر اساس يک شئ
1- شئ یا متن )موضوع( مورد نظر را انتخاب کنيد.

2- سپس یکي از روش هاي زیر را انجام دهيد:
طب��ق ش��کل 35-12 از منوي کنترلي پنل Styles گزینه New	 را برگزینيد، س��بک 

ایجاد شده بر اساس موضوع در ليست Style ها دیده مي شود.

Styles در منوي کنترلي پنل New شکل 35-12 ایجاد سبک جدید با استفاده از گزینه
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 موض��وع  موردنظ��ر را از صفح��ه کاري ب��ه فض��اي خال��ي پن��ل Styles	 درگ کنيد 
)شکل12-36(. 

Styles شکل 36-12 ایجاد سبک جدید با درگ شئ به پنل

، پيش نمایش ش��يئي را که در س��مت چپ نام آن قرار دارد، به فضاي  	Object از پنل
خالي پنل Styles درگ کنيد )شکل 12-37(.

Object شکل 37-12 پيش نمایش شئ در پنل

پ��س از ره��ا کردن ماوس  اگر در فضاي خالي صفحه کليک کنيد، پنل Object به صورت 
شکل 38- 12 خواهد شد. 

Object شکل 38-12 پيش نمایش سبک ایجاد شده در پنل

Styles ايجاد سبک جديد بر اساس طرح موجود در پنل
1- مس��ير Edit→Select→None را پيگيري کرده یا کليد Tab را فشار دهيد تا شيئي در 

وضعيت انتخاب نباشد.
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2- در پنل Styles، سبکي را که مي خواهيد Style جدید بر اساس آن ایجاد شود، انتخاب 
کنيد )شکل 12-39(.

شکل 39-12 شئ رسم شده بر اساس سبک انتخابي

 توجه: اگر ش��يئي در صفحه انتخاب نشده باشد؛ انتخاب یک طرح، سبب مي شود که 

خصوصيات سبک انتخابي به صورت پيش فرض به اشياء جدیدي که رسم مي شوند، داده شود.

1- یکي از موارد ذکر شده را اجرا کنيد:
گزینه New را از منوي کنترل در پنل Styles انتخاب کنيد.	

 پيش نمای��ش س��بک را از پن��ل Object به فضاي خال��ي پن��ل Styles	 درگ کني��د 
)شکل12-40(.

Object وپيش نمایش آن درپنل Stylesشکل 40-12سبک انتخاب شده در پنل
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Object ايجاد طرح جديد براساس ويژگي هاي تنظيم شده در پنل
1- مس��ير Edit→Select→None را پيگيري کرده یا کليد Tab را فشار دهيد تا شيئي در 

وضعيت انتخاب نباشد.
2- ویژگي هاي موردنظر را در پنل  Object تنظيم کنيد .

3- یکي از موارد زیر را انجام دهيد:
. پيش نمایش سبک را از پنل  Object به فضاي خالي پنل Styles درگ کنيد	

گزینه New را از منوي کنترل در پنل Styles انتخاب کنيد.    	
Style 3-3-12 كاربرد

براي اعمال سبک به موضوع انتخاب شده پس از نمایش پنل Styles، یکي از کارهاي زیر 
را انجام دهيد:

Style موردنظر را به شئ انتخاب شده درگ کنيد )شکل 12-41(.	

Style را از موضوع ترس��يمي دلخواه کپي کرده و با انجام عمل Paste	 به ش��ئ دیگر 

اعمال کنيد.
برای نسخه برداري از ویژگي هاي یک Style به ترتيب گفته شده عمل کنيد:

انتخاب موضوع ترسيمي که مي خواهيد از ویژگي هاي آن استفاده کنيد.
2- مسير Edit→Special→Copy Attributes را اجرا کنيد )شکل 12-42(.

Styles به شئ انتخاب شده با درگ طرح از پنل Style شکل 41-12 اعمال
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شکل 42-12 کپي سبک شئ مورد نظر

3- انتخاب موضوع ترس��يمي ک��ه مي خواهيد ویژگي هاي س��بک موردنظر به آن اعمال 
شود.

4- مسير  Edit→Special→Paste Attributesرا اجرا کنيد. مشاهده مي کنيد که سبک به 
شئ اعمال مي شود )شکل 12-43(.

شکل 43-12 اعمال سبک یک شئ به شئ دیگر

Style 4-3-12 ايجاد يک كپي از

1- مسير Edit→Select→None را اجرا کرده یا کليد Tab را فشار دهيد تا شئ در وضعيت 
انتخاب نباشد.

2- در پنل Styles سبک مورد نظر را انتخاب کنيد.
 Duplicate یا کليک راس��ت روي سبک موردنظر، گزینه Styles 3- از منوي کنترلي پنل

را برگزینيد )شکل 12-44(.
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شکل 44-12 کپي سبک موردنظر

Style 5-3-12 حذف يک

1- مس��ير Edit→Select→None را پيگيري کرده یا کليد Tab را فشار دهيد تا شيئي در 
وضعيت انتخاب نباشد.

2- در پنل Styles، سبک موردنظر را براي حذف، انتخاب کنيد.
3- گزینه Remove را از منوي کنترل در پنل Style برگزینيد.

 توجه: با کليک راس��ت روي س��بک انتخابي مي توانيد، آن را حذف کرده )گزینه 

Remove( یا از آن نسخه کپي ایجاد کنيد )گزینه Duplicate( )شکل 12-45(.

شکل 12-45

Style 6-3-12 وارد كردن و صادر كردن

لازم نيست هر زمان که یک سند جدید FreeHand را ایجاد مي کنيد، سبک هاي جدیدي 
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 FreeHand تعریف نمایيد. به سادگي مي توانيد سبک هایي را که قبلًا تعریف کرده اید در اسناد
وارد کرده یا س��بک ایجاد ش��ده را صادر کنيد. با این تفاوت که به جاي پنل Library از پنل 
Styles اس��تفاده ک��رده و از طری��ق کادر مح��اوره Import Styles و Export Styles وارد کردن 

)Import( و صادر کردن )Export( سبک ها انجام مي شود.
براي وارد کردن س��بک به س��ند جاري، از سند هاي FreeHand	 یا کتابخانه  سبک ها 

که سبک مورد نظر را دارند، استفاده مي شود.
در ش��کل 46-12 تعدادي از گروه هاي متفاوت Style	 که از طریق منوي کنترلي در 

پنل Styles قابل دسترسي هستند، نشان داده شده است. 

Style شکل 46-12 فایل گروه هاي مختلف

 Styles را در پنل    Crystal Button سبک ،Button Styles تمرين 4: از گروه س��بک
وارد کرده و آن را به شکل هاي 47-12 که در صفحه کاري رسم کرده اید، اعمال کنيد.

شکل 12-47

 Graphic Hose 4-12 ابزار
به کمک این ابزار و با اس��تفاده از ش��کل هاي گرافيکي از پيش تعریف ش��ده یا طراحي 
شده توسط خود و کليک یا درگ ماوس روي صفحه، قادر خواهيد بود تا جلوه هاي گرافيکي 

جالبي را ایجاد کنيد. 
Graphic Hose 1-4-12 روش كار با ابزار

1- روي ابزار Graphic Hose دابل کليک کنيد تا کادر محاوره Hose مطابق شکل 12-48 
باز شود.

2- با انتخاب گزینهHose  مي توان نمونه هاي از پيش تعریف ش��ده اي مانند گل، ستاره و 
مشابه آن ها را براي ایجاد جلوه انتخاب کرد.
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 Graphic Hose مي توان یک Hose از منوي بازشو کادر محاوره  New3- با انتخاب گزینه
جدید ایجاد کرد.

با انتخاب گزینه Rename   مي توان نام Graphic Hose	 را تغيير داد.
با انتخاب گزینه Duplicate مي توان از Graphic Hose	 جاري یک کپي تهيه کرد.

(، تعداد  منوي بازش��وي Contents واقع در پایين کادر محاوره Hose )شکل 12-48	
شکل هاي Graphic Hose جاري را نمایش مي دهد.

             Hose شکل 48-12 کادر محاوره

 توج�ه: در کادر مح��اورهHose ، تصاویر قرار گرفته در یک نوع ش��کل مي توانند حداکثر تا 10 

عدد باشند.

2-4-12 روش ايجاد يک Graphic Hose جديد

1- این شکل ها را طراحي کنيد )شکل 12-49(.

شکل 12-49 

2- روي ابزار Graphic Hose دابل کليک کنيد تا کادر محاوره Hose باز شود.
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3- در منوي بازشوي کادر محاوره Hose گزینه New را انتخاب کنيد.
 4- در کادر محاوره ظاهر ش��ده )شکل 50-12( در کادر متني Name نام مورد نظر براي

Graphic Hose جدید را وارد کرده، سپس روي دکمه Save کليک کنيد.

شکل 50-12 تایپ نام جدید

5- شکل اول را انتخاب کرده سپس کپي کنيد، سپس در کادر محاورهHose  روي دکمه
Paste in  کليک نمایيد )شکل 12-51(.

شکل 51-12 کپي شکل در Graphic Hose جدید

6- براي ش��کل دوم و سوم همان مراحل را طي کنيد. از منوي بازشوي Contents تعداد 
اشکال موجود در مجموعه ساخته شده خود را مي توانيد مشاهده کنيد. 

7- اکنون با هر بار کليک، شکل هاي موجود در Graphic Hose روي صفحه ظاهر مي شوند.
  Graphic Hoseمي ت��وان تنظيمات مربوط به  Optionsبا انتخاب گزینه Hose درکادرمح��اوره

را انجام داد.
 Graphicتمرين 5: ش��کل هاي 52-12 را طراحي کرده و با اس��تفاده از آن ها یک

Hose  جدید ایجاد کنيد.

شکل 12-52
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 Chart  5-12 ابزار
  Xtra Toolsواقع در ن��وار ابزار Chart ب��راي ایج��اد نمودار از اب��زاري به نام Freehand در

استفاده مي شود.
Chart 1-5-12 روش كار با ابزار

ابزار Chart را انتخاب کنيد و کادري در صفحه بکشيد تا محدوده ترسيم نمودار تعيين شود.
کادر محاوره Chart مطابق شکل 53-12 ظاهر مي شود.

در بالاي کادر محاوره Chart، دو آیکن به شرح زیر وجود دارد:
آیک��ن داده ه��ا  که در ش��کل 54-12 نمایش داده ش��ده و مخص��وص وارد کردن 

اطلاعات است.
آیکن گراف یا نمودار  که در صورت انتخاب آن، شکل 54-12 نمایش داده مي شود 

و مي توان در این قسمت شکل هاي مختلفي را براي نمودار تعيين کرد.

 

شکل 53-12 کادرمحاوره Chart براي وارد کردن داده

Chart شکل 54-12 نحوه تنظيم نمودار  از کادرمحاوره
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 Chart 2-5-12 نحوه تنظيم نمودار از كادر محاوره

گزینه ه��اي ای��ن کادر محاوره، نوع نمودار را از لحاظ ش��کل ظاه��ري و گرافيکي تعيين 
مي کنند.

Grouped Column  : نمودار را به صورت ميله اي رسم مي کند.

Stacked Column  : در این نوع نمودار، داده ها به صورت افزایش��ي با هم مقایس��ه 

مي شوند.
Line  : نمودار را به صورت خطي رسم مي کند.

Pie : ب��راي ارایه داده ه��ا به عن��وان درصدهای��ي از کل، از نمودار دایره اي اس��تفاده 

 مي شود.
Area  : س��طح اشغال شده توسط هر نمودار از رنگ پر مي شود و نحوه قرار گرفتن 

نمودار به صورت افزایش��ي اس��ت. از این نوع ترسيم آماري براي نمایش داده ها در طول یک 
دوره زماني استفاده مي شود.

Scatter : داده ه��اي هر دو خانه در یک ردیف با یکدیگر مقایس��ه و به صورت یک 

نقطه در نمودار ظاهر مي شوند.

واژه نامه
Auto-Updateبه روز شدن، به صورت خودکار

Chartنمودار

Compactفشرده

Decimalاعشاري، دهدهي

Foregroundپيش زمينه
Halftone)در ليتوگرافي( هاف تن، تصویر ترام دار، )در طراحي( خاکستري ميانه

Layersلایه ها

Line Chartنمودارخطي

Parent Styleسبک مبنا، سبک والد، سبک اصلي

Pie Chartنمودار دایره اي
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Replaceجایگزین کردن

Scatterپخش کردن

Separatorجداکننده

Symbolsسمبل ها

Uniformهم شکل، یکسان

خلاصه مطالب
موارد کاربرد پنل Library	 به طور خلاصه به شرح زیر است:

ایجاد سمبل از اشياء و متن یا سمبلي ترکيبي از متن و شئ	
	)Symbols( حذف و اضافه کردن سمبل ها

وارد ک��ردن و ص��ادر ک��ردن س��مبل ها و صفحه ه��اي اصلي در صفحه هاي س��ند  	
FreeHand

، ایجاد یک  	 )add( اضاف��ه ،)remove( حذف ،)new( براي ایجاد یک س��بک جدی��د
نس��خه کپي از س��بک موجود )duplicate( و براي ویرایش سبک ها از پنل Object و 

Styles استفاده مي شود.

ابزار Graphic Hose	 با استفاده از شکل هاي گرافيکي از پيش تعریف شده و با کليک 
یا درگ ماوس روي صفحه، جلوه هاي گرافيکي جالبي ایجاد مي کند. 

از ابزار Chart	 براي ایجاد نمودارهاي گرافيکي استفاده مي شود.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
374

آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعیین کنید.

 Background 1- ب��ه لایه های��ي ک��ه در بالاي خط افق��ي جدا کننده ق��رار مي گيرند، لای��ه
مي گویند. 

2- موضوع هاي ترسيمي که در لایه Foreground قرار دارند، چاپ شدني هستند.
3- انتخاب گزینه Clicking on a Layer name moves selected objects در زبانه Panels در 

کادر محاوره Preferences سبب جا به جایي اشياء با انتخاب نام لایه مي شود.
4- براي ایجاد سمبل جدید، روي آیکن  که در پایين پنل قرار دارد، کليک کنيد.

5- اگر ش��يئي در صفحه انتخاب نش��ده باش��د؛ انتخاب یک طرح، س��بب مي ش��ود که 
خصوصيات طرح انتخابي به صورت پيش فرض به اش��ياء جدیدي که رس��م مي ش��وند، داده 

شود.
 Graphic Hose در کادر محاوره Spacing از منوي بازش��و ،Variable 6- ب��ا انتخاب گزینه

فاصله ميان موضوعات به طور تصادفي تعيين مي شود.
معادل گزينه  هاي سمت راست را از ستون سمت چپ انتخاب کرده و مقابل هر عبارت بنويسید.

7- اشياء و موضوع هایي که  ترسيم مي کنيد یا در سند Import مي شوند، در این لایه قرار 
             Remove                                                                                                                  .مي گيرند
              Edit         .8- براي ویرایش لایه ها، باید آن ها را در وضعيت ......... و ............. قرار دهيد
9- ب��راي ویرای��ش س��مبل گزین��ه ......... از من��و کنت��رل پن��ل Library را برگزیني��د.                                                                                                                                        
     Remove Unused                                                                                         
10- این گزینه براي حذف یک سمبل در پنل Library و با استفاده از منوي کنترلي این 
Active                                                                                                        .پنل به کار  مي رود

11- براي حذف طرح هایي اس��ت که در س��ند به کار نمي رون��د و از منو کنترل در پنل 
 Visible-UnLock                                                               انتخاب مي شود Styles

گزينه صحیح را انتخاب کنید.

12- هنگام استفاده از ابزار Chart مقدار اعشار در کدام قسمت تعيين مي شود؟
Thousands separator -ب   Transpose  -الف
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Column -د               Decimal precision -ج
13- هنگام اس��تفاده از ابزار Graphic Hose با انتخاب کدام گزینه مي توان از مدل جاري 

یک کپي تهيه کرد؟
Delete -د  Rename -ج  Duplicate -ب  Contents  -الف

14- براي ادغام محتویات لایه هاي بالاي خط جدا کننده با لایه Foreground کدام گزینه 
مناسب است؟

Remember Layer Info  -ب           Merge Foreground Layers  -الف
Merge Selected Layer  -د    Move Objects to Current Layer  -ج

15- براي جایگزیني سمبل با اشياء و Instanceهاي سند به کار مي رود:
الف-             ب-               ج-                د- 

16- در این حالت، نمایش طرح ها به صورت پيش نمایش بزرگي از ش��کل آن ها همراه با 
نامشان، نشان داده مي شود:

 Normal View -ب            Large List View  -الف
Compact List View  -د   Previews Only  -ج

در جاي خالي عبارت مناسب را بنويسید.

17-  موضوع هایي که در لایه ............... قرار دارند، چه بالاي خط جدا کننده باشند یا در 
پایين آن قرار بگيرند، چاپ نمي شوند.

18- در س��مت چپ پنجره ویرایش س��مبل، گزینه ............... به صورت پيش فرض فعال 
است و امکان اجرا و مشاهده تغييرات را به صورت همزمان فراهم مي کند.

19- ب��ه ی��کStyle  که مبناي توليد س��بک هاي دیگر قرار داده مي ش��ود، س��بک ......... 
مي گویند.

20- ه��ر تغيي��ري در س��بک ..........، س��بب تغيير در اس��اس اوليه س��بک هاي ............ 
مي شود.

به سؤالات زير پاسخ تشريحی دهید.

21- منظور از لایه قفل شده و قفل نشده، چيست؟
22- علامت + کنار طِرح نشان دهنده چيست؟

23- سه مورد از موارد کاربرد پنل Library را بيان کنيد.
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24- چگونه مي توان یک Graphic Hose جدید ایجاد کرد؟ 

آزمون عملي
1- شکل زیر را رسم کرده، آن را با نام Style 12-85 در ليست سبک هاي پنل Styles وارد 

کنيد، با استفاده از پنل Object ویژگي هاي آن را تغيير دهيد و سبک را Redefine کنيد.

2- شکل هاي زیر را به ترتيب در لایه هایي با نام Design 1 و Design 2 ایجاد کرده و لایه 
Design 2 را پنهان کنيد و لایه Design 1 را در حالت نمایش خطي قرار دهيد و قفل کنيد.

3- شکل زیر را رسم کرده، موارد خواسته شده را روي آن انجام دهيد:
به عنوان یک سمبل در پنل Library قرار دهيد. 	

ی��ک کپ��ي از آن ایجاد کني��د و در نمونه کپي ش��ده رنگ آن را تغيي��ر دهيد و از  	
س��مبل هایي که ایج��اد کرده اید در طراحي ی��ک کاغذ کادو با اندازه A4 اس��تفاده 

کنيد.
موضوع هاي ترسيمي را در لایه هاي مجزا قرار دهيد و در پایان کار ادغام کنيد.	

4- توسط تصاویر زیر یک Graphic Hose جدید ایجاد کنيد.
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5- نمودار ميله اي و دایره اي نمرات درس FreeHand خود را در ماه جاري ترسيم کنيد.
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FreeHand 1-13 آشنايي با فرمت هاي قابل ورود به نرم افزار
در برنام��ه FreeHand، مي تواني��د فایل هایي با فرمت هاي برداري )Vector( و پيكس��لي 
)Bitmap( را به س��ند وارد )Import( کنيد. مهم ترین فرمت فایل هاي Import ش��ده عبارت 

است از:
، ش��امل عناصر ب��رداري، متن ها، لایه ها و  	 Macromedia Fireworks PNGفایل ه��اي

جلوه هایي است که در FreeHand ویرایش مي شود.
، محتواي گرافيكي -   برداري  	CorelDRAW و Illustrator فایل هاي گرافيكي برداري در

آن ها همانند مسيرها قابل ویرایش  هستند.
فایل هاي PSD برنامه Adobe Photoshop، هنگامي که Import	 مي ش��وند به صورت 

تصویر تخت و غيرقابل ویرایش هستند.
 	QuarkXPress و Adobe PageMaker ،Photoshop که در برنامه ه��اي EPS فایل هاي

ایجاد شده اند.
فایل هاي TGA ،TIFF ،PSD ،GIF ،JPEG و BMP	 که با همان قالب و فرمت اصلي در 

سند Import ،FreeHand مي شوند.
فایل هاي دیگر RTF وASCII نمونه هایي از آن ها هستند.	

)Bitmap( 2-13 وارد كردن تصوير طرح بيتي
براي وارد کردن یك کار هنري از نوع طرح بيتي )Bitmap( به FreeHand روش هاي زیر 

را به کاربرید:
1- همان طورکه قبلًا در واحد کار 3 با  فرمان Import آش��نا ش��دید براي وارد کردن یك 

تصویر به برنامه FreeHand از فرمانFile→Import  استفاده مي شود.
2- از طریق کپي کردن تصویر و چس��باندن )Paste( مي توانيد فایل تصویري موردنظر را 

به برنامه FreeHand وارد کنيد.

 نكته: در هنگام ارسال یا انتقال فایل FreeHand، باید تصویر وارد شده را به همراه 
آن ارسال کرد.
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ويرايش تصاوير وارد شده
تغییر اندازه تصوير: با استفاده از ابزار Pointer تصویر را انتخاب کرده سپس دستگيره هاي 
کنترلي را در جهت موردنظر درگ کنيد. توجه داشته باشيد که براي حفظ تناسب  هاي افقي 

و عمودي کليد Shift را نگه دارید.

شكل 1-13 نمایش دستگيره ها براي تغيير اندازه

 Object تغيير اندازه با استفاده از پنل
1- مي توانيد درصدي را در کادر متني x و y براي تغيير اندازه تصویر وارد کنيد )ش��كل 

.)13-2
2- ب��ا وارد ک��ردن مقداري در  کادر متن��ي w )عرض( و h )ارتفاع( ان��دازه تصویر تغيير 

مي کند )شكل 13-2(.

Object شكل 2-13 تغيير اندازه با پنل

تغییر شكل تصاوير Bitmap: براي تغيير شكل تصویر به صورت زیر عمل کنيد:
1- روي تصویر وارد  شده دابل کليك کنيد.

2- از دستگيره هاي  کنترلي یا ابزارهاي تغيير شكل جعبه ابزار Tools براي مورب کردن، 
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چرخش، تغيير مقياس و انعكاس تصویر استفاده نمایيد.
 BMP به  ش��ما امكان مي دهد  که رنگ تصاویر FreeHand :Bitmap تغییر رنگ تصاوير

و Tiff سياه و سفيد یا خاکستري را تغييردهيد.
1- یك تصویر سياه و سفيد یا خاکستري  را انتخاب  نمایيد.

2- نمونه رنگ را از پنل Mixer به سمت  تصویر بكشيد  )شكل 13-3(.

 

شكل 3-13 تغيير رنگ تصویر خاکستري

 ی��ا نمون��ه رنگ را از پن��ل Mixer به س��مت کادر رنگ در پن��ل Object درگ کنيد
)شكل 13-4(.

Object شكل 4-13 تغييررنگ تصویر خاکستري از طریق پنل

تمرين 1: یك تصویر دلخواه با فرمت jpg را وارد برنامه FreeHand کنيد. س��پس 
عمليات زیر را روي آن انجام دهيد.

1- با استفاده از پنل Object اندازه آن را دو  برابر کنيد.
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2- ی��ك کپ��ي از تصوی��ر را 180 درجه بچرخانيد و به نحوي آن را ق��رار دهيد که گویي 
انعكاس تصویر در آب است.

Optimize In Fireworks 3-13 كار با فرمان

 Bitmap براي ویرایش تصاویر Fireworks به ش��ما امكان مي دهد تا از نرم افزار FreeHand

استفاده کنيد. 
با اس��تفاده از برنامه Fireworks مي توانيد حجم تصاویر با کيفيت بالا را کم کرده و براي 

انتشار در وب آماده سازید.

 توجه: Fireworks فایل ها را به اس��ناد RGB تبدیل مي کند، بنابراین اگر قرار است 

تصویري به عنوان سند CMYK باقي بماند از برنامه Fireworks براي ویرایش تصاویر استفاده 
نكنيد.

دو نوع فایل Fireworks وجود دارد که مي توانند به FreeHand وارد شوند:
1- فایل هاي اوليه Fireworks PNG، انواع خاصي از تصاویر پيكس��لي )Bitmap( هس��تند 
که ش��امل لایه ها و اشياي جداگانه مي باشند. منظور این است که هر شئ به یك آیتم مجزا 
در   FreeHand تبدیل مي ش��ود که خط دور، زمينه یا جلوه اعمال ش��ده به ش��ئ را مي توان 

تغيير داد. 
2- فایل ه��اي صادرش��ده Fireworks فایل هاي TIFF ،JPG ،GIFیا PNG هس��تند که در
FreeHand به صورت یك تصویر Bitmap قرار مي گيرند، یعني نمي توانيد اش��ياي مجزا را در 

FreeHand ویرایش کنيد.

1-3-13 فرمت هاي تصاوير در وب

فرمت های تصویری در اصل روش هاي اس��تاندارد برای ذخيره س��ازی داده های تصویري 
هس��تند. فایل هاي گرافيكي Bitmap که فرم��ت JPEG،GIF  و PNG دارند، معمولاً براي وب 
جهان گستر استفاده مي شوند. چون مي توانيد آن ها را بسيار فشرده کنيد تا سریع تر در اینترنت 

انتقال یافته و جا به جا شوند؛ به همين دليل توسط اکثر مرورگرها پشتيباني مي شوند.

 نكته: فرمت GIF و JPEG و PNG پشتيباني مي شوند.
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اس��ت ک��ه ابت��دا آن ه��ا را  ب��راي ایج��اد تصویره��ا در وب، بهتری��ن کار ای��ن 	
بهينه سازي1کنيد.

بهينه س��ازي تصویره��اي وب مس��تلزم انتخ��اب فرمتي اس��ت که بهتری��ن رنگ و  	
فشرده س��ازي را براي تصویر داشته باشد و حداکثر کيفيت آن را تا حد امكان حفظ 

کند.
پس از بهينه سازي تصویر آنچه اهميت دارد پيش نمایش آن ها در مرورگرهاي وب و  	

اطمينان از نمایش دقيق آن هاست.
همان طور که گفته ش��د با اس��تفاده از برنامهMacromedia Fireworks 	 مي توانيد در 

داخل FreeHand تصویرهاي وب را ویرایش کنيد.
2-3-13 بهينه سازي تصويرها

شما مي توانيد تصاویر موجود در FreeHand را با استفاده از برنامه Fireworks بهينه سازي 
کنيد؛ مانند تغيير فرمت فایل که یكي از موارد بهينه سازي است.

به منظور انجام بهينه سازي مراحل زیر را انجام دهيد:
1- در سند FreeHand تصویر  موردنظر خود را انتخاب کنيد.
2- از منوي Edit گزینه Optimize In Fireworks را  برگزینيد.

3- کادر محاوره Find Source نمایان مي ش��ود تا مشخص کنيد که آیا مي خواهيد تصویر 
 Fireworks بهينه س��ازي کنيد یا خير. س��پس از منوي بازشوي PNG را به صورت فایل اوليه
source files گزینه مورد نظر را انتخاب کنيد )در مورد این گزینه ها در بخش 1-3-13 شرح 

داده شد(.
4- هنگامي که فایل در کادر محاوره برنامه Fireworks باز مي ش��ود مي توانيد ویرایش��ات 

بعد را انجام دهيد.

 1- Optimize 
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شكل 5-13 زبانه  Optionsدر کادر محاوره بهينه سازي

ب��راي ویرایش تنظيمات بهينه س��ازي روي زبان��ه Options	 کلي��ك کنيد و تنظيم 
دلخواهي را تغيير دهيد )شكل 13-5(.

ب��راي ویرایش اندازه فای��ل و تنظيم نواحي اطراف  تصویر صادر ش��ده، زبانه File	 را 
انتخاب کنيد سپس تنظيمات موردنظر را اعمال نمایيد.

براي ویرایش تنظيمات متحرك سازي تصویر، زبانه Animation را کليك کنيد.	
5- پس از پایان ویرایش  تصویر دکمه Update را کليك کنيد.

در این صورت تغييرات روي تصویر موجود در FreeHand نيز اعمال مي شود که اصطلاحاً 
به آن Update مي گویند. همچنين اگر فایل اوليه PNG را انتخاب کرده باشيد تصویر به صورت 
 )Link( به آن متصل FreeHand ذخيره مي  شود. اگر تصویر وارد شده در سند PNG فایل اوليه
ش��ده باشد ترجيحاً باید در سند FreeHand نيز چسبانده )Embed( شود تا تغييرات روي آن 

انجام شود. همچنين فایل تصویري خارج از FreeHand نيز Update مي شود.
 Trace4-13تبديل تصاوير نقشه بيتي به برداري توسط ابزار

مي توانيد کارهاي هنري آماده یا اس��كن ش��ده را به سند FreeHand وارد کرده و با به کار 
بردن ابزارTrace  آن ها را به مسير تبدیل کنيد. ابزار Trace مي تواند اشكال مختلف کار هنري 
از قبيل گرافيك هاي ایجاد شده در FreeHand، تصویرهاي Bitmap و متن )Text( را تشخيص 
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داده و آن ها را به مسيرهاي برداري تبدیل کند.
هنگامي که تصاویر را براي استفاده در FreeHand، اسكن )Scan( مي کنيد، بهتر است که 
 )Trace( .اس��تفاده شود )dpi( بين300 تا600 نقطه در اینچ )Resolution( از درجه وضوحي
تصویر اسكن شده با کيفيتdpi  600، نقاط بسيار زیادي ایجاد مي کند. علاوه بر این تصویر 

با کيفيت بالا نسبت به تصویر با کيفيت پایين به حافظه بيشتري نياز دارد.

 توجه: اگر مقدار حافظه کم باشد، تصویر با حداقل Trace( ،Resolution( مي شود.

Trace Tool 1-4-13 تنظيمات ابزار

هنگامي که تصویرهاي Bitmap و اش��ياء ب��رداري )Vector( را Trace مي کنيد؛ تنظيمات 
پيش ف��رض نتيجه مناس��ب را فراهم مي کند ب��دون این که از حافظه سيس��تم بيش از حد 

استفاده کند.

 نكته: قبل از به کارگيري ابزار Trace باید گزینه هاي آن را تنظيم کنيد. 

همچنين در هنگام اجراي Trace روي موضوع هاي گرافيكي، امكان تبدیل رنگ ها وجود 
دارد و مي توانيد تعداد رنگ ها، مد )mode( و محدوده رنگ به کار رفته در اش��ياء را مش��خص 

کنيد.

 توج�ه: ب��ا خارج ش��دن از برنام��ه FreeHand ، تنظيم��ات Trace Tool در بخش 

Preferences فایل FreeHand ذخيره مي شود.

براي تنظيم ابزار Trace به صورت زیر عمل کنيد:
روش اجرا:

1- در جعبه ابزار روي ابزار Trace دابل کليك کنيد.   
2- در کادر محاوره Trace Tool از قسمت Color mode مد رنگ را تعيين کنيد.

تعداد رنگ را که از 2 تا 256	 اس��ت، مش��خص کنيد؛ رنگ هاي اضافي به رنگ هاي 
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نزدیك تر تبدیل مي شوند.
 : 	Colors( را براي تعيين رنگ تصویر نهای��ي انتخاب کنيدGrays  ی��ا Colors گزین��ه

رنگي - Grays: خاکستري(.
 	Trace را ب��راي تعيين مد رنگ تصویر نهای��ي پس از عمل CMYK یا RGB گزین��ه

برگزینيد.

Trace شكل 6-13کادر محاوره تنظيم ابزار

 نكته: براي اضافه کردن رنگ موارد Import ش��ده یا Trace ش��ده به ليست پنل 
 Eyedropper را اج��را کرده یا از ابزار Xtras→Colors→Name All Colors  مس��ير ،Swatches

استفاده کنيد.

3- مقدار درجه وضوحResolution( ( را تعيين کنيد.
انتخاب گزینه High س��بب نمایش جزیيات بيشتر تصویر مي شود. این نوع Trace	 با 

سرعت پایين و مصرف زیاد حافظه اجرا مي شود. 
انتخاب گزینه Low سبب نمایش کمترین جزیيات تصویر مي شود. این نوع Trace	 با 

سرعت بالا و مصرف کم حافظه اجرا مي شود. 
گزینه  Normal حالتي بين دو گزینه High و Low  را ایجاد مي کند.	

4- ی��ك م��ورد از گزینه ه��اي Trace layers را ک��هForeground  )ردیاب��ي لایه ه��اي 
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پيش زمينه(،All )همه لایه هاي س��ند( یا Background )لایه هاي پس زمينه( است؛ برگزینيد. 
در برنامه FreeHand همه مسيرها در لایه هاي مشخص شدهTrace  مي شوند.

5- گزینه Path conversion را براي مش��خص کردن این که چه طور مس��يرها ردیابي یا 
Trace مي شوند، تنظيم کنيد.

، لبه هاي بيروني تصویر را براي ایجاد مس��يرهاي پرش��ده و  	Outline انتخ��اب  گزینه
بسته ردیابي مي کند.

انتخاب  گزینه Centerline، مرکز خط هاي دور تصویر گرافيكي را Trace مي کند.	
، س��بب ترکيب خط دور و مرکزي مي ش��ود. در  	Centerline/Outline انتخاب  گزینه

بخشOpen Paths Below  مقداري بين 2 تا 10 وارد کنيد.
انتخاب  گزینه Outer Edge، فقط خطوط خارجي تصویر را ردیابي مي کند.	

6-  مقدار Trace conformity یا تنظيم حساسيت ابزار Trace، براي مشخص کردن ميزان 
نزدیكي و ش��باهت مسيرهاي Trace ش��ده به مدل اوليه، به کار مي روند. عددها مي توانند از 
صفر )ش��باهت کمتر با نقطه هاي کمتر( تا 10 )شباهت بيش��تر با نقطه هاي  بيشتر( انتخاب 

شوند.
7- ع��دد Noise tolerance  ی��ا دکمه لغزن��ده آن براي حذف پيكس��ل هاي اضافه )نظير 

گردوغبار در اسكن( به کار مي رود. مقدار آن بين 0 تا 20 است.
8- مق��دار Wand color tolerance به ش��ما امكان مي دهد مح��دوده رنگ هایي را تنظيم 
کني��د که ابزار Trace به عنوان رنگ نهایي تش��خيص مي دهد. مح��دوده آن از صفر )رنگ ها 
به محدوده رنگ انتخابي نزدیك تر و ش��بيه تر و محدوده انتخاب کوچك تر( تا  255 )ميزان 

شباهت رنگ ها کمتر و محدوده انتخاب گسترده تر( است.
9- روي دکمه OK کليك کنيد.

تمرين 2: در تصویر برگ شكل 7-13 لبه هاي ناحيه سبز رنگ را Trace کنيد.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
388

شكل 13-7

1- روي ابزار Trace Tool کليك  کنيد.
2- در تنظيمات  Trace Tool مقدار Tolerance را 223 و س��ایر تنظيم ها را طبق ش��كل 

7-13 تعيين کنيد.
3- در سند  روي ناحيه سبز رنگ، کليك کنيد.

4- ب��ا کليك  روي ناحيه انتخاب ش��ده و انتخاب گزین��ه Convert Selection Edge، فقط 
لبه هاي ناحيه انتخاب شده راTrace  کنيد. 

5- تصویر Trace  ش��ده روي ش��كل اصلي ایجاد مي ش��ود )ش��كل 8-13( که با توجه به 
انتخاب رنگ سياه قبل از اعمال Trace، رنگ آن سياه شده است.

Trace شكل 8-13 نتيجه عمل

تمرين 3: لبه هاي شكل 9-13 را Trace کنيد. )توجه داشته باشيد که این فایل 
در پوشه Samples برنامه فتوشاپ قرار دارد.(
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شكل 13-9

)Bitmap( 5-13 تبديل تصوير برداري به طرح بيتي
براي تبدیل سریع تصویرهاي برداري به تصویر Bitmap  فرمانConvert to Image  به کار 
 TIFF مي شوند و شئ تبدیل شده به صورت یك فایل Rasterize ًمي رود و تصویرها اصطلاحا

در درون سند FreeHand  قرار مي گيرد.

 توجه: تصویر Bitmap ایجاد ش��ده جایگزین تصویر اوليه و اصلي که برداري است، 

مي ش��ود. اگر مي خواهيد تصویر اصلي را نگه دارید، ابتدا یك کپي از آن ایجاد کرده و عمل 
تبدیل را روي کپي آن انجام دهيد.

اگر حجم فایل تصویري زیاد باش��د یا تصویر پيچيده باش��د، پيامي مبني بر ایجاد خطا 
 Export ،Bitmap در تبدیل ظاهر مي ش��ود. بهتر اس��ت که این تصویرهاي پيچيده به فرمت

شوند.
 Bitmap 1-5-13 مراحل تبديل تصوير برداري به

1- اشياء یا تصاویر برداري موردنظر را انتخاب کنيد.
 Convert to Image را اجرا کنيد تا کادر محاوره Modify→Convert to Image 2- فرم��ان

آشكار شود.
3- در کادر مح��اوره Convert to Image مق��دار  Resolution)کيفيت یا وضوح تصویر( را 

تنظيم کنيد
dpi 72	 براي کارهاي هنري تحت وب به کار مي رود.

 144dpi	 به عنوان پيش نویس چاپ به کار مي رود.

300dpi براي کار نهایي شده و آماده چاپ به کار مي رود.	
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Resolution شكل 10-13 منو بازشوي

4- براي نرمي خط ها و هموار ش��دن لبه هاي دور تصویر، گزینه Anti-aliasing را تنظيم 
کنيد. عدد بالاتر سبب نرمي بيشتر مي شود.

5- روي دکمه OK کليك کنيد. 

 نكت�ه: مي تواني��د همزمان بيش از یك تصویر ب��رداري را انتخاب کرده و ب��ه Bitmap تبدیل 
کنيد.

 300 dpi مثال 1: یك تصویرِ برداري دلخواه مانند شكل 11-13 را با درجه وضوح
و انتخاب عدد 4 براي گزینه Anti-aliasing به تصویر Bitmap تبدیل کنيد.

1- شكل 10-13 را انتخاب  کنيد.

شكل 11-13 تصویر برداري

2- مسير Modify→Convert to Image را اجرا  کنيد.
 300dpi کيفيت تصویر( را( Resolution مق��دار Convert to Image 3- در  کادر مح��اوره

انتخاب کنيد.
4- عدد 4 را براي Anti-aliasing تنظيم کنيد. 

همان طور که با مقایس��ه نوار Info در  ش��كل هاي 11-13و 12-13 مش��اهده مي کنيد، 
ش��ئ تبدیل ش��ده به صورت یك فایل TIFF درون س��ند FreeHand  قرار مي گيرد )ش��كل 

.)13-12
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شكل 12-13تصویر TIFFکهEmbedded  شده

تمري�ن 4: تصوی��ر برداري زیر )قس��متي از یك فایل در پوش��ه Sample برنامه 
FreeHand است( را به پيكسلي یا Bitmap تبدیل کنيد.

شكل 13-13



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
392

واژه نامه 
Anti-aliasingضدناهمواري، روشي براي هموار نمودن خطوط ناهموار یا دندانه دار

Conversionتغيير، تبدیل

Draftپيش نویس، چرك نویس

Embeddedدر درون قرارگرفتن، چسباندن

Lossyپراتلاف

Losslessبدون اتلاف

Noiseاختلال،خش

Optionاختيار

Sourceمنبع، اصلي، اوليه

Outlineخط دور

Rasterizeتبدیل

Traceرسم کردن، کشيدن

Vectorبرداري

خلاصه مطالب
( و پيكس��لي  	Vector( مي توانيد فایل هایي با فرمت هاي برداري ،FreeHand در برنامه

)Bitmap( را به سند وارد )Import( کنيد.
مي توانيد تصاویر وارد شده در FreeHand را با استفاده از Fireworks ویرایش کنيد.	

 	FreeHand مي توانيد تصاویر موجود در Optimize In Fireworks با استفاده از فرمان
را با استفاده از برنامه Fireworks بهينه  سازي کنيد.

اب��زارTrace  مي تواند گرافيك هاي ایجاد ش��ده در FreeHand، تصویرهاي Bitmap	 و 
متن )Text( را تشخيص داده و آن ها را به مسيرهاي برداري تبدیل کند.

 	 Convert to Imageفرم��ان Bitmap براي تبدیل س��ریع تصویرهاي ب��رداري به تصویر
به کارمي رود.
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعیین کنید.

1- فایل هايMacromedia Fireworks PNG ، در FreeHand ویرایش مي شود.
2- فایل هاي گرافيكي برداري CorelDRAW همانند مسيرها غيرقابل ویرایش هستند.

3- فایل ه��اي JPEG ،TIFF ،TGA ی��ا BMP با همان قالب و فرمت اصلي ش��ان در س��ند 
Import ،FreeHand مي شوند.

4- فایلSWF در FreeHand قابل ویرایش است.
معادل گزينه  هاي سمت راست را از ستون سمت چپ انتخاب کرده و مقابل هر عبارت بنويسید.

5- براي وارد کردن تصاویر طرح بيتي به سند FreeHand از این فرمان استفاده مي شود
GIF                                                                                                        .
Lossy                                    .به کار مي رود Bitmap 6- این نرم افزار براي ویرایش تصاویر
Import                 .7- روش فشرده سازي فایل ها که داده هاي اوليه بازیابي نمي شوند
Fireworks                             .8- عمق رنگ در این نوع فایل حداکثر 8 بيت است

گزينه صحیح را انتخاب کنید.

9- براي صادر کردن تصاویر در وب کدام فرمت شفافيت را حفظ نمي کند؟
Tiff -د                 Jpeg -ج              Gif -ب          PNG -الف

10- کدام یك از موارد زیر به طور اتوماتيك فایل اوليه PNG را باز مي کند؟
Never Use Source PNG -ب                Always Use Source PNG -الف

Use This File -د                            Ask When Launching -ج
11- فرمان Optimize in Fireworks چه عملي انجام مي دهد؟

الف- حذف فایل هاي غيرضروري             ب- افزودن طراحي به تصویر
FreeHand فایل تصویر به Link -د ج- تغيير اندازه و تغيير فرمت فایل 

12- با استفاده از ابزار ................... مي توان تصاویر Bitmap را برداري کرد.
Trace -د           Optimize -ج           Lasso -ب            Pointer -الف

13- دکم��ه لغزنده Trace conformity در کادر مح��اوره Trace Tool به چه منظور به کار 
مي رود؟
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الف- سبب ترکيب خط دور و مرکزي مي شود.
ب- ميزان شباهت مسيرهاي Trace شده به مدل اوليه را تعيين مي کند.

ج- براي حذف پيكسل هاي اضافه تصاویر به کار مي رود.
د- براي تنظيم محدوده رنگ ها استفاده مي شود. 

در جاي خالي عبارت مناسب را بنويسید.

14- فرم��ان .................... ب��راي تبدی��ل تصویر ب��رداري به طرح بيت��ي )Bitmap( به کار 
مي رود.

15- گزینه Anti-aliasing براي تنظيم ......................... استفاده مي شود. 
16- ب��راي ک��م کردن ناحيه انتخاب با اب��زار Trace همزمان با کليك کلي��د ....... را نگه 

دارید.
17- در هنگام بهينه سازي پس از پایان ویرایش تصویر دکمه ................ را کليك کنيد. 

به سؤالات زير پاسخ تشريحی دهید.

18- کدام یك از انواع درجه وضوح سبب ردیابي با سرعت بالا مي شود؟
19- اگر ميزان حافظه کم باشد تصویر چگونه Trace مي شود؟

20- مزیت فرمت GIF را با فرمت JPEG مقایسه کنيد؟
آزمون عملي

1- فای��ل تصویري از ن��وع طرح بيتي وارد FreeHand کنيد س��پس عمليات زیر را انجام 
دهيد:

اندازه تصویر را دو برابر کنيد. 	
با استفاده از پنل Object	 عرض تصویر را به ميزان دلخواه کاهش دهيد.

تصویر را 90	 درجه بچرخانيد.
انعكاس عمودي تصویر را در کنار آن قرار دهيد. 	

 Photoshop رنگي دلخ��واه را در برنام��هBitmap  ی��ك فایل تصوی��ري )mode( 2- م��د
خاکستري کرده سپس از طریق Copy-Paste آن را وارد FreeHand کنيد. سپس توسط پنل 

Mixer آن را به رنگ سبز تغيير دهيد.

3- طرح زیر را رسم کرده سپس با برنامه Fireworks آن را به نحوي ویرایش کنيد که در 
هنگام باز شدن پيغامي را نمایش دهد. ویرایش مربوط به تغيير اندازه فایل باشد.
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4- قس��متي از تصویر مورد نظر از پوش��ه My Pictures سيس��تم خود را با ابزار مناسب و 
تنظيمات زیر ردیابي کنيد.

جزیيات تصویر بيشتر دیده شود. 	
حساسيت ابزار ردیابي را 7	 در نظر بگيرید.

محدوده رنگ تنظيم شده به نحوي باشد که رنگ هاي انتخابي نزدیك تر قرار گيرد. 	
5- ی��ك تصویر ب��رداري را ب��ه FreeHand وارد کنيد س��پس آن را ب��ه Bitmap تبدیل 

نمایيد.
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كليات
یكي  از  جالب ترین  امكاناتي که در FreeHand وجود دارد، ایجاد پویانمایي  و حرکت  اس��ت 
 که  مي تواند در صفحه هاي وب و فيلم هاي تعاملي )Interactive( اس��تفاده شود. در این واحد 

کار این امكانات بررسي مي شود.
FreeHand 1-14 مفاهيم اوليه حركت در

حرکت )Action(: جلوه حرکتي است که به یك موضوع داده مي شود.
پارامتر )Parameters(: محل و موقعيت بعدي و مقصد نهایي حرکت را مشخص مي کند. 

به عبارتي دیگر ارزش هاي موردنظر Action در این قسمت تعيين مي شود.
روي�داد )Event(: رخدادهایي اس��ت که با اعمال آن ها ب��ه موضوعات، حرکت موردنظر 
نمایش داده مي ش��ود و کاربر آن را  اجرا مي کن��د، مانند Press که رویداد کليك کردن روي 

یك موضوع است یا رویداد Over که با حرکت ماوس روي شئ رخ مي دهد.
ش�ئ مبدأ )Source Object(: موضوعي که عمل کشيدن ماوس )Drag( روي آن انجام 

مي شود.
صفحه مقصد )Target Page(: صفحه اي که محل پایان یافتن Action را مشخص مي کند 

و عمل رها کردن ماوس )Drop( در آن انجام مي شود.
صفحه جاري )Current Page(: صفحه اي که نشانگر ماوس در آن قرار دارد.

اراي�ه )Presentation(: نمایش  Actionدر پنجره Flash Player 1 ک��ه دکمه هاي کنترل نمایش 
تعامل��ي )Interactive( در آن ق��رار دارد و همچنين فرمت ارایهSWF  اس��ت که به آن ارایه نيز 

گفته مي شود.
فیلم تعاملي )Interactive Movie(: فيلمي که در هنگام نمایش به ازاي اجراي اعمالي 
که براي آن در نظر گرفته ش��ده یعني کنش، واکنش تعریف ش��ده توس��ط کاربر را نش��ان 

مي دهد. این فيلم ها در صفحه هاي وب نيز قابل استفاده است.
مح�دوده حرکت )Action Area(: فهرس��ت زیرمجموعه م��وارد پویانمایي را به صورت 

Action script یعني زبان برنامه نویسي برنامه Flash 2 در دسترس قرار مي دهد.

فري�م يا قاب )Frame(: به هریك از تصاویري که نمایش متوالي و س��ریع آن ها باعث 

Flash 1- نمایشگر فيلم
2- نرم افزاري براي ساخت انيميشن دو بعدي
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ایجاد فيلم یا انيميشن مي شود، Frame مي گویند که در واقع هر قاب، بيانگر یكي از لحظات 
اجراي فيلم است.

  Action Tool 2-14 ابزار
 )drag &drop( جلوه هاي حرکتي را با انجام عمل کش��يدن و رها کردن Action Tool ابزار
به موضوع ه��ا )objects(، نمادها )Symbols( و صفحه ها )Pages( اعمال مي کند وAction هاي 
Flash را براي موارد گفته شده در سند FreeHand در نظر مي گيرد و به آن ها نسبت مي دهد؛ 

به عنوان مثال مي توانيد در س��ندي دو صفحه اي که در صفحه اول آن یك موضوع گرافيكي 
ق��رار دارد، ی��ك Action را در نظر بگيرید که با کليك روي موضوع، صفحه دوم را ظاهر کند 

و نشان دهد.
Action 1-2-14 ايجاد

براي انتساب یك Action به شئ ]موضوع[ به ترتيب مراحل زیر را اجرا کنيد:
1- روي ابزار  Action در جعبه ابزار کليك کنيد.

2- از ش��ئ موردنظر به سمت صفحه مقصد درگ کنيد بدین ترتيب خطي از شئ مزبور 
تا صفحه مقصد امتداد مي یابد )شكل 14-1(.

شكل 1-14 درگ شئ مبدأ به مقصد

3- زماني که کليد ماوس را رها کنيد، صفحه جاري که برجس��ته شده، به عنوان صفحه 
 مقصد در نظر گرفته مي ش��ود و یك خط  انحنادار نشان  مي دهد که Action ایجاد شده  است

)شكل 14-2(. 
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Action Tool ایجاد شده با ابزار Action 14-2 شكل

زماني که براي یك ش��ئ Action تعریف مي کنيد در گوش��ه پایين س��مت راس��ت آن علامتي به نام

Action Proton ظاهر مي شود )شكل 14-3(. 

  شكل 14-3
Action پيش ف��رض FreeHand ک��ه با ابزار Action Tool	 ایج��اد و به موضوع هاي به وجود 
آورنده حرکت، اختصاص داده مي ش��ود، Go To and Stop اس��ت که در ش��كل 4-14در پنل 
Navigation مش��خص ش��ده اس��ت و با فش��ردن کليد ماوس محتویات صفحه 2 را که در لایه 

Foreground قرار دارد، نشان مي دهد. 

Navigation با استفاده از پنل Flash هايAction شكل 4-14 دسترسي به
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 توجه: ساده ترین روش ایجاد Action، استفاده از ابزار Action Tool   است.

 Action 2-2-14 حذف

اگر در صفحه اي که ش��ئ مبدأ در آن قرار دارد، Action Proton  را با اس��تفاده از ابزار 
انتخ��اب Subselect یا Pointer درگ ک��رده و آن  را در فضاي خالي )فضاي چرك نویس( رها 

کنيد در این صورت Action تخصيص یافته به شئ، حذف مي شود.
 Action 3-2-14 تغيير رفتار

1- براي تغيير رفتار پيش فرض ابزار Action در جعبه ابزار به صورت زیر عمل کنيد:
 Action Tool دابل کليك کنيد ت��ا کادر محاوره Action روي ابزار Tools در جعب��ه اب��زار

ظاهر شود )شكل 14-5(.
2- با توجه به تغييري که مي خواهيد در رفتار Action ایجاد ش��ود یكي از گزینه هاي آن 

را برگزینيد.
4- روي دکمه OK کليك کنيد.

در شكل 6-14 یك   Action   براي یك موضوع متني )شماره صفحه موردنظر( انتخاب شده است به 
 طوري که با کليك روي شماره صفحه که در پایين صفحه خانگي )Home Page-Index( ارایه به صورت 

متني درج شده، صفحه مربوط به آن با محتویاتش نشان داده مي شود.

Action شكل 5-14 تعيين رفتار
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شكل Action 14-6تعریف شده براي موضوع متني

تمرين 1: سه صفحه با این مشخصات ایجاد کنيد:
 Blue 1- در صفحه اول شئ مربع با رنگ آبي در لایه اي به نام
 Red 2- در صفحه دوم شئ دایره با رنگ قرمز در لایه اي به نام

 Black 3- در صفحه سوم شئ ستاره با رنگ سياه در لایه اي به نام
س��پس با اس��تفاده از Action Tool ترتيبي دهيد که به محض کليك روي شئ اول، شئ 

سوم مشاهده شود و با کليك روي شئ سوم، شئ دوم نمایش یابد.
FreeHand به سند Flash Action 3-14 انتساب يک

در برنامه FreeHand مي توانيد، Actionهاي Flash را به طرح ها و ترسيم هاي ایجاد شده، 
نسبت دهيد و در فيلم هاي تعاملي از آن ها بهره بگيرید.

همچني��ن مي توانيد س��ندهاي FreeHand را که محتواي آن هاAction هاي Flash اس��ت 
به ص��ورت فایل SWF براي نمای��ش در Flash Player صادر کنيد. در فيلم تعاملي از مجموعه 
صفح��ه کليد، ماوس یا هر دوي آن ها براي حرکت اش��ياء و پرش به موقعيت ها و بخش هاي 
یك فيلم و اجراي تعداد بي ش��ماري از فعاليت هاي تعاملي1 اس��تفاده مي شود. براي انتساب 
یك Flash Action به اش��ياي ترسيمي در FreeHand، محدوده حرکت )Action Area( و پنل 

Navigation به  کار گرفته مي شود.

1-  Interactive Actions 
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 FreeHand در Flash هاي Action 14-4
نتيجه کاربردAction هاي Flash در برنامه FreeHand به شرح زیر است:

Actionتوضیحات

Go To and Stop
به یك فریم )صفحه اي در فيلم( پرش  مي کند سپس پخش را متوقف مي نماید به عبارتي 
توقف و تكرار صحنه )Play Back( انجام مي شود. بازیابي فهرست URL هاي کادر Link را 

که در پنل Navigation است فراهم مي کند.

Go To and Play.پرش مي کند، سپس پخش فيلم را از همان نقطه ادامه مي دهد )Frame( به یك فریم

Get URL.به کار مي رود Navigation مربوط به پنل Link ليست شده در کادر URL براي رفتن به

Play.سبب اجرا یا نمایش فيلم متوقف شده مي شود

Stop.سبب توقف فيلم در حال اجرا مي شود

Print فریمي از فيلم مشخص شده را چاپ Flash Player کاربر مي تواند به صورت مستقيم در
کند.

Full Screen نمایش فيلم در حالت تمام صفحه و بزرگ تر از حالت معمولي انجام مي شود. در حالت تمام
صفحه، فيلم کل صفحه نمایش را مي پوشاند.

Start/Stop Drag

امكان پذیر مي کند و  این عمل در زمان وقوع یك رویداد، درگ کليپ فيلم را در صفحه 
به  مي شود.  درگ  قابليت  رفتار  توقف  سبب  مي دهد،  رخ  متضاد  رویداد  یك  که  هنگامي 
به عنوان  را   On )press( اگر  مثال  به عنوان  متوقف مي کند.  را  عبارت دیگر عمل درگ 
رویداد شروع این Action در نظر بگيرید، به صورت خودکار )On )release را به عنوان عامل 
توقف درگ انتخاب مي کند. همچنين رویداد )over( On و )On )out رویدادهاي متضاد 

دیگر هستند.

  Load Movie

Unload Movie

فيلم Flash را از یك صفحه به فریم فيلم جاري بارگذاري مي کند.

یك فيلم بارگذاري شده در فریم فيلم جاري را حذف مي کند.

Tell Target
براي کنترل فيلم هایي است که با استفاده از عمل Load Movie در فيلم جاري بارگذاري 
شده اند. پارامترهاي این Action به شما امكان مي دهند تا صفحه بارگذاري شده را تنظيم 

کنيد.
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 نكته: Action هاي Unload Movie ، Load Movie و  Tell Target در صورتي فعال 
هستند که سند حداقل دو صفحه داشته باشد.

بر  و   Tell Targetعلاوه   Load/Unload Movie    ،Print  ،Go To     هاي  Action   توجه:    در   

Parameters در  بازشو  را توسط منوي  اعمال  Action ها  رویداد مي تو انيد، چگونگي  تعيين 
پنل Navigation مشخص کنيد.

 مثال 1: در صفحه اول ش��كل 1 و در صفحه دوم ش��كل 2 را رسم کنيد؛ ترتيبي 
دهيد که با کليك  روي go ، رنگ س��بز چراغ راهنما به نشانه روشن شدن پررنگ شود و در 
 Stop چراغ راهنما در صفحه جابه جا ش��ده و به محض این که روي Stop صفحه دوم با درگ

کليك کردید، دیگر جابه جایي انجام نشود.
1- ابتدا یك س��ند دوصفحه اي مطابق ش��كل 7-14 ایجاد کنيد، س��پس شكل 1 را در 
صفحه اول و ش��كل 2 را در صفحه دوم رس��م کنيد. دقت نمایيد که رنگ قرمز در ش��كل 1 
پررنگ و در شكل 2 کم رنگ است، رنگ زرد در هر دو شكل یكي و رنگ سبز در شكل دوم 
پر رنگ تر است. کلمه go )رنگ سبز( را در صفحه اول و کلمه Stop )رنگ قرمز( را در صفحه 

دوم بنویسيد.
 2- نوش��ته go از صفح��ه اول را انتخ��اب کرده و پن��ل Navigation را فعال کنيد. گزینه

Go To and Stop را از منوي بازشو Action برگزینيد.

3- در ليس��ت بازش��وي Page2 ،Parameters را انتخاب و رویداد )Event( را Press در نظر 
بگيرید.

4- در صفح��ه دوم کلم��ه Stop را انتخاب ک��رده و Start/Stop Drag را با در نظر گرفتن 
رویداد Press انتخاب کنيد.

5- براي مشاهده Action ایجاد شده مسير Window→Movie→Test را اجرا کنيد.
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شكل 7-14 چراغ راهنمایي

5-14 آزمايش فيلم
بعد از ایجاد یك انيميشن مي خواهيد نحوه اجراي آن را مشاهده کنيد، براي این منظور 

یكي از روش هاي زیر را برگزینيد:
1- فرمان Window→Movie→Test را اجرا نمایيد.

2- کليد ترکيبي Ctrl+Enter را بفشارید.
3- روي دکمه Test  در نوار ابزار Controller کليك کنيد.

بدی��ن ترتي��ب FreeHand فيلم را در یك پنجره جداگانه )پنج��ره Flash Player( نمایش 
 Movie Settings دارد، در کادر SWF را که فرمت Flash مي دهد. همچنين مي توانيد فایل فيلم

ویرایش کنيد.
 Controller 1-5-14 نمايش

براي نمایش نوار ابزار Controller مسيرWindow→Toolbars→Controller را اجرا کنيد.
علاوه بر موارد گفته شده سایر امكانات Controller در شكل 8-14 مشخص شده است.

Controllerشكل 8-14 نوارابزار
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6-14 متحرک سازي با متن و شئ
یكي از روش هاي متحرك سازي این است که اشياء را طوري در لایه هاي آن ها قرار دهيد که 
هر لایه مانند یك فریم عمل کند. براي متحرك کردن )انيميش��ن( اش��ياء بدون استفاده از بازه 
  Xtras→Animate→Release to Layers از فرم��ان Flash Player زماني و نمایش متحرك س��ازي در
اس��تفاده کنيد. در این صورت اش��ياء در لایه ها قرار داده مي شوند و لایه ها به عنوان فریم در 
پویانمایي ایجاد ش��ده، عمل مي کنند. همچنين با اجراي این دس��تور موضوع هاي گرافيكي 
گروه بندي ش��ده از گروه خارج ش��ده و بر اس��اس جلوه هاي منوي بازش��و Animate در کادر 
محاوره Release to Layers ، در لایه ها پخش مي ش��وند به طوري که یك لایه جدید براي هر 

شئ ایجاد مي شود.

 توجه: براي ایجاد سریع یك پویانمایي از فرمان Release to Layers استفاده  کنيد.

1-6-14 ايجاد متحرک سازي با استفاده از لايه ها

1- موضوعاتي را که مي خواهيد متحرك شوند، انتخاب کنيد.

 توجه:  یك شئ جاي گرفته در یك گروه مانند یك شئ مستقل و تنها عمل   مي کند.

 2- ب��ا اج��راي مس��ير  Window→Layer پن��ل لای��ه را در صفح��ه، نمای��ش دهي��د 
)شكل 14-9(.

شكل 9-14 انتخاب شئ گروه بندي شده

3- فرمان Release to Layers را از مسير Xtras→Animate برگزینيد. در این صورت کادر 
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محاورهRelease to Layers مطابق شكل 10-14 ظاهر مي شود.

شكل 14-10

 Animate 4- براي متحرك کردن ش��ئ، یكي از جلوه هاي پویانمایي را از منوي بازشوي
انتخاب کنيد. در این صورت مش��خص مي کنيد که اش��ياء چطور به لایه ها منتشر و در آن ها 

پخش شوند )شكل 14-11(.

 

شكل 11-14 انتخاب جلوه پویانمایي 

گزینه هاي منوي بازشو Animate عبارتند از:
Sequence )جلوه اس�تاندارد متحرک س�ازي(:	 اشياء را پشت س��رهم و متوالي در 

لایه هاي مجزا پخش مي کند. 
با کپي کردن اشياي موجود در توالي لایه هاي دنبال هم،  Build )جلوه افزايش�ي(: 	

یك جلوه پشته اي ایجاد مي کند.
به عنوان مثال اگر یك گروه متشكل از دو شئ دارید، با اعمال جلوه Build اولين شئ در 

لایه اول قرار مي گيرد و کپي  هاي اشياي اول و دوم در لایه دوم قرار مي گيرند.
Drop )جلوه کاهش�ي(:	 اشياء را به تمام لایه ها کپي مي کند ولي به طور متوالي یك 

شئ را از هر لایه حذف مي نماید. 
به عنوان مثال اگر یك گروه از س��ه ش��ئ را انتخاب کنيد؛ اشياي اول، دوم و سوم در لایه 
اول قرار گرفته و ش��ئ اول و یك کپي از ش��ئ سوم در لایه دوم و کپي  هاي اشياي دوم و 

سوم در لایه سوم قرار مي  گيرند.
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Trail )جل�وه حرکت�ي(:	 اش��ياء را  در تعدادي از لایه هاي تعيين ش��ده کپي نموده 

و پخش مي کند. اش��ياء به طور فزاینده اي به تعداد لایه هاي مش��خص ش��ده، کپي 
مي شوند.

5- اگر گزینه Trail را انتخاب نمایيد در این صورت با استفاده از کادر Trail by مي توانيد 
تعداد لایه هایي را که اشياء در آن ها کپي مي شوند، تعيين کنيد. 

به عنوان مثال براي کپي هر شئ در چهار لایه، عدد 4 را براي Trail by وارد کنيد.
6- با انتخاب گزینه Reverse direction ترتيب اش��ياء، معكوس ش��ده و آن بخش از فيلم 

در جهت مخالف، متحرك مي شود.
7- انتخاب گزینه Use existing layers اش��ياء را در لایه هاي موجود پخش مي کند و این 
کار را از لایه جاري ش��روع مي نماید. اگر این گزینه را انتخاب نكنيد؛ اش��ياء را در لایه هاي 

جدید قرار مي دهد.
                         

 

Release to Layers پس از اعمال فرمان Layers شكل 12-14مشاهده انتشار اشياء در پنل

8- اگ��ر گزین��ه Use existing layers را انتخ��اب کرده اید، گزینهSend to back  اش��ياء را 
برعكس ترتيب پشته اي پخش مي کند.

9- روي دکمه OK کليك کنيد.
10- پویانمای��ي ایجادش��ده را مي توانيد بااس��تفاده از نواراب��زارController نمایش دهيد 

)شكل14-13(.

 نكته: بلوك هاي متن، Blend، اش��ياء گروه بندي شده و متن متصل به یك مسير 
با فرمان Release to Layers متحرك مي شوند.
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Flash Playerشكل 13-14نمایش پویانمایي در

مثال 2: به نوش��ته شكل 14-14 با اس��تفاده از فرمان Release to Layers، جلوه 
 

پویانمایي Drop را اعمال کنيد.
1- با فرمان Text→Convert to Path هر حرف بلوك متني را به مسير تبدیل کرده، سپس 

دستور Join از منو Modify را اجرا کنيد )شكل 14-15(.

          
                               شكل 14-14  شكل 14-15

2- گزینه Clone را از منوي Edit برگزینيد تا یك نمونه از متن تبدیل شده، ایجاد  شود.
3- با انتخاب ابزار Pointer از کپي متن تبدیل شده تا محلي که مي خواهيد متحرك سازي 

پایان یابد، درگ کنيد )شكل 14-16(.
4- با استفاده از کليد Shift متن اصلي و نمونه کپي ایجاد شده را انتخاب کرده و فرمان 

Xtras→Create→Blend  را روي آن اجرا کنيد )شكل 14-17(. 

      

                     شكل 16-14                  شكل 14-17

5- با اس��تفاده از فرم��ان Release to Layers، جلوه Drop را به متن اعمال کنيد. در پنل 
 Welcome To FreeHand MX 41 لای��ه ایجاد مي ش��ود که هر کدام حاوي عب��ارت ،Layers
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هستند )شكل 14-18(. 

شكل 14-18

Flash  به يک انيميشن Blend 2-6-14 تبديل
همان طورک��ه گفته ش��د اج��راي فرم��ان Release to Layers روي ی��ك Blend و تنظيم 

گزینه هاي کادرRelease to Layers، یك انيميشن Flash ایجاد مي کند.
روش اجرا:

Blend -1  مورد نظر را انتخاب کنيد )شكل 14-19(.

2- با اجراي مسير Window→Layer پنل لایه را در صفحه، نمایش دهيد.
3- مسير Xtras→Animate→Release to Layers را اجرا کنيد.

برگزیني��د  را   Build گزین��ه   Animate بازش��و  من��وي  از  ش��ده  ظاه��ر  کادر  در   -4 
)شكل 14-19(.

5- گزینه Use existing layers را انتخاب کنيد.
6- در پنجره Flash Player انيميشن ایجاد شده را نمایش دهيد )شكل 14-20(.     

 

 Blend شكل 20-14 نمایش متحرك سازي                    Release to Layers شكل 19- 14 اجراي فرمان

Flash در نمایشگر                                                                Blend روي یك     
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 مثال3: با ایجاد یك متحرك سازي به وسيله Blend ، ترتيبي دهيد که شكل مربع 
به دایره و سپس ستاره تبدیل شود.

1- ابتدا ش��كل س��مت راست 21-14 را رس��م و یك Blend از مربع به دایره طبق شكل 
سمت چپ   23-14 ایجاد کنيد. 

2- حال طبق شكل 22-14 یك Blend از دایره به ستاره ایجاد کنيد.
3- پ��س از انتخ��اب Blend موردنظر و در واقع انتخاب کل اش��ياء رس��م ش��ده، مس��ير

Xtras→Animate→Release to Layers را اجرا کنيد.

4- در کادر محاوره ظاهر ش��ده از منوي بازش��و Animate گزینه Sequence را برگزینيد 
)شكل 14-23(.

             

شكل 21-14                                                             شكل 14-22

5- گزینه Use existing layers را انتخاب کنيد.
6- در پنجره Flash Player انيميشن ایجاد شده را نمایش دهيد.

 

شكل 14-23

تمرين 2: با استفاده از Blend، متحرك سازي ایجاد کنيد که کلمه Photoshop را 
به FreeHand تبدیل کند و جلوه حرکتي )Trail( با عدد 5 را براي آن در نظر بگيرید.

)راهنمايي: پس از نوشتن کلمه ها، قبل از ایجاد Blend آن ها را به مسير تبدیل کنيد.(
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 Navigation 3-6-14 كار با پنل

همان طورکه قبلًا شرح داده شد با استفاده از ابزار    Action مي توانيد اعمال )Action( را به 
اشياي FreeHand نسبت دهيد. حال در این جا مي خواهيم از پنل Navigation استفاده کرده 

و Actionهاي Flash را به اشياء سند FreeHand ارتباط دهيم.
براي نس��بت دادن اعمال )Action( با اس��تفاده از پنل Navigation ، مراحل بعد را انجام 

دهيد:
روش اجرا:

1- شئ یا موضوعات موردنظر را انتخاب نمایيد. 
2- براي ظاهر کردن پنل Navigation از مس��ير Window→Navigation استفاده کنيد تا 

این پنل مطابق شكل 24-14 باز شود.
3- از منوي بازشوي Action براي انتخاب یك عمل )Action( استفاده کنيد.

 Event را فعال مي کند، از منوي بازش��وي )Action( 4- ب��راي انتخاب رویدادي که عمل
استفاده نمایيد )شكل 14-24( 

 Navigation شكل 24-14 پنل

 Load /Unload،Print ،Go To and Play ،Go To and Stop 5- در ص��ورت انتخاب گزین��ه
Movie یا Tell Target در منوي بازش��وي Action، از اولين منوي بازش��وي Parameters براي 

انتخاب از ليست صفحات سند جاري، استفاده کنيد. 
6- در صورت انتخاب گزینه Go To and Play ، Go To and Stop یا Print براي تعيين این 
 Parameters که کدام بخش از سند باید نمایش داده شود یا چاپ شود، دومين منوي بازشوي

را به کاربرید.



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
412

7- در ص��ورت انتخاب Tell Target براي کنترل پخ��ش فيلم دیگر، یكي از Action  هاي 
Stop،Go To and Stop/Play ،Play  یا Print را از دومين منوي بازش��وي  Parameters انتخاب 

کنيد.
8- اگ��ر از دومين منوي بازش��وي  Parameters گزین��ه Go To and Stop/Play یا Print را 
انتخاب کردید، براي تعيين این که کدام بخش از س��ند باید نمایش داده شود یا چاپ شود، 

از سومين منوي بازشوي Parameters استفاده کنيد.

 مثال 4: در صورتي که س��ندي از قبل ایجاد کردید مس��ير File→Open را اجرا 
کنيد تا س��ند موردنظر باز شود، سپس مس��ير View→Fit All را اجرا کنيد تا محتواي فایل 

موردنظر که به عنوان مثال در شكل 25-14چهار صفحه اي است، مشاهده شود.

  

شكل 25-14 فایل چهار صفحه اي      

1- در ای��ن مث��ال از صفحه اول در لایه Screen  طبق ش��كل 26-14 ش��ئ مورد نظر را 
برگزینيد. 
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شكل 26-14 انتخاب شئ لایه  Screenدر صفحه اول

2- پنل Navigation را از مسير Window→Navigation باز کنيد.
 Parameters و از اولين منوي بازشوي  Go To and Stop گزینه Action 3- از منوي بازشوي

صفحه دوم را انتخاب کنيد، در منوي بازشوي دوم Parameters ، لایه PDA ظاهر مي شود.
4- پيش فرض منوي بازشوي Event، رویداد Press است )شكل 14-27(. 

 Navigation ایجاد شده در پنل Actionشكل 27-14 نمایش

به این ترتيب یك Action  ایجاد کرده اید که در پنجره Flash Player  با کليك ماوس روي 
شئ Screen  در صفحه اول، صفحه دوم ظاهر مي شود )شكل 14-28(.

5- حال از منوي بازش��و Event گزینه Over  را برگزینيد )ش��كل 29-14(. به این ترتيب 
یك Action  ایجاد کرد ه اید که در پنجره Flash Player، با قراردادن اش��اره گر ماوس روي شئ 

Screen  در صفحه اول، صفحه دوم آشكار شود.

شكل Action 14-28 ایجاد شده از صفحه اول به صفحه دوم   
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Over شكل 29-14 انتخاب رویداد

 6- با ابزار Pointer در صفحه دوم، شئ لایه Screen  را انتخاب کنيد. از منوي Action گزینه
Go To and Stop را برگزینيد. به این ترتيب علامت Action Proton در گوش��ه س��مت راست 

پایين شئ  Screen مشاهده مي شود.
7- در اولي��ن منوي بازش��و Page3 ،Parameters را انتخاب کنيد. خط آبي رنگ تا ش��ئ 

صفحه سوم ادامه مي یابد )شكل 14-30(.

شكل Action 14-30 ایجاد شده از صفحه دوم به صفحه سوم

8- از منوي بازش��و Event، گزینه Over  را انتخاب کنيد. به این ترتيب یك Action  ایجاد 
کرده اید که در پنجره Flash Player با کليك ماوس روي شئ Screen  از صفحه دوم به صفحه 

سوم مي روید.
 FreeHand امكان تست فيلم در داخل برنامه Window→Movie→Test 9- با اجراي مسير
فراهم مي آید و فایل فيلم Flash با فرمت SWF در پنجره Flash Player مش��اهده مي شود که 

محتویات صفحه اول را نشان مي دهد )شكل 14-31(.
1- با قراردادن ماوس روي شئ صفحه اول، صفحه دوم نمایان مي شود )شكل 14-31(.

11- در صفحه دوم اگر براي اش��ياي آن Action تعریف شده باشد، شكل اشاره گر ماوس 



Free Hand پیمانه مهارتی : کاربر
واحد کار چهاردهم: توانایی متحرك سازی و استفاده از سند FreeHand در صفحات وب 

415

به صورت دس��ت تبدیل  شده و ش��ئ مربوطه تيره تر از سایر اشياء مي شود که با کليك روي 
آن، صفحه سوم در پنجره Flash Player مشاهده مي شود )شكل 14-32(.

            

 Flash شكل 32-14 نمایش و تست فيلم                    Flash شكل 31-14 نمایش و تست فيلم                 

Movie Settings و Flash Movie 4-6-14 آشنايي با
در برنامه FreeHand مي توانيد Flash Movie 1را در داخل سند FreeHand وارد کرده و به 

صورت تعاملي در وب نمایش دهيد. 

 توجه: فایل Flash با فرمت SWF از طریق اجراي مس��ير File→Import در س��ند وارد 
مي شود.

باید به این نكته توجه داش��ته باش��يد که فایل Flash با فرمت FLA فایل قابل ویرایش در 
 Flash Movie اس��ت و با اس��تفاده از آن مي توان یك Macromedia Flash MX محيط برنامه

)فيلم Flash( که فرمت آن SWF است، ایجاد کرد )شكل 14-33(.

FreeHand شده در سند Import شكل 33-14 نمایش فيلم
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 FreeHand با استفاده از سند Flash امكان ایجاد یك فيلم سفارشي FreeHand در برنامه
 Movie Settings کادر محاوره ،Flash وج��ود دارد. براي انجام تنظيم هاي مورد نظر در فيل��م

به کار مي رود.
Movie Settings روش اجراي

1- فيلم موردنظر )فيلم ایجاد شده در مثال 4( را در سند وارد کنيد.
2- مسير Window→Movie→Settings را اجرا کنيد.

در کادر محاوره Movie Settings مش��خص مي ش��ود که لایه هاي موجود در صفحه سند 
FreeHand چگونه به فریم هاي فيلم Flash تبدیل مي شوند.

 توجه: در متحرك سازي، لایه هاي پنهان و لایه Guides دیده نمي شوند.

در این کادر محاوره سه ناحيه مختلف وجود دارد )شكل 14-34(.
1- در ادامه اجراي مثال ، گزینه Flatten را در بخش Layers  انتخاب کنيد تا همه لایه هاي 

موجود در صفحه هاي سند ادغام شده و در یك Frame قرار گيرند )شكل 14-34(.
2- در Page Range محدوده صفحه را 1 تا 3 قرار دهيد. در این  صورت صفحه 4 در فيلم 
ایجاد ش��ده در نظر گرفته نمي ش��ود و حجم فایل Movie نسبت به حالت 4 صفحه اي کمتر 

مي شود.
3- دکمه OK  را کليك کنيد. 

شكل 34-14 کادر تنظيمات فيلم ایجاد شده در مثال 4  
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FreeHand در داخل محيط Flash ویرایش فایل
اگر برنامه Macromedia Flash MX و  FreeHand MX هر دو در رایانه نصب ش��ده باش��ند؛ 

مي توانيد فایل Flash با فرمت FLA را در برنامه FreeHand ویرایش کنيد.
روش اجرا:

1- فيلم Flash موردنظر را که مي خواهيد ویرایش کنيد، در صفحه Import کنيد.
2- در پنل Object روي دکمه ویرایش Flash کليك کنيد، س��پس در کادر محاوره ظاهر 
شده، فایل فيلم Flash موردنظر را با فرمت FLA )فرمتي که سبب ایجاد فيلم Flash با فرمت 

SWF مي شود( انتخاب کرده و در صفحه ظاهر کنيد )شكل 14-35(.

3- ویرایش مورد نظر را انجام داده، س��پس روي Done کليك کنيد )شكل 35-14(. در 
این صورت فایل Flash بسته مي شود و به سند FreeHand باز مي گردید. 

 نكته: اگر کادر انتخاب Show Snapshot فعال باش��د، مي توانيد نمایشي از یكي  از 
فریم هاي فيلم را ببينيد.

FreeHand در داخل Flash شكل 35-14ویرایش فایل

تمرين 3: تنظيم ویژگي هاي یك فيلم Import ش��ده در س��ند FreeHand را با 
استفاده از پنل Object که در شكل 36-14 مشخص شده، بررسي کنيد.
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شكل 14-36

HTML با فرمت Web در FreeHand 7-14  انتشار سند
ویژگي هاي وب FreeHand براي طراحي یك وب س��ایت ب��ه کار نمي رود بلكه براي مواردي 
  Publish as HTMLنظير تبدیل یك بروش��ور به مجموعه اي از صفحات وب مفيد است. با فرمان
س��ند FreeHand به س��ند HTML تبدیل مي ش��ود و مي توانيد مانند صفحات وب آن را در 

مرورگر وب مشاهده کنيد.
 ب��ا اج��راي فرم��ان File→Publish as HTML کادر مح��اوره HTML Output مطاب��ق 
 ،HTML به فرمت FreeHand ش��كل  37-14 نشان داده مي ش��ود. مي توانيد براي تبدیل سند
تنظيم��ي را از من��وي HTML Setting انتخاب کرده یا تنظيم جدیدي )با اس��تفاده از دکمه 
Setup( را ایج��اد کنيد. امكان ویرایش تنظيم پيش فرض و تنظيم هاي ایجاد ش��ده نيز وجود 

دارد.
 

شكل 14-37
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 HTML کليك کنيد کادر محاوره Setup روي دکمه HTML Output  اگ��ر در کادر محاوره
Setup باز مي شود )شكل 14-38(.

HTML به فایل FreeHandشكل 38-14 کادر ایجاد و ویرایش تنظيم تبدیل سند

در این کادر تنظيماتي مانند محل ذخيره س��ازي سند HTML، قالب بندي و صفحه آرایي 
آن، رمزگ��ذاري قلمي که در صفحه به کار مي رود، تعيي��ن فرمت و نوع فایل براي اثر هنري 
 FreeHand در پوش��ه اي به نام HTML وجود دارد. محل ذخيره س��ند )Vector ی��ا Bitmap(

HTML Output در روي صفحه Desktop است. 

1-7-14 ايجاد سند

1- سند FreeHand مورد نظر را باز و مسير File→Publish as HTML را اجرا کنيد.
 ،HTML یكي از موارد زیر را براي انتخاب تنظيمات HTML Output  2- در کادرمح��اوره

در بخش HTML Setting انجام دهيد:
تنظيم پيش فرض یا تنظيمي را که ایجاد کرده اید، انتخاب کنيد. اگر تنظيمي ایجاد  	

نكرده اید فقط تنظيم پيش فرض دیده مي شود.
روي دکمه Setup کليك کنيد تا کادر محاوره HTML Setup ظاهر شود.	

روي دکمه Wizard کليك کرده، دستوراتي که براي انتخاب تنظيمات HTML	 ارائه 
مي شود دنبال کنيد و با کليك روي دکمه Finish به کار پایان دهيد. 

3- پس از انجام تنظيمات مورد نظر روي دکمه Save as HTML کليك کنيد.
HTML Output 2-7-14 ايجاد و ويرايش تنظيم هاي

1- روي گزین��ه File→Publish as HTML کليك کنيد تا کادرمحاوره HTML Output در 
صفحه ظاهر شود.
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2- روي دکمه Setup  کليك کنيد تا کادر HTML Setup ظاهر شود.

Name for new HTML Setting شكل 39-14 درج نام تنظيم جدید در کادر متني

3- یكي از مواردي را که در ادامه گفته شده با توجه به نيازتان اجرا کنيد.
براي ایجاد تنظيم جدید، روي علامت + کليك کنيد تا کادر ش��كل 39-14	 آش��كار 
ش��ود. س��پس نام تنظيم جدید را در کادر متني مربوط به آن وارد و دکمه OK را 

کليك کنيد.
 	HTML Setting که قبلًا ایجاد ش��ده، از منوي بازش��و HTML براي ویرایش تنظيم

تنظيم مورد نظر را انتخاب کنيد )شكل 14-40(.

شكل 40-14 انتخاب تنظيم موردنظر براي ویرایش

4- محل ذخيره  س��ند HTML را با کليك روي دکمه Browse و تعيين پوش��ه نگهداري 
فایل HTML مشخص کرده و روي دکمه Select کليك کنيد.

مثال 5: صفحه FreeHand نش��ان داده شده در شكل 41-14 را براساس تنظيم 
پيش فرض به صورت HTML تبدیل کنيد. 

 File→Publish as HTML شكل 41-14 را ایجاد کنيد، سپس مسير FreeHand 1- سند
را اجرا کنيد.

2- در کادر محاوره    HTML      Output، تنظيم پيش فرض را انتخاب کنيد )شكل 14-42(.
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شكل 41-14                                            شكل 14-42

3- از قس��مت Pages گزین��ه All را انتخاب کنيد تا تنظيم��ات روي تمام صفحات اعمال 
شود )شكل 14-42(.

4- با کليك روي دکمه Browse برنامه مرورگر یا ویرایشگر موردنظر را انتخاب نمایيد.
5- روي دکمه Save as HTML کليك کنيد )شكل 14-42(. 

تمري�ن 4: یك فایل FreeHand با ن��ام T14 -3  ایجاد کنيد که داراي دو صفحه 
باشد. در صفحه اول آن یك تصویر Import ،Bitmap شده و در صفحه دوم آن شكل 14-43 

قرار داده شود، با توجه به موارد خواسته شده آن را به فرمت HTML تبدیل کنيد.
1- خروجي در مرورگر وب دلخواه مشاهده شود.
2- کادر هشدار در جریان تبدیل مشاهده شود.

شكل 14-43
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1 URL 8-14 انتساب يک
یك��ي از مهم ترین ویژگي هاي صفحه وب که در HTML وج��ود دارد، قابليت لينك هاي 
URL است. این لينك ها یا پيوندها به شما امكان مي دهد تا روي یك کلمه، عبارت یا تصویر 

کليك کنيد و به مكان دیگري در وب س��ایت جاري یا سایت دیگر منتقل شوید. براي ایجاد 
 Navigation که در پنل Link مي توانيد از کادر متني URL بين ش��ئ یا متن و )Link( پيوند

است، استفاده کنيد.
 HTML یا PDF ،SWF است در فایلي با فرمت URL که حاوي FreeHand وقتي یك سند
صادر شود در این صورت کليك روي شئ متصل شده به آدرس URL، سبب پرش به صفحه 

وب مورد نظر مي شود.
1-8-14 انتساب URL به شئ

1- شيئي را انتخاب کنيد که مي خواهيد پيوند )لينك( به آن اعمال شود.
2- در پنل Navigation آدرس URL را در کادر Link تایپ کنيد )شكل 14-44(.

ی��ا اگ��ر قبلًا لينكي را به س��ند اضافه کرده اید، از منوي بازش��و Link براي انتخاب پيوند 
موردنظر استفاده نمایيد.

شكل 14-44

 نكت�ه: اگر با چندین صفحه در س��ند کار مي کنيد، از منوي Link براي انتخاب 
یك پيوند به صفحه دیگر استفاده کنيد.

پنل Navigation این امكان را مي دهد که یك URL	 را به اش��ياء نسبت دهيد، اشياء 

را بررسي کنيد و مشخص کنيد که چه URLهایي به آن ها متصل است،URL  همه 
اشياء را به روز کنيد و شئ هایي را که به یك URL خاص متصل هستند، بيابيد.

Uniform Resource Locator  -1: مشخص کننده منحصر به فرد منبع، آدرس منحصر به فرد صفحات وب
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منوي Substring	 کلمه یا عبارت هایي را نش��ان مي دهد که داخل بلوك متني فعال 
است و به یك URL در کادرLink  متصل است.

2-8-14 انتساب URL به متن 

1- در فایل FreeHand، متن یا بلوك متني که مي خواهيد URL را به آن نسبت دهيد با 
ابزار Text انتخاب کنيد. 

2- مسير Window→Navigation را براي فعال کردن پنل Navigation اجرا کنيد.
3- در منوي Link، آدرس URL موردنظر را درج یا از منوي بازش��و Link، آن را انتخاب 

کنيد. در این صورت متن انتخابي در کادر Substring آشكار مي شود. 
URL 3-8-14 به روز كردن

1- در سند جاري همه اشياء را از حالت انتخاب خارج کنيد.
2- در پن��ل Navigation ی��ك URL را از منوي بازش��و Link، انتخاب یا یك URL را وارد 

کنيد.
3- روي دکمه جس��تجو  که در س��مت راست منوي بازش��و Link قرار دارد، کليك 

کنيد.
4- تمام اشياي موجود در سند جاري که به URL لينك شده اند، انتخاب مي شوند.

در ای��ن ص��ورت URL براي همه اش��ياي متصل )Link( به آن در س��ند ج��اري به روز 
مي شوند.

URL 4-8-14 جستجوي اشياي متصل شده به
 URL یك Link آدرس را درج کرده یا از منوي بازش��و Link در کادر ،Navigation 1- در پنل

انتخاب کنيد.
کني��د  کلي��ك   ، Link من��وي  راس��ت  س��مت  در    Find Button دکم��ه  روي   -2 

3- تمام اشياي موجود در سند جاري که به URL  متصل شده اند، در سند انتخاب مي شوند.
هنگامي که URL را به شئ سند FreeHand که داراي خط دور )Stroke( است، نسبت مي دهيد؛ 
وقتي کاربر  اشاره گر ماوس را روي خط حرکت دهد پيوند ایجاد شده در سند HTML فعال خواهد 

شد.
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Navigation شكل 45-14نمایش دکمه جستجو در پنل

 مثال 6: درفایل FreeHand نشان داده ش��ده در ش��كل 46-14 یك Link از شئ 
 C:\Documents and Settings\ma\FreeHand متني ب��ه صفحه وب  ذخيره ش��ده  در مس��ير

html.Output\Untitled001 ایجاد کنيد.

1- پس از ایجاد شكل 46-14در سند FreeHand، متن درج شده را انتخاب کنيد.
2- پنل Navigation را فعال کنيد.

3- در کادر Link، آدرس صفحه HTML موردنظر را درج کنيد.
4- در کادر Substring عبارت انتخاب شده مشاهده مي شود )شكل 14-46(. 

        

شكل 14-46

5- فایل FreeHand را به HTML تبدیل کنيد )شكل 14-47(.
6- با کليك روي عبارت show button صفحه Link شده به آن قابل  مشاهده  است )شكل 

سمت چپ 14-47(. 
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شكل 14-47

5-8-14 فشرده سازي اثر هنري )Artwork( براي نمايش در وب

وقت��ي تصویرها را براي نمایش در وب آماده مي کنيد، حجم تصویرهاي فش��رده ش��ده، 
کاه��ش یافته و روي رن��گ تصویرهاي به نمایش درآمده در وب و س��ایر ویژگي هاي تصویر 

کنترل هاي لازم انجام مي شود.
اثر هنري Bitmap در FreeHand به صورت JPEG ،GIF یا فرمت PNG فش��رده مي ش��ود. 
اث��ر هنري برداري ب��ا فرمت SWF، صادر مي ش��ود )Export( و به این ترتيب فایل ایس��تاي 

FreeHand به یك سند پویانمایي با Action هاي Flash تبدیل مي شود.

در فشرده س��ازي کاره��اي از ن��وع Bitmap باید قالبي انتخاب ش��ود که اس��اس رنگ و 
مشخصه هاي تن هاي رنگي اثر هنري اصلي را حفظ کند و نوع مرورگر براي مشاهده صفحه 

نيز در این مورد مؤثر است.
به طورکلي فرمت GIF بهترین حالت براي تصویرس��ازي و طراحي با رنگ هاي Flat	 و 

یكنواخت است، مثل رنگي که در متن به کار مي رود.
قالب JPEG	 بهترین حالت براي اثر هنري با محدوده گسترده و دامنه اي از تناليته هاي 
پيوسته رنگ است، مثل اثر هنري که در آن رنگ گرادیان به کار رفته یا عكس هایي 

که اسكن شده اند.
فرم��ت PNG مانند JPEG	 محدوده وس��يعي از رنگ را دربرمي گي��رد اما غالباً به کار 

نمي رود زیرا فقط امكان نمایش در برخي از مرورگرها را دارد.
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واژه نامه 
Actionحرکت، عمل

Flash Playerنمایشگر برنامه

Interactiveتعاملي

Target Pageصفحه مقصد

Navigationجهت یابي

Parametersپارامترها

Unloadعدم بازیابي

Sequenceترتيب، توالي

Trailکشيدن، کشيده شدن

خلاصه مطالب
در این واحدکار مواردي که سبب نمایش سند FreeHand در وب و ایجاد اثر گرافيكي و 

پویانمایي تحت وب مي شود، به شرح زیر بررسي شد:
انتساب یك Flash Action به شئ سند FreeHand	 و ایجاد فيلم تعاملي در وب

( براي اس��تفاده در اثر  	SWF( Flash در قالب فای��ل FreeHand اث��ر هن��ري Export

برداري پویا و نمایش آن در وب.
 	Flash با استفاده از پنجره FreeHand در داخل Flash پيش نمایش و تست فيلم هاي

.Player

 	FreeHand براي تبدیل سندXtras→Animate→Release to Layers  استفاده از فرمان
به صورت یك انيميشن.

. 	Publish as HTML با استفاده از فرمان HTML به FreeHand تبدیل سند
انتس��اب لينك هاي URL به اش��ياء یا متن در س��ند FreeHand	 با اس��تفاده از پنل 

.Navigation

فشرده س��ازي آث��ار FreeHand در قالب JPEG ،GIF یا PNG	 براي نمایش س��ند به 
.HTML صورت
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعیین کنید.

Over -1، رویداد حرکت ماوس روي شئ است.

2- زماني که براي یك ش��ئ، Action تعریف مي کنيد در گوش��ه بالا س��مت راست آن، 
علامتي به نام Action Proton ظاهر مي شود.

 Play( پرش به یك فریم و توقف تكرار صحنه  Go To and Stop،Action 3- با استفاده از
Back( انجام مي شود.

Action -4ه��اي Load/Unload Movie وTell Target  در صورتي فعال هس��تند که س��ند 

حداقل سه صفحه داشته باشد.
 Macromedia Flash MX فایل قابل ویرایش در محيط برنامه FLA با فرمت Flash 5- فایل

است.
معادل گزينه  هاي سمت راست را از ستون سمت چپ انتخاب کرده و مقابل هر عبارت بنويسید.

Link to Target Page              .6- جلوه حرکتي است که به یك موضوع داده مي شود
7- صفحه اي که محل پایان یافتن Action  را مش��خص مي کند و عمل رها کردن ماوس 
Action                                                                                    .در آن انجام مي شود )Drop(

                   Release to Layers                  .8- یك اتصال و پيوند به صفحه مقصد ایجاد مي کند
Blend  -9، بلوك هاي متن، اشياء گروه بندي شده و متن متصل به یك مسير با این فرمان 

Target Page                                                                         .متحرك مي شوند
گزينه صحیح را انتخاب کنید.

10-کدام ی��ك از Actionها، براي نمایش فيل��م در حالت تمام صفحه و بزرگ تر از حالت 
معمولي انجام مي شود؟

The Print action -ب  The Tell Target action -الف
  The Full Screen action-د  The Play and Stop actions -ج

11- کدام یك از گزینه هاي انيميش��ن، اش��ياء را به تعداد لایه هایي که مشخص مي کنيد 
کپي و پخش مي کند؟

Build  -د             Drop  -ج           Sequence  -ب       Trail  -الف 
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12- کدام فرمت بهترین حالت براي تصویرسازي و طراحي با رنگ هاي Flat است؟
SWF -د          JPG -ج   GIF -ب       PNG -الف

13- کليد ترکيبي Ctrl+Enter چه عملي انجام مي دهد؟
الف- صدور فایل حرکتي به وب        ب- قرار دادن اشياء در فریم

ج- تست و اجراي فيلم         د- اعمال جلوه حرکتي به شكل
در جاي خالي عبارت مناسب را بنويسید.

14- با فرمان .................. س��ند FreeHand به س��ند HTML تبدیل مي ش��ود و مي توانيد 
مانند صفحات وب آن را در مرورگر وب مشاهده کنيد.

 Flash براي ........... و ........... یك فيلم ،The Load Movie and Unload Movie actions  -15

در داخل فيلم Flash جاري )فيلم در حال نمایش( است.
به سؤالات زير پاسخ تشريحی دهید.

16- اعمال )Go To and Play )Action با Play چه تفاوتي دارد؟
17- ابزار Action Tool چه کاري انجام مي دهد؟ نام ببرید.
18- در شكل زیر نام دکمه هاي مشخص شده را بنویسيد.
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آزمون عملي
1- متن این ش��كل را رس��م ک��رده ب��ا اس��تفاده از فرم��ان Release to Layers روي آن 

متحرك سازي با جلوه Trail ایجاد کنيد.

2- موارد خواسته شده را اجرا کنيد:
یك س��ند FreeHand	 که دوصفحه اي اس��ت ایجاد کرده و شكل هاي الف و ب را در 

صفحه اول و دوم آن قرار دهيد.                                                    
ترتيبي دهيد که با اس��تفاده از فایل FreeHand، یك Flash Movie	 ایجاد شود که با 
حرکت ماوس روي شئ اول، شئ دوم ظاهر شود.                                            

3- یك س��ند FreeHand سه صفحه اي شامل تصویر Bitmap و ترسيم برداري ایجاد و آن 

را به یك فایل HTML تبدیل کنيد. ترتيبي دهيد که دو صفحه از سه صفحه فایل به فرمت 
HTML تبدیل شوند.

4- با استفاده از پنل Navigation بين شكل زیر و یك سند HTML دلخواه، ارتباط برقرار 
کنيد.
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كليات 
تاکنون با امكانات و توانایي هاي متعدد برنامه گرافيكي FreeHand آش��نا ش��ده اید. گاهي 
اوقات هنگام طراحي لازم مي ش��ود براي تكميل طرح، فایل ترسيمي را به یك نرم افزار دیگر 
ب��رده و روي آن تغييرات لازم را انجام دهيد همچنين ب��راي خروجي گرفتن از کار طراحي 
نهایي باید بتوانيد با فرمان Print ترس��يمات را چاپ کنيد. بدین منظور در این واحد کار به 
بررس��ي نحوه صدور فایل و فرمت هاي پشتيباني شده براي صدور فایل همچنين نحوه چاپ 

فایل و تصاویر ایجاد شده در FreeHand خواهيم پرداخت.
Export 1-15 فرمان

چنانچه بخواهيد از فایل ترسيمي در یك برنامه گرافيكي دیگر غير از FreeHand استفاده 
کنيد، لازم است فایل را با فرمتي ذخيره کنيد که با برنامه مقصد سازگاري داشته باشد، در 
این صورت از فرمان Export استفاده کنيد. همچنين با استفاده از این فرمان مي توان فایل ها 

را به فرمت هاي گوناگون تبدیل و ذخيره کرد.
FreeHand انواع فرمت هاي گرافيكي برداري و پيكس��لي را پش��تيباني مي کند. مي توانيد 

فایل هاي گرافيكي یا متني را به فرمت هاي زیر Export نمایيد:
	 BMPو GIF ،JPEG ،TIFF ،PNG ،PSD با فرمت هاي Bitmap تصاویر

 	Flash به منظ��ور نمایش در مرورگر وب ی��ا برنامه SWF ب��ا فرمت Flash فيلم ه��اي
Player

و  	Enhanced Metafile )EMF( فرمت ه��اي  ب��ا   )Vector( ب��رداري   گرافيك ه��اي 
 Windows Metafile )WMF(

	FreeHand 8, 9, 10 فایل هاي
	  Illustrator فایل هاي

اس��ناد ایجاد ش��ده با فرمتPDF  که توس��ط برنام��هAdobe Acrobat 	 نمایش داده 
مي شوند.

	RTF و ASCII   مثل )Text( فرمت هاي متني
در مورد انواع فرمت ها قبلًا در واحد کار 3 توضيح داده شده است.

به منظور صادر کردن فایل طراحي ش��ده به نرم افزارهاي دیگر از فرمان File→Export یا 
کليد ترکيبي Ctrl+Shift+R استفاده کنيد تا کادرمحاوره Export Document در صفحه ظاهر 



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
432

شود )شكل 15-1(.

Export Document شكل 1-15 کادر محاوره

 مثال 1: آرم نشان داده شده در شكل 2-15 را طراحي کنيد؛ سپس آن را با نام 
Arm1 و پس��وند JPG به برنامه Paint ویندوز ص��ادر کرده و از طریق آن برنامه، کلمه ITP را 

جدا کرده و به زیر شكل منتقل کنيد.

شكل 15-2

1- ابتدا طراحي آرم را با ابزارهاي مناسب انجام دهيد.
2- از منوي File گزینه Export را برگزینيد.

3- در کادر محاوره ظاهر شده در کادر متني File name نام Arm1  را وارد کنيد.
4- در منوي بازشوي Save as type پسوند JPG را انتخاب کنيد.

5- گزینه Open in external application را فعال کنيد و در کادر محاوره باز ش��ده، فایل 
mspaint.exe را از پوشه ویندوز انتخاب کنيد.
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6- روي دکمه Save کليك کنيد تا وارد برنامه Paint شوید.
7- در این برنامه با ابزار Select متنITP  را انتخاب کرده و به زیر شكل منتقل کنيد.

تمرين 1: براي یك ش��رکت کامپيوتري، کارت ویزیتي مطابق ش��كل 3-15 به 
 Photoshop ابعاد 5×9 س��انتي متر و به صورت افقي، طراحي کنيد؛ س��پس آن را به نرم افزار

ارسال کرده و براي زیبایي کار روي آن چند فيلتر مناسب اعمال کنيد.

شکل 15-3

 توج�ه: دکم��ه Setup ب��راي اعمال کنترل بر فایل ارس��الي به کار م��ي رود که در 

فرمت هاي مختلف تنظيمات گوناگوني دارد.

1-1-15 نحوه صدور برخي فايل ها 

براي تنظي��م صدور هر فرمت نظير JPG ،GIF ،TIFF ،BMP و PNG  روي دکمه Setup در 
کادرمحاوره  Export Document کليك کنيد. در این صورت کادري مطابق ش��كل 4-15 باز 

مي شود.

شكل 15-4

در منوي بازشو Resolution مقدار وضوح را براي اکثر کارهاي چاپي dpi 300	 و براي 
وب مقدار dpi 72 در نظر بگيرید.

براي هموار کردن لبه هاي تصویر، مقدار Anti-aliasing را انتخاب کنيد.	
 	Include alpha براي صادر کردن کانال آلفا که به عنوان ماس��ك به کار مي رود گزینه
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channel را کليك نمایيد. اگر براي تصویر یك کانال آلفا ایجاد کرده باشيد، مي توانيد 

از FreeHand براي نش��ان دادن یا مخفي کردن این کانال اس��تفاده کنيد. اگر کانال 
آلفا قابل رؤیت نباشد تصویر کامل را مي بينيد.

کارگي��ري لایه پس زمينه به  انتخ��اب گزینه Alpha includes background س��بب به 	
عنوان کانال آلفا1 مي شود )شكل 15-5(.

شكل 15-5

 نكت�ه: FreeHand به ش��ما امكان مي دهد که کانال هاي آلف��اي تصاویر با فرمت 
PNG ،TIFF و GIF را نمایش دهيد.

 Export Again 2-15 فرمان
پس از صدور یك فایل، ممكن اس��ت بخواهيد تغييراتي را در س��ند اصلي ایجاد کنيد و 

سپس بدون تنظيم کادر محاوره Export مجدداً فایل مزبور را صادر کنيد.
 FreeHand را اجرا کني��د. در این صورت File→Export Again ب��راي این منظور فرم��ان
بدون استفاده از تنظيم کادرمحاوره Export فایل را با همان نام و پسوند در مسيري که قبلًا 

Export شده بود، ذخيره و صادر مي کند.

Email  3-15 ارسال يک سند به صورت
در صورتي که ویندوز شما داراي سيس��تم نامه الكترونيكي MAPI32-Compliant باشد، 
 Mail یا تمام س��ندهاي باز شده متصل به آن را ارسال یا FreeHand مي توانيد س��ند فعال در

نمایيد. مراحل کار به صورت زیر است:
1- گزینه File→Send را انتخاب کنيد.

2- با توجه به عملي که مي خواهيد انجام دهيد یكي از روش هاي زیر را اجرا کنيد:
1- کانال آلفا انتخابي است که به عنوان ماسك و به شكل تصاویر خاکستري ذخيره مي شود.
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براي اتصال )Attach( سند فعال به پيام E-mail، نام فایل را انتخاب کنيد.	
، گزینه 	E-mail تمام اس��نادي که به تازگي باز شده اند، به پيام )Attach( براي اتصال 

All Open Documents را انتخاب کنيد.

اگر براي اولين بار یك سند را به صورت نامه الكترونيكي Mail یا ارسال کنيد یك پنجره 
ظاهر مي شود و از شما مي خواهد که یك پروفایل را تنظيم کنيد. براي کسب اطلاعات بيشتر 

به مستندات برنامه کاربردي E-mail  خود مراجعه نمایيد.
3- در صورت نياز، پيام هاي مورد نظر را به متن نامه خود اضافه نمایيد.

4- پس از درج آدرسE-mail  ش��خصي که مي خواهيد نامه را به او ارس��ال کنيد، روي 
دکمه Send  کليك کنيد.

اسناد به نامه متصل1 مي شوند. در صورتي که براي سند جاري که آن را ارسال نموده اید 
نامي تعيين نكرده باشيد، با همان نام پيش فرض خود در FreeHand ارسال مي شوند. 

Print 4-15 فرمان
پس از تكميل کار طراحي معمولاً لازم اس��ت که نمونه اي از آن را روي کاغذ مش��اهده 

کنيد و به اصلاح اشكالات احتمالي آن بپردازید.
عمل چاپ را مي توان به دو روش انجام داد که عبارتند از چاپ خانگي و چاپ تجاري یا 

صنعتي. در این بخش، کار با ابزارهاي چاپ خانگي مورد بحث و بررسي قرار گرفته است.
 Print نصب شده باشد، مي توان از روش هاي زیر کادر محاوره )Printer( در صورتي که چاپگر 

)شكل 6-15( را باز کرد:
 Print گزینه File روش 1: منوي

Main روش 2: کليك روي آیكن  در نوار ابزار
 Ctrl+P روش 3:  به کار بردن کليد ترکيبي

پس از باز شدن کادر محاوره Print و قبل از تأیيد این کادر و شروع عمل چاپ، ابتدا باید 
گزینه هاي آن را تنظيم و کنترل کنيد.

 1- Attach        
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Print شكل 6-15 کادر محاوره

 Print 1-4-15 گزينه هاي كنترلي كادر محاوره

Printer -1: در منوي بازشوي این قسمت مي توان نوع چاپگري را که به کامپيوتر متصل 

است، انتخاب کرد. 
Properties -2: با کليك روي این دکمه، کادرمحاوره تنظيمات چاپگر فعال ظاهر مي شود 

که از این طریق مي توان اندازه کاغذ، نوع کاغذ، Resolution چاپگر و غيره را تعيين کرد.
Print Range  -3 : در این قس��مت محدوده چاپ تعيين مي ش��ود که شرح آن به صورت 

زیر است:
All: انتخاب این گزینه سبب چاپ تمام صفحات سند جاري مي شود.	

Current page: این گزینه فقط صفحه جاري را چاپ مي کند.	

Area: براي چاپ ناحيه تعریف شده توسط ابزار Output Area 	 واقع در جعبه 

ابزار Tools، از این گزینه اس��تفاده مي شود )اصول کار با ابزار Output Area در ادامه 
همين فصل آورده شده است(.

Pages:	 با وارد کردن ش��ماره صفحات خاص در این قسمت، تنها صفحات مورد نظر 

چاپ مي شوند.
Page boundary:	 اگر مي خواهي��د صفحات متع��ددي را دریك صفح��ه چاپ کني��د، 

مي توانيد این گزینه را انتخاب کنيد تا لبه هاي صفحه در خروجي چاپ نهایي نشان 
داده شوند.

انتخاب  این گزینه س��بب مي ش��ود که فقط موضوع انتخابي چاپ  	 :Selected objects
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شود.
Output -4: در این قسمت گزینه هاي زیر به کار مي رود:

Copies:	 در این کادر متني مي توان تعداد کپي ها از صفحات مش��خص ش��ده را وارد 

کرد.
Composite:	 انتخاب این گزینه سبب مي شود که همه رنگ ها به صورت ترکيب شده 

در یك صفحه چاپ شوند یعني ترکيب تمام رنگ ها در چاپ نشان داده مي شوند.
Separations: ای��ن گزین��ه براي چاپگرهاي Postscript	 فعال مي ش��ود و چاپگرهاي 

معمولي قادر به چاپ رنگ هاي تفكيكي نيس��تند، با استفاده از این گزینه رنگ ها به 
طور مجزا چاپ مي شوند. به عبارت دیگر براي هر یك از رنگ هاي جوهر که در ایجاد 

فایل مورد استفاده قرار مي گيرند چاپ جداگانه اي انجام مي گيرد.
Print to file:	 اطلاعات چاپ، به جاي اینكه به چاپگر ارس��ال ش��ود، درون یك فایل 

ذخيره مي شود تا بعداً از آن استفاده شود.
Convert Text: همه عبارات متني را به مسير تبدیل مي کند.	

Preview -5: براي مشاهده پيش نمایش چاپ به کار مي رود )شكل 15-7(.

	 ب��راي کنت��رل صفح��ات در پيش نمای��ش چاپ، از منوي بازش��وي ش��ماره صفحه 
)شكل 7-15( استفاده کنيد.

منوي بازشوي انواع پيش نمایش به صورت زیر است:	
Preview: پيش نمایش کار طراحي را با تمام زمينه ها و رنگ ها نشان مي دهد.

Keyline: این نوع پيش نمایش، بدون نمایش رنگ ها و زمينه ها فقط مس��يرهاي طراحي 

را نشان مي دهد.
X-Box: در این پيش نمایش، طراحي به صورت علامت × نشان داده مي شود.

تمرين 2: انواع حالت های Print Preview را مشاهده کرده و به تفاوت بين آن ها 
دقت کنيد.
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شكل 15-7

 توجه: با استفاده از درگ ماوس مي توانيد طراحي خود را به موقعيت هاي مختلف 

در ناحي��ه Print Preview منتقل کني��د. اگر بخواهيد طراحي به موقعيت اوليه بازگردد، روي 
ناحيه هاي خارج از پيش نمایش چاپ کليك کنيد.

Color Management -6: این گزینه مربوط به مدیریت و تفكيك رنگ هاست.
7- بخش %Scale: در منوي بازش��وي شكل 8-15 گزینه هایي وجود دارد که مي توان به 
وس��يله آن ها اندازه فایل چاپ شده را تغيير داد، بدون این که روي فایل اصلي تأثيري داشته 

باشد.

Scale % شكل 8-15 بخش

Uniform:	 این گزینه س��بب مي شود که با وارد کردن اعداد بزرگ تر یا کوچك تر از 

100%، ابعاد فایل چاپ شده نسبت به تصویر اصلي بزرگ تر یا کوچك تر شود بدون 
آن که تناسب تصویر تغيير کند.

Variable: مقي��اس تصویر را طبق مقادیر مختلف ابعاد x و y	 تغيير مي دهد؛ زیرا در 

ای��ن حالت مي توان طول و عرض تصویر را مس��تقل از یكدیگر تغيير داد، تصویر در 
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خروجي تغيير شكل مي دهد.
Fit on paper:	 ان��دازه تصویر را طوري تغيير مي دهد که با کاغذ موردنظر متناس��ب 

باش��د. به عبارت دیگر بدون توجه به ابعاد واقعي تصویر، تصویر چاپ ش��ده به اندازه 
حداکثر فضاي قابل چاپ صفحه کاغذ، تغيير خواهد کرد.

Tile -8 : اگ��ر کار طراح��ي موردنظر، بزرگ تر از کاغذ چاپگر اس��ت و نمي خواهيد اندازه 

آن را کاه��ش دهيد، مي توانيد گزینه کاش��ي کاري )Tile( را انتخاب کنيد که در این صورت 
طراحي ش��ما به تعداد قطعات کاغذ تقسيم مي شود و هر قسمت در یك صفحه چاپ خواهد 

شد )شكل 15-9(.                                                            

شکل 15-9

منوي بازشوي Tile داراي گزینه هایي به این شرح است:
با اس��تفاده از این گزینه مي توانيد مكان ظاهر ش��دن قطعات کاغذ تقسيم  	 :Manual

شده را به طور دستي انتخاب کنيد.
مح��ل قرار گرفتن ه��ر یك از قطعات کاغذ را به ط��ور خودکار تنظيم  	 :Automatic

مي کند.
از قسمت Tile	 مي توان براي چاپ تصویر در چند قطعه روي یك کاغذ استفاده کرد 

که در این صورت گزینه Overlap فاصله ميان قطعات را تعيين مي کند. 
 Printer Setup 15-4-2

ای��ن گزین��ه وظيفه تنظي��م ویژگي هاي چ��اپ پيش��رفته را برعهده دارد که از مس��ير 
File→Printer Setup، قابل دسترسي است.

 مثال 2: تنظيمات زیر را براي چاپ انجام دهيد:
الف- تنها صفحه جاري که شكل 3-15 )تمرین 1( در آن قرار دارد دو بار چاپ شود.
ب- در محيط Print Preview شكل را در وسط صفحه قرار داده و سپس چاپ کنيد.

حل:
1- قب��ل از انج��ام این تنظيمات، از نصب و وصل بودن چاپگر به سيس��تم خود مطمئن 

شوید.
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2- براي تنظيم قسمت الف، از منوي File گزینه Print را انتخاب کرده و در کادر محاوره 
باز شده موارد زیر را انتخاب کنيد:

در قسمت Print Range گزینه Current page را انتخاب کنيد.	
در بخش Output در کادر Copies عدد 2 را وارد کنيد.  	   

3- براي انجام قس��مت ب، در کادر محاوره Print دکمه Preview را کليك کرده و ش��كل 
را به وسط صفحه درگ کنيد.  

4- دکمه OK را کليك کنيد تا عمل چاپ انجام گيرد.
تمرين 3: شكل 10-15 را ترسيم کنيد، سپس آن را انتخاب کرده و فقط ناحيه 
انتخاب ش��ده را به نحوي چاپ کنيد که تصویر چاپ شده به اندازه حداکثر فضاي قابل چاپ 

صفحه کاغذ باشد.

شكل 15-10

 )Color Management( 5-15 آشنايي با مديريت رنگ
گاهي اوقات بين تصاویري که در صفحه نمایش دیده مي ش��وند با نمونه چاپ شده آن ها 
تفاوت رنگ مشاهده مي شود. براي رفع این مشكل و به منظور تنظيم ظاهر تصاویر در صفحه 
نمایش و پس از چاپ در FreeHand مي توان از Color Management یا مدیریت رنگ استفاده 

نمود. 
صفحه نمایش، رنگ ها را با مد رنگ RGB نمایش مي دهد در صورتي که در هنگام چاپ، 
رنگ ها با اس��تفاده از مد رنگ CMYK چاپ مي شوند بنابراین بين رنگ هاي صفحه نمایش و 

رنگ هاي خروجي نهایي تفاوت وجود دارد.
یك سيستم مدیریت رنگ )CMS(1، در صورت لزوم، رنگ را به نحوي تنظيم مي کند تا 
رنگ دس��تگاه هاي پيش نمایش )مانند صفحه نمایش( تا حد ممكن با رنگي که در خروجي 

 Color  Management System -1
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نهایي )چاپ( ایجاد خواهد شد هماهنگي داشته باشد. 
 Output Area 6-15 ابزار

توسط این ابزار )شكل 17-15( مي توانيد یك ناحيه واحد Export را درون محي�ط کاري 
براي سند تعریف کنيد. ناحيه Export مي تواند شامل نواحي انتخابي صفحه جاري و نواحي 
انتخابي Pasteboard )محيطي که شامل صفحات فایل است( باشد. همچنين مي ت�وان براي 

تعریف ناحيه چاپ از این ابزار استفاده کرد.

 نكته: درصورتي که بخواهيد شكل هاي رسم شده را چاپ کنيد و آن شكل ها در 
Pasteboard و خارج از محدوده صفحه باش��ند تنها با اس��تفاده از ابزار Output Area مي توان 

اشكال مورد نظر را چاپ کرد.

Export 1-6-15 تعريف ناحيه

به منظور تعریف و صادر کردن یك ناحيه Export درون سند مراحل بعد را انجام دهيد:
کليك نمایيد.

 
 Output Area روي ابزار ،Tools 1- از جعبه ابزار

2- ناحيه Export  را به وسيله درگ ماوس انتخاب کنيد.
3- گزینه File→Export را انتخاب کنيد.

4- در کادر مح��اوره Export Document ، ب��ه منظور Export کردن ناحيه تعریف ش��ده، 
گزینه Area را انتخاب کنيد.

 Export کلي��ك کنيد. در ای��ن لحظه ناحيه خروجي تعریف ش��ده Save 5- روي دکم��ه
مي شود.

بعد از تعریف ناحيه Export  مي توان اندازه آن را تغيير داد یا آن را حذف نمود.
Export 2-6-15 تغييراندازه، جابه جايي و حذف ناحيه

به منظور تغييراندازه ناحيه Export، در حالي که ابزار Output Area  انتخاب ش��ده است، 
اش��ار ه گر ماوس را در گوش��ه یا روي دس��تگيره کناري ناحيه قرار داده و آن را درگ نمایيد 

)شكل 15-11(.
براي حرکت دادن ناحيه Export باید اشاره گر ماوس را روي آن ناحيه قرار دهيد و زماني 
که اش��اره گر به شكل دس��ت تغيير شكل پيدا کرد، به س��مت موردنظر عمل درگ را انجام 
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دهيد. 

                 

Export شكل 11-15 تغيير اندازه ناحيه

 نكته: به منظور حذف ناحيه Export کليد Delete  را از صفحه کليد فشار دهيد.

3-6-15 تعريف ناحيه خروجي

به کمك ابزار Output Area مي توانيد ناحيه خروجي براي چاپ را نيز تعریف کنيد. ناحيه 
خروجي شامل ناحيه انتخابي در صفحات موجود و نواحي انتخابي در Pasteboard  است.

چاپ ناحيه خروجي 
1- ناحيه مورد نظر از شكل را با ابزار Output Area انتخاب نمایيد.

2- دستور File→Print را اجرا کنيد.
3- در کادرمحاوره  Print گزینه Area را در حالت انتخاب قرار دهيد.

 4- به منظور چاپ ناحيه کل صفحه گزینه Page boundary را در حالت انتخاب قرار دهيد
)شكل 15-12(.

5- روي دکمه Preview کليك کرده و پيش نمایش چاپ را مشاهده کنيد.
6- روي دکم��ه OK  در کادر محاوره Print Preview  و  س��پس کادر محاوره Print کليك 

نمایيد تا   عمل چاپ آغاز شود.
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شكل 12-15چاپ ناحيه خروجي
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واژه نامه
Againدوباره، مجدد

Boundaryکرانه، مرز

Color Managementمدیریت رنگ

Compositeمرکب

Exportارسال، صادر کردن

Externalخارجي، بيروني

Previewپيش نمایش

Separationsتفكيك

Uniformیكسان، متحدالشكل

خلاصه مطالب 
Export:	 این فرمان به منظور ارس��ال و صادر کردن موضوعات به برنامه هاي دیگر یا 

براي چاپ استفاده مي شود.
Print:	 با اس��تفاده از این گزینه مي توان تمام یا بخشي از تصویر ترسيمي مورد نظر 

را روي کاغذ چاپ کرد. 
پ��س از صدور یك فایل، در صورتي که  بخواهيد تغييراتي را در س��ند اصلي ایجاد  	 

کنيد و سپس بدون تنظيم کادر محاوره Export مجدداً فایل مزبور را صادر کنيد از 
فرمان File→Export Again استفاده کنيد.

به منظور تنظيم رنگ تصاویر در صفحه نمایش و هنگام چاپ در FreeHand	 مي توان 
از Color Management یا مدیریت رنگ استفاده کرد.
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آزمون نظري
درستي يا نادرستي گزينه  هاي زير را تعیین کنید.

1- فرمان  Exportبه منظور ارس��ال و صادر کردن موضوعات به برنامه هاي دیگر یا براي 
چاپ استفاده مي شود.

2- هنگام عمل چاپ گزینه  Current Page فقط ناحيه انتخاب شده را چاپ مي کند.
3- هنگام صدور فایل اگر گزینه Page boundary  را انتخاب کنيد، لبه هاي صفحه در فایل 

صادر شده نشان داده مي شود.
4- از Color Management به منظور مدیریت و تفكيك رنگ ها استفاده مي شود. 

5- هنگام عمل چاپ گزینه  Fit on paper اندازه تصویر را طوري تغيير مي دهد که با کاغذ 
مورد نظر متناسب باشد.

معادل گزينه  هاي سمت  راست را از ستون سمت  چپ انتخاب کرده و مقابل هر عبارت بنويسید.

Keyline          .6- این گزینه وظيفه تنظيم ویژگي هاي چاپ پيشرفته را بر عهده دارد
        All           .7-بدون نمایش رنگ ها و زمينه ها فقط مسيرهاي طراحي را نشان مي دهد

8- این پيش نمایش، کار طراحي را با تمام زمينه ها و رنگ ها نشان مي دهد.
Printer Setup                                                                                        
Output Area        .9-انتخاب این گزینه سبب چاپ تمام صفحات سند جاري مي شود
Preview                   .10- مي توان براي تعریف ناحيه چاپ  از این ابزار استفاده کرد

گزينه صحیح را انتخاب کنید.

11- کدام فرمان براي صدور فایل هاي گرافيكي به برنامه هاي دیگر استفاده مي شود؟
Export -د  Import -ج  Save As -ب   Save -الف

12- کدام یك از گزینه هاي زیر وظيفه فرمان Export است؟ 
الف- ذخيره فایل با فرمتي هم ساز با برنامه گرافيكي مقصد 

ب- تبدیل فرمت فایل جاري در  FreeHand به فرمت هاي گرافيكي دیگر
ج- Export معادل فرمان Save است.

د- گزینه هاي الف و ب صحيح هستند.
13- در صورتي که در فایل ارسال شده به نرم افزارهاي دیگر، تغييري ایجاد کرده باشيد، 
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کدام فرمان براي صدور تغييرات مناسب است؟
Again Export -ب        Export Again -الف

Export Document -د    Export As -ج
14- فرمان ............... وظيفه چاپ اسناد گرافيكي را در FreeHand به عهده دارد.

Printer -د  Output -ج            Print Range -ب   Print -الف
15- ب��راي چ��اپ یك موضوع خاص انتخابي در صفحه توس��ط فرمان Print، کدام مورد 

مناسب است؟ 
Current page -د   Area -ج  Selected Objects -ب   All -الف

16- انتخاب گزینه Print to file چه عملي انجام مي دهد؟
الف- خروجي فایل گرافيكي را به چاپخانه مي فرستد.

ب- خروجي چاپ، به اندازه حداکثر فضاي قابل چاپ صفحه کاغذ خواهد شد.
ج- اطلاعات را به یك چاپگر دیگر غير از چاپگر پيش فرض مي فرستد.

د- اطلاعات چاپ شده را درون یك فایل ذخيره مي کند.
در جاي خالي عبارت مناسب را بنويسید.

FreeHand -17 فایل هاي متني را با فرمت ........... فراخواني مي کند.
18- در پيش نمایش X-Box، طراحي به صورت ........... نشان داده مي شود.

19- براي صدور ناحيه تعریف ش��ده توس��ط ابزار Output Area  واقع در جعبه ابزار 
Tools، باید گزینه ......... را انتخاب کنيد.

20- انتخاب گزینه ............................ هنگام صدور فایل، باعث مي ش��ود که پس از ذخيره 
شدن فایل با فرمت انتخاب شده، بلافاصله برنامه مقصد اجرا شده و فایل ذخيره شده در آن 

نشان داده شود.
به سؤالات زير پاسخ تشريحی دهید.

21- فرمت هاي پشتيباني شده براي صدور فایل در FreeHand را نام ببرید.
22- آیا از طریق فرامين Copy/Paste در FreeHand مي توان با فتوش��اپ تبادل اطلاعات 

کرد؟
23- چگونه مي توانيد با استفاده از فرمان Print ترسيمات خود را 50% کوچك تر از اندازه 

واقعي چاپ کنيد؟
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آزمون عملي 
1- آرم زیر را رسم کنيد.

2- کارت ویزیتي به ابعاد موردنظر و با استفاده از آرم دلخواه براي یك سالن بدن سازي طراحي 
 و چاپ کنيد که شامل نام سالن، نام مدیریت سالن ورزشي، خدمات ارایه شده، آدرس، شماره تلفن و

E-mail باشد. 

3- براي یك سالن ورزشي سربرگ مناسب طراحي کنيد که شامل نام سالن، آرم )شكل 
س��ؤال 1(، تاریخ، پيوست، آدرس، شماره تلفن وE-mail باشد. همچنين یك تصویر مرتبط با 

موضوع نيز به صورت محو در زمينه سربرگ وجود داشته باشد.
4- سربرگ طراحي شده را به نام My design براي چاپخانه صادر کنيد )به فرمت ارسالي 

توجه کنيد(.
5- در یك کاغذ A4، 2 نسخه از سربرگ را توسط چاپگر، چاپ کنيد. 
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آزمون پاياني )نظري(

1- کدام یك از عبارات زیر صحيح است؟
الف- کليك روي  در نوار ابزار اصلي، سند جدید را ایجاد مي کند.

ب- نوار اطلاعات )Info( همان نوار ابزار استاندارد است.
ج- برنامه FreeHand 10 بدون سند جدید باز مي شود.

د- امكان باز کردن فایل هاي قبلي در کادر Wizard ورودي وجود ندارد.
2- در پنل Document گزینه  چه عملي انجام مي دهد؟
ب- نمایش دو صفحه اي الف- نمایش تك صفحه اي    
د- نمایش حاشيه صفحه ج- نمایش چند صفحه اي         

Define Grids -3  ب��ه منظ��ور ............ و .............. نماي پرس��پكتيو )Perspective(  به کار 
مي رود.        

الف- نمایش - تغيير جهت                               ب- حذف - غيرفعال شدن 
د- ایجاد - ویرایش  ج- فعال شدن- تعویض                            

4- هر چقدر ش��عاع گردي گوش��ه ها )Corner Radius( در ابزار Rectangle  کمتر باش��د، 
ميزان انحناي گوشه هاي چهارگوش ......................... خواهد بود. 

ج- بيشتر             د- تأثيري ندارد. الف- گردتر        ب- کمتر 
5- شكل مقابل توسط کدام ابزار ترسيم مي شود؟

   Pen -الف  
                Line  -ب  

                     Bezigon -ج  
د- گزینه هاي الف  و ج صحيح  هستند.       

6- هنگام استفاده از ابزار Polygon و انتخاب گزینه Star اگر عبارت Number of Sides را 
برابر 4 قرار دهيد کدام شكل ترسيم مي شود؟

د-      ب-         ج-  
 

الف- 
7- کدام ی��ك از فرمت ه��اي زی��ر، فایل را ب��ا حجم پایي��ن و 16 ميلي��ون رنگ ذخيره 
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مي سازد؟
 bmp-د         fh10 -ج            jpeg -ب               gif -الف

8- در هنگام طراحي با اس��تفاده از کدام گزینه مي توان نماهاي مختلف دید را تعریف و 
ذخيره کرد؟

 magnification -ب    custom -الف

د- با استفاده از نواروضعيت       zoom-ج

9- اگر در هنگام رسم خط، کليدShift  را نگه دارید، خط چگونه رسم مي شود؟
الف- در زوایاي 45 درجه و صاف  

ب- نرم و عمودي
ج- از مرکز و بدون زاویه   

د- به صورت منحني 
Text Rulers-10  چه امكاني را ایجاد مي کند؟

الف- سبب نمایش خط هاي راهنما روي صفحه خواهد شد.
ب- براي ترسيم دقيق اشكال به کار مي رود.

ج- در زمان تایپ، خط کش کوچكي در بالاي متن ظاهر مي کند.
د- همان Page Ruler است.

11- اگر دس��تگيره هاي وس��طي سمت چپ و راس��ت متن بلوك ش��ده را درگ کنيد، 
مي توانيد:

ب- سایز قلم را بزرگ کنيد. الف- متن را بچرخانيد.                  
د- فاصله بين حروف را تغيير دهيد. ج- سایز حروف را کاهش دهيد.        

12- در متن زیر کدام Effect  به کار رفته است؟

Shadow -ب    Highlight -الف
    Inline -د                Zoom -ج

13- براي وارد کردنStyle هاي آماده قبلي باید گزینه ........... را انتخاب کنيد.
   Export-ب     Edit  -الف
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  Redefine -د     Import-ج
14- کليك روي دکمه  در نوار ابزار Text چه عملي را انجام مي دهد؟

الف- متن را روي مسير مورد نظر قرار مي دهد.
ب- مسير را روي متن مورد نظر قرار مي دهد.

ج- متن را از مسير جدا مي سازد. 
د- متن داخل شكل موردنظر قرار مي گيرد.

15- توس��ط کدام  گزینهConvert Case  کلمه  س��مت چپ به کلمه س��مت  راست تبدیل 
مي شود؟

       EXAMINATION              Examination

 lower -ب              upper -الف
small caps -د               title -ج

 Select 16- به منظ��ور انتخاب  کليه موضوعات طراحي ش��ده در کل  س��ند از کدام گزینه
مي توان استفاده کرد؟

  Super Select-ب                All -الف
    All in Document-د        Pointerج- با استفاده از

17- توسط چه گزینه اي از پنلTransform  مي توان شكل 1 را به 2 تغيير داد؟

           

Copy و Rotate  -د           Skew -ج               Rotate -ب     Copy و Scale -الف
18- براي ساخت اشكال خميده از ابزار ...................... استفاده مي شود.

 Fill  -د          Knife -ج               Trace -ب               Freeform-الف
19- براي تبدیل شكل 1 به 2 کدام ابزار به کار رفته است؟
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  Object -د             Scale -ج                 Rotate -ب           Reflect -الف
20- به منظور برش خط صاف کدام گزینه از ابزار Knife به کار مي رود؟

 Freehand-د             Straight -ج            Length -ب         Tight fit -الف
21- کدام گزینه در مورد پنل Object صحيح است؟

الف- مشخصات موضوع ترسيمي را نشان مي دهد.
ب- تنظيمات و مشخصات پنل Object  بستگي به موضوع انتخابي ندارد.

ج- گزینه هاي داخل Panel  فقط زماني فعال مي شوند که شكل با ابزارRectangle  ترسيم 
شود.

د- براي تغيير رنگ شكل رسم شده مورد استفاده قرار مي گيرد.
22- در کدام یك از پنل ها مي توان رنگ هاي جدیدي را از ترکيب رنگ ها ایجاد کرد؟

 Export Color-د      Swatches -ج     Color Mixer-ب  Replace Color -الف
23- توسط کدام گزینه شكل 2 و شكل 1 به وجود مي آید؟

   Pattern-د  Text     -ج  Fill  -ب      Stroke -الف
24- براي تكرار یك طرح در داخل یك شكل از کدام گزینه زیر استفاده مي شود؟

  Texture -د    None-ج            Tiled -ب               Basic -الف
25- انتخابJoin  به صورت   در پنل Object چه عملي را انجام مي دهد؟

الف- نوع گره را در انتهاي مسير مشخص مي کند.
ب- گوشه هاي دو خط یك مسير را پخ مي کند.
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ج- گوشه هاي دو خط یك مسير را گرد مي کند.
د- گوشه هاي دو خط یك مسير را نوك تيز مي کند.

26- براي نگهداري رنگ هاي ایجاد شده از گزینه .................. استفاده مي شود.
Color -ب                Tint-الف

 Color Mixer -د                 Swatches-ج
27- پنلTransform  کدام یك از اعمال زیر را کنترل مي کند؟

ب- تغيير جهت، اندازه و چرخش تصویر       الف- نكات مربوط به نوشته ها در تصویر   
ج- تغيير بزرگنمایي تصویر             د- تغيير رنگ هاي تصویر

28- براي تبدیل یك خط باز به یك پيكان از کدام گزینه استفاده مي شود؟
 Grid-د       Arrowheads -ج        Cap -ب       Color List -الف

29- اگر بخواهيد موضوع انتخاب ش��ده در بزرگ ترین حالت ممكن نمایش یابد از کدام 
گزینه استفاده مي شود؟

 Custom -د   Fit to Page -ج     Fit All -ب      Fit Selection -الف
30- براي نمایش ....................... باید خط کش )Ruler( روي صفحه ظاهر شود.

 Grid -ب    Perspective -الف
    Guides-د               Lock -ج

31- با استفاده از گزینه ..................... مي توان از چند شكل مجزا یك شكل   واحد  ساخت.
 Lock -د                Join -ج         Union-ب        Group-الف

32- براي انتخاب اجزاي یك گروه کدام ابزار به کار مي رود؟
د- همه  گزینه ها صحيح هستند.    Subselect -ج   Pointer -ب    Group -الف

33- براي اتصال دو پاره خط به یكدیگر، پس از انتخاب هردو خط چه باید کرد؟ 
الف- از فرمان Modify→Join  استفاده شود.

ب- از کليد ميانبر Ctrl+J استفاده شود.
ج- از فرمان Modify→Split  استفاده شود. 

د- از فرمان wtras → Join استفاده شود.
34- براي بریدن و جدا کردن قسمت هاي روي هم افتاده مسيرها از کدام فرمان استفاده 

مي شود؟
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  Punch -د           Crop -ج          Ungroup-ب      Split -الف
35- به کمك کدام ابزار مي توانيد با استفاده از اشكال گرافيكي از پيش آماده و با حرکت 

دادن  ماوس در صفحه، جلوه گرافيكي جالبي ایجاد کنيد؟ 
 Smudge -د                 Spiral-ج           Arc -ب       Graphic Hose-الف

36- ابزار 3D Rotation  در نوار ابزارXtra چه کاربردي دارد؟
الف- ایجاد عمق در موضوعات با استفاده از سایه

ب- ایجاد دوران سه بعدي در موضوعات 
ج- ایجاد تقعر و تحدب در موضوعات 

د- ایجاد دوران در موضوعات به صورت دو بعدي 
37- براي ترسيم خطوط مارپيچ از چه ابزاري استفاده مي شود ؟

 Bend -د        Smudge -ج             Spiral -ب              Arc -الف
38- کدام گزینه صحيح است؟

الف- پنل Align از طریق منوي Window ظاهر مي شود.
ب- براي باز کردن پنل Align  مي توانيد از کليد ترکيبي Ctrl+Alt+A استفاده کنيد.

ج- ازطریق پنل Align مي توانيد چندین موضوع را نس��بت به هم یا به صفحه در یك راستا 
قرار دهيد.

د- همه گزینه ها صحيح هستند.
39- با استفاده از کدام فرمان، شكل 1 به 2 تبدیل مي شود؟

 Ungroup-د                Intersect-ج          Divide-ب         Transparency -الف
40- براي محدب کردن یك متن کدام مورد زیر صحيح است؟

الف- ابتدا دستور Convert to path  و سپس ابزار Fisheye Lens را اجرا کنيد.
ب- براي محدب کردن موضوعات باید ابزار Arc را براي ایجاد قوس و انحنا به کار برد. 
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 Xtra  Toolsاز نوار ابزار Fisheye Lens ج- انتخاب ابزار
د- چنين امكاني وجود ندارد.

41- براي اصلاح جهت قرارگيري مس��يرها و کاهش تع��داد گره ها کدام گزینه از منوي 
Xtras به کار مي رود؟

 Clean up -د           Distort -ج           Create -ب      Colors -الف
42- نحوه عملكرد ابزار Blend در کدام گزینه زیر نشان داده شده است؟

الف-          ب-     

ج-      د-         
43- براي تبدیل رنگ موضوعات از مدل RGB یا CMYK به مدل خاکستري کدام مورد 

زیر صحيح است؟ 
Convert to Grayscale -ب                        Darken Colors -الف
         Lighten Colors -د                 Desaturate Colors-ج
44- فرمان Emboss از گزینه هاي فرمان  Create چه کاربردي دارد؟

الف- براي ایجاد جلوه آميختگي بين دو موضوع به کار مي رود.
ب- به منظور روي هم افتادن رنگ ها در چاپ استفاده مي شود.

ج- تعدادي گره به خطوط مسير اضافه مي کند.
د- انواع جلوه هاي برجسته سازي را ایجاد مي کند.

45- فرامين موجود در منوي Path Operation چه عملي را انجام مي دهند؟
الف- جلوه هایي به منظور زیباترکردن کار توليد مي کنند.

ب- مسيرهاي انتخاب شده را تغيير شكل مي دهند.
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ج- عملكرد فرامين آن مانند گزینه هاي منوي Modify است.
د- بعضي از خصوصيات غيرضروري موضوعات را حذف مي کند.

46-  با استفاده از کدام فرمان، شكل 2 از شكل 1 به وجود مي آید؟
Roughen -الف

                                                          Bend-ب
 Distort -ج

                          Simplify -د
47- کدام یك از موارد زیر جزء انواع سایه در ابزار Shadow نيست؟

 Soft Edge -د               Zoom -ج             Trap -ب       Hard Edge -الف
48-براي صدورفایل ایجاد شده در FreeHand   به نرم افزارهاي دیگر از چه فرماني اس��تفاده  

مي شود؟
Export -د       Import -ج          Open -ب            Save -الف

49- براي تعيين مشخصات چاپ از قبيل سایز، نوع کاغذ و کيفيت چاپ از کدام قسمت 
کادر محاوره Print  استفاده مي شود؟

  Color Management -ب   Properties -الف
   Scale -د            Print Range -ج

50- براي تبدیل موضوعات برداري به طرح بيتي از دستور .................. استفاده مي شود.
                                      Output options -د            Rasterize -ج      Extract -ب        Links -الف 

به سؤالات زير پاسخ تشريحي دهید.

     1- تفاوت دستور Import  وOpen  در FreeHand چيست؟
2- ی��ك روش براي اضافه کردن نقاط گره اي به مس��يرها و ی��ك روش براي کم کردن 

گره ها نام ببرید؟
3- اب��زار ................. براي ایجاد نمودارهاي گرافيكي و گزینه .............. براي ش��فاف کردن 

رنگ قسمت هاي مشترك به کار مي روند.
4- عملكرد گزینه ها و کليدهاي زیر را بنویسيد؟

 Ctrl+R -د             Ctrl+L -ج          Crop -ب              Split -الف
5- گزینه Snap to Grid چه عملي را انجام مي دهد؟



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
456

6- ابزارZoom  مشابه با کدام گزینه یا ابزار عمل مي کند؟                                            
7- تفاوت ابزارPen  و Bezigon در چيست؟ 

8- در هنگام کار با متن براي رنگ کردن دور متن از کدام ابزار استفاده مي شود؟
9- دو روش را براي انتخاب موضوعات در یك صفحه بنویسيد؟

10- معادل کليدي و دستوري موارد زیر را بنویسيد.
       Text→Attach to Path-ب             Edit→Select→All-الف

 Ctrl+F2 -د             Ctrl+T  -ج
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آزمون پاياني )عملي(

سري الف
1- الف( فایلي به نام Student بسازید که حاوي 2 صفحه افقي و 2 صفحه عمودي با واحد 

ميلي متر و به ابعاد A4  باشد، سپس نماي دید را دو برابر نماي فعلي قرار دهيد.
ب( تعدادUndo ها را به 16 افزایش دهيد.

 18x30 2- ش��كل زیر را ترس��يم کنيد و سپس آن را طرح یك کاغذ کادو به ابعاد کاغذ
قرار دهيد. 

3- شكل زیر را رسم کنيد.

4- رنگ هاي )M = 50 ،Y =80 ،K =0 و C =65( و )G =80 ،B =50 و R = 10( را ایجاد 
کنيد، سپس آن ها را به Swatches منتقل کرده و با نام هاي Rang1 و Rang2 ذخيره کنيد

رنگ خطوط شكل سؤال 3 را که به رنگ CMYK است، رنگ آميزي کنيد.
سري ب

سربرگي با مشخصات زير براي يک مؤسسه طراحي كنيد:

1- ابعاد سربرگ30×15 سانتي متر باشد.  
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2- از آرم زیر در سربرگ استفاده شود.     

3- با رعایت نكات صفحه آرایي، آرم  را در محل مناس��ب قرار داده و نام مؤسس��ه، شماره 
نامه، تاریخ، پيوست، آدرس و تلفن را در سربرگ بنویسيد.

4- آرم را به Photoshop ارس��ال کرده و براي زیبایي کار، روي آن فيلتر مناس��بي اعمال 
کنيد، سپس آن را به فایل خود وارد کرده و در زمينه سربرگ استفاده کنيد.



459 Free Hand پیمانه مهارتی : کاربر
پاسخنامه

پاسخنامه

آزمون نظري واحد کار 2

1-	غلط																			2-	صحيح																						3-	صحيح	
Welcome -6                       Setup -5                   4- غلط

 Screen-based -9                Publication -8           Stationery -7
10- د(گزینه های ب و ج صحيح هستند        11- ب( Setup.exe         12- ج( 100 

Online 14- ب( مرور سرفصل ها و درس هاي برنامه به صورت   Previous File )13- ج
17- افزایش - کاهش              Wizard-16  Template -15

آزمون نظري واحد کار 3

2- غلط            3- صحيح 1- صحيح 
Revert -6  Zoom -5  Import -4

Customize  Toolbar -7
10- ج( منوي Unit در نوار ابزار Info قرار دارد.  Info 9- ب( نوار 8- د( حذف 

11- ب( تایپ 130% در منوي  Magnification از نواروضعيت
Keyline )13- ج  Preferences )12- الف

14- ب( اگر چندین صفحه گرافيكي داش��ته باش��يد همه صفحات را در محيط نش��ان 
مي دهد.

15- ج( کليه تغييرات در ترسيم به آخرین مرحله ذخيره سازي برمي گردد.
Keyboard Shortcuts -18  TIF )17- د            FH11)16- ب

Text 20- زبانه  Save As -19
آزمون نظري واحد کار 4

2- غلط              3- غلط  1- صحيح 
Release -6  Library -5  Bleed -4

Snap Distance -7
8- د( همه  گزینه ها صحيح هستند.

9- الف( تغيير اندازه صفحه بر اندازه موضوع ترسيمي تأثير مي گذارد.
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Alt )11- د   Custom )10- ج
12- د( رنگ و تعداد خطوط شبكه سه بعدي را نمي توان تغيير داد.

Duplicate )13- ج
14- ب( براي استفاده ازMaster Page هاي ایجاد شده در سندهاي دیگرِ FreeHand آن ها 

را Export مي کنند.
 Release -16  View→Snap to Object )15- ب

17- جابه جایي صفحه
آزمون نظري واحد کار5

2- غلط             3- صحيح 1- صحيح 
Star -6  Rectangle -5 4- غلط 

Pen -8            9- ب( رسم دایره و بيضي  Line -7
Polygon )11- ج    Alt)10- د

12- ب( تعداد اضلاع چندضلعي را مشخص مي کند.
Shift )14- ج            Line )13- الف

15- ج( در ص��ورت فع��ال بودن ابزار Pen هنگامي ک��ه روي صفحه کليك مي کنيم یك 
16- امكان بالا بردن دقت کار  نقطه گوشه به  وجود مي آید. 
Alt -18   Shift -17          19- رسم خط صاف یا منحني

آزمون نظري واحد کار 6

2- غلط            3- غلط 1- صحيح 
 Pointer -6  Knife -5 4- صحيح 

Freeform -8  Alt -7
9- ب( رسم مارپيچ    10- د( رسم کمان    11- د( گزینه های ب و ج صحيح هستند

12- ج( برش زدن تصاویر 
13- د( همه گزینه ها صحيح هستند

Clone)15- ج   Straight )14- ب
Subselect -16                      17- چندین موضوع را باهم درحالت انتخاب قرارداد.

Alt -19 18- اتصال اشكال به یكدیگر 
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آزمون نظري واحد کار 7 

3- صحيح 2- غلط    1- صحيح 
Remove -6  Duplicate -5 4- غلط 

Saturate Colors )8- ب  Replace -7
WebSafe 216  )10- د              Darken Colors  )9- ب

HLS  )13- ج  Alt  )12- ب 11- د(  
 CMYK -15  Show /Hide names  )14- ج

 Name All Colors -17              16- کاهشي
18- 360+% تا 360-%             19- تك رنگ و دورنگ

آزمون نظري واحد کار 8

3- صحيح 2- صحيح  1- غلط 
6- شيب تابعي 5- شيب کروي  4- غلط 
Pattern )9- د   Trap -8  Fractalize -7

11- د( گزینه هاي الف و ج صحيح هستند.              Gradient )10- ب
    Eye Dropper)13- الف 12- ج( تعيين وضعيت انتهاي خطوط 

Blend -16  Stroke -15 14- د( مخروطي 
Ctrl+Shift+B -18                  17-جلوه هاي برجسته سازي

آزمون نظري واحد کار 9

3- صحيح 2- صحيح  1- غلط 
Remove Transform -6  Text Editor -5 4- غلط 

 Flow Around Selection -8  Attach To Path -7
9- ب( در روي متن خط رسم مي کند.

Text از منوي Attach To Path )11- ب 10- ج( ایجاد سبك قلم نازك و معمولي 
Shadow )13- د               Text→Leading→Other )12- الف

14- د( گزینه هاي الف و ب صحيح هستند.
15- ج( تبدیل حروف کوچك و بزرگ به یكدیگر در متون انگليسي
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16- ب( حرف اول همه کلمات متن انتخابي را بزرگ و بقيه را کوچك مي کند.
19- متن را به موضوع ترسيمي  Percentage -18  Sentence )17- ب

آزمون نظري واحد کار 10

3- غلط  2- صحيح  1- غلط 
Punch -6  Intersect -5 4- غلط 

Reverse Direction -8  Crop -7
Remove Overlap  )10- ب  Join )9- الف

 Unlock )13- ج  Union )12- ج  Align )11- الف
Expand Stroke )15- ب            Join )14- د

 Inset Path -18  Subselect )17- ب  Divide )16- الف
Skew -20  Horizontal -19

آزمون نظري واحد کار 11

2- صحيح   3- صحيح 1- غلط 
 Bend -6               Blur -5 4- غلط 

 Rotate from )9- ج   Emboss -8  Bevel -7
Bend  )11- ب              Fisheye Lens   )10- ج

Paste as envelope )13- د              Transparency )12- ب
Sketch -16  Ragged -15  Expand Path -14

آزمون نظري واحد کار 12

3- صحيح 2- صحيح  1- غلط 
6- غلط 5- صحيح  4- صحيح 

Unlock -Visible -8  Active -7
Remove Unused -11       Remove -10       Edit -9

Duplicate  )13- ب  Decimal Precision )12- ج
15- ج(    Merge Foreground Layers  )14- الف

 Guides -17            Large List View )16- الف
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19- والد یا اصلي         20- والد )اصلي( - فرزند  Auto-Update -18
آزمون نظري واحد کار 13

3- صحيح 2- غلط     1- صحيح 
Fireworks -6  Import -5 4- غلط 

 Jpeg )9- ج            GIF -8  Lossy -7
 Always Use Source PNG )10- الف

Trace )12- د 11- ج( تغيير اندازه و تغيير فرمت فایل 
13- ب( ميزان شباهت مسيرهاي Trace شده به مدل اوليه را تعيين مي کند.

Convert to Image -14                15- نرمي لبه هاي دور تصویر
Update -17   Alt -16

آزمون نظري واحد کار 14

3- صحيح 2- غلط    1- صحيح 
Action -6 5- صحيح  4- غلط 

Link to Target Page -8  Target Page -7
 The Full Screen action )10- د  Release to Layers -9

13- ج( تست و اجراي فيلم   GIF  )12- ب  Trail  )11- الف
Publish as HTML -14            15- بازیابي یا بارگذاري - عدم بازیابي

آزمون نظري واحد کار 15

2- غلط             3- صحيح 1- صحيح 
 Printer setup -6 5- صحيح  4- صحيح 

 All -9  Preview -8  Keyline -7
 Export )11- د  Output -10

Export Again )13- الف 12- گزینه های الف و ب صحيح هستند  
Selected Objects  )15- ب                           Print )14- الف

16- د( اطلاعات چاپ شده را درون یك فایل ذخيره مي کند. 
   RTF, ASCII-17

Open in external application -20  area -19 18- علامت ×   
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ضميمه الف
تمرينات كاربردي

1- تصاویرکتاب کودك را که در شكل 1- الف ، 2- الف و 3- الف نشان داده شده، ترسيم 
کنيد.

    

شکل 1- الف

شكل 2- الف
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شكل 3- الف

2- جلد کتاب با مشخصات زیر را طراحي کنيد.
الف( آموزش درس زبان انگليسي باشد.
ب( مربوط به پایه دوم دبيرستان باشد.

ج( سال چاپ و قيمت روي آن مشخص باشد.
3- کارت ویزیت مربوط به یك ش��رکت گرافيكي که در زمينه کار تبليغاتي فعاليت دارد 

را ترسيم کنيد.
4- یك سربرگ براي کلينيك تخصصي چشم پزشكي طراحي کنيد.

5- یك پوستر در ابعاد مناسب طراحي کنيد که موضوع آن اصلاح الگوي مصرف باشد.
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6- تصویر زیر را رسم کنيد.

شكل 4- الف

7- یك جعبه دستمال کاغذي را طراحي کنيد )از دستور Import براي استفاده از تصاویر 
استفاده کنيد(.

8- آرم هاي زیر را طراحي کنيد.

  

شكل 5- الف
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9- پشت و روي ساك دستي مربوط به یك فروشگاه کيف و کفش را طراحي کنيد.
10- کاغذ کادویي را ترسيم کنيد که مناسب براي کادوي تولد یك کودك باشد.

11- براي شعر زیر تصویر سازي کنيد.
» اي شاپرك! تن تو

ُپر موج، مثل آب است
آن بال کاغذینت 

مانند یك کتاب است    
در آن کتاب رنگی

عكس بهار پيداست
هم کوه و باغ و صحرا 

هم جویبار پيداست
کار تو، صبح تا شب

گشتن ميان باغ است
در این بهار زیبا

بازار تو چه داغ است!
اي شاپرك بيا، باز

 واکن کتاب خود را

در انتظار هستند

گل هاي خانه ما.” 
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ضميمه ب
MX FreeHand ميانبرهاي صفحه كليد در برنامه

File منوي

معادل کلیديگزينه

NewCtrl+N

OpenCtrl+O

Close  Ctrl+W

SaveCtrl+S

Save AsCtrl+Shift+S

ImportCtrl+R

ExportCtrl+Shift+R

PrintCtrl+P

QuitCtrl+Q

Edit منوي

UndoCtrl+Z

RedoCtrl+Y

CutCtrl+X

CopyCtrl+C

PasteCtrl+V

Special: Paste AttributesCtrl+Alt+Shift+V

Cut ContentsCtrl+Shift+X

Paste InsideCtrl+Shift+V

Duplicate Ctrl+Alt+D

CloneCtrl+Shift+D

Select:AllCtrl+A

Select All In DocumentCtrl+Shift+A

Select:NoneCtrl+D
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Find And ReplaceCtrl+F

PreferencesCtrl+U

  View منوي

Fit SelectionCtrl+Alt+ 0

Fit To PageCtrl+Shift+W

Fit AllCtrl+0

Magnification :%50Ctrl+5

Magnification :%100Ctrl+1

Magnification :%200Ctrl+2

Magnification : %400Ctrl+4

Magnification : %800Ctrl+8

KeylineCtrl+K

Fast ModeCtrl+Shift+K

ToolbarsCtrl+Alt+T

PanelsF4,Ctrl+Shift+H

Page Rulers:ShowCtrl+Alt+R

Text Rulers Ctrl+/

Guides:ShowCtrl+;

Guides: LockCtrl+Alt+;

Guides:Snap To GuidesCtrl+Shift+;

Grid: ShowCtrl+Alt+G

Grid:Snap To GridCtrl+Alt+Shift+G

Snap To PointCtrl+ '

Modify منوي

Transform:Scale…Ctrl+ F10

Transform AgainCtrl+,

 Arrange:Bring To FrontCtrl+Shift+Up Arrow
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Arrange:Move ForwardCtrl+Up Arrow

 Arrange:Move BackwardCtrl+Down Arrow

 Arrange:Send To BackCtrl+Shift+Down Arrow

Align:TopCtrl+Alt+ 4

Align:BottomCtrl+Alt+ 6

Align:Center HorizontalCtrl+Alt+ 5

Align:Center VerticalCtrl+Alt+ 2

Align:LeftCtrl+Alt+ 1

Align:RightCtrl+Alt+ 3

Align AgainCtrl+Alt+Shift+A

JoinCtrl+J

SplitCtrl+Shift+J

Combine:BlendCtrl+Shift+B

Combine:Join Blend To PathCtrl+Alt+Shift+B

LockCtrl+L

UnlockCtrl+Shift+L

GroupCtrl+G

UngroupCtrl+Shift+G

Symbol:Edit SymbolCtrl+ E

Symbol:Convert To SymbolF8

Convert to ImageCtrl+Alt+Shift+Z

Text منوي

Size:SmallerCtrl+Shift+ ,

Size:LargerCtrl+Shift+ .

Font Style: BoldCtrl+B

Font Style: ItalicCtrl+I

Font Style: BoldItalicCtrl+Alt+Shift+O



Free Hand پیمانه مهارتی : کاربر
ضمیمه ب

471

Effect:HighlightCtrl+Alt+Shift+H

Effect:StrikethroughCtrl+Alt+Shift+S

Effect:UnderlineCtrl+Alt+Shift+U

Align:LeftCtrl+Alt+Shift+L

Align:RightCtrl+Alt+Shift+R

Align:CenterCtrl+Alt+Shift+C

Align:JustifyCtrl+Alt+Shift+J

Special Character:Em SpaceCtrl+Shift+M

Special Character:En SpaceCtrl+Shift+N

Special Character:Thin SpaceCtrl+Shift+T

Special Character:Discretionary HyphenCtrl+ -

EditorCtrl+Shift+E

Flow Around SelectionCtrl+Alt+W

Flow Inside PathCtrl+Shift+U

Attach To PathCtrl+Shift+P

Xtras منوي

RepeatCtrl+Shift+ =

Window منوي

New WindowCtrl+Alt+N

ToolsCtrl+F2

ObjectCtrl+F3

AnswersCtrl+Alt+F1

LayersF2,Ctrl+ 6

SwatchesCtrl+F9

Styles Shift+F11, Ctrl+ 3

LibraryF11

Color MixerShift+F9, Ctrl+Shift+C



وزارت فرهنگ و ارشاد اسلامی
Free Hand نام استاندارد : کاربر

شماره : 15/7- ف - ه�
472

HalftonesCtrl+H

AlignCtrl+Alt+A

TransformCtrl+M

Movie:TestCtrl+Return

Movie: SettingsCtrl+Shift+Return
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